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Chapter 1. Release notes for DevOps Test Embedded
2023.12 (9.0.0)

This document includes information about the new features introduced, features deprecated or removed, defects
fixed, and known issues identified in this version of HCL DevOps Test Embedded (Test Embedded). You can also find

the installation and upgrade instructions along with the contact information of HCL Customer Support.

Exemple

Product description

Test Embedded is a complete test and runtime analysis tool set for systems development created in any cross-

development environment.

Test Embedded provides tools for automated component testing, code coverage, memory leak detection,
performance profiling, and UML sequence diagram tracing.

What's new

You can find information about the features introduced, enhancements, or other changes in Test Embedded. See

What's New on page 7

Deprecated features or capabilities

To find information about the features or capabilities that are deprecated in this version and are planned for removal

in a future release, see Deprecations and removals on page 14.

Removed features or capabilities

To find information about the features or capabilities that are removed in this version, see Deprecations and removals

on page 14.
Product download and installation
For instructions about installing the software, see Installing software on page 39.

If you have purchased the licenses to use the product, you can download the product software packages from HCL®

License & Delivery portal.
Product upgrade

Defect fixes and known issues

For the list of defects fixed in this version that include defects submitted by customers and defects found during

testing, see Defect fixes on page 15.
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For the list of known issues that are identified in this version and the previously published known issues that are still

applicable, see Known issues on page 21.
Contacting HCL support

« For technical assistance, contact HCL Customer Support.

- Before you contact HCL support, you must gather the background information that you might need to describe
your problem. When you describe a problem to the HCL support specialist, be as specific as possible and
include all relevant background information so that the specialist can help you solve the problem efficiently.
To save time, know the answers to these questions:

> What software versions were you running when the problem occurred?

> Do you have logs, traces, or messages that are related to the problem?

> Can you reproduce the problem? If so, what steps do you take to reproduce it?

o |s there a workaround for the problem? If so, be prepared to describe the workaround.

What's New

You can find information about the features introduced, enhancements, or other changes made in HCL DevOps
Test Embedded (Test Embedded). You can also find the features that were introduced in previous versions of Test
Embedded. DevOps Test Embedded is the new name of HCL OneTest™ Embedded from 9.0.0 onwards.

What's New in 2023.12 (9.0.0)

The following section lists the features, enhancements, or other changes made in Test Embedded.

Feature title Description
Renaming of OneTest The following OneTest products have new names starting from 9.0.0:
products

« HCL OneTest™ Embedded is now HCL DevOps Test Embedded.

* HCL OneTest™ Ul is now HCL DevOps Test Ul.

« HCL OneTest™ API is now HCL DevOps Test Integrations and APlIs.

« HCL OneTest™ Performance is now HCL DevOps Test Performance.

« HCL OneTest™ Server is now HCL DevOps Test Hub.

« HCL® Quality Server is now HCL DevOps Test Virtualization Control Panel.
» HCL OneTest™ Virtualization is now HCL DevOps Test Virtualization.

* HCL OneTest™ Studio is now HCL DevOps Test Workbench.

Addition of new MISRA DevOps Test Embedded now includes new MISRA rules, specifically rule 12.11 for
rules MISRA 2004 and rules 9.4, 9.5, 11.9, and 12.4 for MISRA 2012. The qualification kit is
enhanced to align with these newly added rules. See Code review MISRA 2004 rules
on page 238 and Code review MISRA 2012 rules on page 271.
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Feature title

Description

Support for ASM ARM cov-
erage for 64-bit version

The ASM ARM coverage capabilities are enhanced to include both 32-bit and 64-bit
version. This is an extension of the coverage for ASM ARM 32-bit version. The sup-
ported coverage levels are also the same for 64-bit version. The ASM ARM coverage
extension is compatible with C/C++ and Ada coverage. Additionally, the Target De-
ployment Port (TDP) for Raspberry Pi is enhanced to include the ASM ARM coverage
for 64-bit version.

Non-coverage justification
extended to include Ada

language

The non-coverage justification feature is now extended to the Ada language. You can
now justify non-reachable branches by using a pragma directly in the relevant source
code. The coverage percentage incorporates this justification, and the details of the

justification are included in the report. See Justification of non-covered lines of code

on page 196 and Instrumentation pragmas for Ada language on page 1309

Enhanced the requirement

traceability matrix

You can now select the attribute that you want to use as the identifier for traceabili-
ty between test cases and requirements. Previously, requirements used the attribute
ID, which might not be relevant for certain requirements management tools, partic-
ularly those with automatically generated IDs. See Linking tests to requirements on

page 963 and Importing requirement files on page 402

Enhancement to the com-

mand line option

You can run a test suite or a test harness by using the command-line interface of
Eclipse. You can now select the Target Deployment Port (TDP) and the configuration
when you run tests in the batch mode. See Starting a test from the command line on

page 390.

Support to generate a

merged report

You can now generate a merged report, which includes the results of all the test har-
nesses and the runtime analysis results by selecting multiple test suite results and by
clicking the Merge... option from the menu in Project Explorer. See Running a test suite
on page 388.

Introducing the Run Static
Analysis option in Project

Explorer

You can now run code reviews and other static analysis tools directly from the Project
Explorer without compiling the application, and then view the results at the end of the

analysis. See Running static analysis on page 188.
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Feature title

Description

Introducing the project set-

tings option on the toolbar

The project settings option is now available on the toolbar on DevOps Test Embedded.
You can now easily access and modify your project property settings directly from the
toolbar. See Running static analysis on page 188.

Support to create a project

by using the import wizard

You can now create a DevOps Test Embedded project by using an import wizard. You
can now import a compilation database from either a CMake database or a folder that
contains the source code under test. You can optionally use a CMake compilation
database or select a folder that contains the source code under test.

Support to integrate Git in
DevOps Test Embedded
Studio

The support for Git is added in the integrated tools of DevOps Test Embedded Studio.
You can now manage your code versioning directly in your DevOps Test Embedded

Studio environment.

Qualification Kit

The qualification kit has been updated with the following new components:

« Visual Test

« Control Coupling

« Data Coupling

» Coverage ASM ARM 32 & 64 bits

Control & Data Coupling qualification kit is an extension of the C Coverage qualifica-
tion kit.

The qualification kit for MISRA 2014 & 2012 is updated with new rules and tests on
command line interface.

Target Deployment Port
(TDP)

» New Ada gnat TDP based on GPRBuild.
« Visual Studio 2022.

Supported Platforms

« Eclipse 2022-06
* Eclipse 2023-06

You can find information about the features introduced in previous versions of HCL OneTest™ Embedded in the

following sections:

« What's New in 8.3.2 on page 10

« What's New in 8.3.1 on page 10

« What's New in 8.3.0 on page 11



10

HCL DevOps Test Embedded

What's New in 8.3.2

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Embedded.

Feature title

Description

Features and Enhance-

ments

The following sections list the new features, enhancements or other changes made in

this release.

« Integration with ETM 7.0.2
- Better support of C++20 syntaxes
+ Miscellaneous:
o TDP for Visual Studio 2022
o Export HTML reports in HCL OneTest™ Embedded for Eclipse IDE

What's New in 8.3.1

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Embedded.

Feature title

Description

Monitoring

- This feature targets cyclic-executive applications, that is applications that main-
ly rely on a cycle where input data are read and output data are set at each cycle.
These input/output data are implemented with global variables. See Application
monitoring on page 405

» The complete application is instrumented to be able to access to the global vari-
ables in read/write mode with various means (socket, files...). See Application
monitoring on page 405.

« A new view in HCL OneTest™ Embedded for Eclipse IDE is available to interac-
tively modify the input data and display the output data. See Recording a moni-
toring script on page 411.

« Output data can be displayed as curves on a graphical view.

Test Case Generation for C
(preview)

- This is a preview feature of the new test case generation integrated in HCL
OneTest™ Embedded for Eclipse IDE only for now.
« When this feature is enabled, the source code is analyzed and the test cases can

be generated from:
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Feature title

Description

> The call graph: A coverage objective can be provided to generate test
cases.

> The coverage viewer: Clicking on a branch displays in a new view the
precondition to satisfy in input of the function under test, and a new test
case can be generated to satisfy this precondition.

Import requirements with

format ReqlF

In HCL OneTest™ Embedded for Eclipse IDE preferences, the user can now load a require-
ment file that supports the format ReqlF. See https://www.omg.org/spec/ReqlF/About-
ReqlF/ and Tests linked to requirements.

Support C++17 and C++20

syntaxes

Almost all C+20 syntaxes are supported under Support for C17 and C+20 syntaxes.

Multiple user-defined
MISRA rules

» Multiple user-defined rules can be defined in MISRA 2004 and MISRA 2012.
« Each rule can have its own severity.

See Configuring code review rules on page 230 and Configuring code review

rules on page 528.

MISRA updater

» When you update from an old version of HCL OneTest™ Embedded and you
use MISRA in HCL OneTest™ Embedded for Eclipse IDE 8.3.1 for the first time,
you are requested to update the configuration rule with the new rules added to
the new version. By default, the unselected rules are disabled, they must be se-
lected to be enabled. See Configuring code review rules on page 230.

« In HCL OneTest™ Embedded Studio, the configuration file is automatical-
ly updated and the new rules are disabled. See Running a code review on
page 533.

Support for Eclipse
2020-06 (4.12)

HCL OneTest™ Embedded is still delivered with Eclipse 4.7.2 but it can be also in-
stalled on Eclipse 2020-06 (4.12).

TDP Visual 2019

A new Target Deployment Port dedicated to Microsoft Visual 2019 is delivered.

What's New in 8.3.0

The following section lists the features, enhancements, or other changes made in HCL OneTest™ Embedded.
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Feature title

Description

Justification of non-cover-

age

« It could be difficult to achieve 100% of code coverage during the testing phases
because some pieces of code could be non-reachable by tests.

- Testers can now justify the non-reachable branches with a pragma in the relevant
pieces of source code.

« This justification is taken into account in the coverage percentage and the justi-

fication is included in the report.

For more information, see Justification of non-covered lines of code on

page 196 for Eclipse IDE and for Studio.

Coverage of Assembler
language for ARM 32 bits
processor

* HCL OneTest™ Embedded includes now assembler code coverage for ARM 32
bits processor using the gcc for ARM tool chain.
- Assembler source files are taken into account in the builds as the C/C
++ source files.
o Or, optionally, C/C++ source files could be instrumented at the assembler
level instead of being instrumented at the C/C++ level.
 The supported coverage levels are:
> Functions
o Functions and exits
o Statement blocks
o Calls
. o Coverage of Assembler language for ARM processor is fully compatible
with C/C++ and Ada coverage.

> A new TDP for Raspberry Pie is now delivered.

For more information, see Code coverage for assembler source files on
page 203 for Eclipse IDE and Code coverage for assembler source files on

page 599 for Studio.

Support Eclipse 4.7.3 and
4.12 (2019.06) and CDT 9

« HCL OneTest™ Embedded is now delivered with Eclipse 4.7.3 and CDT 9.
« It can be also installed on Eclipse 4.12 (a.k.a. 2019.06) using the update site

mechanism.

Support Eclipse 4.7.3 and
4.12 (2019.06) and CDT 9

« HCL OneTest™ Embedded is now delivered with Eclipse 4.7.3 and CDT 9.
« It can be also installed on Eclipse 4.12 (a.k.a. 2019.06) using the update site

mechanism.
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Feature title

Description

Execute OTD test scripts in

« A tester can now import and run OTD test scripts from Studio to Eclipse IDE

Eclipse IDE and run them, exactly as he does with PTU test scripts. See Testing with .otd
test scripts on page 393
« Reports are generated in the same way as it is in Studio.
New Code Review HTML - Code review post-processor generates now a new HTML report additionally to
report the standard report.

« This report is created from a template that the tester can modify to introduce
his own logo, or titles for example. See Customizing the code review report on

page 333

MISRA 2004 and 2012

rules improvements

See Code review MISRA 2004 rules on page 238 and Code review MISRA 2012 rules
on page 271

« The rules related to the number of lines of code propose now different ways to
compute this number of lines of code (with or without the empty lines, with or
without the comments).

* New rules are available:

- max # of functions in a compilation unit
- max # of global variables in a compilation unit
> max # of lines in a compilation unit

> max # of parameters in a function

Open Eclipse IDE to other

testing tools

- Eclipse IDE supports now test scripts based on Python, shell or windows com-
mand instructions. See Testing with Python, Perl, Windows or Linux scripts
on page 394 and Configuring Python, Perl, Windows or Linux scripts on
page 395

 Runtime analysis features can be used in parallel.

« HTML reports generated by these tools can also be part of the global report.

For more details, see Creating test suites on page 385.

Publish HTML reports on
HCL OneTest™ Embedded

OneTest Embedded HTML reports can now be published on OneTest Server. See Pub-
lishing HTML reports to the Server on page 1177.
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Deprecations and removals

You can find the features or capabilities announced as deprecated and the features or capabilities that are removed
in HCL DevOps Test Embedded (Test Embedded). DevOps Test Embedded is the new name of HCL OneTest™
Embedded from 9.0.0 onwards.

When features or capabilities are announced as deprecated, they continue to be supported although such features or
capabilities are no longer enhanced and might be removed in a subsequent release. If you use a deprecated feature,

you must migrate to the alternate feature, if applicable, before the deprecated feature is removed.

The removed features will not be available in the product version in which they are removed.
Note: You can contact the HCL Client Support team if you have any concerns.

You can find information about the following deprecations or removals:

« Product features or capabilities on page 14

« Dependent software on page 14

Product features or capabilities
You can find information about the features or capabilities of Test Embedded that are announced as deprecated in an

earlier version, and the version in which they are removed.

Note: The features removed in this version are listed first, followed by the features deprecated. The features

removed or deprecated in earlier versions are listed later in the table.

Feature or capability Feature deprecated in ver- | Alternate feature, if ap- | Feature removed in
sion plicable version
attolccp parser 8.2.0 attolcc4 parser Not applicable

Dependent software

You can find information about the dependent software that were announced as deprecated in an earlier version and
the version in which they were removed. Dependent software can include the operating systems, license servers,

applications, or software required for using Test Embedded.
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Note: The features removed in this version are listed first, followed by the features deprecated. The features

removed or deprecated in earlier versions are listed later in the table.

Feature or capability

Feature deprecated in ver- Alternate feature, if ap- | Feature removed in
sion plicable version

No dependent software feature or capability removed.

Defect fixes

You can find the defects that are fixed in this version of HCL DevOps Test Embedded (Test Embedded). You can also

find the defects that were fixed in the earlier versions of Test Embedded. DevOps Test Embedded is the new name of
HCL OneTest™ Embedded from 9.0.0 onwards.

You can find the following information:

« Defects fixed in Test Embedded 2023.12 (9.0.0) on page 15

« Defects fixed in earlier versions on page 16

Defects fixed in Test Embedded 2023.12 (9.0.0)

The defects fixed in the current version of Test Embedded are as follows:

Table 1. List of fixes in Test Embedded

ID /APAR

Description

TESTRT-3807

Previously, when you clicked the Open Call Graph option on the project or Refresh op-
tion from the View Menu drop-down list in DevOps Test Embedded for Eclipse IDE, a
null pointer exception error message was displayed if the code contained ternary ex-

pressions with function pointers. This problem is fixed.

TESTRT-3801

Previously, when you selected the Convert to IBM Rational Test RealTime Project op-
tion from the menu on a project that was not a C project, a null pointer exception error

message was displayed. This problem is fixed.

TESTRT-3796

Previously, if a ternary expression contained a constant, the coverage instrumentor
failed to correctly determine the instrumentation position and completed the test run

with an internal error. This problem is fixed.
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Table 1. List of fixes in Test Embedded (continued)

ID /APAR

Description

TESTRT-3708

Previously, during an Ada unit test, post processing of a complex Data Description
Type (DDT) file might fail that results in errors such as TestRT-F-LEXERRTDC and
TestRT-E-BADRODFIL. This problem is fixed.

TESTRT-3706

Previously, when the server had only one license, the checkout process for that license
occasionally failed. This problem is fixed.

TESTRT-3705

Previously, when you analyzed a package separately from another package by using
Ada source code parser at t ol st art Ada. The parser generated all the services for pro-
cedures in all sub-packages that resulted in the creation of large PTU files. This prob-

lem is fixed.

TESTRT-3619

Previously, documentation for the launcher attolcc (C and C++ Instrumentation
Launcher) and for attolcc4 (C and C++ Instrumentor) was not updated. This problem
is fixed.

TESTRT-3619

Previously, the Coverage C++ instrumentor (attolcc4) failed when the analyzed files in-
cluded Visual Studio 2019 C++ header files. This problem is fixed.

TESTRT-3597

Previously, when you used the FORMAT instruction to format a 64-bit integer in a field
of structured variables, the instruction failed to apply the specified format and dis-

played the value in the decimal format. This problem is fixed.

TESTRT-3568

Previously, when you included a VAR instruction with an expression in a PTU file that
contained a shift operator, for example, 277<<22, the post processor failed to gener-

ate the report. This problem is fixed.

Defects fixed in earlier versions

You can find information about the defects fixed in each of the following versions:

- Defects fixed in 8.3.2 on page 17

« Defects fixed in 8.3.1 on page 19

« Defects fixed in 8.3.0 on page 20
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The defects fixed in HCL OneTest™ Embedded 8.3.2 are as follows:

Table 2. List of fixes in 8.3.2

ID /APAR Description

TESTRT-2080 When you ran a test suite, the Control Coupling and the Worst Stack Size reports were
not generated.

This problem is fixed.

TESTRT-2275 Previously, HCL OneTest™ Embedded incorrectly calculated the essential type for the
enum constants.
This problem is fixed.

TESTRT-3342 Previously, the essential type calculation on the enum constant was incorrect if the
enum type declaration had no name.
This problem is fixed.

TESTRT-3343 Previously, Rule 10.3.2 was applied incorrectly on pointers during a Code Review.
This problem is fixed.

TESTRT-3340 Previously, for the rule M15.4, if there was a switch/case statement in a loop (for /
do while / while), the break instructions relative to the switch/case was counted as a
break in the loop.

This problem is fixed.

TESTRT-3366 Previously, when you used a custom Boolean type constant the essential type was in-
correctly calculated.
This problem is fixed.

TESTRT-3372 Previously, HCL OneTest™ Embedded incorrectly performed Rule M10.1.1 checks on
the preprocessing expressions.
This problem is fixed.
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Table 2. List of fixes in 8.3.2 (continued)

ID /APAR Description

TESTRT-3314 Previously, the preprocessor of System Test crashed when displaying a variable that
was declared as an enum. This problem is fixed.

TESTRT-3326 Previously, the count of the statement metric was incorrect for the atostart4.
This problem is fixed.

TESTRT-3335 Previously, attolstartC crashed on displaying a specific syntax error message.
This problem is fixed.

TESTRT-3350 Previously, the GNAT compiler failed to include the subdirectories specified under
[myPath]/** when working in Studio or Ada. This problem is fixed. The notation [my-
Path]/** that is used by the GNAT compiler to specify the subdirectories is extended
for C/C++.

TESTRT-3529 Previously, when you used the #h format in a .ptu file, the postprocessor generated a
result with insignificant digits.
This problem is fixed.

TESTRT-3344 Previously, the preferences were not saved in attolstudio2.ini file if it existed or the at-
tolstudio2.ini file was not created if it did not exist. This problem is fixed.

TESTRT-3425 Previously, there was no documentation about the command line of the HTML report
generator. This problem is fixed.

TESTRT-3423 Previously, when you generated the Control Coupling report for the top node of the
project explorer in Studio, the report did not display any data.
This problem is fixed.

TESTRT-3446 Previously, the "\xff' character in a C comment was incorrectly identified as an End Of
File character. This problem is fixed.
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Defects fixed in 8.3.1

The defects fixed in HCL OneTest™ Embedded 8.3.1 are as follows:

Table 3. List of fixes in 8.3.1

ID /APAR Description

TESTRT-1578 Previously, attolcc4 might have taken a longer time to process a corelation between macros
in the source file (.c) and the preprocessed file (.i).
This problem is fixed.

TESTRT-3055 Previously, in HCL OneTest™ Embedded 8.3.0.1, when a custom rule was used, a syntax er-
ror occurred in the generated perl file.
This problem is fixed.

TESTRT-3063 Previously, code review linker tool (crcld) took a very long time or crashed without any sig-
nificant message in case of complex combination of files that are mutually inclusive.
This problem is fixed.

TESTRT-3074 Previously, if you customized the confrule file, and then ran a code review with a new version
of One Test Embedded, the rule raised is in the format 'CRC_XX_YYY' instead of 'Rule MX.Y".
This problem is fixed.

TESTRT-3135 Previously, HCL OneTest™ Embedded incorrectly identified the type of enum initialized with
a casted constant when you ran a Code Review.
This problem is fixed.

TESTRT-3075 Previously, the crcld ignored the edited parameters in the confrule file for some rules and
did not raise the rule.
This problem is fixed.

TESTRT-3085 Previously, on windows, attolcc4 incorrectly displayed a fatal error when trying to match the
short and long DOS file names.
This problem is fixed.
Now, attolcc4 displays a message and not a fatal error.
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Table 3. List of fixes in 8.3.1 (continued)

ID /APAR

Description

TESTRT-3125

Previously, HCL OneTest™ Embeddedincorrectly applied rules E15.4 and M15.6.6. in the
MISRA C 2012.

This problem is fixed.

TESTRT-3152

Previously, when you used the Studio command line to export an html report, HCL OneTest™
Embedded Studio disregarded the value provided for the html report.

This problem is fixed.

TESTRT-3147

Previously, the code review source code analysis failed due to an implicit cast of the pointer

to an internal error.

This problem is fixed.

TESTRT-3118

Previously, when you ran the Code Review, HCL OneTest™ Embedded incorrectly raised Rule

10.1.1 when pointers were initialized with ‘0’.

This problem is fixed.

TESTRT-1915

Previously, on RedHat 7, the Call Graph in Eclipse IDE did not correctly display the links and
colors.

This problem is fixed.

TESTRT-2610

Previously, the rod2xrd binary crashes if the rod file was too large as a result of running a

large test.

This problem is fixed.

Defects fixed in 8.3.0

The defects fixed in HCL OneTest™ Embedded 8.3.0 are as follows:

Table 4. List of fixes in 8.3.0

ID /APAR Description
TESTRT-2370 Requirement link: Should add http:// or https:// when required
TESTRT-2375 Control coupling HTML report - bad display in internal eclipse browser.
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Table 4. List of fixes in 8.3.0 (continued)

ID /APAR Description

TESTRT-1447 Too much information in the ‘output window' made the user interface 'studio’ crash.
Workaround: Set the environment variable TESTRT_LOGFILE to point to a file in which
all the login information was diverted.

TESTRT-2604 When opening all the reports in Studio, the process tries to open nonexisting reports.

TESTRT-2739 The settings 'Additional included system directories' is not taken into account in Code
Review.
This problem is fixed.

Known issues

You can find the known issues that are identified, if any, in this version of HCL DevOps Test Embedded (Test
Embedded). You can also find the known issues identified in the earlier versions of Test Embedded. 2023.12 (9.0.0)

You can find the following information:

» Known issues in Test Embedded 2023.12 (9.0.0) on page 21

« Known issues from earlier versions on page 22

Known issues in Test Embedded 2023.12 (9.0.0)

The known issues identified in Test Embedded 2023.12 (9.0.0) are as follows:

Table 5. Known issues in Test Embedded 2023.12 (9.0.0)

ID Description

TESTRT-3592 In a PTU file, when you try to initialize or check the results of an array of structures and the
structures that contain arrays, might lead to an index error. This error leads to an incorrect
initialization or comparison, and results in a test failure.
To work around this problem, instead of having a single test instruction for the entire struc-
ture or array, write one test instruction per field.

TESTRT-3808 In DevOps Test Embedded Studio Project Explorer, a parent node incorrectly displays a suc-
cess status even when one or more of its child nodes fails.
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Table 5. Known issues in Test Embedded 2023.12 (9.0.0) (continued)

ID

Description

Known issues from earlier versions

The known issues identified in the earlier versions of Test Embedded that are still applicable are as follows:

Table 6. Known issues from earlier versions

ID

Description

Identified in version

TESTRT-143

@n Eclipse, in the Test Case editor, the red cross
on Stub Behavior is not refreshed after execution.
Workaround: Select another result to display, then
re-select the original one.

8.3.0

TESTRT-130

BThe Studio C++ wizard does not generate stub
and OTD properly when the method to stub is
declared into a class which is part of a tem-
plate.Workaround: Change the .stb and .otd manu-

ally once generated by the wizard.

8.3.0

TESTRT-136]

8The TDP cvisual10 and cvisual10_64 do not de-
tect FIU properly due to removed system meth-
ods. Workaround: Set Library/Heap Management
Configuration/FIU detection to RTRT_NONE.

8.3.0

TESTRT-208

Control Coupling and Worst Stack reports are not
available on Test Suite results.

8.3.0

TESTRT-246

60N large trace file, there is no way to stop the load-

ing.

8.3.0

TESTRT-347

2In recent gcc compiler (cygwin), the qualification
kit could not compile after instrumentation that

uses absolute paths.

8.3.2

TESTRT-213

PDepending on the compiler definition, plain char

may be signed or unsigned. So, any rule related to

8.3.0
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Table 6. Known issues from earlier versions (continued)

ID

Description

Identified in version

unsigned the type should be ignored when under-
lying type is a plain char.

TESTRT-323

Ain Misra 2004, the rule M6.1.1 is not triggered on

plain char when char are unsigned by default.

8.3.2

TESTRT-347

2In recent gcc compiler (cygwin), the qualification
kit could not compile after instrumentation that

use absolute paths.

8.3.2

TESTRT-282

bTesting a C file that requires header (.h) files,
when linking these files, we lost the visibility of
the data types (required for enumerated types
and stubs that return an enumerated type). What

would happen if, when

8.3.1

TESTRT-189

7Tiny toolbar icons for Coverage and Performance

reports

8.3.1

TESTRT-227|

8n chapter 10, 'essential type' is calculated for all
expression nodes. Enums have a specific behav-
ior as they can be seen either as true enum, or as
signed (in case of anonymous enums). Result may

be erroneous on enum constants.

8.3.0

TESTRT-191

50n RedHat 7, the Call Graph is not displayed prop-

erly, which makes it nearly unusable.

8.3.0

TESTRT-261

00N very large test reports, rod2xrd could
crash (depending of the machine memory
size).Workaround: Reduce the size of the test re-
port by running the test case selecting a subset of

test cases.

8.3.0
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This document includes information about hardware and software requirements for HCL DevOps Test Embedded
(Test Embedded).

Contents

- Hardware on page 25

» Operating systems on page 25

* Prerequisites on page 26
o Eclipse Runtime Environment on page 26
o Installation on page 27
» Development environments on page 36
« Integration environments on page 27
o Compilers and languages on page 27
> Development Tools on page 28

o Quality_management on page 28
« Disclaimers on page 24

Disclaimers
This report is subject to the Terms of Use and the following disclaimers:

The information contained in this report is provided for informational purposes only. While efforts were made to
verify the completeness and accuracy of the information contained in this publication, it is provided AS IS without
warranty of any kind, express or implied, including but not limited to the implied warranties of merchantability, non-
infringement, and fitness for a particular purpose. In addition, this information is based on HCLs current product
plans and strategy, which are subject to change by HCL without notice. HCL shall not be responsible for any direct,
indirect, incidental, consequential, special or other damages arising out of the use of, or otherwise related to, this
report or any other materials. Nothing contained in this publication is intended to, nor shall have the effect of, creating
any warranties or representations from HCL or its suppliers or licensors, or altering the terms and conditions of the
applicable license agreement governing the use of HCL software.

References in this report to HCL products, programs, or services do not imply that they will be available in all
countries in which HCL operates. Product release dates and/or capabilities referenced in this presentation may
change at any time at HCLs sole discretion based on market opportunities or other factors, and are not intended to
be a commitment to future product or feature availability in any way. Discrepancies found between reports and other
HCL documentation sources may or may not be attributed to different publish and refresh cycles for this tool and
other sources. Nothing contained in this report is intended to, nor shall have the effect of, stating or implying that any
activities undertaken by you will result in any specific sales, revenue growth, savings or other results. You assume

sole responsibility for any results you obtain or decisions you make as a result of this report.
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Notwithstanding the Terms of Use users of this site are permitted to copy and save the reports generated from this

tool for such users own internal business purpose. No other use shall be permitted.

Hardware
You can find information about the hardware requirements for HCL DevOps Test Embedded (Test Embedded) 9.0.0.
Hardware Deployment units Requirement
Disk space Desktop For Windows/Linux: 1.5GB
Memory Desktop Windows/Unix: 4 GB RAM
Processor Desktop Windows/Unix: x64

Related information

System Requirements on page 24

Operating systems

You can find details about the supported operating systems.

Operating systems

Operating system Version Hardware
Red Hat Enterprise Linux (RHEL) Client 7.0 x64
x64
Red Hat Enterprise Linux (RHEL) Client 8.0
SUSE Linux Enterprise with Legacy Module in- 15.0 x64

stalled (64 bits)

Ubuntu Desktop 16.04 x64

Ubuntu Desktop 18 18.04 x64
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Operating system Version Hardware
Ubuntu Desktop 20.04 x64
Windows 10 x64

11 x64
Windows Server 2016 x64

2019 x64

Note: For Linux, the product is dynamically linked with the following libraries:

* libc.s0.6, libXp.s0.6, libc-2.2.4.s0

Related information

System Requirements on page 24

Prerequisites

You can find the prerequisites that support the operating capabilities for HCL DevOps Test Embedded (Test

Embedded) 9.0.0.

Contents

Eclipse Runtime Environment on page 26

Installation on page 27

Eclipse Runtime Environment

Prerequisite Version

Version Minimum

Eclipse 412
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Prerequisite Version

Version Minimum

Eclipse 4.24 (2022-06)

473

Installation

Prerequisite Version

Version Minimum

IBM Installation Manager 1.8.6

Related information

System Requirements on page 24

Integration environments

The Prerequisites section specifies the capabilities that HCL DevOps Test Embedded (Test Embedded) 9.0.0 requires,

and the prerequisite products that can be used to fulfill those capabilities. You can find details about the additional

software that are supported.
Contents

Compilers and Languages on page 27
Development Tools on page 28

Quality Management on page 28

Compilers and languages

Supported software Version

Microsoft Visual C++ 2005 and future fix packs
2008 and future fix packs

Microsoft Visual C++ .NET 2003 and future fix packs
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Development Tools

Supported software Version Supported software minimum
Microsoft Visual Studio 2005 and future fix packs
2005 and future fix packs

201x and future versions, releases,

and fix packs

Rational Software architect 8.x
Engineering Workflow Management
5.0.x 4.x
Model RealTime
11.2
Quality Management
Supported software Version Supported software minimum
IBM Engineering Test Management | 7.0.2 7.0.2

Related information

System Requirements on page 24




Chapter 3. Getting Started Guide

This guide provides an overview of HCL DevOps Test Embedded (Test Embedded). You can find the information to
get you started with Test Embedded. This guide is intended for new users.

Before you can perform the various tasks described in the Getting Started Guide and the other guides, you must install

Test Embedded. See Installing on page 38.

Overview

HCL DevOps Test Embedded (Test Embedded) is a complete test and runtime analysis tool set for systems
development created in any cross-development environment. Test Embedded provides tools for automated
component testing, code coverage, memory leak detection, performance profiling, and UML sequence diagram
tracing.

Systems development includes (but is not limited to) embedded, real-time and/or technical systems development.
And this type of software is often performed in conjunction with the larger scope of a systems engineering activity.
Test Embedded is a cross-platform solution designed specifically for developers creating software applications for
products of embedded (for example, mobile phone, medical device, handled global positioning system, and so on),
real-time (for example, aerospace, automotive or telecommunications control system), and other technical systems

applications for example, simulated research computation and advanced grid computing systems).

Implementing a practical, effective and professional testing process within your organization has become essential
because of the increased risk that accompanies software complexity. The time and cost devoted to testing must
be measured and managed accurately. Very often, lack of testing causes schedule and budget overruns with no
guarantee of quality. Critical trends require software organizations to be structured and to automate their test
processes. These trends include:

« Ever increasing quality and time to market constraints.

- Growing complexity, size and number of software-based equipment.

« Lack of skilled resources despite need for productivity gains

« Increasing interconnections of critical and complex embedded systems.

- Proliferation of quality and certification standards throughout critical software markets, including the avionics,
medical, and telecommunications industries.

Test Embedded provides a full range of answers to these challenges by enabling full automation of system and
software test processes.

Test Embedded is a complete test and runtime analysis tool set for embedded, real-time and networked systems
created in any cross-development environment. Automated testing, code coverage, memory leak detection,

performance profiling, UML tracing, code review - with Test Embeddedyou fix your code before it breaks.

Test Embedded covers runtime analysis and software testing, all in a fully integrated testing environment.
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The latest release of Test Embedded integrates with Engineering Test Management to provide a more collaborative
approach to product software development and testing. Test Embedded is the most complete automated developer
testing solution available on a wide range of host and target platforms. In addition, new integrations with other
popular development tool environments allow developers to work in the environment of their choice. This enables
the powerful testing capabilities of Test Embedded to be used early in the product software development lifecycle

because it is part of the developers daily work environment.

Target deployment port technology

Target deployment port (TDP) technology is a versatile, low-overhead mechanism that enables target-independent
testing and runtime analysis with limitless target support. As a key component of Test Embedded, TDP technology

allows your tests be run directly on your target embedded hardware.

Each TDP is customized to accommodate your compiler, linker, debugger, and target architecture. Tests are
independent of the TDP, so that the tests don't change when your environment changes. For example, you can run the
same tests and code on the embedded hardware or on your local computer by switching the TDP and rebuilding the
project.

Target deployment ports are designed to strongly reduce the data communication and runtime overhead that
can affect your embedded systems when tested, while being versatile enough to adapt to any cross-development
environment (RTOS, compiler, debugger, target communication) within a very short time.

DO0-178B/C Qualification Kit

All Test Embedded customers have access to the Test Embedded DO-178B/C Qualification Kit, which can be
submitted with your other project artifacts to meet DO-178B/C compliance requirements. The Qualification Kit covers
unit testing for C and Ada languages, coverage for C and Ada languages and code review for C language (MISRA
2004).

For more information about DO-178bB/C support, contact the Products & Platforms Customer Support via this link:

https://www.hcltech.com/products-and-platforms/support.

Related information

Target deployment port overview on page 34
Source code instrumentation overview on page 32
Integrating Test Embedded Studio with other development tools on page 76

Runtime analysis overview on page 542

Qualification kit overview

A qualification kit, is a collection of documents, procedures, and information used in various industries and contexts

to assess, validate, and certify the quality, performance, and compliance of a product, system, or process.
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What is a qualification kit and how to access it?

As part of the certification process, all the verification tools, such as Test Embedded, must be qualified. The
qualification of a verification tool requires to demonstrate that the tool does what it claims to do, that involves writing
down the specification or a list of requirements of the tool, and then the test suite to validate those requirements, and
to create a traceability matrix.

To avoid you to do this process by yourselves, the development team provide a qualification kit that contains the
specification of the capabilities of the product Test Embedded the one used for the certification as well as the test
suite needed to validate those capabilities.

The qualification kit is not shipped with the Test Embedded, since the content of the kit includes the detailed
specifications and the test suites of the components of the Test Embedded product. Therefore, the kit is considered
HCL confidential materials. However, you can under active maintenance request a copy of the kit, after you have
signed a specific Confidential Disclosure Agreement with HCL.

Note: For each new version of the Test Embedded product, there is a corresponding new version of the

qualification kit.

Qualification kit for code review

The qualification kit for MISRA demonstrate that the feature tool Code Review (CRC) effectively performs what it
claims to do, that involves writing down the specification of the set of rules which serves as a list of requirements, it
also includes the test suite to validate the set of rules or requirements, and then create a traceability matrix. The kit is
available for MISRA 2004 and 2012, and is available for C language.

Does a kit exist for your Machine/0S/Target?

Test Embedded run on a specific host and operating system and is able to run tests on any target. The provided
qualification kit validates the Test Embedded performance on the host system used for the Target deployment

port (TDP). Only one qualification kit is provided, and it can run on supported host and the operating system. The
qualification kit must be run after each use of Target deployment port in order to demonstrate that the tool does what
it claims to do for each used Target deployment port. Therefor the kit must be installed on the same host where Test
Embedded is installed and when you run the qualification kit, it generates final reports that confirms the qualification
of the tool for the dedicated target.

What is the real impact of DO-178C and ED-12C?
D0-178C and ED-12C are now released. What does this mean to you and for Test Embedded

Now that RCTA DO-178 and its European equivalent, EUROCAE ED-12, have been updated after nearly twenty years,
many are wondering, what is the impact on you and on Test Embedded. We have provided you with products based
on DO-178B and ED-12B guidelines for over 10 years and have deployed qualification kits on many programs. With the
arrival of DO-178C and ED-12C we can incrementally adopt the standard in our future offerings.
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The guidelines are now published in other RTCA and EUROCAE document called:
D0-330/ ED-215, Software Tool Qualification Considerations

The one significant change for Test Embedded in DO-178C and ED-12C certification evidence is that all requirements
for verification tools, such as code coverage tools, are moved into formal RTCA document, DO-330 (EUROCAE
ED-215).

All of DO-178B/ED-12B qualification that is provided today in Kit meet the requirements of DO-178C and ED-12C
TQL-5.

The next generation of qualification kit will be created to enhance it to demonstrate compliance to DO-330/ED-215
TQL-4.

D0-330 now defines five qualification levels for tools (TQL-1 through TQL-5) and objectives for each level depending
on the software level of verification. The total number of objectives in DO-330 exceeds the number of DO-178B
objectives in some cases. This means that developers who previously qualified tools using Tool Operational
Requirements and Tool Qualification Documents, also need to produce other documents required by DO-330 and
show a compliance matrix to the applicable objectives and then have these data items approved by the certification
authority. In short, qualification of tools has become a much more formal process in DO-330 than it was with
DO-178B.

While the core DO-178C/ED-12C document was not changed substantially, there are changes to the guidance that
may impact how some companies demonstrate compliance. For example, it is expected that you can create low-level
requirements that can be explicitly tested and it may no longer be permissible to test only high level requirements and
demonstrate source code coverage. Moreover, one would also need to create robustness requirements that must be
tested. In such scenarios, special test cases may be required to stimulate these conditions. Test Embedded tool can

be employed to assist in robustness verification.

If you use object oriented design you must demonstrate compliance to DO-332 and others who chose to use model-

based development or formal methods of verification will have to use DO-331 and DO-333, respectively.

Source code instrumentation overview

Source code insertion (SCI) technology uses instrumentation techniques that automatically add specific code to the
source files under analysis. After compilation, execution of the code produces dump data for runtime analysis or
component testing.

Test Embedded makes extensive use of source code insertion technology to transparently produce test and analysis
reports on both native and embedded target platforms.

Instrumentation overhead

Instrumentation overhead is the increase in the binary size or the execution time of the instrumented application,

which is due to source code insertion (SCI) generated by the Runtime Analysis features. Source code insertion
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technology is designed to reduce both types of overhead to a bare minimum. However, this overhead may still impact

your application. The following table provides a quick estimate of the overhead generated by the product.

« Code Coverage Overhead: Overhead generated by the Code Coverage feature depends largely on the coverage

types selected for analysis.

A 48-byte structure is declared at the beginning of the instrumented file. Depending on the information mode
selected, each covered branch is referenced by an array that uses

> 1 byte in Default mode

> 1 bit in Compact mode

> 4 bytes in Hit Count mode

The actual size of this array may be rounded up by the compiler, especially in Compact mode because of the
8-bit minimum integral type found in C . See Information Modes for more information. Other Specifics:
> Loops, switch and case statements: a 1-byte local variable is declared for each instance.
> Modified/multiple conditions: one n-byte local array is declared at the beginning of the enclosing
routine, where n is the number of conditions belonging to a decision in the routine 1/0 is either
performed at the end of the execution or when the end-user decides (please refer to Coverage

Snapshots in the documentation).

In summary, hit count mode and modified/multiple conditions produce the greatest data and execution time
overhead. In most cases you can select each coverage type independently and use pass mode by default in

order to reduce this overhead. The source code can also be partially instrumented.

Memory and Performance Profiling and Runtime Tracing: Any source file containing an instrumented routine
receives a declaration for a 16 byte structure. Within each instrumented routine, a n byte structure is locally
declared, where n is 16 bytes +4 bytes for Runtime Tracing, +4 bytes for Memory Profiling, and +3*t bytes for
Performance Profiling, where t is the size of the type returned by the clock-retrieving function.

For example, if t is 4 bytes, each instrumented routine is increased of 20 bytes for Memory Profiling only, 20
bytes for Runtime Tracing only, 28 bytes for Performance Profiling only, or 36 bytes for all Runtime Analysis

features together

.

Memory Profiling Overhead: Any call to an allocation function is replaced by a call to the Memory Profiling
Library. These calls aim to track allocated blocks of memory. For each memory block, 16+12*n bytes are
allocated to contain a reference to it, as well as to contain link references and the call stack observed at
allocation time. n depends on the Call Stack Size Setting, which is 6 by default. If ABWL errors are to be
detected, the size of each tracked, allocated block is increased by 2*s bytes where s is the Red Zone Size
Setting (16 by default). If FFM or FMWL errors are to be detected, a Free Queue is created whose size depends
on the Free Queue Length and Free Queue Size Settings. Queue Length is the maximum number of tracked
memory blocks in the queue. Queue Size is the maximum number of bytes, which is the sum of the sizes of all
tracked blocks in the queue.
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- Performance Profiling Overhead: For any source file containing at least one observed routine, a 24 byte
structure is declared at the beginning of the file. The size of the global data storing the profiling results of an
instrumented routine is 4+3*t bytes where t is the size of the type returned by the clock retrieving function.

 Runtime Tracing Overhead: Implicit default constructors, implicit copy constructors and implicit destructors
are explicitly declared in any instrumented classes that permits it. Where C++ rules forbid such explicit
declarations, a 4 byte class is declared as an attribute at the end of the class.

Instrumentation technology is designed to reduce both performance and memory overhead to a minimum.
Nevertheless, for certain cross-platform targets, it may need to be reduced still further. There are three ways to do
this.

- Limiting code coverage types: When using the Code Coverage feature, procedure input and simple and implicit
block code coverage are enabled by default. You can reduce instrumentation overhead by limiting the number
of coverage types.

Note: The Code Coverage report can only display coverage types among those selected for

instrumentation.

- Limiting instrumented calls: When calls are instrumented, any instruction that calls a C user function or library
function constitutes a branch and thus generates overhead. You can disable call instrumentation on a set of C
functions using the Selective Code Coverage Instrumentation Settings. For example, you can usually exclude
calls to standard C library functions such as printf or fopen.

- Optimizing the information mode: When using Code Coverage, you can specify the information mode, which

defines how much coverage data is produced and therefore stored in memory.

Target deployment port overview

Target deployment port (TDP) technology is a versatile, low-overhead technology enabling target-independent tests

and run-time analysis despite limitless target support.

As a key component of HCL DevOps Test Embedded (Test Embedded), TDP technology allows your test cases as well
as test execution analysis to be applied directly to your target embedded system. It is constructed to accommodate
your compiler, linker, debugger, and target architecture. Tests are independent of the TDP, so tests don't change when
the environment does. Test script deployment, execution and reporting remain easy to use.

TDPs are designed to strongly reduce the data communication and runtime overhead that can affect your embedded
systems when tested, while being versatile enough to adapt to any cross-development environment (RTOS, compiler,

debugger, target communication) within a very short time.

TDP technology includes the following capabilities and benefits:
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- Compiler dialect-aware and linker-aware, for transparent test building.

- Easy download of the test harness environment onto the target via the user's IDE, debugger, simulator or
emulator.

- Painless test and run-time analysis results download from the target environment using JTAG probes,
emulators or any available communication link, such as serial, Ethernet or file system.

- Powerful test execution monitoring to distribute, start, synchronize and stop test harness components, as well
as to implement communication and exception handling.

« Versatile communication protocol adaptation to send and receive test messages.

» XML-based Target Deployment Port Editor enabling simple, in-house TDP customization

Obtaining target deployment ports

TDP technology was designed to adapt to any embedded or native target platform. This means that you need a
particular TDP to deploy Test Embedded to your target. A wide array of TDPs has already been developed to suit most
target platforms. The following platforms are already supported:

- Native development platforms: Windows™ and Linux™, the development platforms that leading companies in
the devices/embedded systems and infrastructure industries are using.

« Cross-development environments: From 8- to 64-bit cross-development environments from WindRiver,
GreenHills, ARM, Sun, Montavista, Tl, NEC, Hitachi, Nohau, and more.

If there is no existing TDP for your particular target platform, HCL Customer Support can provide the service of

creating a tailored TDP for you.

To obtain a copy of an existing TDP or to inquire about custom development, follow one of the methods:

 Contact your HCL sales representative.
« If you do not know your sales representative, contact HCL Customer Support or create an HCL Support case.

Creating new target deployment ports

You can choose to create, unassisted, a TDP tailored for your embedded environment. There are several requirements

to consider before choosing this option:

« Perl language knowledge: The Test Embedded compiler interface is written in perl

» Programming language and compiler knowledge: The Test Embedded runtime library uses the same language
as the code under test (C, C++, Ada)

- Knowledge of Test Embedded: Improve your experience with the product before considering your first TDP.
You will need to be familiar with the runtime analysis and component testing tools and how the TDP is used

with them.

Before creating a TDP for a new target platform, determine whether the target platform is capable of running

embedded tests. To create a TDP, see the documentation that is embedded in the Target Deployment Port Editor,

35


https://support.hcltechsw.com/csm
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0010164

HCL DevOps Test Embedded

which provides an overview and detailed information on setting up a TDP, and using the Target Deployment Port
Editor.

Development environments

HCL DevOps Test Embedded (Test Embedded) supports multiple development environments thanks to its Target
Deployment Port (TDP) technology.

The following aspects of the development environments are considered:

« Compiler & linker used to compile the generated tests and link them with the code under test, or to compile
and link the instrumented code.
« Target used to execute the tests. These targets can be a laptop itself (case of TDP with native compilers), a

simulator, an emulator or an electronic board.

The multiple Target Deployment Ports that are provided in Test Embedded can be used as they are or modified to

adapt them to a new environment.

Non-exhaustive list of supported compilers/linkers:

« C/C++ languages:
> gcc (tested until version 11.2)
> Microsoft Visual Studio (tested with versions 2010 to 2019)
> Codewarrior
o gcc ARM
o Mirotec
o Keil
- DiabData
o Texas Instruments
> Microsoft eMbedded Visual
> HighTec TriCore
> GreenHills IAR

 Ada language:
> gnat

> Rational Apex

* Targets:
o winIDEA
o Hiwave simulator
> OpenODC
° jTag
> gdb
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> MPLAB

o Code Composer

> QNX

> Windows CE simulator
o Single Step

> IAR C-SPY

o Lauterbach Trace32

> Tornado (VxWorks)

Note: Some specific versions of compilers can include additional packages that might require a TDP

customization.

Test Embedded integrates the EDG parser for C and C++ version 6.1. The EDG parser supports almost all the
C++17 and C++20 features.

List of supported features until EDG 6.1:

« For C++17 features, refer to https://docs.google.com/spreadsheets/d/1cb1bA60V-
hkSGMykaGweU1HaQbscXGTy-dpLtCMd7W8/pubhtml.

« For C++20 features, refer to: https://docs.google.com/spreadsheets/d/1H-aqgjzVI2a-
XQKGtw0xaS0tyjDOFcoQP8ttJI9JZQTc/edit#gid=0.
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Chapter 4. Administrator Guide
This guide describes how to install the HCL DevOps Test Embedded (Test Embedded) software.

After you install the software, you can perform administration tasks such as license configuration, user management,
security, memory and disk usage management, back up and restore user data, and other tasks that a server

administrator can perform. This guide is intended for administrators.

Installing

This section provides the instructions for installing the product as well as installation verification. To install your
product, follow the procedures and information in these topics. Installing the product involves verifying requirements,

planning, managing licenses.

Installation requirements

This section details hardware, software, and user privilege requirements that must be met in order to successfully
install and run HCL DevOps Test Embedded (Test Embedded).

Hardware and Software requirements

Before you install the product, verify that your system meets the hardware and software requirements.

For information about hardware and software compatibility, see System Requirements on page 24.

User privileges requirements

You must have a user ID that meets the following requirements before you can install HCL DevOps Test Embedded
(Test Embedded).

« Your user ID must not contain double-byte characters.

 You must install Installation Manager as an administrator on Windows if the version of your operating system
requires user privileges to install or update product offerings, or install license keys for your products.

« If you install Installation Manager as an administrator on Windows, all products installed from Installation
Manager must be run with the administrator privilege. In this case, you must run Test Embedded as an
administrator.

- If you install Installation Manager as a non-administrator on Windows, Test Embedded can be installed with
the same User account as the one used to install Installation Manager.

« You can enable users who are not the administrator so that they can work with Test Embedded on some
versions of Windows. If you are in such a case:

> Do not install Test Embedded into a package group (installation location) in the Program Files
directory (C:\Program Files\) and do not choose a shared resources directory in the Program Files
directory.

o If you are extending an existing Eclipse installation, then do not install Eclipse in the Program Files
directory (C:\Program Files\).
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« On Linux, you must be able to log in as root (with sudo) to install and run Test Embedded.

» On Ubuntu, you must ensure that the environment variables that are set while installing the products are
retained when you open Test Embedded and the application-under-test.

« License Key Administrator must be installed on Windows at the same time or prior to Test Embedded so
that the license information entered during Test Embedded installation is valid. License Key Administrator
requires Administrator privileges. If you need to install the License Key Administrator client on Windows™ with
a User account, right-click the | aunchpad. exe file, and click Run as Administrator or install the License Key
Administrator separately with an Administrator account.

Installing software

Installing the product involves verifying requirements, planning, performing pre-installation tasks and managing

licenses.

Installation roadmap

The installation roadmap lists the high-level steps for installing your product.

Roadmap for installing HCL DevOps Test Embedded (Test Embedded)

Perform the following tasks to install Test Embedded:

1. Review the release notes on page
2. Plan the installation.
a. Review System Requirements on page 24.
b. Review user privilege requirements on page 38.
c. Plan for installation locations on page 47.
d. Plan for product coexistence on page 48.
e. Plan for Installing in Eclipse instance on page 53.
3. Install the product with Installation Manager on page 49 or Installing InstallAnywhere on page 43

4. Set up and manage product licenses on page 55.

Pre-installation Tasks

Before you install the product, you need to prepare or configure your computer.

Installing required libraries on Ubuntu

Before you install HCL DevOps Test Embedded (Test Embedded) on Ubuntu, you must install some libraries.
About this task

You must perform these procedures before installing Test Embedded Studio or Test Embedded for Eclipse IDE.

Follow these procedures to download and install | i bXp. so. 6,1 i bssl . so.6and !l i bcrypto. so. 6 libraries on
Ubuntu:
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1. Run the following commands to download the libraries:

wget -c
http://archive.ubuntu.com/ubuntu/pool/main/g/glibc/multiarch-support_2.27-3ubuntul.6_amd64.deb
wget -c  http://archive.debian.org/debian/pool/main/libx/libxp/libxp6_1.0.2-2_amd64.deb

2. Run the following commands to install the | i bXp. so. 6 library:

sudo apt-get install ./multiarch-support_2.27-3ubuntul.6_amd64.deb ./libxp6_1.0.2-2_amd64.deb
3. Run the following commands to install | i bssl . so. 6 and | i bcrypt o. so. 6:

sudo apt-get install libssl-dev
sudo ln -s /1lib/x86_64-1linux-gnu/libcrypto.so0.1.0.0 /1lib/x86_64-linux-gnu/libcrypto.so.6
sudo 1n -s /1lib/x86_64-1inux-gnu/1libssl.s0.1.0.0 /1ib/x86_64-1inux-gnu/libssl.s0.6

Pre-installation tasks for Studio

Before you install your product, review the following information and ensure that all the pre-installation steps are

completed as required.

About this task
To help ensure a smooth installation process, complete these tasks before starting the installation tasks.

1. For Test Embedded Studio support, you must first install Exuberant Ctags. See Installing Exuberant Ctags on
page 40 for more information.

2. Download and install Cygwin. See Installing Cygwin on page 41.

3. Ensure that your existing compilers and development environments are installed and run properly.

In particular, if you are using Microsoft™ Visual Studio, install and run it at least once before installing Test
Embedded. See Support for Microsoft Visual Studio on page 41 for more information.

4. For UNIX™: If you want the product to be used by users other than root, then set the umask variable to 0022
before you install the product. To set this variable, log in as root user, start a terminal session, and type unesk
0022.

5. Install required libraries on Ubuntu. See Installing required libraries on Ubuntu on page 39.

Installing Exuberant Ctags

Before using Test Embedded Studio on Windows™, you must ensure that Exuberant Ctags is installed on your
computer and that the directory containing Ctags binary files is set in the PATH environment variable.

To install Exuberant Ctags:

1. Go to the following website and download the latest package labeled Source and binary for Windows™: http://
ctags.sourceforge.net.
If the latest binary package is not available for download, go to the Download section and download the binary
package for the previous version of Ctags.

2. Extract thefileto C: \i nstal | ati on_di r ect or y\ HCL\ DevQpsTest Enbedded\ ct ags.

3. From the Start menu, select Parameters > Control Panel > System.
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4. Select the Advanced tab and click Environment variables.
5. Edit the PATH environment variable to add the C: \ i nstal | ati on_di r ect or y\ HCL
\ DevpsTest Enbedded\ ct ags directory and click OK.

Installing Cygwin

Before using HCL DevOps Test Embedded (Test Embedded) Studio on Windows™, you must ensure that Cygwin
is installed on your computer and that the directory containing Cygwin binary files is set in the PATH environment

variable.

To install Cygwin:

1. Go to the following website, on the Install Cygwin page and download the latest package for 32 or 64 bits
versions of Windows™: http://www.cygwin.com.

2. Run the setup program. Once the root install directory and local package are selected, select a download site.

3. Check MAKE box.

4. Then, select a packages to install. You must select gcc, gcc-core, gcc: GNU Compiler Collection (C) and (C++)
and GNU version of the make utility.
If you want to use the Cygwin gcc compiler, make sure that the Cygwin installation options include the

development tools category. If not, you can install a different gcc 3.2 compiler.
Update the PATH environment variable:

5. From the Start menu, select Parameters > Control Panel > System.

6. Select the Advanced tab and click Environment variables.

7. Edit the PATH environment variable to add the Cygwin installation directory, for example c: \ cygwi n\ bi n;
and click OK.

Support for Microsoft™ Visual Studio

If you plan to use HCL DevOps Test Embedded (Test Embedded) on Windows™ with Microsoft™ Visual Studio you
must install Visual Studio and execute it at least once before installing Test Embedded in order to correctly initialize

the Windows™ registry database.
About this task

If you omitted to run Visual Studio before installing Test Embedded, the installation produces an error message. In

this case, proceed with the installation and then execute the following steps.

To enable support of Microsoft™ Visual Studio after installation:

1. Run and close Visual Studio at least once.
2. Open a Windows™ Explorer and browse to the following directory:
C\installation_directory\HCL\ DevOpsTest Enbedded\t ar get s\ xm \
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3. Double-click the cvi sual 6. xdp (for Visual 6.0) or cvi sual 7. xdp (for Visual .NET), or cvi sual 8. xdp (for
Visual 2005). This opens the Target Deployment Port (TDP) in the Target Deployment Port Editor.
4. Save the TDP to regenerate the TDP directory.

Increasing the number of file handles on Linux™ workstations

For best product performance, increase the number of file handles above the default of 1024 handles.

About this task

! Important: Before you work with your product, increase the number of file handles. Most products use more
than the default limit of 1024 file handles per process. A system administrator might need to make this

change.

Exercise caution when using the following steps to increase your file descriptors on Linux™. If the instructions are not

followed correctly, the computer might not start correctly.

To increase your file descriptors:

1. Log in as root. If you do not have root access, you will need to obtain it before continuing.

2. Change to the / et c directory

! Attention: If you decide to increase the number of file handles in the next step, do not leave an empty
initscript file on your computer. If you do so, your computer will not start up the next time that you turn

it on or restart.

3. Use the vi editor to edit the initscript file in the et ¢ directory. If this file does not exist, type vi initscript to
create it.
4. On thefirst line, type ulinit -n 4096. The point is that 4096 is significantly larger than 1024, the default on

most Linux™ computers.

! Important: Do not set the number of handles too high, because doing so can negatively impact

system-wide performance.

5. On the second ling, type eval exec "$4".
6. Save and close the file after making sure you have completed steps 4 and 5.

Note: Ensure that you follow the steps correctly. If this procedure is not completed correctly, your

computer will not start.

7. Optional: Restrict the number of handles available to users or groups by modifying the limits.conf file in the
/ et c/ securi ty directory. Both SUSE Linux™ Enterprise Server (SLES) Version 9 and Red Hat Enterprise
Linux™ Version 4.0 have this file by default. If you do not have this file, consider using a smaller number in step
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4 in the previous procedure (for example, 2048). Do this so that most users have a reasonably low limit on
the number of open files that are allowed per process. If you use a relatively low number in step 4, it is less
important to do this. However, if you set a high number in step 4 earlier and you do not establish limits in the
limits.conf file, computer performance can be significantly reduced.

The following sample limits.conf file restricts all users, and then sets different limits for others afterwards.
This sample assumes that you set handles to 8192 in step 4 earlier.

B soft nofile 1024
B hard nofile 2048
r oot soft nofile 4096

r oot hard nofile 8192
userl soft nofile 2048

user1l hard nofile 2048

Note that the = in the preceding example sets the limits for all users first. These limits are lower than the limits
that follow. The root user has a higher number of allowable handles open, while number available to user1 is
between the two. Make sure that you read and understand the documentation contained in the limits.conf file

before making changes.

Installing InstallAnywhere

The following pages explain how to install HCL DevOps Test Embedded (Test Embedded) by using InstallAnywhere
installer on Windows

Installing the product on Windows

As an alternative to Installation Manager, you can install HCL DevOps Test Embedded (Test Embedded) on Windows
with Install Anywhere installer.

Before you begin

You must have performed these tasks:

« Uninstalled any older version of this product.
« Installed JRE from v8.0 to 11.0.

About this task

1. Download the installation file from the HCL License & Delivery portal HCL_OT_EMB_83_Install_IA_Win_64.zip
2. Righ-click the .exe file and select Run as Administrator.
Result
The installer is launched.
3. On the Introduction window, read through the details, and click Next.
4. Read the license agreement carefully, select the | accept check box and then click Next.

5. Browse the location or directory where you want to install the product and click Next.
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Note: You must select any other directory if the default directory is not empty.

6. Read through the installation details and click Install.
7. After the installation is complete, click Done.

Then, You must enter the license key when you launch the product.

Uninstalling the product on Windows

When you want to remove the product software on a Windows computer, use the uninstall option.

Before you begin
You must have completed the following tasks:

- Closed any open windows of the product.
« Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

About this task

1. Open Windows explorer and goto <i nstal | ati on fol der>/ HCL/ Uni nstal | .
2. Launch Uni nst al | - HCL- DevQps- Test - Enbedded. exe.
3. In the dialog box, follow the on-screen instructions.

Results

The product software is removed from your system.

Installing the product on Linux

As an alternative to Installation Manager, you can install HCL DevOps Test Embedded (Test Embedded) on Linux with

InstallAnywhere installer.

About this task

1. Download the product installer from the HCL License & Delivery portal :
Test Embedded 8.3.1 (InstallAnywhere based) Install for Linux 64 bits:

HCL_OT_EMB 831_Install _I A LNX_64. zi p

. Log in as a root user and enter the unzip filename command to extract the .zip file.
. Execute the .bin file.
. On the Introduction screen, read through the details, and click Next.

. Read the license agreement carefully, select the 'l accept check' box and then click Next.

o g b~ WODN

. Browse the location or directory where you want to install the product and click Next.

The default installation directory is / opt / HCL.
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7. Read through the installation details and click Install.

8. When the installation is complete, click Done.

Results

You must enter the license key when you launch the product.

Uninstalling the product on Linux

When you want to remove the product software on Linux machine, use the uninstall option.

Before you begin
You must have completed the following tasks:

« Closed any open windows of the product.
* Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

About this task

1. Log in as root user.

Note: If you are not a root user, uninstall the product by entering the following commands in the
terminal:
o <installation directory>/Uninstall
o sudo ./Uninstall-HCL-DevOps-Test-Embedded

2. Click Applications > > Programming > Uninstall.
3. On the Uninstall screen, click Uninstall and follow the on-screen instructions.

Results

The product software is removed from your system.

Installing the product by using IBM® Installation Manager

In this section, you will learn how to install the product by using IBM® Installation Manager.

Planning the installation

After verifying hardware, software, and user privilege requirements, plan the features and software that you want to
install.

Planning features

You can customize your product by selecting which features to install.
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When you install the product package by using IBM® Installation Manager, the installation wizard displays the
features in the available product package. From the features list, you can select which to install. A default set of
features is selected for you (including any required features). Installation Manager automatically enforces any
dependencies between features and prevents you from clearing any required features.

0 Tip: After you finish installing the package, you can still add or remove features from your software product by
running the Modify Packages wizard in Installation Manager.

Planning compilers

During the installation process, the product scans your system for existing compilers. It is important that all

compilers and development environments that you plan to use with Test Embedded are installed beforehand.

Note: If you plan to use Test Embedded on Windows™ with Microsoft™ Visual Studio, you must install Visual
Studio and run it at least once before installing Test Embedded to correctly initialize the Windows™ registry
database. See Support for Microsoft Visual Studio on page 41

Installation conventions and terminology
Understanding these terms and conventions can help you take full advantage of the installation information and your
product.

The following conventions are used in this installation information:

The default installation directory is writtenas C: \'i nstal | ati on_di r ect or y\ HCL\ DevOpsTest Enbedded\ in
Windows andi nstal | ati on_di rect ory/ HCL/ DevQpsTest Enbedded in UNIX.
These terms are used in the installation pages:
Installation directory
The location of product artifacts after the package is installed.
Package

An installable unit of a software product. Software product packages are separately installable units
that can operate independently from other packages of that software product.

Package group

A package group is a directory in which different product packages share resources with other
packages in the same group. When you install a package using Installation Manager, you can create a
new package group or install the packages into an existing package group. (Some packages cannot

share a package group, in which case the option to use an existing package group is unavailable.)
Repository

A storage area where packages are available for download. A repository can be disc media, a folder on a
local hard disk, or a server or Web location.
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Shared directory

In some instances, product packages can share resources. These resources are located in a directory
that the packages share.

UNIX™

Unless specified otherwise, in this document, the term UNIX™ refers to all UNIX-based operating

systems.

Installation Manager overview

IBM® Installation Manager is a program for installing, updating, and modifying packages. It helps you manage the
applications, or packages, that it installs on your computer. Installation Manager does more than install packages: It
helps you keep track of what you have installed, determine what is available for you to install, and organize installation
directories.

Installation Manager provides tools that help you keep packages up to date, modify packages, manage the licenses
for your packages, and uninstall packages.

Installation Manager includes six wizards that make it easy to maintain packages:

« The Install wizard walks you through the installation process. You can install a package by simply accepting
the defaults or you can modify the default settings to create a custom installation. Before you install, you get
a complete summary of your selections throughout the wizard. Using the wizard you can install one or more
packages at one time.

« The Update wizard searches for available updates to packages that you have installed. An update might be a
released fix, a new feature, or a new version of the product. Details of the contents of the update are provided
in the wizard. You can choose whether to apply an update.

« The Modify wizard helps you modify certain elements of a package that you have already installed. During
the first installation of the package, you select the features that you want to install. Later, if you require other
features, you can use the modify packages wizard to add them to your package. You can also remove features
and add or remove languages.

« The Roll Back wizard helps you to revert to a previous version of a package.

« The Uninstall wizard removes a package from your computer. You can uninstall more than one package at a
time.

Installation considerations

Part of planning entails making decisions about installation locations, working with other applications, extending

Eclipse, upgrading, migrating, and configuring help content.

Installation locations

IBM® Installation Manager retrieves product packages from specified repositories and installs the products into
selected locations, referred to as package groups.
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Package groups

During installation, you specify a package group into which to install a product.

A package group represents a directory in which products share resources.

» When you install a product using the Installation Manager, you either create a package group or install the
product into an existing package group. A new package group is assigned a name automatically; however, you
choose the installation directory for the package group.

- After you create a package group you cannot change the installation directory. The installation directory
contains files and resources shared by the products installed into that package group.

« Product resources designed to be shared with other packages are installed in the shared resources directory.
Not all products can share a package group, in which case the option to use an existing package group will be
disabled.

« When you install multiple products at the same time, all products are installed into the same package group.

Note: When installing products from Windows™ operating system, if you create the package groups in the
Program Files directory (C: \ Pr ogr am Fi | es\ ), only users with Administrator privileges will be able to use

the product. If you do not want to require running your product as Administrator, complete one of these steps:

« For your product and any other programs that sharing the same installation location, select an
installation location that is not in the path C:\ Program Fi | es.

« For your product and all Software Delivery Platform product packages (regardless of their installation
location), select a shared resources directory and installation locations that are not in the path C:
\ Program Fi |l es.

Shared resources directory

The shared resources directory is where product resources are installed so that they can be used by multiple product
package groups. You define the shared resources directory the first time that you install the first product package.
For best results, use your largest disk drive for shared resources directories. You cannot change the directory location
unless you uninstall all product packages.

Coexistence considerations

Some products are designed to coexist and share functions when they are installed in the same package group. A

package group is a location where you can install one or more software product packages.

When you install each product package, you select whether you want to install the product package into an existing
package group or whether you want to create a new package group. Installation Manager blocks products that are not
designed to share or do not meet version compatibility and other requirements. If you want to install more than one

product at a time, the products must be able to share a package group.
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Any number of eligible products can be installed to a package group. When a product is installed, the product
functions are shared with all of the other products in the package group. If you install a development product and a
testing product into one package group, when you start either of the products, you have both the development and
testing functions available to you in your user interface. If you add a product with modeling tools, all of the products in

the package group will have the development, testing, and modeling functionality available.

Installing multiple instances of the product
You can install multiple instances of Test Embedded on a single system. However, you must be aware of the

following limitations:

« On Windows™, Start menu shortcuts will point to the last installed instance of the product. You can manually
create your own shortcuts to previously installed versions.

« The product requires that the environment variable TESTRTDIR is set to the product installation directory. This
will be set to the directory of the last installed instance of the product. Before running a different instance of

the product, you must change it manually to point to the directory of the version that you want to use.

Installing the product with Installation Manager

Use these instructions to install HCL DevOps Test Embedded (Test Embedded).

About this task

To learn how to install the product from a command prompt in silent mode, see the Installing Silently section of the

Installation Manager Knowledge Center.

To install the new version of the product, you must first uninstall the previous version of the product and then install

the new one.

1. Review the Installation considerations on page 47, if you have not done so already.
2. Click a product package to highlight it.
Result
The description of the package is displayed in the Details pane at the bottom of the screen.

3. To search for updates to the product packages, click Check for Other Versions, Fixes, and Extensions. If
updates for a product package are found, then they are displayed in the Installation Packages list on the
Install Packages page below their corresponding products. Only recommended updates are displayed by
default.

Choose from:

- To view all updates that are found for the available packages, click Show all versions.

- To display a package description in the Details pane, click the package name. If additional information
about the package is available, such as a r eadne file or release notes, a More info link is included at
the end of the description text. Click the link to display the additional information in a browser. To fully
understand the package that you are installing, review all information.

4. Select the product package and any updates to the package to install. Updates that have dependencies are

automatically selected and cleared together. Click Next to continue.
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Note: If you install multiple packages at the same time, then all the packages are installed into the

same package group.

5. On the Licenses page, read the license agreement for the selected package. If you selected more than one
package to install, there might be a license agreement for each package. On the left side of the License page,
click each package version to display its license agreement. The package versions that you selected to install
(for example, the base package and an update) are listed under the package name.

a. If you agree to the terms of all of the license agreements, click | accept the terms of the license
agreements.
b. Click Next to continue.

6. On the Location page, type the path for the shared resources directory in the Shared Resources Directory field,

or accept the default path. The shared resources directory contains resources that can be shared by one or

more package groups. Click Next to continue.

The default path to use follows:
o IIITTTTEM C: \ Pr ogr am Fi | es\ HCL\ HCLI Mshar ed
o IYTTTI / opt / HCL/ HCLI MBhar ed

! Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this to help ensure adequate space for the shared resources of

future packages. You cannot change the directory location unless you uninstall all packages.

7. On the Location page, create a package group to install the product package into or if this is an update, use
the existing package group. A package group represents a directory in which packages share resources with

other packages in the same group. To create a package group:
a. Click Create a new package group.

b. Type the path for the installation directory for the package group.

The name for the package group is created automatically.

The default path follows:
« IITTIEM C: \ Progr am Fi | es\ HCL\ DevOpsTest Enbedded
. / opt / HCL/ DevOps Test Enbedded

c. Click Next to continue.

8. On the Summary page, review your choices before installing the product package. To change the choices that
you made on previous pages, click Back, and make your changes. When you are satisfied with your installation
choices, click Install to install the package.

Result
A progress indicator shows the percentage of the installation that is completed.
9. When the installation process is complete, a message confirms the completion of the process.
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a. Click View log file to open the installation log file for the current session in a new window. You must
close the Installation Log window to continue.

b. In the Install Package wizard, select whether to start the product when you exit.

c. Click Finish to start installing the selected package.

10. License the product.

See the Setting up licensing on page 56 topic.

Updating software

You can search for product updates and install the updates for your product.

Before you begin
By default, Internet access is required unless your repository preferences points to a local update site.

Each installed package has the location embedded for its default update repository. For Installation Manager to
search the update repository locations for the installed packages, select the preference Search service repositories
during installation and updates on the Repositories preference page. This preference is selected by default. See the

Installation Manager help for more information.

See Migrating from previous versions for information about updating your target deployment ports and projects.

! Important:

« Close all programs that were installed using Installation Manager before updating.

- During the update process, Installation Manager might prompt you for the location of the repository
for the base version of the package. If you installed the product from CDs or other media, they must
be available when you use the update feature.

To find and install product package updates:

1. From the Start page of the Installation Manager, click Update.

2. If Installation Manager is not detected on your computer, continue with the installation of the latest release.
Follow the instructions in the wizard to complete the installation.

3. In the Update wizard, select the location of the package group where the product you want to update is
installed or select Update All, and then click Next.
Installation Manager searches for updates in its repositories and the predefined update sites for the product.
A progress indicator shows the search is taking place.

4. If updates for a package are found, then they are displayed in the Updates list on the Update Packages page
after the corresponding package. Only recommended updates are displayed by default. Click Show all to
display all updates found for the available packages.

51



52

HCL DevOps Test Embedded

a. To learn more about an update, click the update and review its description under Details.

b. If additional information about the update is available, a More info link is included at the end of the
description text. Click the link to display the information in a browser. Review this information before
installing the update.

5. Select the updates that you want to install or click Select Recommended to restore the default selections.
Updates that have a dependency relationship are automatically selected and cleared together.

6. Click Next.

7. On the Licenses page, read the license agreements for the selected updates. On the left side of the License
page, the list of licenses for the updates you select is displayed

8. Click each item to display the corresponding license agreement text.

a. If you agree to the terms of all the license agreements, click | accept the terms of the license
agreements.

b. Click Next to continue.

9. On the Summary page, review your choices before installing the updates.

a. If you want to change the choices you made on previous pages, click Back, and make your changes.

b. When you are satisfied, click Update to download and install the updates. A progress indicator shows
the percentage of the installation completed.

10. Optional: When the update process is completed, a message that confirms the process is displayed near
the top of the page. Click View log file to open the log file for the current session in a new window. Close the
Installation Log window to continue.

11. Click Finish to close the wizard.

12. Optional: Only the features that you already have installed are updated using the Update wizard. If the update
contains new features that you want to install, run the Modify wizard, and select the new features to install
from the feature selection panel.

Uninstalling software

Use Installation Manager to uninstall your product. If no other products are installed, you can uninstall Installation
Manager also.

To uninstall your product from Windows™:

1. Start Installation Manager

2. Select the Uninstall wizard

3. Choose a package group and the package to uninstall, and follow the instructions on the wizard to complete
the uninstall process.
After uninstalling the product, some files are not removed, including any target deployment ports that you
might have modified after the installation. If you intend to reinstall the product later, you must delete the

DevOpsTest Enbedded directory manually before reinstalling.

To uninstall your product from Linux™ or UNIX™:
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4. Open a terminal window, change directory to your installation directory (/ opt / HCL/
I nstal | ati onManager/ by default), and run /opt/HCL/InstallationManager/eclipse/HCLIM.
5. In Installation Manager, select the Uninstall wizard
6. Choose a package group and the package to uninstall, and follow the instructions on the wizard to complete
the uninstall process.
7. When the product is uninstalled, quit Installation Manager, change directory to / opt / HCL/
Dev(psTest Enbedded and run the following command to delete the remaining HCL/
DevOpsTest Enbedded directory cd/opt/HCL/DevOpsTestEmbedded && rm -rf.

Installing in Eclipse instance

The product package that you install using Installation Manager comes with a version of Eclipse, which is the base
platform of this product package. If you already have an Eclipse integrated development environment (IDE) installed
on your workstation, after installing the product, you can add your product package directly to that other Eclipse
installation and extend the functions of your Eclipse IDE by installing HCL DevOps Test Embedded (Test Embedded)
from a local update site.

Extending an Eclipse IDE adds the functions of the newly installed product, but maintains your IDE preferences and

settings. Previously installed plug-ins are also still available.

In most cases, your current Eclipse IDE must be the same version as the Eclipse that the product you are installing
uses. For more information about installing the product inside an existing Eclipse IDE, see the page 'Installing the

product from an update site'.

Installing DevOps Test Embedded for Eclipse IDE from an update site

You can install HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE) in your Eclipse integrated
development environment (IDE) from an update site.

About this task
To install Test Embedded for Eclipse IDE in your current Eclipse instance, you must download and install some

dependencies from the eclipse.org update site:

« EMF - Eclipse Modeling Framework SDK
« Graphical Editing Framework GEF SDK

» C/C++ Development Tools
To install the product from the local update site, follow these steps:

1. Click Help > Install new software.

2. In the Work with drop down menu, select All Available Sites.

3. When the list of available modules is populated, select the following choices:
> In the Modeling group, select EMF - Eclipse Modeling Framework SDK and GEF (MVC) SDK
> In the Programming Language group, select C/C++ Development Tools

4. Click Next.
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5. Approve the licensing agreement and click Install.
6. After installing the product, restart the workbench when it is requested.
7. Follow these steps to install Test Embedded for Eclipse IDE by using the update site:

a. Click Help > Install new software
b. Click on Add....
c. Enter a name in the Name field.

d. Click Local... and select the following folder: <installation folder>/HCL DevOps Test Embedded for
Eclipse IDE update site

e. Click Add.
Result
Test Embedded for Eclipse IDEupdate site is displayed in the list.

f. Select Test Embedded for Eclipse IDE update site.
g. Click Next.
h. Click Next.
i. Approve the license agreements and click Finish.

Verifying the installation

When the installation process is complete, a message confirms the success of the process. You can open the log file

to verify your installation of the product.

Before you begin
When the installation process is complete, a message confirms the success of the process.

To verify the installation:

1. Click View log file. The installation log file for the current session opens in a new window. To continue, close
the Installation Log window to continue.

2. In the Install Package wizard, select whether you want Test Embedded to start when you exit.

3. Click Finish to launch the selected package. The Install Package wizard closes and you are returned to the

Start page of Installation Manager.
Starting DevOps Test Embedded
You can start your product from the desktop environment or a command-line interface.
About this task

For Microsoft™ Windows™ operating systems:

54



Chapter 4. Administrator Guide

« Click Start > Programs > HCL DevOps Test Embedded for Eclipse IDE to start Test Embedded for Eclipse IDE.

« Click Start > Programs > HCL DevOps Test Embedded Studio to start Test Embedded Studio for testing C, C+
+, Ada.

* To start Test Embedded for Eclipse IDE from a command line, type this command:
<installation_directory>\eclipse.exe -product comibmrational.testrealtinme.product.ide.

- To start Test Embedded Studio from a command line, type this command: <i nst al I ati on_di rect ory>\bi n

\intel\w n32\ studio. exe

If the installation location or Shared Resources directory for your product is in a directory in the path C: \ Pr ogr am
Fi | es, you can run the product only as the administrator. To run as administrator, right-click the program shortcut,

and click Run as administrator.

Note: For Windows, the Pr ogr am Fi | es directory is usually virtualized in order to allow users who are not
running as the administrator to have write access to this protected directory. However, the virtualization
workaround is not compatible with your product. If you selected an installation location or shared resources
directory in the path C: \ Pr ogr am Fi | es\ and you do not want to require running your product as

Administrator, complete one of these steps:

- Reinstall your product and any other programs that sharing the same installation location, and select
an installation location that is not in the path C:\ Program Fi | es\ .

« Reinstall your product and all Software Delivery Platform product packages (regardless of their
installation location), and select a shared resources directory and installation locations that are not in

the path C: \ Progr am Fi | es\

For UNIX™ operating systems:

- Verify that the file <i nstal | ati on_di rectory>/testrtinit.shisupdated with the correct variable
values for TESTRTDIR, HCL_LICENSING_URL and HCL_LICENSING_ID{}.
* Run the following command from a sh or bash shell:

. <installation_directory>/testrtinit.sh

- To start Test Embedded for Eclipse IDE from a sh or bash shell, enter the following command:
<installation_directory>/start_visualtest.sh

« To start Test Embedded Studio from a sh or bash shell, type this command:

<installation_directory>/start_testrt.sh

Managing Licenses

Licensing for your HCL software is administered through HCL® License & Delivery portal. This portal is FlexNet-based
web application to manage software entitlements and licenses.
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You must have ordered software. When a software order is placed and acknowledged, a software entitlement

is created. You can then create the devices and map the software entitlement with the devices. Every device is
associated to a server ID. This server ID is applied in the product. Multiple software entitlements can be created
based on your requirements. Follow the instructions in Software Order Acknowledgment document that you received

to activate your entitlement, create devices, and download the software from the Portal.

If you do not have access to the Internet, you can install and configure a local license server.
Setting up licensing

Before you can start using HCL DevOps Test Embedded (Test Embedded), you must set up licenses.
Before you begin

You must have completed the following tasks if you want to set up a cloud server:

* Purchased the licenses.
« Configured the URL of a FlexNet Cloud License Server with the appropriate entitlements. The URL of the

FlexNet Cloud License Server is in this form:

https://hcl software. conpl i ance. fl exnet operati ons. com

 Been issued the Server ID of the FlexNet Cloud License Server.
You must have completed the following tasks if you want to set up a local license server:

» Purchased the licenses.

- Configured the Local License Server with the appropriate entitlements.

About this task

You must set up either a cloud license server or a local license server by configuring environment variables based on
the operating system.

Setting up a Cloud License Server

Before you start the product, you must configure the following environment variable on the computer on which you
have installed Test Embedded

You can add the licensing parameters as environment variables described in the following table:

Environment vari- | Description
able

HCL_LICENSING_- | The value specifies the URL of the cloud server. If it is not set, it points to the HCL cloud li-

URL cense.
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Environment vari- | Description

able

HCL_LICENSING_ID | The license server ID that was provided to you. You can copy the ID from the HCL® License &
Delivery portal.

When you launch the product, it connects to the HCL® License & Delivery portal to verify this server ID and if there
is a license available, it is checked out so that you can use the product. If the license is not available, a message is
displayed about it, in the console.

Note: If the license is not used for 15 minutes, the license is returned to the License server for others to

consume it.

Setting up a Local License Server

When you install the product on computers which cannot access the internet and are behind a firewall, you must set
up a Local License Server. You must install the Local License Server on a physical computer or a virtual machine.
For more information about installing and configuring the Local License Server, see the documentation of the local
license server from where you downloaded the product bits. As part of configuration, the local license server maps

your entitlements of software with the Local License Server to serve your requests.

Note: If the license is not used for 15 minutes, the license is returned to the License server for others to
consume it.

Before you start the product, you must set the following environment variable as described in the following table:

Environment | Description

variable

HCL_LI- The value specifies the URL of the local license server. The URL must be set up to point to your lo-
CENSING_URL | cal server.

Example: HCL_LI CENSI NG_URL=htt p: // nySer ver: port Nunber

HCL_LI- The environment variable must be blank or undefined. If you enter a value, the local server acts like

CENSING_ID |a cloud server, and the licenses do not apply.

Note: Ensure the HCL_LICENSING_URL matches the hostname of your computer where the local server
is installed. You must be attentive to the case sensitivity of the licensing server URL. You can obtain the

accurate and case-sensitive information from the system administrators responsible for installing the local
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server. This information is important for you to properly configure and establish connectivity on the local

server for licensing services.

Setting up licenses on Windows
Before you use HCL DevOps Test Embedded (Test Embedded), you must set up and apply the licenses by using a

license server.

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you

install the product can access the internet.

You can apply the licenses for the product by using any of the following methods that is based on your network set

up:

« Setting up licenses by using the Cloud License Server on page 58

« Setting up licenses by using a Local License Server on page 59

Setting up licenses by using the Cloud License Server

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you
install the product can access the internet.

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you
install the product can access the internet.

Before you begin

* Purchased the licenses.
« Configured the URL of a FlexNet Cloud License Server with the appropriate entitlements. The URL of the

FlexNet Cloud License Server is in this form:

https://hcl software. conpl i ance. fl exnet operati ons. com

» Been issued the Server ID of the FlexNet Cloud License Server.
» Download the FlexNet Publisher certificate file for example f1 exera_vertifi cate. pem

1. Press Windows + Break to open the System Properties window.
2. Select the Advanced tab, and then click Environment variables.
3. Click New under System variables and add the following environment variables:
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Environment vari-

able

Value

HCL_LICENSING_-
URL

https://hclsoftware.compliance.flexnetoperations.com

HCL_LICENSING_-
ID

The value specifies the ID of the licensing server. The ID provided is a 12-digit alphanu-

meric code.

Results

You have set up the licenses by using the FlexNet Cloud License Server.

What to do next

You can configure Test Embedded. See Configuration of Test Embedded on page 63.

Setting up licenses by using a Local License Server

When you install the product on computers which cannot access the internet and are behind a firewall, you must

set up a Local License Server. You must install the Local License Server on a physical computer and not on a Virtual

Machine.

Before you begin

» Purchased the licenses.

« Installed the Local License Server.

« Configured the Local License Server with the appropriate entitlements. For more information about installing

and configuring the Local License Server, see the documentation for the Local License Server on the HCL®

License & Delivery portal.

» Download the FlexNet Publisher certificate file for example f1 exera_vertifi cate. pem

1. Perform any of the following actions:

° = If you are using HTTP to check out the licenses, go to Step 2 on page 59.

= If you are using HTTPS to check out the licenses, go to Step 3 on page 60.

2. Perform the following steps if you are using the HTTP method:

a. Press Windows + Break to open the System Properties window.

b. Select the Advanced tab, and then click Environment variables.

c. Click New under System variables and add the following environment variable:
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Environment variable | Value

HCL_LICENSING_URL | http://myServer:portNumber

Substitute the following variables with the values as indicated in the following table:

Variable Value

myServer The hostname of the Local License Server.

The port number of the Local License Serv-

portNumber
er.

3. Perform the following steps if you are using the HTTPS method:
a. Download the local server certificate, and point to it by using the following environment variable:

Environment variable Value
FLEXERA_CERTIFICATE_LO- Path to the local server certificate
CATION file.

Results

You have set up the licenses by using a Local License Server.

What to do next

You can configure Test Embedded. See Configuration of Test Embedded on page 63.

Setting up licenses on Linux

Before you use HCL DevOps Test Embedded (Test Embedded), you must set up and apply the licenses by using a

license server.

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you
install the product can access the internet.

You can apply the licenses for the product by using any of the following methods that is based on your network set
up:

« Setting up licenses by using the Cloud License Server on page 61

« Setting up licenses by using a Local License Server on page 61
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Setting up licenses by using the Cloud License Server

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you

install the product can access the internet.

You can set up licenses for Test Embedded by using the FlexNet Cloud License Server, if the computers on which you

install the product can access the internet.

Before you begin

« Purchased the licenses.
« Configured the URL of a FlexNet Cloud License Server with the appropriate entitlements. The URL of the
FlexNet Cloud License Server is in this form:

https://hcl software. conpl i ance. fl exnet operati ons. com

» Been issued the Server ID of the FlexNet Cloud License Server.

» Download the FlexNet Publisher certificate file for example f1 exera_verti ficat e. pem

1. Open a terminal.
2. Add the following environment variables to / et ¢/ envi r onnment

3. Click New under System variables and add the following environment variables:

Environment vari- | Value
able

HCL_LICENSING_- |https://hclsoftware.compliance.flexnetoperations.com
URL

HCL_LICENSING_- | The value specifies the ID of the licensing server. The ID provided is a 12-digit alphanu-

ID meric code.

Results
You have set up the licenses by using the FlexNet Cloud License Server.
What to do next

You can configure Test Embedded. See Configuration of Test Embedded on page 63.

Setting up licenses by using a Local License Server

When you install the product on computers which cannot access the internet and are behind a firewall, you must
set up a Local License Server. You must install the Local License Server on a physical computer and not on a Virtual

Machine.
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Before you begin

* Purchased the licenses.

« Installed the Local License Server.

« Configured the Local License Server with the appropriate entitlements. For more information about installing
and configuring the Local License Server, see the documentation for the Local License Server on the HCL®
License & Delivery portal.

« Download the FlexNet Publisher certificate file for example f | exera_verti fi cat e. pem

1. Open a terminal.
2. Perform any of the following actions:
0 = If you are using HTTP to check out the licenses, go to Step 3 on page 62.
= If you are using HTTPS to check out the licenses, go to Step 4 on page 62.
3. Perform the following steps if you are using the HTTP method:
a. Add the following environment variable to / et ¢/ envi r onnent :

Environment variable | Value

HCL_LICENSING_URL | http://myServer:portNumber

Substitute the following variables with the values as indicated in the following table:

Variable Value

myServer The hostname of the Local License Server.

The port number of the Local License Serv-

portNumber
er.

4. Perform the following steps if you are using the HTTPS method:
a. Download the local server certificate, and point to it by using the following environment variable:

Environment variable Value
FLEXERA_CERTIFICATE_LO- Path to the local server certificate
CATION file.

b. Set FLEXERA CERTI FI CATE_LOCATI ON:
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= Export the FLEXERA CERTI FI CATE_LOCATI ON environment variable with the path to your FlexNet

Publisher certificate file.

export FLEXERA CERTI FI CATE_LOCATI ON=/ C/ Pr ogr am
Fi | es/ HCL/ DevOpsTest Enbedded90/ i b/ certificates/flexera_vertificate.pem

Results
You have set up the licenses by using a Local License Server.
What to do next

You can configure Test Embedded. See Configuration of Test Embedded on page 63.

Configuration of DevOps Test Embedded

Use these topics to configure the product.

Target Deployment Port Editor overview

The TDP Editor provides a user interface designed to help you customize and create Target Deployment Ports (TDP)

for any platform on which you want to run tests or programs.

The Target Deployment Port Editor user interface is made up of 4 main sections:

« Navigation: Use the navigation explorer view to select customization points.

« Help: This area provides direct reference information for the selected customization point.

« Edit: Use this area to edit the customization point. The form of the Edit window depends on the nature of the
customization point.

« Comment: Use this area to store comments or descriptions for each customization point.

In the Navigation view, you can click on any customization point to obtained detailed reference information for that

parameter in the Help area. Use this information to customize the TDP to suit your requirements.

Target Deployment Port Editor overview

The TDP Editor provides a user interface designed to help you customize and create Target Deployment Ports (TDP)

for any platform on which you want to run tests or programs.

The Target Deployment Port Editor user interface is made up of 4 main sections:

« Navigation: Use the navigation explorer view to select customization points.

« Help: This area provides direct reference information for the selected customization point.

« Edit: Use this area to edit the customization point. The form of the Edit window depends on the nature of the
customization point.

- Comment: Use this area to store comments or descriptions for each customization point.

63



64

HCL DevOps Test Embedded

In the Navigation view, you can click on any customization point to obtained detailed reference information for that

parameter in the Help area. Use this information to customize the TDP to suit your requirements.

Opening the Target Deployment Port Editor

Target Deployment Ports (TDP) are stored as XDP files, which can be viewed and edited with the Target Deployment
Port Editor.

To open a TDP in the Target Deployment Port Editor:

1. From the Start menu, click HCL DevOps Test Embedded > Target Deployment Port Editor, or from a shell or
command window, type the command: t dpedi t or .
2. Click File > Open
3. Inthet ar get s directory, select an XDP file and click Open.
4. Save your changes and reload the TDP in Test Embedded:
Choose from:
o In Test Embedded for Eclipse IDE, right-click the project and click Properties > C/C++ Build > Settings
> TDP Build, select another TDP and select the updated TDP again. Click OK.
> In Test Embedded Studio, restart Test Embedded Studio, click Project > Configuration, select the TDP,
click Remove. Click New, select the updated TDP again and click OK.

To open a TDP from HCL DevOps Test Embedded :

5. First you must have the Target Deployment Port view displayed in Test Embedded. To open this view, in the
toolbar associated with the Test Embedded perspective, click Window, and select Show View > Other > HCL
DevOps Test Embedded > Target Deployment Port.

6. The Target Deployment Port view opens and displays the list of all the Target Deployment Ports that are

installed in Test Embedded. Select a Target Deployment Port and click the 7 button to edit the selected
Target Deployment port.
From this view, you can also open the preferences panel and configure the Target Deployment Port search

path.

Creating a TDP

This topic provides a typical example workflow for creating a new target deployment port (TDP) for a C compiler.

About this task

Creating a new TDP requires advanced familiarity with:

» Test Embedded and its underlying TDP technology.
« The target platform hardware and software architecture.
* The target development environment.
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1. In the Target Deployment Port Editor, at the top of the Navigation area, right-click the TDP name and type a
new name.

2. Specify all the Basic settings. Create intermediate keys to help with future changes and save the TDP.

w

. In Test Embedded Studio, open the add. r t p project which is located in exanpl es/ TDP/ t ut ori al . Thisis a
simple project that can be used for debugging target deployment ports.

. Click Edit > Preferences > Project and select Verbose.

. Click Project > Configuration to create a new configuration, and select the new TDP. Click OK.

. Select the new configuration based on the new TDP.

N o o b

. Click Settings > Build > Build Options > ... and remove all instrumentation. At this point any modifications

of the DEFAULT_xxxx in the Target Deployment Port Editor will be ignored in the project. Therefore, you must

duplicate or copy any changes in the Build > Build > Compiler/Link configuration settings.

8. In the project browser, right click add. ¢ and select Compile. Check that the object file is generated in the
correct directory. If any problems occurred, open the Target Deployment Port Editor and correct the problems
in Build Settings > Compilation function. Repeat this step until add. c is properly generated.

9. In the Build > Build options > ... settings, enable coverage instrumentation only and remove all files located in
the exanpl es/ TDP/ t ut ori al / xdp nane directory.

10. In the project browser, right click add. ¢ and select Compile. The instrumentation occurs after the
preprocessing and before compilation. Check the . i file is generated properly in the correct directory and that
it contains #line xx "fileName" or # xx "fileNane". If any problems occurred, open the Target Deployment
Port Editor and correct the problems in Build Settings > Preprocessing function. Repeat this step until the . i
file is properly generated.

11. Check that add. o or add. obj is generated in the correct directory and not a file named add_aug. o or
add_aug. obj . If any problems occurred, open the Target Deployment Port Editor and correct the problems in
Build Settings > Compilation function. Repeat from step 9 until add. o or add. obj are properly generated.

12. In the project browser, right click TP.c and select Compile. Check that TP. o or TP. obj are generated in the
correct directory. If any problems occurred, open the Target Deployment Port Editor and correct the problems
in Library Settings. Repeat this step until TP. o or TP. obj are properly generated.

13. Check that Test.exe is generated in the correct directory. If any problems occurred, open the Target

Deployment Port Editor and correct the problems in Build Settings > Link function. Repeat this step until

Test.exe is properly generated.

Note: Any files added in the TDP Editor Build settings are located in STARGETDIR/cmd by default.

Using the TDP Editor

The TDP Editor provides a user interface designed to help you customize and create unified Target Deployment Ports.

The TDP Editor is made up of 4 main sections:

- A Navigation Tree: Use the navigation tree on the left to select customization points.

« A Help Window: Provides direct reference information for the selected customization point.
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- An Edit Window: The format of the Edit Window depends on the nature of the customization point.

« A Comment Window: Lets you to enter a personal comment for each customization point.

In the Navigation Tree, you can click on any customization point to obtained detailed reference information for that

parameter in the Help Window. Use this information to customize the TDP to suit your requirements.

Note The TDP Editor is not included with the trial version of the product.

To learn about See

Making changes to the TDP Editing customization points in a TDP on
page 66

Launching the TDP Editor Opening the Target Deployment Port Editor on
page 64

Creating a new TDP Creating a TDP on page 64

Applying changes made to a TDP Updating a Target Deployment Port on page 67

Changing the way a TDP is generated Using a Post-generation Script on page 67

Importing old TDPs from ATTOL Testware prod- Migrating from Pre-v2002 Target Deployment
ucts Ports on page 68

Editing customization points in a TDP

Use the Target Deployment Port Editor to adapt an existing Target Deployment Port (TDP) to a specific target

platform or development environment.

About this task
Target Deployment Ports can be subdivided into four primary sections:

- Basic Settings: This section specifies default file extensions, default compilation and link flags, environment
variables and custom variables required for your target environment. This section allows you to set all the
common settings and variables used by Test Embedded and the different sections of the TDP. For example,
the name and location of the cross compiler for your target is stored in a Basic Settings variable, which is
used throughout the compilation, preprocessing and link functions. If the compiler changes, you only need to
update this variable in the Basic Settings section.

- Build Settings: This section configures the functions required by the Test Embedded build process. It defines
compilation, link and execution Perl scripts, plus any user-defined scripts when needed. This section is the
core of the TDP, as it drives all the actions needed to compile and execute a piece of code on the target. All
files related to the Build settings are stored in the cnd subdirectory of the TDP folder.

- Library Settings: This section describes a set of source code files and a dedicated customization file
(cust om h), which adapt the TDP to target platform requirements. This section is the most complex and
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usually only requires customization for specialized platforms (unknown RTOS, no RTOS, unknown simulator,
emulator, etc.). These files are stored in the | i b subdirectory of the TDP folder.

.

Parser Settings: This section modifies the behavior of the parser in order to address non-standard compiler
extensions (for example: non-ANSI extensions). This section allows Test Embedded to properly parse your
source code, either for instrumentation or code generation purposes. The resulting files are stored in the ana
subdirectory of the TDP folder.

1. In the Navigation view of the Target Deployment Port Editor, select the customization point that you want to
edit.
2. In the Help window, read the reference information pertaining to the selected customization point. Use this
information fill out the Edit window.
3. Type any remarks or comments in the Comments window.
4. Save your changes and reload the TDP in Test Embedded:
Choose from:
o In Test Embedded for Eclipse IDE, right-click the project and click Properties > C/C++ Build > Settings
> TDP Build, select another TDP and select the updated TDP again. Click OK.
o In Test Embedded Studio, restart Test Embedded Studio, click Project > Configuration, select the TDPR,
click Remove. Click New, select the updated TDP again and click OK.

Updating a Target Deployment Port

Target Deployment Technology

The Target Deployment Port (TDP) settings are read or loaded when a HCL DevOps Test Embedded (Test Embedded)
project is opened, or when a new Configuration is used.

If you make any changes to the Basic Settings of a TDP with the TDP Editor, any project settings that are read from
the TDP will not be taken into account until the TDP has been reloaded in the project.

To reload the TDP in Test Embedded:

1. From the Project menu, select Configurations.
2. Select the TDP and click Remove.
3. Click New, select the TDP and click OK.

Related Topics

Editing customization points in a TDP on page 66 | Creating a TDP on page 64

Using a Post-generation Script
Target Deployment Technology

In some cases, it can be necessary to complete the generation of the TDP in the target directory by adding an

additional phase at the end of the generation.
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To do this, the TDP editor runs a post-generation Perl script called postGen.pl, which can be launched automatically

at the end of the TDP directory generation process.

To use the postGen script:

1. In the TDP editor, right click on the Build Settings node and select Add child and Ascii File.

2. Name the new node postGen.pl.

3. Write a perl function performing the actions that you want to perform after the TDP directory is written by the
TDP Editor.

Example

Here is a possible template for the postGen.pl script file:

sub postGen

{

Sd=shift;

# the only parameter passed to this function is the path to the target directory
# here any action to be taken can be added

}

1

The parameter $d contains <tdp_dir>/<tdp_name>, where <tdp_dir> is a chosen location for the TDP directory (by
default, the targets subdirectory of the product installation directory), and <tdp_name> is the name of the current TDP

directory
Related Topics

Creating a TDP on page 64

Migrating from v2001A Target Deployment Ports
Target Deployment Technology

This section describes the conversion of TDPs built for older versions (before v2002) of HCL DevOps Test Embedded
(Test Embedded) to the current, unified format.

This section applies to TDPs and ATTOL Target Packages created for:

« ATTOL Coverage, UniTest and SystemTest

» Test Embedded v2001A
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TDPs created for later versions of Test Embedded or Test Embedded are compatible with the current version.

To migrate your old TDP to the current format:

1. In the TDP Editor, create a new Target Deployment Port based on the appropriate new template:
> use templatec.xdp for C and C++ TDPs

> use templatea.xdp for Ada TDPs

2. Item by item, recode or copy-paste information from your old TDP to the corresponding customization points
in the TDP Editor, using the information in this section of the Target Deployment Guide to direct you.

Related Topics

Updating a Target Deployment Port on page 67 | Migrating from a previous version on page 69

Migrating from a previous version

The current version of HCL DevOps Test Embedded (Test Embedded) is capable of importing from Test Embedded
v2001A or from any of the following legacy ATTOL Testware products.

» ATTOL UniTest
» ATTOL SystemTest

» ATTOL Coverage
Files from later versions of the product are directly compatible with the current version Test Embedded.

Workspaces and projects

Some earlier versions of the product used the concept of workspaces instead of sub-projects. When opening an older
project that contains workspaces, these are automatically converted into sub-projects in the current version of the

product.

Migrating target deployment ports

See Updating a Target Deployment Port on page 67 for details about upgrading and customizing target
deployment ports (TDPs).

Migrating from ATTOL UniTest

Test Embeddedv2002 and later provides an Import function to import .prj, .cmp, and .ses files from ATTOL UniTest
and Test Embedded v2001A. See Importing v2001 Component Testing Files on page 746 for more information.
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Migrating from ATTOL SystemTest

There is no import facility for ATTOL SystemTest files. The recommended approach is to manually import the existing
source and .pts test script files into a Test Embedded project with the System Testing Wizard on page 915.

Project files created in ATTOL SystemTest Studio are not compatible with Test Embedded.

To import an ATTOL SystemTest project into the product:

1. Use the Activity Wizard to create a new workspace and System Testing test node.

When prompted, specify your existing source files.

2. Follow the indications until the System Testing Wizard appears.
3. In the System Testing Wizard, clear the Create a new test script option and click the ... button to import an
existing .pts test script. Click Add to add the .h interface file.

4. Follow the standard System Testing instructions to configure and deploy the Virtual Testers.

Migrating from ATTOL Coverage
The Code Coverage Viewer in Test Embedded can open and display .fdc and .tio files from ATTOL Coverage versions.

To open a Code Coverage Report:

1. From the File menu, select Open.

2. In the File type list, select Code Coverage Viewer files (*.fdc,*.tio).
3. Locate and select the .fdc and .tio files from the older version.

4. Click OK.

Related Topics

Importing V2001 Component Testing Files on page 746 | New Project Wizard on page 910 | Activity Wizards on
page 909 | Updating a Target Deployment Port on page 67 | Upgrading from v2001 target deployment ports on
page 68

Integrating

Read these topics to learn how the product works when integrated with other products.

Engineering Test Management integration

You can integrate IBM® Engineering Test Management (ETM) with HCL DevOps Test Embedded (Test Embedded) to

create test environments and test scripts, deploy and run tests, and view HTML reports.

IBM® Engineering Test Managementis a business-driven software quality environment for users who are seeking a
collaborative and customizable solution for test planning, workflow control, tracking and metrics reporting. It is used

to quantify how project decisions and deliverable impact and align with business objectives.
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Note: IBM® Engineering Test Management is the new name for IBM® Rational® Quality Manager (RQM) from

version 7.0.

With Engineering Test Management integrated with Test Embedded, you can perform the following tasks:

« Create Engineering Test Management test environments that are linked to Test Embedded target deployment
ports

- Create Engineering Test Management test scripts that are linked to Test Embedded test assets.

« Deploy and run Test Embedded tests for the Engineering Test Management interface.

« View HTML reports in the Engineering Test Management interface.

For Engineering Test Management the term test script is used to describe basic test assets. Engineering Test
Management test scripts are mapped to Test Embedded test suites. A test suite contains multiple test harnesses

that are run sequentially to provide global results for a project.

To use Engineering Test Management with Test Embedded for Eclipse IDE or Test Embedded Studio, the Test

Embedded adapter service must be running on the computer.

With the adapter running, you can import test suites as Engineering Test Management test scripts, build a new
Engineering Test Management test case based on those test suites, and run the tests from Engineering Test

Management. You can also view the results of the tests in Engineering Test Management as HTML reports.

Related information

Running the adapter on page 71

Importing test suites into Engineering Test Management on page 73

Running the adapter

To use Engineering Test Management with HCL DevOps Test Embedded Studio (Test Embedded Studio) or HCL
DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE), the Test Embedded adapter must be running

on the computer.
Before you begin

As an RQM or ETM user, you must have write access to a valid RQM Public URL and project, and the appropriate RQM
CALs.

Before running the adapter, ensure that both the PATH and JAVA_HOME environment variables are properly set to the
correct location of a Java Runtime Environment (JRE) version 1.5 or later.

From Test Embedded 9.0.0, Engineering Test Management 7.0.2 must be used.

To start the Test Embedded and Engineering Test Management adapters, follow these steps:
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1. Run the command prompt as an administrator user on Windows. On Linux open the command shell and enter
sudo to have root rights.
2. Start the Engineering Test Management adapter service with the following command, located in the
\ RQVAdapt er \ Test RTadapt er folder of the product installation directory:
Choose from:
> On Windows™, enter the following command: st ar t Test RTAdapt er . bat

C:\Program Files\HCL\DevOpsTestEmbedded\RQMAdapter\TestRTAdapter\"startTestRTAdapter.bat"

o On UNIX™, enter st art Test RTAdapt er . sh

sudo startTestRTadapter.sh

Note: The adapter requires access to a writable temporary directory. The %TEMP% variable is
used to access to the default directory. If the adapter encounters permission problems with
the default settings, add the following option to the command to specify a writable directory:

-tenpDir=tenp_directory. For example: start Test RTAdapt er. bat -tenpDir=C: \tenp.

3. If you run the adapter for the first time, you must configure the adapter in the command window when

prompted as follows:

a. Enter the base URL of the Engineering Test Management server.
Example
For example: ht t ps: // host nane: 9443/ j azz

b. Enter your login and password for Engineering Test Management account.
c. Enter the Engineering Test Management project area name.

d. Enter a name for the adapter, or press Return to use the default name.

Note: This step is not mandatory. If you don't enter any name, the default adapter name is
taken into account.

The adapter only asks these questions the first time it is run. If you need to change the server URL or login
information, run the adapter with the - reconf i gur e option as follows:

o On Windows, enter:

C:\Program Files\HCL\DevOpsTestEmbedded\RQMAdapter\TestRTAdapter\"startTestRTAdapter.bat"
-reconfigure

o On Linux, enter:

sudo startTestRTadapter.sh -reconfigure

Results
The Engineering Test Management adapter service is started.
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Related information

Engineering Test Management integration on page 70

Importing test suites into Engineering Test Management on page 73

Importing test suites into Engineering Test Management

The Engineering Test Management adapter for HCL DevOps Test Embedded (Test Embedded) enables you to import
Test Embedded test suites as Engineering Test Management test scripts.

To import Test Embedded test suites as Engineering Test Management test scripts, follow these steps:

1. Log in to Engineering Test Management and click Construction > Create test scripts.

2. In Script type, select Test Embedded.

3. Select Use test resources that are local to a test machine and click Select Adapter.

4. Select the Test Embedded adapter that you want to use and click Next.

5. In Project Path, specify the path to the workspace project where the Test Embedded test suite is located, and

select Go.

Note: For Test Embedded Studio, specify the directory where the Test Embedded .rtp project file is
located.

The adapter parses all the sub-directories under the selected directory, therefore, if you specify a workspace
path, it will find all the test suites in that workspace.
6. Select one or several test suites to import, click Finish and Import.

What to do next

Once the test scripts are imported, build a new test case in Engineering Test Management with the Test Embedded
test suites. After running the Engineering Test Management test case, click Close and Show results. You can click
the links in the Result Details section of Engineering Test Management. To view HTML reports in Engineering Test

Management, see Opening reports in ETM on page 74.

Related information

Engineering Test Management integration on page 70

Running the adapter on page 71

Associating Target Deployment Ports with test environments

When you select the HCL DevOps Test Embedded (Test Embedded) adapter in Engineering Test Management, by
default, the Test Embedded project is run with the Target Deployment Port (TDP) that is selected in the project. To run
the same project with different TDPs, you can create different test environments in Engineering Test Management by

associating TDPs with the test environment.
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To associate a test execution with a specific TDP, follow this procedure:

1. Log in to in Engineering Test Management, click Lab Management > Create Test Environment.

2. Enter a name for the test environment that applies to the name of the Test Embedded configuration. The
name must be exactly the same as the Configuration name in Test Embedded, for example: C Win32 - GNU.

. Click Save.

. Click Construction > Create Test Execution Record and enter a name for the new test execution record.

. Select the Test Case and the Default Test Script.

. In Available Test Environments, select the test environment with the name of the TDP that you want to use.

. Click Save.

N o o0 AW

Opening reports in ETM

To view reports in IBM® Engineering Test Management 7.0.2, you must download them for security reasons. However

you can change the settings in the project properties to be able to open the reports directly in the test results.

About this task
This task explains how to proceed to open reports directly in ETM. The procedure applies to IBM® Engineering Test

Management 7.0.2.
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1. In the test result page, click and select Manage project properties in the drop-down menu.
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3. Select Open attachments in test results directly, without prompting users to open or save them.
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When the settings are changed, you can click a test result to open the reports.

Integrating DevOps Model RealTimewith DevOps Test Embedded

HCL DevOps Model RealTime (Model RealTime) is an Eclipse-based modeling and development environment for

creating event-driven real-time applications. It supports the Unified Modeling Language (UML) and its real-time profile
(UML-RT).

Systems engineers use DevOps Model RealTime for specifying and documenting the structure and behavior of
complex application architectures using UML diagrams of various kinds.

HCL OneTest Embedded axecution compisted propery - Execulad bests: 3 - Passs
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Software engineers use DevOps Model RealTimefor developing application code which to a large extent can be
automatically generated from the UML model. Highly efficient C and C++ code can be generated, which together with
a run-time library can be built into executable applications.

RTist integration with Test Embedded extends the run-time analysis capabilities to also cover applications developed
with RTist. In addition to code coverage you can also obtain coverage information at model level. For example, you
can run tests against your DevOps Test application and then check which states and transitions that were executed
or more importantly, which were not. This helps you increase your test coverage. It can also help you to find out which
parts of your state machines run the most and hence need to be as efficient as possible, as well as finding unused
parts of your state machines that perhaps can be removed.

For more information about the DevOps Model RealTimeintegration, refer to DevOps Test Embedded Integration
documentation.

Configuring the Jenkins environment to run test suites

You must configure Jenkins to be able to run test suites created with HCL DevOps Test Embedded for Eclipse IDE
(Test Embedded for Eclipse IDE) in a Jenkins environment.

Before you begin
About this task
Test Embedded for Eclipse IDE command line interface facilitates the integration of Jenkins in Test Embedded.

To configure Jenkins:

1. On the Jenkins dashboard, click Configure.

2. Under Build, click Add build step where you want to insert your test execution.

3. Select Execute Windows batch command for Windows, or Execute shell for UNIX.

4. Setup your command as follows to execute your test suite: rtrteclipse -WORKSPACE= <your workspace> <your
test suite>.

For more details, see Running test suites from the command line on page 389.

Integrating Test Embedded Studio with other development tools

HCL DevOps Test Embedded Studio (Test Embedded Studio) is a versatile tool that is designed to integrate with your

existing development environment.

To learn about See

IBM® Rational® ClearCase® integration Working with Rational ClearCase on
page 77

Rational® ClearQuest®integration Working with ClearQuest on page 79


https://rtist.hcldoc.com/help/index.jsp?topic=%2Fcom.ibm.xtools.rsarte.webdoc%2FArticles%2FIntegrations%2FOneTest+Embedded+Integration%2Findex.html
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Microsoft Visual Studio integration Configuring Microsoft Visual Studio on
page 80

Using third party configuration management soft- Working with Configuration Manage-

ware ment on page 77

Integrating Studio with configuration management

The GUI provides an interface that allows you to control your project files through a configuration management (CM)
system such as IBM® Rational® ClearCase® and submit software defect report to a Rational® ClearCase® system.

Note Before using any configuration management tool, you must first configure the CMS Preferences dialog box. See

Customizing Configuration Management.

You can also set up the GUI to use a CM system of your choice.

To learn about See

Configuration management with Rational® ClearCase® Working with Rational ClearCase
on page 77

Reporting defects with Rational® ClearQuest® Working with Rational Clear-

Quest on page 79

Setting up the GUI to use a third-party configuration management Customizing source control tools

tool. on page 79

Related information

ClearQuest preferences on page 1269
CMS Preferences on page 1268

Working with Other Development Tools on page 76

Integrating Studio with IBM® Rational® ClearCase®

IBM® Rational® ClearCase® is a configuration management system (CMS) tool providing version control, workspace
management, configuration process, and build management. With Rational® ClearCase®, your development team
gets a scalable, best-practices-based development process that simplifies change management — shortening your
development cycles, ensuring the accuracy of your releases, and delivering reliable builds and patches for your

previously shipped products.

By default, Test Embedded offers configuration management support for Rational® ClearCase®. You can however
customize the product to support different configuration management software. When using Rational® ClearCase®,

you can instantly control your files from the product Tools menu.
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Note: Before using Rational® ClearCase® commands, select Rational® ClearCase® as your CMS tool in the
CMS Preferences. on page 1268
Source Control Commands.

For any file in the Test Embedded project, Code ClearCase, or any other CMS tool, can be accessed through a set of

source control commands.

Source control can be applied to all files and nodes in the Project Browser or Asset Browser. When a source control

command is applied to a project, group, application, test or results node, it affects all the files contained in that node.

The following source control commands are included to be used with Code ClearCase:

« Add to Source Control

» Check Out

* Check In

+ Undo Check Out

» Compare to Previous Version
» Show History

» Show Properties

Refer to the documentation provided with Code ClearCase for more information about these commands.
Source control commands are fully configurable from the Tools menu.

To control files from the Tools menu:

1. Select one or several files in the Project Explorer window.
2. From the Tools menu, select Code ClearCase and the source control command that you want to apply.

To control files from the Source Control popup menu:

1. Right-click one or several files in the Project Explorer window.
2. From the popup menu, select Source Control and the source control command that you want to apply.

Related Topics

Working with Rational® ClearQuest® on page 79 | CMS Preferences on page 1268 | About the Tools Menu on

page 958 | Customizing source control tools on page 79
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Integrating Studio with IBM® Rational® ClearQuest®

IBM® Rational® ClearQuest® is a defect and change tracking tool designed to operate in a client/server environment.
It allows you to easily track defects and change requests, target your most important problems or enhancements to
your product. Rational® ClearQuest® helps you determine the quality of your application or component during each
phase of the development cycle and helps you track the release in which a feature, enhancement or bug fix appears.

By default, the product offers defect tracking support for Rational® ClearQuest®. When using ClearQuest with HCL
DevOps Test Embedded Studio (Test Embedded Studio) you can directly submit a report from a test or runtime
analysis report.

To submit a ClearQuest report from Test Embedded Studio:

1. In the Report Explorer, right-click a test.

2. From the pop-up menu, select Submit ClearQuest Report.

3. This opens the ClearQuest Submit Defect window, with information about the Failed test.
4. Enter any other necessary useful information, and click OK.

For more information, see the Rational® ClearQuest® documentation.
Related Topics

ClearQuest Preferences on page 1269

Customizing source control tools

Out of the box, the product offers configuration management support for Rational® ClearCase®, but the product can
be configured to use most other Configuration Management Software (CMS) that uses a vault and local repository

architecture and that offers a command line interface.

To configure the product to work with your version control software:

1. Add a new CMS tool to the Toolbox with the command lines for checking files into and out of the configuration
management software. This activates the Check In and Check Out commands in the Project Explorer on
page 1278 and the ClearCase Toolbar.

2. Set up version control repository in CMS Preferences.

Related information

Working with Rational ClearCase on page 77
CMS Preferences on page 1268

About the Tools Menu on page 958
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Integrating Studio with Microsoft Visual Studio

HCL DevOps Test Embedded (Test Embedded) provides a special setup tool to configure runtime analysis tools with
Microsoft Visual Studio 6.0.

Note Integration with Microsoft Visual Studio is only available with the Windows version of Test Embedded Studio.

Installation

Both Test Embedded and Microsoft Visual Studio must be installed on the same machine.

To install the Microsoft Visual Studio 6.0 plug-in:

1. From the Windows Start menu, select Programs HCL® Software > Test Embedded Software Test Embedded,
Tools and Test EmbeddedPlug-in for Microsoft Visual Studio Install to add the new menu items to Microsoft
Visual Studio

To uninstall the plug-in:

1. From the Windows Start menu, select Programs > Test Embedded Software > Test Embedded Software, Test
Embedded, Tools andTest Embedded Plug-in for Microsoft Visual Studio Uninstall to remove the plug-in from

Microsoft Visual Studio.
To install the Microsoft Visual Studio .NET plug-in:

1. From the Windows Start menu, select All Programs > Test Embedded Software > Test Embedded > Tools >
TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml
directory.

3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to TRUE.

4. Save cvisual7.xdp and close the TDP Editor.

To uninstall the plug-in:

1. From the Windows Start menu, select All Programs > Test Embedded Software > Test Embedded > Tools >
TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml
directory.

3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to FALSE.

4. Save cvisual7.xdp and close the TDP Editor.

Configuration

The Test Embedded setup for Microsoft Visual Studio tool allows you to set up and activate coverage types and

instrumentation options for Test Embedded Studio runtime analysis features, without leaving Microsoft Visual Studio.
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To run the product Setup for Microsoft Visual Studio:

In Microsoft Visual Studio, two new items are added to the Tools menu:

- Test Embedded Viewer:this launches the Studio user interface, providing access to reports generated by Test

Embedded runtime analysis and test features.

» Test Embedded Options:this launches the Setup for Microsoft Visual Studio tool.
The following commands are available:

« Apply:Applies the changes made
» OK:Apply the choices made and leave the window
- Enable or Disable: Enable or Disable the runtime analysis tools

» Cancel:Cancels modifications

Code Coverage Instrumentation Options

See About Code Coverage on page 192 and the sections about coverage types.

* Function instrumentation:
. > SelectNoneto disable instrumentation of function inputs, outputs and termination instructions.
- SelectFunctionsto instrument function inputs only.

> SelectExitsto instrument function inputs, outputs and termination instructions.

« Function calls instrumentation (C only):
. > SelectNoneto disable function call instrumentation.

o SelectCallsto enable function call instrumentation.

« Block instrumentation
. > SelectNoneto disable block instrumentation.
o SelectStatement Blocksto instrument simple blocks only.
> Selectlmplicit Blocksto instrument simple and implicit blocks.

> SelectLoopsto instrument implicit blocks and loops.
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- Condition instrumentation (C only)

. o SelectNoneto disable condition instrumentation
o SelectBasicto instrument basic conditions
- SelectModified/Multipleto instrument multiple

- SelectForcedto instrument forced multiple conditions

» No Ternaries Code Coverage:when this option is selected, simple blocks corresponding for the ternary

expression true and false branches are not instrumented
« Instrumentation Mode:see Information Modes on page 546 for more information.
. > Pass mode:allows you to distinguish covered branches from those not covered.

> Count mode:The number of times each branch is executed is displayed in addition to the pass mode

information in the coverage report.

o Compact mode:The compact mode is similar to the Pass mode. But each branch is stored in one bit

instead of one byte to reduce overhead.
Other Options

« Dump:this specifies the dump mode:
. o SelectNoneto dump on exit of the application
> SelectCallingto dump on call of the specified function
- Selectincomingto dump when entering the specified function
> SelectReturningto dump when exiting from the specified function
- Static Files Directory:allows you to specify where the.fdcand.tsffiles are to be generated
« Runtime Tracing:this option activates the Runtime Tracing runtime analysis feature
- Memory Profiling:this option activates the Memory Profiling runtime analysis feature
 Performance Profiling:this option activates the Performance Profiling runtime analysis feature

« Other:allows you to specify additional command-line options that are not available using the buttons. See the

Reference help for a complete list of Instrumentor options.

Integrating DevOps Test Embedded Studio with Microsoft Visual Studio

Integration with Microsoft Visual Studio is only available for the Windows versions of HCL DevOps Test Embedded
Studio (Test Embedded Studio).
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Test Embedded Studio and Microsoft Visual Studio 6.0 must be installed on the same machine.

« To enable the integration with Visual Studio, from the Windows Start menu, select Programs > Test
Embedded, Tools > Test Embedded Plug-in for Microsoft Visual Studio 6.0 Install to add the new menu items

to Microsoft Visual Studio.

« To disable the integration with Visual Studio, from the Windows Start menu, select Programs >Test
Embedded, Tools > Test Embedded Plug-in for Microsoft Visual Studio 6.0 Uninstall to add the new menu

items to Microsoft Visual Studio.

Related Topics

Configuring Microsoft Visual Studio Integration on page 80 | Importing Files from a Microsoft Visual Studio Project

file on page 935

Integrating Studio with Microsoft Visual Studio

HCL DevOps Test Embedded (Test Embedded) provides a special setup tool to configure runtime analysis tools with
Microsoft Visual Studio 6.0.

Note Integration with Microsoft Visual Studio is only available with the Windows version of Test Embedded Studio.

Installation
Both Test Embedded and Microsoft Visual Studio must be installed on the same machine.

To install the Microsoft Visual Studio 6.0 plug-in:

1. From the Windows Start menu, select Programs HCL® Software > Test Embedded Software Test Embedded,
Tools and Test EmbeddedPlug-in for Microsoft Visual Studio Install to add the new menu items to Microsoft
Visual Studio

To uninstall the plug-in:

1. From the Windows Start menu, select Programs > Test Embedded Software > Test Embedded Software, Test
Embedded, Tools andTest Embedded Plug-in for Microsoft Visual Studio Uninstall to remove the plug-in from

Microsoft Visual Studio.
To install the Microsoft Visual Studio .NET plug-in:

1. From the Windows Start menu, select All Programs > Test Embedded Software > Test Embedded > Tools >
TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml
directory.

3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to TRUE.

4. Save cvisual7.xdp and close the TDP Editor.
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To uninstall the plug-in:

1. From the Windows Start menu, select All Programs > Test Embedded Software > Test Embedded > Tools >
TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml
directory.

3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to FALSE.

4. Save cvisual7.xdp and close the TDP Editor.

Configuration

The Test Embedded setup for Microsoft Visual Studio tool allows you to set up and activate coverage types and

instrumentation options for Test Embedded Studio runtime analysis features, without leaving Microsoft Visual Studio.
To run the product Setup for Microsoft Visual Studio:

In Microsoft Visual Studio, two new items are added to the Tools menu:

» Test Embedded Viewer:this launches the Studio user interface, providing access to reports generated by Test

Embedded runtime analysis and test features.

» Test Embedded Options:this launches the Setup for Microsoft Visual Studio tool.
The following commands are available:

« Apply:Applies the changes made
« OK:Apply the choices made and leave the window
 Enable or Disable: Enable or Disable the runtime analysis tools

» Cancel:Cancels modifications

Code Coverage Instrumentation Options

See About Code Coverage on page 192 and the sections about coverage types.

* Function instrumentation:
. - SelectNoneto disable instrumentation of function inputs, outputs and termination instructions.
o SelectFunctionsto instrument function inputs only.

o SelectExitsto instrument function inputs, outputs and termination instructions.
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« Function calls instrumentation (C only):
. > SelectNoneto disable function call instrumentation.

> SelectCallsto enable function call instrumentation.

« Block instrumentation
. o SelectNoneto disable block instrumentation.
- SelectStatement Blocksto instrument simple blocks only.
> Selectlmplicit Blocksto instrument simple and implicit blocks.

> SelectLoopsto instrument implicit blocks and loops.

« Condition instrumentation (C only)

. > SelectNoneto disable condition instrumentation
o SelectBasicto instrument basic conditions
o SelectModified/Multipleto instrument multiple

> SelectForcedto instrument forced multiple conditions

- No Ternaries Code Coverage:when this option is selected, simple blocks corresponding for the ternary

expression true and false branches are not instrumented
* Instrumentation Mode:see Information Modes on page 546 for more information.
. > Pass mode:allows you to distinguish covered branches from those not covered.

- Count mode:The number of times each branch is executed is displayed in addition to the pass mode

information in the coverage report.

o Compact mode:The compact mode is similar to the Pass mode. But each branch is stored in one bit

instead of one byte to reduce overhead.
Other Options

« Dump:this specifies the dump mode:
. > SelectNoneto dump on exit of the application
o SelectCallingto dump on call of the specified function
> Selectincomingto dump when entering the specified function

- SelectReturningto dump when exiting from the specified function
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- Static Files Directory:allows you to specify where the.fdcand.tsffiles are to be generated

* Runtime Tracing:this option activates the Runtime Tracing runtime analysis feature

- Memory Profiling:this option activates the Memory Profiling runtime analysis feature

- Performance Profiling:this option activates the Performance Profiling runtime analysis feature

- Other:allows you to specify additional command-line options that are not available using the buttons. See the

Reference help for a complete list of Instrumentor options.
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The C, C++ and Ada tutorials apply to the use of HCL DevOps Test Embedded Studio (Test Embedded Studio).

These tutorials are presented in logical sequences and they must be completed before starting the next ones. Even if
there are some feature differences between the support for Ada, C, and C++, the majority of product features are the
same. If you are an advanced user and you want to use adapt the product to a particular development environment,
you must follow the TDP tutorial.

Note : For those who are interested specifically in Ada, the C, C++ and Ada track uses a C/C++ example. Ada support
consists of component testing and code coverage analysis.

Follow the lessons in order; this may take you 4 to 5 hours, depending on your prior knowledge of the Test Embedded
feature-set and on your comfort level with software development.

Occasionally, further practice is suggested - additional use of the tools to be performed outside of this Tutorial. You
can follow the Further Practice links on the corresponding pages.

To navigate through the browse sequences:
« On Windows: Click the browse sequence pages at the top of the online Help viewer.

« Other platforms: Use the Next Page and Previous Page links on each page.

To learn about See

How to perform runtime analysis and component testing in C and C++ C and C++ tutorial on

page 87
How to perform runtime analysis and component testing in Ada Ada tutorial on page 147
How to adapt a TDP to your target development platform Target deployment port tutori-

al on page 169

C and C++ tutorial

The purpose of this tutorial is to teach you how to use HCL DevOps Test Embedded (Test Embedded) to help you

improve your code.

This tutorial applies to Studio. It is made up of the following sections:

- Preparing for the tutorial: In this section we will set up our environment with everything we need to start
working with the product.

 Runtime analysis for C and C++: This section will introduce you to the basic features of the product for

profiling and analyzing your C and C++ applications. It will be followed by a series of hands-on exercises.
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- Testing C and C++ applications: This section will demonstrate how to perform component testing. It also

includes exercises.

« Conclusion: This section sums up what you will have learned.

Preparing for the tutorial

This tutorial can be performed on all development platforms supported by HCL DevOps Test Embedded (Test
Embedded) - Windows and Linux.

About this Tutorial

This tutorial demonstrates how to make the most of Test Embedded through a sample UMTS mobile phone

application, made of:

« A mobile phone simulator, running a basic embedded application

« A UMTS base station demonstrating the communication system

UMTS - Universal Mobile Telecommunications System - is a Third Generation (3G) mobile technology that will
enable 2Mbit/s streaming not only of voice and data, but also of audio and visual content. A UMTS base station is a

switching network device enabling the communication of multiple UMTS-enabled mobile phones.

Example File Locations

Source files for the base station (the mobile phone executable is provided) are located within the product installation
folder, in the folder \examples\BaseStation_C\src.

If you do not have write permission to the installation location of Test Embedded, you must copy the examples folder
and its contents to a new location. Otherwise, you will be unable to perform any part of the Tutorial that creates or

modifies files.

Mobile Phone Simulator

The mobile phone simulator consists of both a Graphical User Interface (GUI) as well as of internal logic. The GUI
is constructed from 0S-independent graphical C++ classes; the logic within the simulator is constructed from OS-
independent C and C++ code.

The mobile phone executable is located within the installation folder, in the folder \examples\BaseStation_C
\MobilePhone\. The name of the executable depends on your operating system:

» Windows: MobilePhone.exe
« Linux SUSE: MobilePhone.Linux

« Linux RedHat: MobilePhone.Linux_redhat
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A launcher shell script - MobilePhone.sh - is provided as well.

UMTS Base Station

The UMTS base station is constructed from 0S-independent C++ code. You are provided with both the source code
and an executable for the base station. The UMTS base station executable is located within the folder, in the folder
\examples\BaseStation_C. The name of the executable depends on your :

» Windows: BaseStation.exe
« Linux SuSE: BaseStation.Linux
« Linux RedHat: BaseStation.Linux_redhat

« A launcher shell script - BaseStation.sh - is provided for the non-Windows platforms as well.

Host-based testing vs target-based testing

The testing and runtime analysis that you will perform for this tutorial take place entirely on your machine. However,
one of the greatest capabilities of HCL DevOps Test Embedded (Test Embedded) is its support for testing and
analyzing your software directly on an embedded target. Does this mean you will need to change how you interact
with your application when switching from host-based to target-based testing? Will your tests have to be rewritten, for
example?

Not at all.

Thanks to the versatile, low-overhead Target Deployment Technology, all tests are fully target independent. Each
cross-development environment - that is, every combination of compiler, linker, and debugger - has its own Target
Deployment Port (TDP). In addition, any TDP can be modified via the Test Embedded user interface at a more
granular level, letting you customize a particular test or runtime analysis interaction without affecting neighboring
interactions. Such granular tailoring is supported by the concept of Configurations. Each Configuration can support
one or more TDP and can apply separate customization settings to each interaction assigned to it.

Over thirty reference TDPs, supporting some of the most commonly used cross-development environments, are
supplied out-of-the-box. After creation of a project (you will be doing this in a few moments), you can access a list of
TDPs installed on the machine.

To view a list of currently installed TDPs:

1. From the Project menu, select Configuration...
2. Select New...

3. Use the dropdown list to scroll through the available TDPs

Target Deployment Port Web Site

As new reference TDPs become available, they are first posted on a customer-accessible Web site. Check this site
periodically for news of the latest TDPs to be made available to the Test Embedded community.
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To access the Test Embedded Web site:
1. From the Help menu, select Test Embedded on the Web and Target Deployment Ports

Creating and Editing Target Deployment Ports

Does your organization target an environment for which no TDP yet exists? Using the Target Deployment Port Editor
you can create support, just as many of Test Embedded customers have done before you.

The reference TDPs supplied with Test Embedded can guide your TDP creation efforts; Test Embedded also provides

professional services should you choose to contract out their creation.
To access the Target Deployment Port Editor:

1. From the Tools menu, select Target Deployment Port Editor and Start.

For more information about the Target Deployment Port Editor, please refer to the Test EmbeddedTarget Deployment
Guide.

Every Test Embedded feature is accessible regardless of the environment within which you will be executing your
tests. Rest assured, your intended targets are supported.

Goals of the tutorial

The UMTS base station has been pre-loaded with errors; your responsibility, during the tutorial, will be to uncover:

- amemory leak
« a performance bottleneck
« alogic error in C code

« alogic error in C++ code
In addition, test completeness will be achieved by:

- improving the code coverage of your tests

- improving your understanding of the code via runtime tracing
Finally, you will
« simulate virtual actors in order to validate base station network messaging

To accomplish the above, you will first manipulate the UMTS base station through manual interaction with a mobile
phone simulator. Afterwards, automated hands-free interaction will be used.
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Regardless of the programming language you intend to use on your development project, make sure to perform the

runtime analysis tutorial.

For component testing and system testing, however, only certain sections of the Tutorial may apply:

« for C users - Component Testing for C and Ada, System Testing for C
- for Ada users - Component Testing for C and Ada

« for C++ users - Component Testing for C++

To continue this tutorial, follow the C, C++ and Ada track in the next lesson: Runtime Analysis.

Runtime Analysis for C and C++

You will start your tour with the runtime analysis features provided by HCL DevOps Test Embedded (Test Embedded).
The automated component testing features provided by Test Embedded will be discussed in the chapter entitled

Component Testing with Test Embedded.

Runtime analysis refers to the ability of Test Embedded to monitor an application as it executes. There are a variety of

advantages to be gained from this monitoring:

« Memory profiling
« Performance profiling

» Code coverage analysis

» Runtime tracing

Memory Profiling

Dynamically working with system memory can be quite a complicated affair. If you're not careful, your code might

either:

« Fail to free memory - referred to as a memory leak

- Mistakenly reference non-allocated memory - referred to as an array bounds read or array bounds write

A memory leak detection utility monitors an application as it executes, keeping an eye on memory usage to ensure
the above problems don't occur. If they do occur, the detection utility points out the sequence of events leading up to

the poor usage of memory, helping you deduce the cause of the error and thereby repair your code.

This function is provided in Test Embedded by the memory profiling feature for the C and C++ languages.

Performance Profiling

Optimal performance is, needless to say, crucial for real-time embedded systems. Measuring performance can be
quite difficult, however, particularly when it comes to determining the specific functional bottlenecks in your system.
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That's where performance profiling monitors come in. These tools watch your application as it executes, measuring
statistics such as:

« How often a function is called
« How long it takes for that function to execute

» Which functions are the bottlenecks of your application

With this information you can optimize your code, ensuring all real-time constraints placed upon your system are
accommodated.

This function is provided in Test Embedded by the performance profiling feature for the C and C++ languages.

Code Coverage analysis

One of the greatest difficulties a developer experiences is a failure to determine the portions of code that have gone
untested. For many embedded systems, failure is not an option, so every part of an application must be thoroughly
tested to ensure there is no unhandled scenario or dead code.

In addition, project managers need a concrete measurement to determine where the team is in the development cycle
- in particular, how much more testing needs to be done. A decreasing number of defects does not necessarily mean
the product is ready; it might simply mean the portions of code that have been tested appear to be ready.

Code coverage measurement tools observe your running application, flagging every line of code as it executes.
Advanced tools - such as Test Embedded - are also able to differentiate different types of execution, such as whether
or not a do-whileloop executed 0 times, 1 time, or 2 or more times. These advanced measurements are critical for

software certification in industries such as avionics.

This function is provided in Test Embedded by the code coverage feature for the C and C++ languages.

Runtime Tracing

As all embedded developers quickly learn, intentions don't necessarily translate into reality. There can often be a vast
difference between what you want to happen and what actually happens as your application executes.

This problem becomes more severe when the code is inherited. Yes, you could try to piece things together yourself,
but system complexity might just undercut your efforts at understanding the code.

And what about multi-threaded applications? If you've ever encountered race conditions or deadlocks, you know how
difficult it can be to uncover the source of the problem.

This is where runtime tracing monitors come in. These utilities graphically display the sequence of function or
method calls in your running application - as well as the active threads - illustrating through pictures what is actually
happening. With this information, unexpected exceptions can be easily traced back to their source, complex
procedures can be distilled to their essence, threading conflicts can be resolved and inherited code can jump off the
page and display its inherent logic.
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This function, using the industry standard Unified Modeling Language for its graphical display, is provided in Test
Embedded by the runtime tracing feature for the C and C++ languages.

Runtime Analysis exercises

The following exercises will walk you through a typical use case involving the four runtime analysis features of HCL
DevOps Test Embedded (Test Embedded) to which you have just been introduced. Pay close attention not only to
the capabilities of these features but also to how they are used. The better you understand these features, the more
quickly you will be able to adopt them within your own development process.

If you have never run this tutorial before, make sure your machine has a temporary folder in which you can store the
test project you will be creating. For the tutorial, it is assumed that the test project will be stored in a folder called
tmp.

If you have run this tutorial before, do not forget to undo the source file edits you made the last time you ran through
it. The following files are modified during the tutorial:

« PhoneNumber.cpp
» UmtsCode.c

» UmtsServer.cpp

If you intend to use Microsoft Visual C/C++, but installed it after installing the product you will need to update the

associated TDP. If the product was installed after Microsoft Visual C/C++ then no changes need to be made.

To run the tutorial without Microsoft Visual Studio:

 For Windows: install a recommended GNU C and C++ compiler - see Installing the GNU Compiler on
page 226 for instructions.

« For Linux: use the native C and C++ compiler already installed on your machine.

Note: During the installation of the product:

» On Windows: A local Microsoft Visual Studio compiler and JDK are located, based on registry
settings. Only the compiler and JDK located during installation will be accessible within the product.

- On UNIX or Linux: The user is confronted by two interactive dialogs. These dialogs serve to clarify
the location of the local GNU compiler and (if present) local JDK. Only the GNU compiler and JDK
specified within these dialogs will be accessible within the product.

To make a different compiler available for the product:

1. From the Tools menu, select Target Deployment Port Editor and Start.
2. In the Target Deployment Port Editor, from the File menu, select Open.

93



94

HCL DevOps Test Embedded

3. Open the .xdp file corresponding to the new compiler for which you would like to generate support.
4. In the Target Deployment Port Editor, from the File menu, select Save and Generate.
5. Close the Target Deployment Port Editor.

Exercise 1

In this exercise you will create a new project in which the UMTS base station source code will be referenced.

See Preparing for the tutorial on page 88 for details about the application you will be using in this tutorial.

Creating a Project

There is a one-to-one relationship between your current development project and a HCL DevOps Test Embedded (Test
Embedded) project. Even if your development project contains multiple applications, these applications have often a
common theme. Use the Test Embedded project to enforce that theme.

To create a project in Test Embedded:

1. Start Test Embedded. For Windows, use the Start menu. For UNIX, type studio in the command.
2. Select the Get Started link on the left-hand side of the Test Embedded Start Page.

Two links appear on the top of the page: New Project and Open Project.

3. Select the New Project link.

You should now see the New Project Wizard.

4. In the Project Name field, enter BaseStation (no spaces).

5. In the Location field, select the J button, browse to the folder in which you want the BaseStation project
to be stored, and then select it. For this Tutorial, let's assume that the project has been stored in the C:\tmp
(Windows) or \usr\tmp (UNIX) folder.

6. Click the Next button.

7. From the list of Target Deployment Ports currently installed on your computer, select the one you intend to use
to compile, link, and deploy your source code and the test or runtime analysis harness. Since the UMTS base
station consists of C++ code, you should choose either C++ Visual 6.0 if you have Microsoft Visual C++ 6.0
installed, or, if you are using a GNU/native compiler, select the item appropriate for your operating system:

> Windows - C++ Gnu 2.95.3-5 (mingw)
o Linux - C++ Linux - Gnu 2.95.2

Note: Do not be concerned if the version of the GNU compiler that you have installed does not match
the version of the GNU
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@ the version mentioned for the TDP. The differences are not relevant in this tutorial, thus other versions

are equally supported as well.

8. Click theFinishbutton.

Note: The project has been created - named BaseStation - and a project node by the same name

appears on the Project Browser tab of the Project Explorer window on the right-hand side of the Ul:
& &Easeﬁtatiun

Starting a New Activity

Now that you have created a project, it is time to specify:

« Your development project's source files

« The type of testing or runtime analysis activity you would like to perform first
To start a new activity:

1. Once a project has been created, the user is automatically brought to the Activities page. In this tutorial you
are starting with a focus on runtime analysis functionality, so select the Runtime Analysis link. This will bring
up the Runtime Analysis Wizard.

2. In the window entitled Application Files, you must list all source files for your current development project. For
this tutorial, you will directly select the source files. Click AddT,

3. Browse to folder into which you have installed Test Embedded and then access the folder \examples
\BaseStation_C\src

4. Make sure All C++ and Header Files in the Files of Type dropdown box is selected, then select all of the C and

C++ source files. Now click the Open button.
You should see a set of .c, .cpp and .h files listed in the large listbox of the Application Files window.

Click Next.

5. At this time, an analysis engine parses each source file - referred to as tagging. This process is used to extract
the various functions, methods, procedures and classes located within each source file, simplifying code
browsing within the UL

6. In the window entitled Selective Instrumentation you have the ability to select those functions, procedures,
methods or classes that should not be instrumented for runtime analysis. Such selective instrumentation

ensures that the instrumentation overhead is kept to a minimum. For this Tutorial, you will be monitoring

o
everything and thus all items should be checked. This should happen by default; if not, click Select AIIJ’
Click Next.
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7. You have now reached the window entitled Application Node Name. Enter the name of the application node
that will be created at the conclusion of the Runtime Analysis Wizard; since you will be monitoring execution
of the UMTS base station, type the word BaseStation within the text field labeled Name.

8. The Application Node Name window also gives you the opportunity to modify build settings associated
with the TDP you selected when creating the Test Embedded project. Some changes may need to be made,
depending on your operating system. (Note that these changes do not affect the actual TDP; you will be
making changes to a Configuration. A Configuration lets you modify a variety of settings on a node-by-node
basis within a project.

» For Windows:

. o Select the button on the bottom of the Application Node Name window entitled Configuration

Settings.

> In the window that has just appeared, named Configuration Settings, expand the Build node in the tree

on the left-hand side and left-click the Compiler node.

> In the Compiler flags edit box on the right-hand side of the window, add the flag -MLd to the end of the
list, separated by a space from the flag -GR

> In the Preprocessor macro definitions edit box, add the macro _DEBUG (make sure to include the

preceding underscore, and use only capital letters).

o Select the OK button on the bottom of the window.

1. Click Next.

2. You are now confronted with the Summary window. Everything should be in order, so click the Finish button.

The BaseStation application node has now been created. The Project Browser tab of the Project Explorer window

should appear as follows:

o &Easeﬁtatiun
- & BaseStation
% bazeStation.cpp

.@ [termsList.cpp
% PhoneMumber. cpp

.%j tepack.c

% UrmtzCode. o
.%j ImtzConnection. cpp

(_% Urtztdzg.c
éﬁ_‘j UrntsS erver.cpp

LI D D T D I
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Additional Build Customization

In this example, the UMTS base station consists of a mix of C and C++ source files. Some C++ compilers can handle

both the C and C++ languages; other compilers are not able to do this.

Recall that you selected the TDP for the C++ compiler on your machine. On Windows, the Visual C++ 6.0 TDP can
process both C and C++ files. For the GNU compiler on Windows, and for the native compilers on Linux, you need to

specify a C language TDP for the .c source files:
If you're using the GNU compiler on Windows, or the native compilers on Linux:

To set a C language TDP for .c files:

1. In the Project Browser, right-click the tcpsck.c child node of the BaseStation application node and select
Settings.

2. Position the Configuration Settings window that has opened so that you can easily see the Project Browser.

3. Expand the Build node in the tree on the left-hand side of the window and left-click the Build Options child
node.

4. Click the dropdown list for the Target Deployment Port setting. It's current value is the TDP selected when you
created the project.

5. Expand the dropdown list - either by left-clicking the field one more time or by selecting the dropdown list
arrow to the right - and select the corresponding C language TDP for your machine. Click Apply once the new
TDP is selected.

6. Back in the Project Browser, select the node for the file UmtsCode.c and then follow steps 4 and 5 above.

7. Select the node for the file UmtsMsg.c in the Project Browser and then follow steps 4 and 5 above.

8. In the Configuration Settings window, click OK.

Note: Only the settings for these specific file nodes have been changed; all other file nodes continue
to use the default TDP settings.

Conclusion of Exercise 1

Have a look at the right side of your screen. This is the Project Explorer window, and within it two tabs are visible.

The first - the Project Browser tab - contains a reference to all group, application and test nodes created for the active
project. The project node, named BaseStation, contains an application node named BaseStation; the application node
contains a list of all of the source files required to build the UMTS base station application. (Though the project and

application nodes have the same name, this is not a requirement.)

The second tab - the Asset Browser tab - lets you browse all of your source and test files. If the selected Sort Method
is By File, you are presented with a file-by-file listing of test scripts, source code and source code dependents (such
as header files). Note how each header file can be expanded to display every class, function, and method declaration,
while each source file can be expanded to display every defined object and method or function. Double-clicking any
test script/source file/header file node will open its contents within the editor; double-clicking any class declaration
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or method definition node will open the relevant source file/header file to the very line of code at which the definition/
declaration occurs.

There are two other sort methods as well on the Asset Browser. The first, By Object, lets you filter down to classes
and methods, independent of the source files. The second, By Directory

You may have noticed along one of the toolbars at the top of the Ul that the TDP you selected in the New Project
Wizard is listed in a dropdown box. In fact, this is not a reference to the TDPR, it is a reference to the Configuration
whose base TDP was the one you selected in the wizard - in the case of this tutorial, it is a TDP supporting C++.
(Recall that the Configuration allowed you to select the TDP designed for use with C language files. Configurations are
initially named after their base TDP, but this name can be changed.) Should you have multiple configurations for the

same project, use this dropdown box to select the active Configuration for execution.

Finally, to the right of the Configuration dropdown list is the Build[> button. This button is used to build your
application for application nodes and the test harness for test nodes. The test harness consists of:

« source files needed to build the application of interest
- stubs

» atest driver

The Build Options~ button lets the user decide from which point the build process should initiate and what runtime
analysis features should be used. The runtime analysis features do not have to be used at the same time; this Build
Options window provides a quick and simple method for deselecting undesired runtime analysis features immediately
prior to execution of the build process.

Armed with this knowledge, proceed to Exercise Two.

Exercise 2

In this exercise you will:

« build and execute the UMTS base station application
- manually interact with the UMTS base station application

- view the runtime analysis reports derived from your interaction

Building and Executing the Application

When performing runtime analysis, your source code must be instrumented. Instrumentation, by default, is enabled
for all four runtime analysis features - that is, for memory profiling, performance profiling, code coverage analysis and
runtime tracing. All four features are turned on by default.

To build and execute the application:
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1. In order to instrument, compile, link, and execute the UMTS base station application in preparation for runtime
analysis, simply ensure the BaseStation application node is selected on the Project Browser tab of the Project
Explorer window, and then click the Buildl# button.

Note: More information about the source code insertion technology can be found in the User Guide, in the

chapter Product Overview->Source Code Insertion.

1. In the Output Window at the bottom of the screen, on the Build tab, you can watch the preprocessing,
instrumentation, compilation, and link phases of the build process as they occur. A double-click on an error
listed within any of the Output Window tabs opens the relevant source code file to the appropriate line in the
Editor.

2. The build process has completed, and the UMTS base station is running, when the UML-based sequence
diagram generated by the runtime tracing feature appears. (More about this feature in a moment.)

3. Close the Project Explorer window on the right-hand side of the Ul by clicking the Close Window 2 button.

Note how the graphically displayed data in the Runtime Trace viewer dynamically grows - this is because the UMTS
base station is being actively monitored. The UMTS base station endlessly searches for mobile phones requesting
registration; the Runtime Trace viewer reflects this endless loop. If you wish, use the Pause button on the toolbar

to stop the dynamic trace for a moment (the trace is still being recorded, just no longer displayed in real time). In
addition, use the Zoom In@ and Zoom Outefh buttons on the toolbar to get a better view of the graphical display (or
right-click-hold within the Runtime Trace viewer and select the Zoom In or Zoom Out options). Undo the Pause when

you're ready to proceed.

You'll look at the Runtime Trace viewer in more detail later. Of primary importance right now is interaction with the
UMTS base station. You'll do this by using the mobile phone simulator mentioned earlier in the Overview section of
this tutorial. Through this manual interaction you will expose memory leaks, performance bottlenecks, incomplete

code coverage, and dynamic runtime sequencing.

Interacting with the Application

To run the application:

1. Start the mobile phone by running the provided mobile phone executable built for your operating system.
The mobile phone executable is located within the Test Embedded installation folder in the folder \examples

\BaseStation_C\MobilePhone\. The name of the executable depends on your operating system:
2. > Windows: MobilePhone.exe

o Linux: MobilePhone.Linux

(A launcher shell script - MobilePhone.sh - is provided for the non-Windows platforms as well.)
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1. Click the mobile phone's On button ().

2. Wait for the mobile phone to connect to the UMTS base station (if you watched the Runtime Trace viewer
closely, you would have noticed a display of all the internal method calls of the UMTS base station that occur
when a phone attempts to register). The current system time should appear in the mobile phone window when
connection has been established.

3. Once connected, dial the phone number 5550000, then press the button to send this number to the
UMTS base station (again, try to see the Runtime Trace viewer update).

4. Unfortunately, the party you are dialing is on the line so you'll find the phone is busy. Shut off the simulator by
closing the mobile phone window via the | button in its upper right corner.

The UMTS base station is designed to shut off when a registered phone goes off line. Not a great idea for the real
world, but it serves the Tutorial's purposes well. Alternatively, you could have just used the Stop Buildd button

located next to the Build button on the toolbar.

The UMTS base station has stopped running when the green execution light next to the execution timer - located

, , ' ' ' - ‘|
beneath the Project Explorer window on the lower right-hand side of the Ul - stops flashing (I Wk <Lk = 1 ).

Wait for it to stop flashing.

Everything that occurred at the code level in the UMTS base station was monitored by all four runtime analysis
features. Once the UMTS base station stopped (i.e. once the instrumented application stopped), all runtime analysis
information was written to user accessible reports that are directly linked to the UMTS base station source code. In
order to look at these reports:

1. Reopen the Project Explorer window by selecting the menu item View->Other Windows->Project Window

2. In the Project Explorer window, on the Project Browser tab, double-click the BaseStation application node. All
four runtime analysis reports will open. (Alternatively, right-click the BaseStation application node and select
View Report->All.)

3. Close the Project Explorer window and the Output Window (at the bottom of the Ul) to create room for the
now-opened reports. You may also want to resize the left-hand window to gain additional room.

Understanding Runtime Tracing

To view the UML sequence diagram report:

1. Select the Runtime Tracing Viewer tab.

2. As you recall, the Runtime Trace viewer displayed all objects and all method calls involved in the execution of
the UMTS base station code. Using the toolbar Zoom Outefh button, zoom out from the tracing diagram until
you can see at least five vertical bars.

3. Make sure you are looking at the top of the runtime tracing diagram using the slider bar on the right.
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What you are looking at is a sequence diagram of all events that occurred during the execution of your code. This
sequence diagram uses a notation taken from the Unified Modeling Language, thus it can be correctly referred to as a
UML-based sequence diagram.

The vertical lines are referred to as lifelines. Each lifeline represents either a C source file or a C++ object instance.
The very first lifeline, represented by a stick figure, is considered the "world" - that is, the operating system. In this
UMTS base station tracing diagram, the next lifeline to the right represents an object instance named Obj0, derived

from the UmtsServer class.

Green lines are constructor calls, black lines are method calls, red lines are method returns, and blue lines are
destructor calls. Hover the mouse over any method call to see the full text. Notice how every call and call return is

time stamped.

Everything in the Runtime Trace viewer is hyperlinked to the monitored source code. For example, if you click on

the Obj0::UmtsServer lifeline, the header file in which the UmtsServer class declaration appears is opened for you,
the relevant section highlighted. (Close the source file by right-clicking the tab of the Text Editor and selecting
Close.) All function calls can be left-clicked as well in order to view the source code. Look at the very top of the
Obj0::UmtsServer lifeline. It's "birth" appears to consist of a List() constructor first, then a UmtsServer() constructor.
Why a call to the List() constructor if the object is an instance of the UmtsServer class? Click on the UmtsServer()
lifeline again - see how the UmtsServer() constructor inherits from the List() class? This is why the List() constructor
is called first. Click the two constructor calls if you wish to pursue this matter further.

Notice how the window on the left-hand side of the user interface - called the Report Window - contains a reference to
all classes and class instances. Double-clicking any object referenced in this window will jump you to its birth in the

Runtime Trace viewer. This window can also be used to filter the runtime tracing diagram.

1. In the left-hand window, close the node labeled NETWORKNODE.H - notice how all objects derived from the
NetworkNode class declared in this header file are reduced to a single lifeline.
2. Reopen the node labeled NETWORKNODE.H.

You've probably noticed the vertical graph with the green bar to the left of the Runtime Trace viewer. This is the
Coverage Bar. It highlights, in synchronization with the trace diagram, the percentage of total code coverage achieved
during execution of the monitored application. The Coverage Bar's caption states the percentage of code coverage
achieved by the particular interaction presently displayed in the Runtime Trace viewer. Scroll down the trace diagram;
note how code coverage gradually increases until a steady state is achieved. This steady state is achieved following
the moment at which the mobile phone has connected to the UMTS base station. Dialing the phone number increases
code coverage a bit; shutting off the phone creates a last burst of code coverage up until the moment the UMTS base
station is shut off. Can you locate where, on the trace diagram, the mobile phone simulator first connected to the
UMTS base station? (The Coverage Bar can be toggled on and off using the right-click-hold menu within the Runtime
Trace viewer.)

Note If the C++ code in the UMTS base station spawned multiple threads, the Coverage Bar would be joined by
the Thread Bar, a vertical graph highlighting the active thread at any given moment within the trace diagram. A
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double-click on this bar would open a threading window, detailing thread state changes throughout your application's

execution.

Continue to look around the trace diagram. Can you locate the repetitive loop in which the UMTS base station looks
for attempted mobile phone registration (it always starts with a call to the C function tcpsck_data_ready)? You can
filter out this loop using a couple of methods. One is to simply hover the mouse over a method or function call you

wish to filter, right-click-hold and select Filter Message. An alternative method would be to build your own filter. You
will do both.

1. Hover the mouse over any call of thetcpsck_data_readyfunction, right-click-hold and selectFilter Message- the
function call should disappear from the entire trace.

2. Select the menu item Runtime Trace->Filters (you'll see the filter you just performed listed here)

Click the Import button, browse to the installation folder and then the folder \examples\BaseStation_C, and
then Open the filter file filters.tft

3. Check that BaseStation Phone Search Filter is selected. Select it if necessary.
4. Click the OK button.

The loop has been removed.

The runtime tracing feature can capture standard function/method calls, but it can also capture thrown

exceptions.View the very bottom of the runtime tracing diagram using the slider bar.

Do you see the icon for the catch statement - (you may have to drag the slider bar slightly upward;
closing the NETWORKNODE.H node in the left-hand report window will also make things easier to see)? This Catch
Exception statement is preceded by a diagonal Throw Exception. Why diagonal? Because when the exception was
thrown, prior to executing the Catch statement, the LostConnection constructor and UmtsMsg destructor were called.
Click various elements to view the source code involved in the thrown exception and thus decipher the sequence of

events.

This exception occurred by design, but it is clear how the runtime tracing feature, through the power of UML, would be
extremely useful if you have:

- inherited old or foreign code
« unexpected exceptions

- questions about whether what you designed is occurring in practice

And you are guaranteed the identical functionality for application execution on an embedded target.

Understanding Memory Profiling

The Memory Profile viewer displays a record of improper memory usage within the application of interest.

To read the Memory Profiling report:
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- Select the Memory Profile tab.

First, block and byte memory use is summarized for you in a bar chart, immediately followed by a textual

description to the same information. What you have is a record of:
o total number of blocks/bytes allocated for the entire run
o total number of non-freed blocks/bytes allocated for the entire run
o total number of blocks/bytes in use at any one time

If any memory errors were detected, or if any warnings are warranted, those comments are listed next. The
Report Window on the left hand side of the screen gives you a quick look at the contents of the report - your
manual interaction with the UMTS base station via the simulated mobile phone has resulted in the creation of
(BaseStation)<timestamp>. If you click an item in the Report Window, the memory profiling report will scroll to

the proper location.

« On the Report Window, left-click the ABWL error.

Apparently, the memory profiling feature has detected a Late Detect Array Bounds Write (ABWL) - in other words, the
UMTS base station code attempted to add data to an array element that does not exist. This error report is followed
by the call stack, with the last function in the call stack listed first. Notice how each function is highlighted; clicking
on the functions in the call stack will jump you to the relevant source code. Each source code file is highlighted at the
line in which memory was requested - in this particular case, some part of the UMTS base station code overwrote an

array, thereby causing the ABWL error.

The ABWL is followed by one File In Use (FIU) and four Memory Leak (MLK) warnings. The File In Use warning
references <internal use> - in other words, the file is being used by the memory profiling feature. As for the memory
leaks - well it looks like you have some work to do here. Although it is conceivable the memory leak occurs by design
(e.g. perhaps some clean-up code has not yet been written), assuredly the UMTS base station is not meant to have

any.

Finally, the exit code is printed - look for the informational/warning note in the viewer starting with the words Program

exit code. The memory profile report lists the exit code as a warning if it is of any value other than 0.

Notice how easily this information has been acquired; no work was required on your part. A real advantage is that
memory leak detection can now be part of your regression test suite. Traditionally, if embedded developers looked for
memory leaks at all, it was done while using a debugger - a process that does not lend itself to automation and thus
repeatability. The memory profiling feature lets you automate memory leak detection.

And again, the identical functionality can be used on either your host platform or on your embedded target.

Understanding Performance Profiling

The Performance Profile viewer displays the execution time for all functions or methods executing within the

application of interest, thereby allowing the user to uncover potential bottlenecks. First, the three functions or
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methods requiring the most amount of time are displayed graphically in a pie chart (up to six functions will be
displayed if each is individually responsible for more than 5% of total execution time). This is then followed by a
sortable list of every function or method, with timing measurements displayed.

To read the Performance Profiling report:

» Select the Performance Profiletab.

Notice how the function tcpsck_data_ready was responsible for around 45% to 50% of the time spent
processing information in the UMTS base station. By looking at the table, where times are listed in
microseconds, we can see that this function's average execution time was between 1 to 2 seconds (it will
vary somewhat based on your machine) and that it has no descendents - i.e. it never calls and then awaits the
return of other functions or methods (which explains why the Function time matches the F+D time). Is this to
be expected? If you wished, you could click on the function name in the table to jump to that function to see if

its execution time can be reduced.

Each column can be used to sort the table - simply click on the column heading.

* Click the column heading entitled F+D Time

It is probably no surprise that the main() procedure - combined with its descendents - takes the longest time to
execute overall. Notice, though, that the main() procedure itself only takes around 300us (depending on the operating
system) to execute - so there doesn't appear to be any bottleneck here. The main() procedure spends its life waiting
for the UMTS base station to exit.

As with the memory profiling feature, notice how easy it was to gather this information. Performance profiling can
now also be part of your regression test suite. And again, as with every other runtime analysis feature, performance
profiling functionality is identical whether it is used on your host platform or on your embedded target.

Understanding Code Coverage

And finally, here you have the code coverage analysis report. The code coverage feature exposes the code coverage

achieved either through manual interaction with the application of interest or via automated testing.

To view the Code Coverage report:
1. Select the Code Coverage tab.

On the left hand side of the screen, in the Report Window, you see a reference to Root and then to all of the source
and header files of the UMTS base station. Root is a global reference - that is, to overall coverage. For each individual
source and header file, a small icon to the left indicates the level of coverage (green means covered, red means not
covered).

In the Code Coverage viewer, on the Source tab, a graphical summary of total coverage is presented in a bar chart
- that is, information related to Root. Five levels of code coverage are accessible when the source code is C++,
and those five levels are represented here. (Four more levels of coverage are accessible when working with the
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C language - up to and including Multiple Conditions/Modified Conditions. These levels are required by stringent

certification standards such as aviation's DO-178B/C.) Notice how, on the toolbar, there is a reference to these five

possible coverage levels (|_F|? [ F|_||_L ).

1. Deselect Loops Code Coverage (| L)

2. Reselect Loops Code Coverage (| L)
3. In the Report Window to the left, select the PhoneNumber.cpp node.

Note: The Source tab now displays the source code located in the file PhoneNumber.cpp. This code is
colored to reflect the level of coverage achieved. Green means the code was covered, red means the
code was not covered.

4. In the Report Window, expand the PhoneNumber.cpp node and then select the void

PhoneNumber::clearNumber() child node

Note: The clearNumber() function should now be visible on the Source tab. Notice how its for
instruction is colored orange and sitting on a dotted underline. This is because the for statement was
only partially covered.

5. Click on the orange for keyword in the clearNumber() function

Note: As you can see, the for loop was only executed multiple times, not once or zero times. Why
should you care? Well some certification agencies require that all three cases be covered for a for
statement to be considered covered. If you don't care about this level of coverage, just deselect Loops
Code Coverage.

6. On the toolbar, deselect Loops Code Coverage (| L).

Note: Now the for loop is green. If you would like to add a comment to your code indicating how this
loop is not covered by typical use of the mobile phone simulator, have a look at the code by right-

clicking the for statement and selecting Edit Source.
7. Select the Rates tab in the Code Coverage viewer.

Note: The Rates tab is used to display the various coverage levels for:
o the entire application

> each source file
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o individual functions/methods

8. Click various nodes in the Report Window in order to browse the Rates tab. Note how a selection of the Root
node gives you a summary of the entire application.

9. From the File menu, select Save Project.

Conclusion of Exercise 2

With virtually minimal effort, you have successfully instrumented your source code for all four runtime analysis
features. Manual interaction (in your case, via a mobile phone simulator) was monitored, and the subsequent runtime
analysis results were displayed for you graphically. Source code is immediately accessible from these reports, so
nothing prevents the developer from using the results to correct possible anomalies.

In addition, using the Test by Test option provided with each runtime analysis feature (introduced in the Further Work
section for code coverage), you can easily discern the effectiveness of a test, ensuring maximal reuse without waste.

Your next step is to use the runtime analysis results to remove memory leaks, improve performance, and increase
code coverage.

Exercise 3

In this exercise you will:
« Improve the UMTS base station code by eliminating memory leaks and by improving performance
* Increase code coverage

- Rerun the manual test to verify that the defects have been fixed

Using Memory Profiling to Remove Memory Leaks

By using the call stacks displayed in the Memory Profile viewer, you will deduce the corrections that need to be made

to eliminate memory errors.

To locate and fix memory errors:

1. Select the Memory Profile tab.
2. Select the ABWL error node in the Report Window on the left hand side of the screen.

Have a look at the call stack for the Late Detect Array Bounds Write error. Three C++ methods are listed.

3. Select the last function first, the one that occurs inside main().

Within the main() procedure a UmtsServer object is instantiated. Nothing looks out of sorts here, so return to

the call stack.
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. Close the source file for the main() procedure, and then click the second function from the bottom in the call

stack referenced by the ABWL error - the UmtsServer constructor.

The next function in the stack is the UmtsServer constructor. The line in the constructor that is flagged, the

creation of a NetworkNodes object, is a call to the List constructor. Continue to follow the sequence of events.

. Close the source file for the UmtsServerconstructor, and then click the top function in the call stack

referenced by the ABWL error - the List constructor.

The highlighted line is a call to malloc. A quick look at this function shows that a return to the UmtsServer
constructor is fairly quick, and nothing seems unusual. You should continue to track the string of events as

they happened to see if the ABWL error shows itself. Return to the UmtsServer constructor.
. Close the source file for the Listconstructor, and then click the second function from the bottom in the call

stack referenced by the ABWL error - the UmtsServer constructor.

What happens next? The NetworkNodes object was assigned 3 List objects in an array. Immediately following
the call to the List constructor, 4 elements are assigned to this array. Not good. The NetworkNodes object

should be an array of 4 List objects, not 3.
. In the source code, replace the following line with the line from the second block:
networkNodes = new List(3);
Replacement line:

networkNodes = new List(4);

8. From the File menu, select Save. The revised file UmtsServer.cpp is saved.

This should fix the ABWL error. Before redoing you manual test to verify if the memory error was fixed, move on to the

Performance Profile viewer and see if you can streamline the performance of the UMTS base station code.

You might have to fix the other memory warnings.

Using Performance Profiling to Improve Performance

Now you will use information in the Performance Profile viewer to determine if you can improve performance in the
UMTS base station code.

To locate and fix performance bottlenecks:

1. Select the Performance Profiletab.

2. Within the table, left-click the column title Avg F Time (Average Function Time) in order to sort the table by this

column. (You may want to scroll down the report a bit to view more data elements in the table.)

For this exercise you have sorted by the Average Function Time - that is, you're looking at functions that take,
on average, the longest time to execute. This isn't the only potential type of bottleneck in an application - for
example, perhaps it is the number of times one function calls its descendants that is the problem - but for this

exercise, you will look here first.
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As the developer of this UMTS base station, you would know that the C function tcpsck_data_ready() does
take a fair amount of time to execute - so you won't look here first (although feel free to have a look if you
wish). Instead look at a different function in the table.

3. Select the link for the C function checkUmtsNetworkConnection().
A quick look at the source code shows you that the developer treated this as a dummy function, inserting a
"time-waster" to make it appear as if the function were executing. Simply comment out the line.

4. Change the code from doSonest uff (1); to // doSomeStuff(1);

5. From the File menu, select Save.

This way, the checkUmtsNetworkConnection() method will do nothing at all. The next time you perform the
manual test, this C++ method should have an execution time of 0.

There is another UmtsServer class method that also needs to be improved.

Using Code Coverage Analysis to Improve Code Coverage

You will now use the information gathered by the code coverage analysis feature to modify the manual test in such a

way as to improve code coverage.

To improve coverage of your code:

1. Select the Code Coveragetab.

2. If necessary, select the Source tab of the Code Coverage viewer

3. In the Report Window on the left-hand side of the screen, open the UmtsConnection.cpp node and then select
the processMessages() child node

4. Drag the slider bar down slightly until you see the line:i f (strcnp(nsg- >phoneNunber, " 5550001") ==0) .

Notice how the if statement was never true - the else block is green, but the if block is red. In order to improve
coverage of this if statement, you need to make the boolean expression evaluate to true.

According to this code, the if expression would evaluate to true if mobile phone sends the phone number
5550001. You should do that.

You will now rerun the UMTS base station executable, restart the mobile phone simulator, and dial this new
phone number. When you have finished, you will check the memory profiling, performance profiling, and code
coverage analysis reports to see if you have improved matters.

Redoing the Manual Test

You have changed some source code, so some of the UMTS base station code will have to be rebuilt. These changes
are taken into account by the integrated build process of HCL DevOps Test Embedded (Test Embedded), so you do

not have to specify any updated files.
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To rebuild your application:

1. Select the menu item View->0Other Windows->Project Window.

2. From the Window menu, select Close All.

3. Select the Project Browser tab in the Project Explorer window that has now appeared on the right-hand side of

the UL

. Right-click the BaseStation application node and select Rebuild. When you select Rebuild, all files are rebuilt,

whereas Build simply rebuilds those files that have been changed. If no files had been changed, you could

have just selected Execute BaseStation.

. Once the UMTS base station is running (indicated by the appearance of the Runtime Trace viewer), run the

mobile phone simulator as before.

6. Click the mobile phone's On button ( ).

7. Wait for the mobile phone to connect to the UMTS base station (if you watch the dynamic trace closely, you'll

10.

11.

12.

notice a display of all the actions that occur when a phone registers with the server). The time should appear

in the mobile phone window.

~
ok
. Once connected, dial the phone number 5550001, then press the- button again to send this number to

the UMTS base station (again, watch the dynamic trace update).

. Success! You have connected to the intended party. Stop right here to see the results of your work. Close the

mobile phone window by clicking the %/ button on the right side of its window caption. As you may recall, this
action will shut down the UMTS base station as well.
The UMTS base station has stopped running when the green execution light next to the execution timer

- located beneath the Project Explorer window on the lower right-hand side of the Ul - stops flashing

ETE
(I UL g ‘|). Wait for it to stop flashing.

In the Project Explorer window, on the Project Browser tab, double-click the BaseStation application node. All
four runtime analysis reports will open with refreshed information. (Alternatively, right-click the BaseStation
node and select View Report->All.)

Close the Project Explorer window to the right and the Output Window at the bottom.

So have you improved your code and increased code coverage?

Verifying Success

Was the memory leak eliminated?

To check that the memory leak was fixed:

1.
2.
3.

Select the Memory Profile tab.

Maximize the window

In the Report Window on the left-hand side of the screen, look inside the node labeled
(BaseStation)<timestamp> - do you see the ABWL error anymore?
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You successfully eliminated the ABWL error. Have you improved performance?

To check that performance was improved:

1. Select the Performance Profile tab.
2. Select the menu option Performance Profile->Test by Test
3. In the Report Window on the left-hand side of the screen, left-click the node labeled Test #2

4. Sort the table by Avg F Time - do you see the function checkUmtsNetworkConnection()?

You successfully improved performance. Was code coverage improved?

To check that code coverage was improved:

1. Select the Code Coverage tab.

2. In the Report Window on the left-hand side of the screen, open the node for UmtsConnection.cpp and then
left-click the method processMessages|()

3. Scroll down until you can see the if statement for which you have attempted to force an evaluation of true - did
you? Has code coverage been improved?

You successfully improved code coverage. Note, by the way, that you can discern what this second manual
interaction has gained you in terms of code coverage.

1. Select the menu option Code Coverage->Test by Test
2. In the Report Window on the left-hand side of the screen, reselect the method processMessages()
3. With your mouse anywhere within the Source tab of the Code Coverage viewer, right-click and select CrossRef

4. Scroll the Code Coverage viewer to expose the line of code that has been newly covered and then left-click it:
strcpy(response.command,cmd_accepted);
Notice that only Test #2 is mentioned. However, what tests are listed for the if statement itself?

1. Left-click the line i f (st rcnmp(msg- >phoneNunber, " 5550001" ) ==0) .

Both Test #1and Test #2are listed. As further proof, follow these steps:

1. With your mouse anywhere on the Source tab of the Code Coverage viewer, right-click and deselect Cross
Reference

2. In the Report Window, on the left-hand side of the screen, open the Tests node and deselect the checkbox next
to Test #2.

Since you have deselected Test #2, all you are left with is the code coverage that has resulted from running Test #1,

and Test #1 never forced the if statement to evaluate to true. Thus the newly covered code has become red again - in
other words, unevaluated.
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Conclusion of Exercise 3

After correcting the UMTS base station code directly in the Text Editor, you simply rebuilt your application and used
the mobile phone simulator to initiate further interaction. A second look at the runtime analysis reports validated the
accuracy of your changes. Consider the speed with which you could perform these monitoring activities once you are

familiar with the user interface...

Conclusion - with a Word about Process

Automated memory profiling, performance profiling, runtime tracing, and code coverage analysis - no less important
in the embedded world than elsewhere in software. So why is it done less often? Why is it so much harder to find
solutions for the embedded market? It is because embedded software development involves special restrictions that
make these functions more difficult to achieve, particularly when speaking of target-based execution:

« strong real-time timing constraints

« low memory footprints

» multiple RTOS/chip vendors

- limited host-target connectivity

- complicated test harness creation for target-hosted execution

« etc.

Test Embedded has been built expressly with the embedded developer in mind, so all of the above complications
have been overcome. Nothing stands between you and the use of a full complement of runtime analysis features in
both your native and target environment.

So use them! It should be automatic - part of all your Regression testing on page 112 efforts (discussed in
greater detail in the Tutorial conclusion). As you have seen, these functions are only a mouse-click away so there is

absolutely no drain on your time.

You may be concerned about the instrumentation - "But | don't want my final product to be an instrumented

application. Doesn't it have to be if I'm testing instrumented code?" No, it does not have to be:

1. Using the code coverage feature, generate a series of tests that cover 100% of your code

2. Instrument that code for full runtime analysis

3. Uncover and address all reliability errors as you test (e.g. memory leaks, overly slow functions, improper
function flow, untested code)

4. Now uninstrument your code - that is, simply shut off all runtime analysis features and rebuild your application

5. Run your regression suite of tests once more, this time looking only for functional errors

6. No errors? Time to ship
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Make it part of your development process, just another step before you check in code for the night. Test Embedded

simplifies runtime analysis to such an extent that there is no longer a reason not to do it.

You can proceed to the next lesson: Automated Component Testing on page 112.

Testing C and C++ applications

You have just completed a variety of what are, in essence, reliability tests on the UMTS base station. In other words,
you have verified the absence of memory leaks, the optimization of performance, the sensibility of process flow, and

the completeness of your testing.

But does the base station code do what it is designed to do? And wouldn't it be useful to create automated tests

rather than rely solely on manual interaction?

Runtime analysis completes the picture, but functional testing of your code gets to the heart of the matter - that
is, will your application generate the results it was designed to achieve. Test Embedded provides you with three

automated testing features to address your testing needs.

- Component Testing for C: For use with C functions and Ada functions and procedures.
« Component Testing for C++: For use with C++ classes.

- System Testing for C: For use with C threads, tasks, processes, and nodes.

You'll start with a look at the component testing feature for C and Ada.

Regression testing

Regression testing involves the reuse of all tests to ensure your software experiences no regression - in other words,
to ensure that the repair of one defect doesn't break some other feature that worked in the past. Frankly, software
testing would be much simpler if nothing ever broke once it worked properly. Even manual testing efforts would be
acceptable for some since the effort would only be focused on "new" code - a lot of testing at the beginning, but

decreased testing as the development cycle matures and no new features are added into the project.

But things do break and manual testing is far from an achievable goal. Software is just too complicated and too

interdependent to succeed without automated assistance.

With Test Embedded, you can create full regression tests that are comprised of all the testing and runtime analysis
nodes created throughout your testing effort. It's as simple as creating a Group node and then copying and pasting
your test and analysis nodes within it. Run the Group node as you would any other; every test and analysis node
would (optionally) build and execute. When the Group execution has finished, a double-click on the Group node opens
consolidated reports that let you easily determine where errors have been detected.

With regression testing you close the loop. Code might break, but it will never find its way into the finished product.
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Component Testing for C

When speaking of C programs, the term "component testing" - also sometimes referred to as "unit testing” - applies
to the testing of functions. A function is passed a possible set of inputs, and the output for each set is validated to
ensure accuracy. This can be done with either a single function, a group of unrelated functions, or with a sequential
group of functions - i.e. one function calling another, verifying the overall or integrated, result.

Sounds simple but, unfortunately, in the embedded world its practice can be quite difficult. Why?

» What if the function you wish to test relies on the existence of other functions that have not yet been coded?
« How will you call the function-under-test in the first place?

- How will you create and maintain a variety of potential inputs and associated outputs - that is, how will you

make data-driven testing manageable?

- What kind of effort and knowledge is required to run the test on your target architecture - that is, in the

intended, native environment?

The component testing feature for the C language provides a means for automating and verifying the above

concerns. Through source code analysis:

« Yet-to-be coded functions and procedures are "stubbed"; in other words, these functions are created for you
- A test driver is generated to facilitate communication between your running code and the test

« A test harness, independent of your test, is constructed to ensure adoption of your target architecture and

thus enabling in-situ test execution
Plus, thanks to a powerful test script API:

« Define stub responses to varied input generated by the function(s) under test

« Enable highly detailed data definitions for data-driven testing

With the assistance of the Target Deployment technology, the end result is an extensible, flexible, automated testing

tool for component and integration testing.

Exercise 1

In this exercise you will create a new project in which the UMTS base station source code will be referenced.

See Preparing for the tutorial on page 88 for details about the application you will be using in this tutorial.

113



114

HCL DevOps Test Embedded

Using Code Coverage to Find Untested Code

During the code coverage review, you surely noticed a fair amount of untested code. For this tutorial, you will focus on

one particular section.

To select a particular section of code:

1. First, select the menu item File->Save Project
2. If necessary, select the Code Coverage tab.
3. In the Report Window on the left-hand side of the screen, open the UmtsCode.c node and then left-click the

code_int() function

This function contains two partially covered while statements - focus on the second while statement (you may need
to scroll down a bit):

while (x!=0)

A left-click on the whilestatement shows you that of the three possible types of coverage, only one type was achieved
- 2 or more loops. You should really create one or more tests to appropriately cover this whilestatement - but first,
perhaps you should spend a little more time understanding what the code_intfunction does.

Code Review
It doesn't make much sense to test a function without understanding it first.

To locate the source code, right-click-hold the mouse over the while statement you have just inspected and select Edit

Source.

The objective of the code_int function is to place a given integer at the end of a buffer with the following format:
I[Iength of nunber][lowest order digit]....[highest order digit]

Thus the number 1234 would be stored at the end of the buffer as 144321.

Once ready, proceed to the next step in which you will build your test.

Adding a new Configuration to your project

Since you will be testing a C function, you should use a Target Deployment Port for the C language. Rather than
modifying the existing Configuration, you will now create a new one whose base TDP is a TDP for the C language.

To add a new configuration to a project:
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. Select the menu item Project->Configuration.

Note: In the Configurations window that has just appeared, the existence of the Configuration you
have been working with up to now.

2. Click the New... button.
3. In the dropdown list of the NewConfiguration window, choose either C Visual 6.0 if you have Microsoft Visual

C++ 6.0 installed, or, if you are using GNU/native compilers, select the item appropriate for your operating
system:

> Windows - C Gnu 2.95.3-5 (mingw)

o Linux - C Linux - Gnu 2.95.2

Do not be concerned if the version of the GNU compiler you have installed does not match the version
mentioned for the TDP. The differences are not relevant for this tutorial and thus other versions are

supported equally as well.

. Click the OK button to close the New Configurations window.

5. Click the Close button to close the Configurations window.

6. In the toolbar dropdown list that mentions the current Configuration - named after the C++ TDP you selected

at the beginning of the tutorial - select the new Configuration, based on the C TDP you just added to the
project.

Note: If you're using the Microsoft Visual C/C++ TDPs, the configuration is the following one:

[ cvisualB0 ~1|

Now the C language TDP will be used by any new node generated via the Activity Wizard.

Creating a Component Test for C

Using the Component Testing Wizard, you will now create a test for all functions in the file UmtsCode.c - including the

code_int function that contains the while statement for which you wish to improve coverage.

To create a component test:

o U~ WN =

. If the Project Explorer window is not visible, from the View menu, select Other Windows and Project Window.
. From the Window menu, select Close All.

. Click the toolbar Start_®] button to relaunch the Start Page.

. Select the Activities link on the left-hand side of the Start Page.

. Select the Component Testing link that has now appeared.

. In the Application Files window, notice how all the C source files of your development project are already

visible.

. Select the Compute static metrics option. This allows the measurement of code complexity from which you

can prioritize your test campaign.
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8. Click the Next button.

In the Components Under Test window, you are asked to specify which functions you would like to test.
There are multiple methods to do it. One method consists in using the static metrics that have just been
automatically calculated. Certain measurements of code complexity are listed for you:

> V(g) - Also called the Cyclomatic Number, it is a measure of the complexity of a function that is
correlated with difficulty in testing. The standard value is between 1 and 10. A value of 1 means the
code has no branching. A function's cyclomatic complexity should not exceed 10

o Statements - Total number of statements in a function.
o Nested Level - Statement nesting level.

Sorting by any of these metrics columns - by left-clicking a column header - lets you prioritize your test
selection, choosing the more complicated functions first.

Additional metric information can be viewed by selecting the Metrics Diagram button on the lower right-hand
side of the screen. Selection of this button opens a graph enabling visualization of two, selected static metrics
graphed against one another. Select a data point in this graph to indicate your desire to test the associated

functions.

For this Tutorial, your test selection is based on the desire to increase code coverage, so the static metrics

do not affect your decision. You need to test the code_int function. However, to help you get a better
understanding of how the component testing feature of Test Embedded works, you should select all functions
in the file UmtsCode.c.

9. Left-click the box to the left of every function in the source file UmtsCode.c (there are five functions in total).

11.

12.

. Click the Next button.

In the Test Script Generation Settings window, you are asked to make two decisions:
- If you've selected more than one function to test, do you want all functions to be part of the same
test script (Single Mode) or do you want each function to be assigned to its own test script (Multiple
Mode). A single test script would be easier to manage, but multiple test scripts let you provide custom
Configuration settings to each test.

> Do you want Test Embedded to make some basic assumptions about test harness and test stub
generation? If so, use Typical Mode; if not, use Expert Mode.

Type UmtsCode in the Test Name field - that is, name the test node after the source file whose functions you
will be testing. Leave the default selections. You will be creating a single test script that automatically stubs
all referenced but undefined functions. Click the Next button.

You should now be viewing the Summary window.

Click the Next button.
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The Component Testing Wizard now analyzes the source code in UmtsCode.c and creates a test for every

function within it.When test script generation has completed,

13. Click the Finish button.

In the Project Browser tab of the Project Explorer window on the right-hand side of the screen, you should now see a

component test node named UmtsCode.

Conclusion of Exercise 1

Use of the C++ component testing feature should have been a lot easier for you, considering your experience with test
creation for C and Ada. Not much is different - and that's by design. All you need to do now is specify the exact test

and assertion checks you would like to perform, and then execute the test. You will do that next.

Exercise 2

In this exercise you will:

« build and execute the UMTS base station application
» manually interact with the UMTS base station application

« view the runtime analysis reports derived from your interaction

The Autogenerated C++ Component Test

Once you become familiar with the layout of the auto generated test and contract check, the modifications you need

to make to increase code coverage will become obvious.

To complete the test script:

1. In the Project Browser tab on the right-hand side of the screen, double-click the node PhoneNumber.otd.

2. Maximize the test script editor.

This is the test driver script. In it you will perform those steps necessary to drive and test classes in the file

under test.

Along with the .otc contract-checking test - discussed in the next section - full C++ class testing is possible.
The idea is that the files PhoneNumber.cpp, PhoneNumber.otd, and PhoneNumber.otc will be compiled
and executed together (with execution taking place on the target specified by the currently selected Target

Deployment Port Configuration).

C++ component testing test scripts are written with a compiler-independent test script API. For detailed
information about the script layout, see the Reference section in the online help. For the Tutorial, only critical

script elements will be discussed.
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Each class used in the file under test is assigned its own TEST CLASS block - PhoneNumber.cpp only handles
the PhoneNumber class, so there is only one Test Class block. Each TEST CLASS block is divided into a
single PROLOGUE, one or more TEST CASE blocks, and then a single EPILOGUE.

The PROLOGUE statement defines native code that is to be executed whenever the surrounding TEST CLASS
execution begins. You typically use the PROLOGUE statement to declare and sometimes initialize the object
instances of a class under test. In this exercise, the generated PROLOGUE creates an instance of the class
PhoneNumber. The EPILOGUE structure defines native code that is to be executed whenever the execution of
the surrounding TEST CLASS ends.

The TEST CASE block generates a public method test of the class under test. The test case name is made up

of the identifier of the method under test with the prefix test. This ensures correct overload handling.

A typical test starts with the display of a trace (with the PRINT statement) and continues with the C++ native
code that calls the method under test. This call is performed on the instance declared in the PROLOGUE
block. Any parameter values are null. If the method under test returns a value, the test case continues with a
CHECK statement. The test case ends with another trace display.

For this tutorial, we would like to call the PhoneNumber constructor with an integer value of 0. Since your goal
is to simply increase code coverage, don't bother testing anything - just call the PhoneNumber constructor

with a value of 0.

3. In the PROLOGUE block, add (0) after the obj0 identifier, so that it appears as follows:

PROLOGUE

{

// Declarations of variables needed by this test class.
// Actions to be performed before executing this test
// class.

#PhoneNumber objo (0) ;

}

The # symbol indicates that the line contains native C++ code.

4. From the File menu, select Save

Technically, you are finished. When this test script is executed, the PhoneNumber constructor will be called with an
integer value of 0. However, to give you some idea of how an assertion test would be useful, the next topic will take a

look at the contract checking script.

A Customized Component Test

A customized component test script has been created for you. This test will be used to test the functions within

UmtsCode.c - in particular, the function code_int, which contains the while statement of interest.

To customize the test:
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1. Select the menu item Window->Close All

2. Select the Project Browser tab on the right-hand side of the screen, select the UmtsCode.ptu node (child of
the UmtsCode component testing node), and then select the menu item Edit->Delete.

3. Right-click the UmtsCode component testing node and select Add Child->Files...

4. In the Files of Type dropdown box, select the C and Ada Test Scripts option, then browse to the Test
Embeddedinstallation folder and Open the file \examples\BaseStation_C\tests\UmtsCode2.ptu

5. After this new test script is analyzed, your screen should appear as follows:
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1. Double-click the node UmtsCode2.ptu
2. Maximize the test script window.

3. Bring the code_int test blocks for UmtsCode2.ptu into view using the Asset Browser tab. (The Asset Browser

tab continues to reference the original test script - UmtsCode.ptu - because it still exists on your machine - it is

simply no longer referenced by any tests.)

4. As you can see, two Test blocks are now part of the code_int Service block. In the first Test block the
initial value of x has been set to 3 and the expected value for buffer has been set to 113. In the second Test
block, the initial value of x has been set to 34 and the expected value for buffer has been set to 1243. These

expected values should make sense based on the function review you performed back in Exercise One.

Running a Component Test for C

Running a component test is as simple as it was to build and execute the UMTS base station used in the runtime

analysis exercises.

To execute the test:

1. From the File menu, select Save Project.

2. From the Window menu, select Close All

3. On the Project Browser tab, select the UmtsCode component testing node (the parent node of the
UmtsCode2.ptu and UmtsCode.c nodes) and then press the Build(> toolbar button.

4. The test is executed as part of the build process - you will know the test has finished executing when the

green execution light on the lower-right of the Ul stops flashing.

You may have forgotten that the runtime analysis tools are still selected in the Build options; the file under test

- UmtsCode.c - was instrumented for the memory profiling, performance profiling, code coverage analysis and

runtime tracing features of Test Embedded which explains why the Runtime Trace viewer appears during the
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run. Notice how this feature tracked all of the calls made to functions in UmtsCode.c. Each call is a test in the

component testing test script that just executed.

5. In the Project Browser tab on the right-hand side of the screen, double-click the UmtsCode component testing

node in order to open the test report and all of the runtime analysis reports.

What is the result of your tests? Did you improve coverage on the while statement? That is the subject of the next

exercise.

Conclusion of Exercise 2

With virtually minimal effort, you have successfully instrumented your source code for all four runtime analysis
features. Manual interaction (in your case, via a mobile phone simulator) was monitored, and the subsequent runtime
analysis results were displayed for you graphically. Source code is immediately accessible from these reports, so

nothing prevents the developer from using the results to correct possible anomalies.

In addition, using the Test by Test option provided with each runtime analysis feature (introduced in the Further Work

section for code coverage), you can easily discern the effectiveness of a test, ensuring maximal reuse without waste.

Your next step is to use the runtime analysis results to remove memory leaks, improve performance, and increase

code coverage.

Exercise 3

In this exercise you will:

« Improve the UMTS base station code by eliminating memory leaks and by improving performance
« Increase code coverage

« Rerun the manual test to verify that the defects have been fixed

The C Component Test Report

The component testing report summarizes all of the test results. It is hyperlinked to the test script (the .ptu file) and

can be browsed using the Report Browser on the left-hand side of the screen..

1. Close the Project Explorer window on the right-hand side of the screen as well as the Output Window at the
bottom of the screen to free up space.

2. Select the Test Report tab to ensure the component testing report is active, and then maximize this window.
At the top of the report is an overall summary of test execution. Notice the Passed and Failed items - all eight
tests in UmtsCode2.ptu passed. Good news.

3. In the Report Window on the left-hand side of the screen, double-click the node Test 1 (a child node of the
node CODE_INT:
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=- B CODE_INT

E| * Test 1
: -- £ Element]
! % Test Coverage
El e Test 2

In the component testing report, you can see:

- General test information
« Initial, expected, and obtained values for all variables involved in a test

« Code coverage information

Your next concern should be whether code coverage on the while statement in the code_int function has been
improved.

Checking the Code Coverage Report

Has code coverage been improved by running the unit test?

To analyze code coverage:

1. Select the Code Coverage tab.

2. In the Report Window on the left-hand side of the screen, open the UmtsCode.c node and then select the
code_int node.

3. If necessary, scroll through the Code Coverage viewer Source window until the second while statement is
visible.

4. Left-click this second while statement. You should see:

LI P | Y

loop branches :
O loop
1 loop
2 loops or mare

{
*ptr
K=
ptr+
len++

Code coverage has been improved, but the while statement has yet to be executed 0 times. To do this, you will
have to create a new test. It would be preferable to do as little work as possible to create this new test. What
other tests have forced the while statement to execute?

5. Select the menu item Coverage->Test by Test.
6. With the mouse anywhere within the Source window of the Code Coverage viewer, right-click-hold and select
CrossRef.
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7. Click any part of the line: whil e (x!=0)

The two code_int tests might have covered this while statement. All you need to do is copy one of the two
tests but make sure x equals 0 (i.e. when x is equal to 0, you will be achieving the highest level of coverage on

this while statement).

Updating and Running the Component Test

Through reuse of existing test assets, your testing effort can be significantly reduced.

To reuse test elements:

1. Select the Test Report tab.
2. In the Report Window on the left-hand side of the screen, double-click the node Test 2, which is a child node of

the node CODE_INT:

=8 afj drmtzCodez
- E]CODE_INT

=+ Test1
S & Element
4% Test Coverage

£ Elemnent
b A T ot Crwsrans

3. On the Test Report tab, left-click the green section header 1.2.3 -Test 2, located at the top of the screen.

You are now looking at the code for the second of the two code_int tests. Since the objective is to execute the
while statement where x has a value of 0, reuse this second test block but assign x an initial value of 0 and
buffer an expected value of - what? A value of 110.

4. In the Text Editor, copy all of the lines between Test 2 and End Test -- Test 2, including these two lines:

TEST 2

FAMILY nominal

ELEMENT

VAR x, init = 34 ev = 1init

VAR buffer, 1init = "", ev = "I243"

#code_int(x,buffer);
END ELEMENT
END TEST -- TEST 2

5. Paste these lines immediately below the last line copied, and then rename the Test block to Test 3. It should

look like the following:

END TEST -- TEST 2

TEST 3

FAMILY nominal

ELEMENT

VAR x, init = 34 ev = 1init

VAR buffer, dinit = "", ev = "I243"
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#code_int(x,buffer);
END ELEMENT
END TEST -- TEST 3

6. Change the initial value of x to 0 and change the expected value of buffer to 110.

TEST 3

FAMILY nominal

ELEMENT

VAR x, init = 0 ev = init

VAR buffer, dinit = "", ev = "I10"

#code_int(x,buffer);
END ELEMENT
END TEST -- TEST 3
7. From the File menu, select Save to save your changes to the Unit Testing test script.
8. From the View window, select Other Windows and Project Window.
9. From the Window menu, select Close All.
10. In the Project Browser tab on the right-hand side of the screen, left-click the UmtsCode component testing
node and then click the Buildl> toolbar button.

11. The test run is complete when the green execution light on the lower right of the Ul stops flashing.

You should have now achieved proper code coverage. But were you looking at the Output Window? Why was there a
warning?

Repairing a Defect

The runtime tracing feature has uncovered what looks to be an unhandled case - that is, handling a phone number of
0 length. The code must be fixed.

To fix the defect:

1. In the Runtime Trace viewer, left-click the green PhoneNumber constructor call made by the Test Case.

Take a look at this PhoneNumber constructor (you may need to scroll down a bit in order to fully expose the
function). In essence, a numberString object is being prepared to hold the phone number. What happens if the
length of the phone number - the input to this constructor - is 0? The numberString object is never created.

The problem is the last line of this constructor. The numberString object is assigned a final value. How can
this be if the numberString object is never created when the length of the phone number is 0? You need to add
an extra line of code to ensure that the last line of the constructor is only executed if the length of the phone

number is greater than 0.

2. Modify the source code of this PhoneNumber constructor as follows:

if(length > 0)
numberString[length] = '"\0';

In other words, add the if statement.
3. Select the menu item File->Save
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This should fix the problem. In the next topic, you will rerun your test to make sure that the unexpected exception

goes away.

Verifying the success of your repairs
As you have now learned, tests always need to be rerun and reports should always be checked.

To validate the repair:

1. From the Window menu, select Close All.

2. In the Project Browser tab on the right-hand side of the screen, left-click the UmtsCode component testing
node and then click the Buildl> toolbar button.

3. The test has finished executing when the green execution light on the lower-right of the Ul stops flashing.

4. Double-click the UmtsCode component testing node to view all of the reports.

5. Select the TestReport tab.

When looking at the Report Windowto the left, you will find that the defect has been repaired. It's a good thing

you tested all three possible coverage levels for the while loop!

6. Select the menu item File->Save Project.

Conclusion of Exercise 3

After correcting the UMTS base station code directly in the Text Editor, you simply rebuilt your application and used
the mobile phone simulator to initiate further interaction. A second look at the runtime analysis reports validated the
accuracy of your changes. Consider the speed with which you could perform these monitoring activities once you are
familiar with the user interface...

Component Testing for C and Ada Conclusion - with a Word about Process

Component testing is probably the type of testing that comes to one's mind when considering the minimal amount of
effort one must make to ensure a defect-free product. As these exercises have shown, component testing is a non-

trivial activity.

Imagine a world in which no tool exists that can automate stub, driver, and harness creation, in which no tool can
automate data-driven tests. No wonder that testing is typically viewed negatively by developers. Again, it's not that

anyone feels testing is unimportant. But how repetitive and work-intensive!

To make matters worse, without code coverage the best tests in the world are run in a vacuum. How do you know

when you are finished? How do you know what test cases have been overlooked?

Use Test Embedded to simplify your component testing of C functions and Ada functions and procedures. All the
tedious tasks are automated so you can focus on good tests. Test boundary conditions. Try inputs that would "never"
happen. And let the test scripting API generate an overabundance of inputs; why not, considering no additional effort
is required on your part.
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Perhaps now you can see how Test Embedded combined with the runtime analysis tools reviewed in the last group of
exercises, provides you with full regression testing capabilities without having to sacrifice time better spent creating

quality code.

Further Component Testing Exercises

Until the code is completely covered, there's always another unit test to perform.

» What is the most complex function in the UmtsCode.c file? Do you remember where you can find the

complexity measurement V(g)?
« Add additional component tests until you achieve 100% code coverage for this most complex function.

» And what about the other functions in UmtsCode.c?

Component Testing for C++

When speaking of C++ applications, the term "component testing" applies to the testing of C++ classes. As when
working with C functions and Ada functions and procedures, embedded object testing requires the construction of a
test harness (consisting of stubs and test drivers), the generation of suitable input data, and the subsequent passing

of that data into the methods under test in order to verify the accuracy of the output data.

In addition to the overhead effort that was automated by the component testing feature for C and Ada - such as stub,

test driver, and data generation - the component testing feature for C++ adds additional capabilities:

« Support for complex data types
« Support for private and protected class methods and variables

- Support for contract assertion checking - that is, the ability to verify properly obeyed preconditions,
postconditions, and data invariants.

Such features are crucial for efficient, proactive debugging. Without them, you wouldn't have enough power at your

disposal to catch all the defects in your C++ code.

The following exercise will highlight these additional capabilities.

Exercise 1

In this exercise you will create a new project in which the UMTS base station source code will be referenced.

See Preparing for the tutorial on page 88 for details about the application you will be using in this tutorial.
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Using Code Coverage to Find Untested Code

Creating and executing a component test for C++ in HCL DevOps Test Embedded (Test Embedded) is much like the
process for C and Ada component testing. Most steps are shared in common - the main difference is the content of

the C++ component tests themselves, which you will see later.

As with the C and Ada testing exercises, the first step in these exercises is to use the code coverage feature of Test

Embedded to determine which parts of your code require greater coverage.
To locate uncovered code:

From the Window menu, select Close All.

1. In the Project Browser tab on the right-hand side of the screen, right-click the BaseStation application node
and select View Report->Code Coverage - that is, open the coverage information pertaining to your manual
interaction with the UMTS base station.

2. Maximize the Code Coverage viewer

3. In the Report Window on the left-hand side of the screen, open the PhoneNumber.cpp node and then select

the node for PhoneNumber(unsigned int)

Looking at the coverage for this constructor of the PhoneNumber class, you can see that the for loop has only been

covered in one of three possible ways - you still need to cover 0 loop and 1 loop through the for statement.

To achieve this coverage, you would be wise to create an automated component test. Of particular interest would
be to see what happens when a phone number of zero length is sent to the UMTS base station. The objective of this

tutorial is to increase code coverage by ensuring this PhoneNumber constructor is called with a value of 0.

Creating an C++ Component Test

Since you will be testing C++ code, the first order of business is to reselect the C++ TDP- based Configuration.
Once done, you will follow virtually the same steps as you took for creation of a component testing test script for C
and Ada. The difference? Accommodating the HCL DevOps Test Embedded (Test Embedded) ability to implement
assertion tests.

To create a C++ Component Testing test node

1. Select the menu item Window->Close All(and close the Output Window at the bottom of the Ul if you wish to
free up additional space).
2. In the toolbar dropdown list for Configurations, select the C++ TDP configuration you used in the Runtime
Analysis exercises, thereby replacing the currently selected C TDP-based Configuration.
. On the toolbar, click the Start Page E button.
. Select the Activities link on the left side of the Start Page.

. Select the Component Testing link in the center of the Start Page.

o g AW

. In the window Application Files -Notice how all C++ source and header files of your project are already

visible . No changes need to be made, so simply click the Next button.
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7. In the window Components Under Test, select the checkbox next to the reference to the PhoneNumber class.
(Since a single C++ class can be defined in multiple files, classes are listed by the Wizard rather than any
implementation reference. This also explains why the file in which a class is declared is listed in the File Name
column - there is only one declaration, while definitions can occur across multiple files.) Click the Next button.

8. In the Test Name field, enter the name PhoneNumber. Leave the default values and click the Next button.

9. You should now be viewing the Summary window. Click the Next button.

The component testing wizard now analyzes the source code in PhoneNumber.cpp and PhoneNumber.h and

creates a test for every class defined in the .cpp file.

10. Click the Finish button.

11. Select the menu item File->Save Project.

Note: In the Project Browser tab, a C++ component testing node named PhoneNumber has been added to

your project.

Conclusion of Exercise 1

Use of the C++ component testing feature should have been a lot easier for you, considering your experience with test
creation for C and Ada. Not much is different - and that's by design. All you need to do now is specify the exact test

and assertion checks you would like to perform, and then execute the test. You will do that next.

Exercise 2
In this exercise you will:
« build and execute the UMTS base station application
» manually interact with the UMTS base station application

« view the runtime analysis reports derived from your interaction

The Autogenerated C++ Component Test

Once you become familiar with the layout of the auto generated test and contract check, the modifications you need

to make to increase code coverage will become obvious.

To complete the test script:

1. In the Project Browser tab on the right-hand side of the screen, double-click the node PhoneNumber.otd.

2. Maximize the test script editor.

This is the test driver script. In it you will perform those steps necessary to drive and test classes in the file

under test.
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Along with the .otc contract-checking test - discussed in the next section - full C++ class testing is possible.
The idea is that the files PhoneNumber.cpp, PhoneNumber.otd, and PhoneNumber.otc will be compiled
and executed together (with execution taking place on the target specified by the currently selected Target
Deployment Port Configuration).

C++ component testing test scripts are written with a compiler-independent test script API. For detailed
information about the script layout, see the Reference section in the online help. For the Tutorial, only critical
script elements will be discussed.

Each class used in the file under test is assigned its own TEST CLASS block - PhoneNumber.cpp only handles
the PhoneNumber class, so there is only one Test Class block. Each TEST CLASS block is divided into a
single PROLOGUE , one or more TEST CASE blocks, and then a single EPILOGUE.

The PROLOGUE statement defines native code that is to be executed whenever the surrounding TEST CLASS
execution begins. You typically use the PROLOGUE statement to declare and sometimes initialize the object
instances of a class under test. In this exercise, the generated PROLOGUE creates an instance of the class
PhoneNumber. The EPILOGUE structure defines native code that is to be executed whenever the execution of
the surrounding TEST CLASS ends.

The TEST CASE block generates a public method test of the class under test. The test case name is made up

of the identifier of the method under test with the prefix test. This ensures correct overload handling.

A typical test starts with the display of a trace (with the PRINT statement) and continues with the C++ native
code that calls the method under test. This call is performed on the instance declared in the PROLOGUE
block. Any parameter values are null. If the method under test returns a value, the test case continues with a
CHECK statement. The test case ends with another trace display.

For this tutorial, we would like to call the PhoneNumber constructor with an integer value of 0. Since your goal
is to simply increase code coverage, don't bother testing anything - just call the PhoneNumber constructor
with a value of 0.

3. In the PROLOGUE block, add (0) after the obj0 identifier, so that it appears as follows:

PROLOGUE

{

// Declarations of variables needed by this test class.
// Actions to be performed before executing this test
// class.

#PhoneNumber objo (0) ;

}

The # symbol indicates that the line contains native C++ code.

4. From the File menu, select Save

Technically, you are finished. When this test script is executed, the PhoneNumber constructor will be called with an
integer value of 0. However, to give you some idea of how an assertion test would be useful, the next topic will take a
look at the contract checking script.
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The Autogenerated Contract Check

Use the contract checking test to ensure assertions are not violated. Assertions are parameter limits or restrictions
that should be obeyed, but which are very often not explicitly enforced by the code. For example, it surely makes
sense that a phone number never has zero digits. If that is the case then calling the PhoneNumber constructor with a
value of 0 should violate this assertion. You will create this assertion.

To complete the test script:

1. In the Project Browser tab, double-click the node PhoneNumber.otc

2. Maximize the test script editor.

This is the C++ component testing contract checking script. In it you will perform those steps necessary to

verify that assertions are not violated.

Contract checking scripts are written with a compiler-independent test script API. For this Tutorial, only critical

script elements will be discussed.
For each class a CLASS block is created and this CLASS block can test for violations of:
o invariants
o pre-conditions/post-conditions
o states
o transitions

Since you wish to verify that the length of the phone number always exceeds 0, then one possible contract
check would be to ensure the stringLength variable of the PhoneNumber constructor is always greater than 0

(have a look at the source code if you wish to verify this approach yourself).

3. Scroll down the contract checking test script until you see the line:

WRAP PhoneNumber (unsigned 1int length)
REQUIRE ("Require PhoneNumber'")
ENSURE ("Ensure PhoneNumber™)

4. Modify the code as follows:

WRAP PhoneNumber (unsigned int length)
//REQUIRE ("Require PhoneNumber")
ENSURE (stringLength > 0)

5. From the Filemenu, selectSave.

The WRAP keyword lets you check for pre- and post-conditions of a class method. The REQUIRE keyword

checks pre-conditions; the ENSURE keyword checks post-conditions.

Another example of a contract check would be to verify that class invariants are never violated. For example,

it certainly makes sense that the phone number can never be full and empty at the same time. This can never
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be, it is an invariant. The PhoneNumber class actually has these methods - isFull() and isEmpty() - so use

them to verify this assertion.

6. Scroll up the contract checking test script until you see the following line: // | NVARI ANT (/* expression */);
7. Modify this line as follows: | NVARI ANT (! (isFull () && isEmpty()));
8. Select the menu item File->Save.

You are ready to compile and run the test and contract check.

Running a C++ Component Test

You have set up your tests to increase coverage of the for loop in one of the PhoneNumber constructors by calling it
with a value of 0. You have also set up two contract checks - one verifies that the phone number object is never full
and empty at the same time, the other verifies that the phone number length is never set to 0. Time to run the test.

To execute the test node:

1. Select the menu item Window->Close All

2. Left-click the PhoneNumbertest node (the parent node of the PhoneNumber.otd, PhoneNumber.otc and

PhoneNumber.cpp nodes) and then press the Build toolbar button ( [= )
3. The test is executed as part of the build process - you will know the test has finished executing when the
green execution light on the lower-right of the Ul stops flashing.

4. Select the menu item File->Save Project.

As with your C and Ada component test, the runtime analysis features are still selected in the Build options; the file
under test - PhoneNumber.cpp - was instrumented for the memory profiling, performance profiling, code coverage
and runtime analysis features, which explains why the Runtime Trace viewer appears during the run. Notice how the

runtime tracing feature tracked all of the method calls made throughout the execution of the test.

So have you improved code coverage? Were any of your assertions violated? That is the subject of the next exercise.

Conclusion of Exercise 2

With virtually minimal effort, you have successfully instrumented your source code for all four runtime analysis
features. Manual interaction (in your case, via a mobile phone simulator) was monitored, and the subsequent runtime
analysis results were displayed for you graphically. Source code is immediately accessible from these reports, so

nothing prevents the developer from using the results to correct possible anomalies.

In addition, using the Test by Test option provided with each runtime analysis feature (introduced in the Further Work

section for code coverage), you can easily discern the effectiveness of a test, ensuring maximal reuse without waste.

Your next step is to use the runtime analysis results to remove memory leaks, improve performance, and increase

code coverage.
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Exercise 3

In this exercise you will:

- Improve the UMTS base station code by eliminating memory leaks and by improving performance
« Increase code coverage

« Rerun the manual test to verify that the defects have been fixed

The C++ Component Test Report

The C++ component test report summarizes all of the test results. It is hyperlinked to the test script (the .otd and .otc

file) and can be browsed using the ReportWindow.

To analyze the test report:

1. In the Project Browser tab on the right-hand side of the screen, right-click the PhoneNumber component
testing node and select View Report->Code Coverage.

2. Maximize the Code Coverage viewer

3. Using the Report tab on the left hand side of the screen, view the source code for the PhoneNumber
constructor you called with a value of 0 in your test script.

Have you covered the 0 loop case of the for loop? Yes, indeed. (Notice the absence of coverage for 2 loops
or more - remember, in your component test, only the 0 case was tested. Your manual interaction with the
UMTS base station via the mobile phone simulator was responsible for the 2 loops or more coverage - and

that coverage won't be listed here.)

How about your contract checks?

4. In the Project Browser tab on the right-hand side of the screen, right-click the PhoneNumber test node and
select View Report->Test.
5. Close the Project Explorer window to the right, and the Output Window at the bottom of the Ul to give you

more room to explore the report.

Look at the Report Windowon the lower-left side of the Ul. Your method contract check failed - that is, the
stringLength variable was not greater than 0. It should come as not surprise that this assertion failed since
you went out of your way to supply a length of 0. Sensibly, you should continue to test this assertion in all your
regression testing of the UMTS server to ensure that "normal” phone number inputs never have a length of 0.

Does anything else need to be done? Is everything else working properly?

Notice how the test cases corresponding to the methods appear to have failed as well. Why should this be?
As you recall, no test was actually performed in the Test Case block - you simply called the PhoneNumber()
constructor. In fact, this failure implies the test was not able to finish properly. You should take a closer look at
the runtime trace to ensure nothing unusual happened.

6. Select the Runtime Trace tab.
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Look closely. There are lifelines for:

- the operating system
« the test class block
« the test case that calls the PhoneNumber constructor

« a PhoneNumber object

Your assertion checks are flagged by notes - a green note means the assertion has been observed, a red note means
the assertion has been violated. (Thus the note for the stringLength test is red.)

What about the unexpected exception? That can't be good. In fact, close inspection of the PhoneNumber lifeline
shows that the destructor method was never called. Intuition probably tells you that this unhandled exception is
directly related to your input of a phone number of 0 length.

The code needs to be fixed.

Repairing a Defect

The runtime tracing feature has uncovered what looks to be an unhandled case - that is, handling a phone number of
0 length. The code must be fixed.

To fix the defect:

1. In the Runtime Trace viewer, left-click the green PhoneNumber constructor call made by the Test Case.

Take a look at this PhoneNumber constructor (you may need to scroll down a bit in order to fully expose the
function). In essence, a numberString object is being prepared to hold the phone number. What happens if the

length of the phone number - the input to this constructor - is 0? The numberString object is never created.

The problem is the last line of this constructor. The numberString object is assigned a final value. How can
this be if the numberString object is never created when the length of the phone number is 0? You need to add
an extra line of code to ensure that the last line of the constructor is only executed if the length of the phone

number is greater than 0.

2. Modify the source code of this PhoneNumber constructor as follows:

if(length > 0)
numberString[length] = '\0';

In other words, add the if statement.
3. Select the menu item File->Save

This should fix the problem. In the next topic, you will rerun your test to make sure that the unexpected exception

goes away.
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Verifying the Success of Your Repairs
As you have now learned, tests always need to be rerun and reports should always be rechecked.

To check that defects have been resolved:

1. From the View menu, select Other Windows and Project Window.

2. From the Window menu, select Close All.

3. In the Project Browser tab on the right-hand side of the screen, left-click the PhoneNumber test node and then
select the Build[* toolbar button.

4. The test has finished executing when the green execution light on the lower-right of the Ul stops flashing.

5. From the File meny, select Save Project.

6. Expand the Runtime Trace viewer that appeared during the test run.

By looking at the Runtime Trace Viewer, you will find that the unexpected exception has disappeared and is now
replaced with a call to the PhoneNumber destructor. One more defect has been eliminated. That was one defect you

would not have caught without the assistance of the runtime tracing feature of Test Embedded.

Conclusion of Exercise 3

After correcting the UMTS base station code directly in the Text Editor, you simply rebuilt your application and used
the mobile phone simulator to initiate further interaction. A second look at the runtime analysis reports validated the
accuracy of your changes. Consider the speed with which you could perform these monitoring activities once you are

familiar with the user interface...

C++ Component Testing Conclusion - with a Word about Process

Now you have seen how to perform host- and target-based unit testing for C, C++, and Ada.

For all of these languages, notice how HCL DevOps Test Embedded (Test Embedded) has allowed you to focus solely
on your code. Notice how easily it has been to expose untested code and to generate new tests that not only test that
code, but test it well. The time you spend testing can now be devoted to good tests - which increases the usefulness
of your attention to testing in the first place.

Contract checking adds an extra layer of protection, so give some thought to using it when testing your C++ code. It's
optional - you don't have to add assertion checking to your regression suite. Nevertheless, particularly if your code
is called by someone else's code, assertion checking is a simple and clean method for verifying that your code is

properly used.

So are you finished? You've seen how to detect and repair:

* memory leaks
« performance bottlenecks

« functional defects
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You've learned how to clarify:

- your code's call sequences

- the completeness of your testing

What's left?

System-level testing - the integration testing of distributed components. Up to now you have tested and monitored the
code. Next you must see how to test the interaction of various threads, tasks, processes, and subsystems.

Further C++ Component Testing Exercises

You covered the case of 0 loops through the for loop of one PhoneNumber constructor.

« Increase coverage by creating tests that force 1 and 2 or more loops through the for loop.

System Testing for C

What does embedded software testing at the system level focus on? It focuses on the interaction between two or
more threads, tasks, processes, and subsystems. In this case, the communication mechanism is provided by a C

language messaging API, and the system-under-test is stimulated by stubbed virtual actors.

As a tester, you have three primary interests at this point:

« does the system-under-test respond to the input signal as designed
« does the system-under-test respond to the input signal quickly enough

- can the system-under-test handle various loads that accurately reflect a working environment

The system testing feature for C-based messaging APIs enables system level testing. This is achievable because
Test Embedded can define virtual actor behavior - or, using Test Embedded terminology - virtual tester (VT) behavior.

There are two ways to define VT behavior:

- use the system testing test script API to define virtual tester actions

« use a probing technology to monitor system execution, recording the actions of system actors so that they
can be played back one or more times simultaneously

The output virtual tester scripts not only define the message content sent to the system-under-test, but also define
tests for the messages subsequently received - tests in which success or failure is based on message content, time-
of-response, or both.

Once the virtual tester scripts are created, the system test deployment scheduler is used to configure the launch of
one or multiple VT instances, including the machines upon which the deployment should occur (virtual testers can be

executed on multiple machines, remotely, during a single test run). The resulting report consolidates all interactions,
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highlighting errors, while a runtime tracing diagram graphically displays system interactions. (Note how the ability to
launch multiple, concurrent virtual testers lets you generate a load on the system under test, thereby enabling load
and stress testing of the target system.)

This tutorial will focus on the first method suggested for generating a system test - that is, through the use of the
System Testing test script API.

Exercise 1

In this exercise you will create a new project in which the UMTS base station source code will be referenced.

See Preparing for the tutorial on page 88 for details about the application you will be using in this tutorial.

System Testing requirements

Having performed the runtime analysis exercises, you have seen how a mobile phone simulator can be used to

interact with the UMTS base station. The implication then is that signals were being traded between the two.

If this is the case - if, in fact, signals are passed between the mobile phone simulator and the UMTS base station -
would it not be useful to "fake" the simulator with a test that can send signals to the base station and then analyze the

content and timing of the signals that are returned?

You will be doing just that. You will be simulating the simulator, creating a test that can interact with the base
station in a well-defined way and then test the returned signals. Put another way, you will be automating the manual
interaction you performed in the Runtime Analysis portion of this tutorial.

This test is coded with a system testing test script API.

In order to build this system testing test script - that is, in order to create virtual testers - the test script code must
have access to the C language messaging API used by the system under test. Without a messaging API, it would

not be possible to define the signals sent from the virtual tester to the system under test, nor would it be possible to
analyze the returned signals. The messaging APl might be accessible in a preexisting library, accessible in source
code used to build the system under test, or inaccessible (thereby necessitating manual creation of a referenceable
messaging API file). In this tutorial, you will be reusing some of the UMTS base station source files; these files define
the messaging APl used to communicate with mobile phones.

In addition to having access to the messaging API, you must also define an adaptation layer. The adaptation layer
describes how the APl is to be used; in other words, how are messages sent and received.

Finally, your test script will need to describe the action of a virtual tester - indicated in a system testing test script with
the reserved keyword INSTANCE. This is the part of the test script that specifies what signals are sent to the target,
what signals are expected, and any timing requirements.

To summarize: When building a System Testing test, you are responsible for:
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« creating or providing access to the C language messaging API
« coding the adaptation layer

« coding the INSTANCE blocks describing the simulated behavior and tests

You will not be responsible for creating any of these above items in the Tutorial - the files are provided for you - but

their content will be reviewed.

For Linux Users

You need to install the System Testing agent software, a daemon that must be running on the host to act as an

interface between virtual testers and the machine running Test Embedded.

For Windows users, this daemon has already been installed.

Creating a system test
As with the component testing tools, your first responsibility is to create a node in your project for the system test.

To create a System Testing node:

1. Clean up the user interface by closing unnecessary windows. From the View menu, select Other Windows and
Project Window. From the Window menu select Close All.

2. Using the TDP Configuration selector on the toolbar, ensure the C TDP-based configuration is selected. This is
necessary to support the C language messaging API.

3. Click the Start PageE toolbar button to open the Start page. Click Activities and System Testing for C to
launch the System Testing wizard.

4. In the window Create System Testing Node, enter the name MobilePhoneVT and then click the OK button.

5. In the Test Script Selection (1/7) window, make sure Create a new test script option is not selected. For this
tutorial, we will use an existing .pts test script. Click Browse (...) and select the file \examples\BaseStation_C
\tests\MobilePhoneVT.pts from the Test Embedded installation folder.

6. On the same page, in the Interface Files List area, click the AddT 1 button and browse to the UMTS base
station source files located within the product installation folder, in \examples\BaseStation_C\src.

7. Select the two following C language header files, by pressing CTRL and clicking:
> tcpsck.h

o UmtsMsg.h

8. Click Open. These two files define the messaging APl used by the UMTS base station to communicate with
mobile phones. They will be reused in order to define the messaging API employed by the virtual testers. Click
Next to continue. Because we have used an existing .pts test script instead of creating a new one, the wizard

has jumped to step 5/7.
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The system testing node has already been created (you can see it on the Project Browser). However, the the wizard
has not finished guiding you through the creation of the system test. The next step is to configure the test script that
will reference the messaging API, define the adaptation layer, and describe virtual tester actions.

Configuring virtual testers

The System Testing Wizard has analyzed the preexisting test script - MobilePhoneVT.pts - noting the INSTANCE
blocks defined within. Recall that the INSTANCE blocks describe the exact actions a virtual tester should take,
including:

 what signals to send

- what signals are expected in response

« what tests should be performed

A test script can contain more than one INSTANCE definition. (The System Testing test script will be reviewed in
Exercise Two.)

Your next responsibility is to create virtual tester drivers. A virtual tester driver is used to create one or more virtual
testers - or, more specifically, one or more virtual testers for one or more of the INSTANCE blocks defined in the test
script. A virtual tester driver can be configured to support only one INSTANCE block, or it can be configured to support
multiple. The advantage of only supporting only one type of INSTANCE block is that the driver size is minimized.

To set up a Virtual Tester:

1. We are still in the System Testing wizard. In the Virtual Test Driver Creation (5/7), next to the Virtual Tester
Driver List, click New. and enter the name of the virtual tester as Driver1. Click OK.

2. This step let's you specify which INSTANCE blocks apply to this virtual tester and, if applicable, which
SCENARIO and FAMILY blocks within the INSTANCE blocks are supported. (Again, the system testing test
script language is discussed in Exercise Two.)

Notice how the General tab on the Virtual Tester Driver Creation window lets you select the INSTANCE block
supported by the virtual tester. In addition, the TDP configuration for this binary can be changed and modified
as well. The Scenario and Family tabs let you clear SCENARIO and FAMILY blocks that you don't want the
driver to support.

For this tutorial, you will only be using the Driver1 driver, and you want this driver to support all INSTANCE
blocks. On the General page, set the Implemented INSTANCE to <all>.

3. Set the Target to your C language TDP for the machine you are working on. Since multiple drivers could be
distributed across multiple execution environments, it is conceivable that each test driver would be assigned
its own TDP.

4. Click the Next button.
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One step to go. You must now describe the deployment configuration - that is, you must create individual virtual
testers, the VT driver from which each will be generated, and - if applicable - the INSTANCE block that will be
executed. This window can also be used to create multiple, concurrent VTs of the same type.

Deploying virtual testers

Each virtual tester driver can be used to create one or more virtual testers. In addition, if the driver supports more than
one INSTANCE block, then each specific INSTANCE block needs to be assigned a virtual tester. For this tutorial, you
will just be running a test that consists of a single virtual tester.

To set up the Deployment Configuration:

1. We are still in the System Testing wizard. On the Deployment Configuration(6/7) page, click the Add button to

create a virtual tester.

The Virtual Tester Driver column is used to select the driver, the INSTANCE column is used to select the
INSTANCE, and the Network Node column is used to specify the machine to which the virtual tester(s) will
be deployed. Since only one virtual tester is required for the tutorial, the column Number of Occurrences can

remain equal to 1.

2. Select phone1 in the Instance column and ensure the Network Node is 127.0.0.1, which is the local host. You
can use either a host name or an IP address.

3. Click the Next button.

4. Review the settings on the Test Generation Summary window if you wish, then click the Finish button.

You're system test node should appear as follows in the Project Browser:

o EriBMobilePhoneyT

: *:r--F{eauItS
o | E-&MobilePhoneT pts
o B Driver]

Note that if you need to modify the deployment configuration, you can right-click the test script node (in this
tutorial that would be the MobilePhoneVT.pts node) and select the Virtual Tester Driver Configuration option.

One step remains. Recall that you will be using UMTS base station files to implement the messaging API.
During the System Testing Wizard you selected the two header files that contain the API specification. What
you must do now is reference the source files that implement the messaging API. This could not be done in
the wizard because there was no messaging-API library to import. The source files for the messaging API

need to be compiled along with the test script and thus must be added directly.

5. Right-click the virtual tester driver node driver1 on the Tests tab and select Add Child->Source Files.
6. Browse to the UMTS base station source files located within Test Embedded installation folder, in the folder

\examples\BaseStation_C\src, and open all of the C language files:
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otcpsck.c
> Ut sCode. ¢
o Unt sMsg. C
7. From the File menu, select Save Project.

There is no need to instrument the three C language files used to implement the messaging API, but rather than
altering the entire TDP configuration using the Build dropdown menu, you are simply ensuring these three particular

files won't be instrumented.

You are now ready to simulate the mobile phone and thus drive the UMTS base station, ensuring the base station
responds to signals in a proper and timely fashion.

Conclusion of exercise 1
Have a look at the right side of your screen. This is the Project Explorer window, and within it two tabs are visible.

The first - the Project Browser tab - contains a reference to all group, application and test nodes created for the active
project. The project node, named MyProject, contains an application node named MyApplication; the application

node contains a list of all of the source files required to build the application.

The second tab - the Asset Browser tab - lets you browse all of your source files and test scripts. If the selected Sort
Method is By File, you are presented with a file-by-file listing of test scripts and source code. Note how each source
file can be expanded to display every defined package or function. Double-clicking any test script or source file node
will open its contents in the Test Embeddededitor; double-clicking any package node will open the relevant source file

to the very line of code at which the definition or declaration occurs.

There are two other sort methods as well on the Asset Browser. The first, By Object, lets you filter down to packages,

independently of the source files. The second, By Directory

You may have noticed along one of the toolbars at the top of the Ul that the TDP you selected in the New Project
Wizard is listed in a dropdown box. In fact, this is not a reference to the TDPR, it is a reference to the Configuration
whose base TDP was the one you selected in the wizard - in the case of this tutorial, it is a TDP supporting Ada.
Configurations are initially named after their base TDP, but this name can be changed. Should you have multiple

configurations for the same project, use this drop-down box to select the active Configuration for execution.

Finally, to the right of the Configuration drop-down list is the Build[ button. This button is used to build your

application for application nodes and the test harness for test nodes.

Armed with this knowledge, proceed to Exercise Two.

Exercise 2

In this exercise you will:
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« build and execute the UMTS base station application
- manually interact with the UMTS base station application

« view the runtime analysis reports derived from your interaction

The System Testing test script

A brief tour of the C-based system testing test script should clear up any further mystery about how the virtual testers

are implemented.

To modify the test script:

1. Double click the MobilePhoneVT.pts node on the Project Browser tab.
2. Maximize the test script

Highlights, from top to bottom (See the web help for detailed information regarding the system testing test script
API):

+ DECLARE_INSTANCE - Note how only one INSTANCE block exists in this test script.
« MESSAGE - These variables will contain the message sent from the UMTS base station to the mobile phone.
« PROC ... END PROC - Used to define a function that will be called multiple times.

* PROCSEND ... END PROCSEND - Part of the adaptation layer; describes the steps necessary for a virtual tester

to send a message.

« CALLBACK ... END CALLBACK - Part of the adaptation layer; describes the steps necessary for a virtual tester

to receive a message.

« INITIALIZATION ... END INITIALIZATION - Indicates those steps that must occur before any SCENARIO block
executes. Only applies to those SCENARIO blocks at the same level as the INITIALIZATION block. In this case,
the virtual tester opens a TCP/IP socket to the base station and then connects to it. (Note that the phone has
not yet been registered to the base station; the INITIALIZATION block only opens a connection to the phone;

with this connection, the mobile phone can then try to register.)

- TERMINATION ... END TERMINATION - Indicates those steps that must occur after every SCENARIO block
finishes executing. Only applies to those SCENARIO blocks at the same level as the INITIALIZATION block.

« SCENARIO ... END SCENARIO - Highest level blocking of specific virtual tester actions. A SCENARIO block
can consist of more than one child SCENARIO block. The INSTANCE blocks are typically defined in SCENARIO

blocks.

« INSTANCE ... END INSTANCE - Contains code specific for a virtual tester instance.
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» SEND - Sends a message.

« WAITTIL - Waits for a message, and tests the message for both content and promptness. Reports a failure if

the received message does not match expected, was never received, or was received late.

Take a look around. Notice how the call_busy scenario uses the phone number 5550000, and how the call_success
scenario uses the phone number 5550001. As you may recall, these were the phone numbers used in the runtime

analysis portion of this tutorial.

Once you are comfortable with the test script, you can proceed to execute the test.

Running the base station in the background

The objective of your system test is to test the UMTS base station. However, how will you run the base station
application at the same time as the test? Normally, the tested thread, task, process, or subsystem will be run
somewhere on your network, but for the purposes of the Tutorial, you will have to manually run it yourself.

To execute the system under test:

1. From the command line (or via Windows Explorer on Windows) browse to the UMTS base station executable
provided with the Tutorial. This file is located within the Test Embedded installation folder, in the folder
\examples\BaseStation_C, and is calle

- on Windows - BaseSt at i on. exe
o on Linux - BaseSt ati on. sh

(For Linux, you also have the option of selecting the base station executable itself, located in the same
directory. The shell script referenced above simplifies matters.)

2. Run the base station executable. Windows users should minimize the command window that appears.

Executing the system test

It might seem like a lot of work to get to this point, but consider what you have accomplished and what can be

accomplished. You have:

» Modeled dynamic, distributed component interaction
- Created virtual testers that could, simply by specifying various IP addresses, execute on multiple machines
 Enabled load testing

« Provided a means for implementing scenario-based testing

Each step you performed, in reality, has hidden an enormous amount of complexity.

In this section, you will run the test.
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To execute the test:

1. Run the System Testing agent software - that is, run the software that supports virtual tester execution. The
agent executable is called atsagtd and it can be executed in one of two ways:

> On Windows - In the Start menu, select Programs >Test Embedded Software >Test Embedded
> Tools->Test Embedded System Testing Agent (which is simply a link to the file atsagtd.exe,
executable from the command line with a single argument - the port number to be used, 10000 in this

case). Minimize the command window that appears.

> On Linux - This agent is already launched if you have followed the System Testing Agent installation

instructions in the Test Embedded installation help pages.

When test execution has completed, a post-execution trace of events will be created; this trace is used later in
the tutorial. However, if you wish to monitor execution via an on-the-fly trace as well, follow the next five steps.
Otherwise, skip to Step 7.

2. Right-click the MobilePhoneVT system testing node on the Project Browser tab and select Settings.

3. Expand the System Testing node on the left-hand side of the Configuration Settings window, select the
Advanced options node and then select Yes in the dropdown list associated with the property On-the-fly
tracing.

4. Click OK.

5. From the Window menu, select Close All.

6. Left-click the MobilePhoneVT system testing node and press the Buildl= button to run the test. (If you are
asked to rebuild the nodes, click the Yes button.) The test harness is now built, deployed, and executed.

If you opted to create an on-the-fly trace: The Runtime Trace viewer will appear. The test has finished

executing when the right-hand phone1_0 lifeline in the viewer is stamped at its base by a black X:

main 11s5...
TERMINAT... [11s7...
TERMINAT... [11s9...

*115 106ms

If you opted to not create an on-the-fly trace: Execution has completed when the green execution light in the

. ) nn-nm- g ‘|
lower-right of the Test Embedded GUI stops flashing (I L - - 1 )

7. From the File menu, select Save Project.

8. On Windows only - close the System Testing Agent.

The on-the-fly runtime tracing diagram shows interactions, as they happened, between the software-under-test (SUT)
- that is, the UMTS base station - and the single virtual tester you had created for the system test. This virtual tester

is named phone1_0. Such an on-the-fly diagram is useful for monitoring test execution; however, this diagram is not
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crucial to the extent that the information within it has also been captured for post-execution analysis in a separate
runtime tracing diagram.

In the next exercise, you will look at this runtime tracing diagram and then study the system test report.

Conclusion of Exercise 2

With virtually minimal effort, you have successfully instrumented your source code and the subsequent code
coverage results were displayed for you graphically. Source code is immediately accessible from these reports, so

nothing prevents the developer from using the results to correct possible anomalies.

Exercise 3

In this exercise you will:

« Improve the UMTS base station code by eliminating memory leaks and by improving performance
« Increase code coverage

« Rerun the manual test to verify that the defects have been fixed

Analyzing the execution-based Runtime Trace viewer

A complete runtime tracing diagram of test execution was created at the conclusion of the test run.

To open the UML sequence diagram:

1. To gain additional space, close the Output Window at the bottom of the UL

2. On the Project Browser tab, right-click the MobilePhoneVT System Testing node and select Runtime Trace.
3. Right-click-hold within the Runtime Trace viewer and select the option Hide Coverage Bar.

4. Make sure you are viewing the top of the runtime tracing diagram, using the right hand slider bar if necessary.

The UMTS base station is represented by the lifeline labeled SUT BaseStation; the virtual tester lifeline is
labeled VTphone1_0 (that is, virtual tester 0 for the phone1 INSTANCE block you chose in the Deployment
Configuration window - see the topic Configuring the Deployment Algorithm in the previous exercise to

refresh your memory).

The virtual tester first performs its initialization functions - represented by the INITIALIZATION note. Then
it performs each of the three SCENARIO blocks located in the test script - named connect, call_busy, and
call_success. Each is visually traced, consecutively, as they occur.

The main block consists of the three SCENARIO blocks, performed one at a time. Each scenario consists of
a single test - a WAITTIL. Recall that a WAITTIL command both checks the content of a received message as

well as ensures the message is received within a specified amount of time.

5. Click on the INITIALIZATION node at the top of the runtime tracing diagram.

The system test report is opened. You will look at that report next.
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Analyzing the System Test report

The Runtime Trace viewer shows you what happened, but it doesn't make any reference to the success or failure of

each WAITTIL. All success or failure values for any system test are recorded in the system test report.

To open the test report:

1. Close the Project Explorer Window on the right-hand side of the screen to gain additional room for the runtime
tracing diagram.

2. In the Report Window on the left-hand side of the Ul, close the INITIALIZATION, SCENARIO main, and
TERMINATION nodes. The window should appear as follows:

ii.'f'-@MDbileF'hnne"-.-"T.Hrd

£ ¢BINSTANCE phonel_0
- = INITIALIZATION
= SCENARID main
- =] TERMINATION

R

Look at the Report Window; notice the existence of a node named INSTANCE phone1_0 - this is a reference
to Virtual Tester O for the phone1 INSTANCE block. For every virtual tester executing the phone1 INSTANCE
block, a separate node would exist in this browse tree. Since your test consisted of only one virtual tester, only
one node exists in the tree.

By clicking the INITIALIZATION note in the Runtime Trace viewer, you were jumped to the INITIALIZATION
section of the system test report. This section of the report could also be accessed by double-clicking the
INITIALIZATION node in the Report Window.

3. Expand the INITIALIZATION node in the Report Window.

Here, in the report, you see all of the CALLs made in the INITIALIZATION block of your system test. If any of
these calls failed, that information would be found here.

4. Expand the SCENARIO main node in the Report Window.

Now you're looking at all of the functions that occur within each SCENARIO block. (Expanding the
SCENARIOmain block in the Report Window will let you maneuver through the three SCENARIOs.) Again, every
action is listed. Successes are color-code pink.

5. In the Report Window, expand the SCENARIO main node if you haven't done so already, and then double-click
the WAITTIL node located within the SCENARIO connect node:

=) =) SCENARID main

. [ E] SCENARID connect

: <] SEMD [mConnect,BaseStation)
o o5 WAITTIL [MATCHIMNG[mB ezponze eStation], ' TIME > 1000]
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Look at the report. Notice how the WAITTIL section is broken down into a WAITED EVENTS/RECEIVED
EVENTS section - specifically, into the expected message (called MATCHING) and the obtained message
(called mResponse). The expected message defines what must be in the obtained message; in this case, the
obtained message must contain a field named command with a string value of CNX OK. As you can see, the
obtained message can contain more data than was tested for; for example, the obtained message contains

the additional fields phoneNumber, simCardld and baseStationlid.

(The WAITTIL contains the clause WTIME>1000. This means that if it takes more than 10 seconds for the
awaited message to arrive, a timeout would occur and the timeout error would be reported. The unit of
measurement for this parameter can be modified via a TDP setting.)

6. To view the test summary, scroll to the top of the report in the Test Report window.

Notice that 4 tests passed and 0 tests failed. This is a reference to the four SCENARIO blocks - the parent SCENARIO
block named main and the three child SCENARIO blocks named connect, call_busy, and call_success.

Familiarize yourself with this report, noting that you can left-click all green-colored script functions performed by the
virtual tester to view the test script itself.

Conclusion of exercise 3

With the assistance of both the on-the-fly runtime tracing diagram as well as the post-execution runtime tracing
diagram, test activity can be monitored, messaging sequences can be understood, and scenario-based system
testing use cases can be visualized.

Once the test has been performed, the system test report succinctly summarizes the results, letting you focus directly
on uncovered problems without the distraction of what might have been a large amount of collected data.

C System Testing Conclusion - with a Word about Process

C and Ada component testing exposed problems at the function level in the UMTS base station C code. C++
component testing exposed problems at the class level in the UMTS base station C++ code. Finally, with system
testing, problems that might exist at the signal passing level were exposed. The base station has been tested at all

levels of complexity.

Message-passing defects can be very difficult to catch. Ideally, to uncover problems in this area:

- system actors should be simulated to ensure well-defined scenario use cases
- these system actors should be distributed to closely mirror the true target environment

- test data should be summarized and stored in a single, exportable file

The system testing feature of Test Embedded does all of these, with the additional benefits of:
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« interactive source-code editing
« runtime observation capabilities

- target independence

The key to successful system testing is an understanding of realistic scenario use cases. You need to ask yourself
what is really going to happen in your system, in what order it will happen, and what environmental constraints will
exist at that time. Once determined, you should next consider the likelihood of environmental stress factors that could
cause system degradation. If so, then load and stress testing should become a part of your testing regimen.

Assuming true component architectures have been used in your system, if defects are found at the system level -
either improper or missing signals or signal delays - then the Test Embedded runtime analysis features should be

used in conjunction with the testing features to narrow your focus and thereby find the root cause.

All of these tests should become part of a regression testing suite. This is the topic of the Tutorial Conclusion -

combining all tests into a single regression testing suite.

Further System Testing exercises

As the MobilePhoneVT.pts file is currently constructed, there are no failures. Can you make changes to the test script
that will guarantee the UMTS base station fails to act appropriately?

Proactive Debugging

As software complexity increases, developers must become more responsible for their contribution to the overall
development project. It is becoming harder and harder for the developer to consider robust, end-to-end testing of their

code an unachievable luxury.

In fact, developers need to proactively debug - that is, treat testing as an integral part of the development process,

rather than waiting for defects to force their hand.

And why should this not be achievable? The advantage of proactive debugging is that it is manageable - testing is
only performed on the code known intimately well by the developer (barring the case of inherited code, where the
runtime tracing feature plays such a crucial role). There is little chance for confusion, so the time spent developing
and deploying tests are optimized. Defects are eliminated early, ensuring that any system level defects that

have slipped through the nets won't find their origin deep in the code. And test independence - due to the Target

Deployment Port technology - ensures test reuse despite changes in target architecture.

Test Embedded is integrated with:

- Rational® ClearCase® - Out-of-the-box integration with Rational® ClearCase®, the industry's clear market

leader for version control software. Go here to access to the Rational® ClearCase®website:

http://www.ibm.com/software/awdtools/clearcase/
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- Rational® ClearQuest® - Out-of-the-box integration to Plan the premier change management utility for
diversified software teams. Submit context-sensitive defect reports directly from Test Embedded interface.
Go here to access to the Rational® ClearQuest® website:

http://www.ibm.com/software/awdtools/clearquest/

- IBM Rational Unified Process - Tool mentors help you implement various features of Test Embedded
conceived in the RUP framework - a mature, field-tested guide to the software development process. Go here
to access to the IBM Rational Unified Process website:

http://www.ibm.com/software/awdtools/rup/

Ada tutorial

The purpose of this tutorial is to teach you how to use HCL DevOps Test Embedded (Test Embedded) to help you
improve your code.

This tutorial applies to Studio. It is made up of the following sections:

« Preparing for the tutorial: In this section we will set up our environment with everything we need to start

working with the product.

* Runtime analysis: This section will introduce you to the basic features of the product for profiling and

analyzing your Ada applications. It will be followed by a series of hands-on exercises.

- Testing Ada applications: This section will demonstrate how to perform component testing. It also includes

exercises.

« Conclusion: This section sums up what you will have learned.

Now, let's move on to the first part: Preparing for the tutorial on page 147

Preparing for the tutorial

This tutorial can be performed on HCL DevOps Test Embedded (Test Embedded) supported development platforms -
Windows and Linux.

About this Tutorial

This tutorial demonstrates how to make the most of Test Embedded through a sample project called TestSuiteAda.

Example File Locations

Source files for the tutorial are located within the product installation folder, in the folder \examples\TestSuiteAda

\src.

To open any of the example projects, go to the Start page, click Examples and select the example project.
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Sample Ada application

The tutorial will use the following source files from the TestSuiteAda project:

+ calc_cov.adb

« calculator.ads

« calculator.adb

- operation.ads

- operation.adb

* low_op.ads

« low_op.adb

« CodeCoverage.adb

» CodeCoverage.ads

The project also contains a series of tests and .ptu test scripts. You can ignore these for the moment, since you will
generate your own component tests.

Host-based testing vs target-based testing

The testing and runtime analysis that you will perform for this tutorial take place entirely on your machine. However,
one of the greatest capabilities of the product is its support for testing and analyzing your software directly on an
embedded target. Does this mean you will need to change how you interact with your application when switching
from host-based to target-based testing? Will your tests have to be rewritten, for example?

Not at all.

Thanks to the versatile, low-overhead Target Deployment Technology, all tests are fully target independent. Each
cross-development environment - that is, every combination of compiler, linker, and debugger - has its own Target
Deployment Port (TDP). In addition, any TDP can be modified via the product user interface at a more granular level,
letting you customize a particular test or runtime analysis interaction without affecting neighboring interactions. Such
granular tailoring is supported by the concept of Configurations. Each Configuration can support one or more TDP and

can apply separate customization settings to each interaction assigned to it.

Over thirty reference TDPs, supporting some of the most commonly used cross-development environments, are
supplied out-of-the-box. After creation of a project (you will be doing this in a few moments), you can access a list of
TDPs installed on the machine.

To view a list of currently installed TDPs:
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1. From the Project menu, select Configuration.
2. Select New...
3. Use the dropdown list to scroll through the available TDPs.

Target Deployment Port Web Site

As new reference TDPs become available, they are first posted on a customer-accessible Web site. Check this site

periodically for news of the latest TDPs to be made available.

Creating and Editing Target Deployment Ports

Does your organization target an environment for which no TDP yet exists? Using the Target Deployment Port Editor

you can create support.
The reference TDPs supplied with the product can guide your TDP creation efforts.
IBM also provides professional services should you choose to contract out their creation.

To access the Target Deployment Port Editor:
1. From the Tools menu, select Target Deployment Port Editor and Start.

For more information about the Target Deployment Port Editor, please refer to the Web help Reference section.

Every feature is accessible regardless of the environment within which you will be executing your tests. Rest assured,

your intended targets are supported.

Next: Host-based testing vs target-based testing on page 148

Goals of the tutorial

The sample has been pre-loaded with an error; your responsibility, during the tutorial, will be to:

« to measure code coverage on our application

« to uncover a logic error in Ada code

Regardless of the programming language you intend to use on your development project, make sure to perform the

runtime analysis tutorial.

To continue this tutorial, follow the Ada track in the next lesson: Runtime Analysis for Ada on page 149

Runtime Analysis for Ada

You will start your tour with the runtime analysis features provided by HCL DevOps Test Embedded (Test Embedded).
The automated component testing features provided by Test Embedded will be discussed in the chapter entitled
Testing Ada applications.
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Runtime analysis refers to Test Embedded ability to monitor an application as it executes. For Ada applications,

runtime analysis only includes Code Coverage on page 150 analysis.

Code Coverage Analysis

One of the greatest difficulties a developer experiences is a failure to determine the portions of code that have gone
untested. For many embedded systems, failure is not an option, so every part of an application must be thoroughly

tested to ensure there is no unhandled scenario or dead code.

In addition, project managers need a concrete measurement to determine where the team is in the development cycle
- in particular, how much more testing needs to be done. A decreasing number of defects does not necessarily mean
the product is ready; it might simply mean the portions of code that have been tested appear to be ready.

Code coverage measurement tools observe your running application, flagging every line of code as it executes.
Advanced tools such as Test Embedded are also able to differentiate different types of execution, such as whether
or not a do-whileloop executed 0 times, 1 time, or 2 or more times. These advanced measurements are critical for

software certification in industries such as avionics.

This function is provided by the code coverage feature for the C, Ada and C++ languages.

Exercise 1

In this exercise you will create a new project in which the sample project source code will be referenced

Creating a project

There is a one-to-one relationship between your current development project and a HCL DevOps Test Embedded (Test
Embedded) project. Although your development project may consist of more than one application, these applications
often possess a common theme. Use the Test Embedded project to enforce that theme.

To create a project in Test Embedded:

1. Start Test Embedded:

o For Windows, use the Start menu

> For Linux, enter studio in the command
2. Select the Get Started link in the Start Page.

Two links are displayed New Project and Open Project.

3. Select the New Project link.

You can see the New Project Wizard.

4. In the Project Name field, enter MyProject (no spaces).
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In the Location field, select the N button, browse to the folder in which you want MyProject to be stored and

then select it. For this Tutorial, the project is stored in the C:\tmp (Windows) or \usr\tmp (Linux) folder.

5. Click Next.

6. In the list of Target Deployment Ports (TDPs) installed on your computer, select the TDP to use to compile,
link, and deploy your source code and the test or runtime analysis harness. Since we are working on Ada
source code, you should choose the TDP corresponding to your Ada development environment.

7. Click Finish.

The project MyProject is created and a project node is displayed in the Project Browser tab of the Project Explorer

window:

o & b uProject

Starting a new activity

Now that you have created a project, it is time to specify your development project's source files and the type of
testing or runtime analysis activity that you would like to perform first.

To start a new activity:

1. Once a project has been created, the user is automatically brought to the Activities page. In this tutorial you
are starting with a focus on runtime analysis functionality, so select the Runtime Analysis link. This will bring
up the Runtime Analysis Wizard.

2. On the Application Files page, you must list all source files for your current development project. For this

tutorial, you will directly select the source files. Click the Add T button.

3. Browse to folder into which you have installed Test Embedded and then access the folder \examples
\TestSuiteAda\src

4. Make sure that All Ada Files in the Files of type dropdown box is selected, then select the following files:

o calc_cov.adb
o calculator.ads
o calculator.adb
> operation.ads
o operation.adb
> low_op.ads

> low_op.adb

5. Click the Open button. You should see all the source files in the list of the Application Files page.
6. Click Next.
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7.

10.
11.

W,
click Select AIIJ? and click Next.

At this time, an analysis engine parses each source file - referred to as tagging. This process is used to extract
the various functions, methods, procedures and classes located within each source file, simplifying code
browsing within the Ul.

On the Selective Instrumentation page, you have the ability to select those functions or procedures that
should not be instrumented for runtime analysis. Selective instrumentation ensures that the instrumentation
overhead is kept to a minimum. For this tutorial, you will be profiling everything and thus all items should be
checked. This should happen by default; if not, follow step 8.

. Click Select All and click Next.

You have now reached the Application Node Name page. Enter the name of the application node that will be

created at the conclusion of the Runtime Analysis Wizard; type the word MyApplication in the Name text field.

The Application Node Name window also gives you the opportunity to modify Configuration Settings

associated with the TDP that you selected when creating the project.

. Specify the name of the main application procedure, this step mandatory for Ada.

> Select the button on the bottom of the Application Node Name window entitled Configuration
Settings.
> In the Configuration Settings window, expand the Build node in the tree on the left-hand side and click
the Execution node.
> In the Main Procedure edit box, enter the name of the main procedure, in this case calc_cov.
o Select the OK button.
Click Next.
Click Finish.

The MyApplication application node has now been created and the project Browser tab of the Project Explorer

window is the following one:

& &MyF‘rniect
o B EMpapplication
+- Resultz

e 9 9 9 9 0 0

4@ cale_cov,adb
@ calculator.adb
4@ calculator, ads
@ [oow_op.adb

4@ love_op.ads

@ operatioh. adb
4@ operation, adzs

Conclusion of exercise 1

Have a look at the right side of your screen. This is the Project Explorer window, and within it two tabs are visible.
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The first - the Project Browser tab - contains a reference to all group, application and test nodes created for the active
project. The project node, named MyProject, contains an application node named MyApplication; the application
node contains a list of all of the source files required to build the application.

The second tab - the Asset Browser tab - lets you browse all of your source files and test scripts. If the selected Sort
Method is By File, you are presented with a file-by-file listing of test scripts and source code. Note how each source
file can be expanded to display every defined package or function. Double-clicking any test script or source file node
will open its contents in the Test Embeddededitor; double-clicking any package node will open the relevant source file

to the very line of code at which the definition or declaration occurs.

There are two other sort methods as well on the Asset Browser. The first, By Object, lets you filter down to packages,

independently of the source files. The second, By Directory

You may have noticed along one of the toolbars at the top of the Ul that the TDP you selected in the New Project
Wizard is listed in a dropdown box. In fact, this is not a reference to the TDPR, it is a reference to the Configuration
whose base TDP was the one you selected in the wizard - in the case of this tutorial, it is a TDP supporting Ada.
Configurations are initially named after their base TDP, but this name can be changed. Should you have multiple

configurations for the same project, use this drop-down box to select the active Configuration for execution.

Finally, to the right of the Configuration drop-down list is the Buildl button. This button is used to build your

application for application nodes and the test harness for test nodes.

Armed with this knowledge, proceed to Exercise Two.

Introduction to Exercise 2

In this exercise you will:

« build and execute the application

« view the runtime analysis reports derived from your interaction

Building and executing the application

When performing runtime analysis, your source code must be instrumented. In Ada, instrumentation is enabled for
code coverage.

Before we can build the application, we need to specify the include directory of the source files. HCL DevOps Test
Embedded (Test Embedded) stores this kind of information in its Configuration Settings.

The Configuration Settings can be seen as database containing information, parameters and options for building,
executing, profiling and testing. Within a given Configuration, each node has its own settings. Any changes made at

any level of the project are cascaded down to its child nodes.

To change the include files setting for all the nodes of our application node:
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1. Select the application node
2. Click the Settings button in the Project Browser

3. Select Build > Compiler and click the User include directories setting.

4. Click J

5. Click the New Directory button, and select the examples/TestSuiteAda/src.

6. Click Ok and apply the settings.
To build and execute the application:

1. In order to instrument, compile, link, and execute the application in preparation for runtime analysis, simply
ensure the MyApplication application node is selected on the Project Browser tab of the Project Explorer
window, and then click the Build* button.

Do so now.

Note More information about the source code insertion technology can be found in the User Guide, in the chapter

Product Overview > Source Code Insertion Overview.

1. Notice that in the Output window at the bottom of the screen, on the Build tab, you can watch the
preprocessing, instrumentation, compilation, and link phases of the build process as they occur. A double-
click on an error listed within any of the Output Window tabs opens the relevant source code file to the

appropriate line in the Text Editor.

2. The build process has completed.

Understanding Code Coverage

And finally, here you have the code coverage analysis report. The code coverage feature exposes the code coverage

achieved either through manual interaction with the application of interest or via automated testing.

To open the code coverage report after the execution of the application, in the Project Explorer, expand the Results

node, and double-click Code Coverage.

To view the Code Coverage report:
1. Select the Code Coverage tab.

On the left hand side of the screen, in the Report Window, you see a reference to Root and then to all of the source.
Root is a global reference - that is, to overall coverage. For each individual source and header file, a small icon to the

left indicates the level of coverage (green means covered, red means not covered).
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In the Code Coverage viewer, on the Source tab, a graphical summary of total coverage is presented in a bar chart
- that is, information related to Root. Five levels of code coverage are accessible when the source code is Ada, and
those five levels are represented here. Notice how, on the toolbar, there is a reference to these five possible coverage

levels (|_F|? [ El—l|_|‘ ).

1. Select the Rates tab in the Code Coverage viewer
The Rates tab is used to display the various coverage levels for
« the entire application
- each source file
« individual functions/methods

Click various nodes in the Report Window in order to browse the Rates tab. Note how a selection of the Root node

gives you a summary of the entire application.

1. From the File menu, select Save Project.

Conclusion of Exercise 2

With virtually minimal effort, you have successfully instrumented your source code and the subsequent code
coverage results were displayed for you graphically. Source code is immediately accessible from these reports, so

nothing prevents the developer from using the results to correct possible anomalies.

Conclusion - with a Word about Process

Automated memory profiling, performance profiling, runtime tracing, and code coverage analysis - no less important
in the embedded world than elsewhere in software. So why is it done less often? Why is it so much harder to find
solutions for the embedded market? It is because embedded software development involves special restrictions that
make these functions more difficult to achieve, particularly when speaking of target-based execution:

« strong real-time timing constraints

 low memory footprints

« multiple RTOS/chip vendors

- limited host-target connectivity

- complicated test harness creation for target-hosted execution

* etc.
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Test Embedded has been built expressly with the embedded developer in mind, so all of the above complications
have been overcome. Nothing stands between you and the use of a full complement of runtime analysis features in
both your native and target environment.

So use them! It should be automatic - part of all your Regression testing on page 112 efforts (discussed in
greater detail in the Tutorial conclusion). As you have seen, these functions are only a mouse-click away so there is
absolutely no drain on your time.

You may be concerned about the instrumentation - "But | don't want my final product to be an instrumented
application. Doesn't it have to be if I'm testing instrumented code?" No, it does not have to be:

1. Using the code coverage feature, generate a series of tests that cover 100% of your code

2. Instrument that code for full runtime analysis

3. Uncover and address all reliability errors as you test (e.g. memory leaks, overly slow functions, improper
function flow, untested code)

4. Now uninstrument your code - that is, simply shut off all runtime analysis features and rebuild your application

5. Run your regression suite of tests once more, this time looking only for functional errors

6. No errors? Time to ship

Make it part of your development process, just another step before you check in code for the night. Test Embedded

simplifies runtime analysis to such an extent that there is no longer a reason not to do it.

You can proceed to the next lesson: Automated Component Testing on page 112.

Component Testing for Ada

When speaking of Ada programs, the term "component testing" - also sometimes referred to as "unit testing" - applies
to the testing of Ada functions and procedures. A function or procedure is passed a possible set of inputs, and the
output for each set is validated to ensure accuracy. This can be done with either a single function/procedure, a

group of unrelated functions or procedures, or with a sequential group of functions - i.e. one function calling another,
verifying the overall or integrated, result.

Sounds simple but, unfortunately, in the embedded world its practice can be quite difficult. Why?

» What if the function you wish to test relies on the existence of other functions that have not yet been coded?
« How will you call the function-under-test in the first place?

- How will you create and maintain a variety of potential inputs and associated outputs - that is, how will you

make data-driven testing manageable?

- What kind of effort and knowledge is required to run the test on your target architecture - that is, in the

intended, native environment?

The component testing feature of Test Embedded for the C and Ada languages provides a means for automating and

verifying the above concerns. Through source code analysis:
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- Yet-to-be coded functions and procedures are "stubbed"; in other words, these functions are created for you
« A test driver is generated to facilitate communication between your running code and the test

« A test harness, independent of your test, is constructed to ensure adoption of your target architecture and
thus enabling in-situ test execution

Plus, thanks to a powerful test script API:

- Define stub responses to varied input generated by the function(s) under test

- Enable highly detailed data definitions for data-driven testing

With the assistance of the Target Deployment technology, the end result is an extensible, flexible, automated testing

tool for component and integration testing.

Regression testing

Regression testing involves the reuse of all tests to ensure your software experiences no regression - in other words,
to ensure that the repair of one defect doesn't break some other feature that worked in the past. Frankly, software
testing would be much simpler if nothing ever broke once it worked properly. Even manual testing efforts would be
acceptable for some since the effort would only be focused on "new" code - a lot of testing at the beginning, but

decreased testing as the development cycle matures and no new features are added into the project.

But things do break and manual testing is far from an achievable goal. Software is just too complicated and too

interdependent to succeed without automated assistance.

With Test Embedded, you can create full regression tests that are comprised of all the testing and runtime analysis
nodes created throughout your testing effort. It's as simple as creating a Group node and then copying and pasting
your test and analysis nodes within it. Run the Group node as you would any other; every test and analysis node
would (optionally) build and execute. When the Group execution has finished, a double-click on the Group node opens
consolidated reports that let you easily determine where errors have been detected.

With regression testing you close the loop. Code might break, but it will never find its way into the finished product.

Exercise 1

In this exercise you will create a new activity in which you build a unit test.

Before starting this exercise, make sure that you have followed the Runtime Analysis exercises for Ada and that you

have created a project called MyProject.

Creating a Component Test for Ada

Using the Component Testing Wizard, you will now create a test for all functions in the file CodeCoverage.ads and

CodeCoverage.adb.
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To create a component test:

—_

. If the Project Explorer window is not visible, from the View menu, select Other Windows and Project Window.
2. From the Window menu, select Close All.

3. Click the toolbar Start | button to reopen the Start Page.

4. Select the Activities link on the left-hand side of the Start Page.

5. Select the Component Testing link.

6. In the Application Files window, notice how all the Ada source files of your development project are already

visible. For this tutorial, you will directly select two additional source files. Click the Add 1 button.

7. Browse to folder into which you have installed Test Embedded and then access the folder \examples
\TestSuiteAda\src

Make sure All Ada Files in the Files of type dropdown box is selected, then select the following files:

« CodeCoverage.ads

« CodeCoverage.adb

Now click the Open button.
You should see all the source files in the list of the Application Files page.

Select the Compute static metrics option. This allows the measurement of code complexity from which you can
prioritize your test campaign.

Click the Next button.

1. In the Components Under Test window, you are asked to specify which functions you would like to test. There
are a variety of ways for making this decision. One method is to use the static metrics that have just been

automatically calculated. Certain measurements of code complexity are listed for you:

2. > V(g) - Also called the Cyclomatic Number, it is a measure of the complexity of a function that is
correlated with difficulty in testing. The standard value is between 1 and 10. A value of 1 means the

code has no branching. A function's cyclomatic complexity should not exceed 10
- Statements - Total number of statements in a function.

> Nested Level - Statement nesting level.

Sorting by any of these metrics columns - by left-clicking a column header - lets you prioritize your test selection,
choosing the more complicated functions first.
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Additional metric information can be viewed by selecting the Metrics Diagram button on the lower right-hand side
of the screen. Selection of this button opens a graph enabling visualization of two, selected static metrics graphed
against one another. Select a data point in this graph to indicate your desire to test the associated functions.

For this Tutorial, your test selection is based on the desire to increase code coverage, so the static metrics do not
affect your decision.

1. Click the box to the left of the CodeCoverage.adb file.

2. Click the Next button.
In the Test Script Generation Settings window, you are asked to make two decisions

« If you've selected more than one function to test, do you want all functions to be part of the same test script
(Single Mode) or do you want each function to be assigned to its own test script (Multiple Mode). A single test
script would be easier to manage, but multiple test scripts let you provide custom Configuration settings to

each test.

« Do you want Test Embedded to make some basic assumptions about test harness and test stub generation?
If so, use Typical Mode; if not, use Expert Mode.

1. Type MyAdaTest in the Test Name field. Leave the default selections. You will be creating a single test script

that automatically stubs all referenced but undefined functions. Click the Next button.

2. You should now be viewing the Summary window. Click the Next button.

The Component Testing Wizard now analyzes the source code in CodeCoverage.adb and CodeCoverage.ads and
creates a test for every function within it.

1. When test script generation has completed, click the Finish button.

In the Project Browser tab of the Project Explorer window on the right-hand side of the screen, you should now see a
component test node named MyAdaTest.

& 9?-4 uProject
e = L?My.ﬁ.daT et
+- Results
o {3 CodelCoverage. ptu
é‘j CodeCoverage. adb
o 4@ CodelCoverage. ads

159



HCL DevOps Test Embedded

Conclusion of Exercise One

The advantages of automated testing is that it enables regression testing - that is, it ensures nothing regresses. Just
because code appeared to be functional in Build X, doesn't mean that code will continue to be functional in Build X+1.

Few would dispute the usefulness of component testing, but many would claim there is not enough time to do it.
Every effort has been made to simplify this process in Test Embedded so that you can simply focus on making good

tests, getting readable results, and making quality code.

Exercise 2

In this exercise you will:

- review the generated component test
« improve the generated component test

« execute the component test

Editing the generated component test for Ada

The Component Testing Wizard analyzed the CodeCoverage source files and produced a test script called
CodeCoverage.ptu. What does this test do?

To edit the generated .ptu script:

1. In the Project Browser tab on the right-hand side of the screen, open the file CodeCoverage.ptu by double-
clicking it.

2. Maximize the test script window that has just opened, closing the lower Output Window to free up some
additional space.

3. Click the Asset Browser tab on the right-hand side of the screen and select the By File sort method.

On the Asset Browser tab you now see each of the functions listed as a child of the test script CodeCoverage.ptu.
Each function requires its own test; all test scripts are stored in the .ptu file. Back on the Project Browser tab, you'll
notice that the .ptu file is associated with the source file upon which it was based. The idea is that when you build
the MyAdaTest component testing node, you are actually building a test harness comprised of the .ptu file, the
original source files and any stubs required for the simulation of as yet undeveloped code. The build process and
test execution, as you recall, is managed by the information stored in a Configuration which, in turn, is based on the

information stored in a Target Deployment Port.

Component testing scripts for C and Ada are written with a compiler-independent test script API. For detailed
information about the script layout, take advantage of the Reference Guide accessible via the Help menu. For the

tutorial, only critical script elements will be pointed out.

In the Asset Brower tab, double-click the SIMPLECONDITION function (child node of CodeCoverage.ptu).
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SERVICE blocks in a test script:

Each function in the file under test is assigned its own SERVICE block. Each SERVICE block can consist of one or

more Test blocks. Each Test block consists of data-driven calls to the function under test.

See the Service block for the CodeCoverage.ptu function SIMPLECONDITION. It is followed by native Ada language
calls (indicated by the # symbol) used to declare the variables X and Ret_SIMPLECONDITION that are passed to the
function SIMPLECONDITION.

The variable declarations are followed by an Environmentblock. The Environment block is used to define input (called
init - i.e. initial) and output (called ev - i.e. expected value) values for the variables passed to the function under test.
In the Environmentblock for the SIMPLECONDITION service block, X is initialized to 0 and has an expected value of
init - that is, a value of 0, the initial value. Ret_SIMPLECONDITION is initialized to 0 with an expected return value of 0.

The TEST 1 block for SIMPLECONDITION consists of a call to this function.
A return value is expected - referred to as:
#Ret_SIMPLECONDITION:=CODECOVERAGE.SIMPLECONDITION(X);

You now understand Test Embedded component testing test script for Ada.

For the purposes of performing useful work, the test script needs to be more detailed than it is immediately following
generation. You need to create good tests that supply relevant input values and then verify appropriate output values.

Rather than writing it yourself, a revised test has been created for you.

Customizing a component test for Ada

A customized component test script has been created for you. This test will be used to test the functions within
CodeCoverage.ads and CodeCoverage.adb in particular, the function SIMPLECONDITION, which contains a
conditional loop.

Normally, it is up to you to rewrite the test script based on the skeleton provided by the Component Test wizard
and the specifications of your code. For this tutorial, let's just replace the generated test script with a completely

functional one.

To customize the test:

1. Select the menu item Window->Close All

2. Select the Project Browser tab on the right-hand side of the screen, select the CodeCoverage.ptu node (child

of the MyAdaTest component testing node), and then select the menu item Edit->Delete.

3. Right-click the MyAdaTest component testing node and select Add Child->Files...
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4. In the Files of Type dropdown box, select the C and Ada Test Scripts option, then browse to theTest
Embedded installation folder and Open the file \examples\TestSuiteAda\CodeCoverage2.ptu

5. After this new test script is analyzed by Test Embedded, your screen should appear as follows:

o &Mypmiect
e = %MyﬁdaTest
+- Results
%
& .%j CodeCoverage. adb
o % CodeCoverage. ads

1. Double-click the node CodeCoverage2.ptu, and maximize the test script window.

2. Bring the SIMPLECONDITION test blocks for CodeCoverage2.ptu into view using the Asset Browser tab. (The
Asset Browser tab continues to reference the original test script - CodeCoverage.ptu - because it still exists

on your machine - it is simply no longer referenced by any tests.)

3. As you can seeg, two Test blocks are now part of the SIMPLECONDITION service block. In TEST 1 the initial
value of X has been set to -1 and the expected value for Ret_SIMPLECONDITION has been set to -1. In the
second Test block, the initial value of X has been set to 1 and the expected value for Ret_SIMPLECONDITION
has again been set to -1.

Running a component test for Ada

Running a component test is as simple as it was to build and execute the application used in the runtime analysis

exercises.

To execute the test:

1. From the File menu, select Save Project.
2. From the Window menu, select Close All

3. On the Project Browser tab, select the MyAdaTest component testing node and then press the Buildl# toolbar

button.

4. The test is executed as part of the build process - you will know the test has finished executing when the

green execution light on the lower-right of the Ul stops flashing.

You may have forgotten that the runtime analysis tools are still selected in the Build options; the files under test -
CodeCoverage.adb and CodeCoverage.ads - are instrumented for code coverage analysis.

1. In the Project Browser tab on the right-hand side of the screen, double-click the MyAdaTest component

testing node in order to open the test report and Code Coverage report.
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What is the result of your tests?

Conclusion of Exercise Two

The component testing test scripting language for C and Ada gives you enormous data-driven testing power with
minimal effort. This compiler-independent language lets you build tests that can be used with any embedded target,
so you'll never have to change your tests when the architecture you're writing for changes.

As for test script execution, this is accomplished through the Test Embedded interface regardless of the target. The
Target Deployment Port takes care of everything; there is no distraction from the task at hand - making quality tests
and then fixing problems as they are exposed.

Exercise 3

In this exercise you will:
- analyze the results of the improved component test
« continue to increase code coverage
- repair the uncovered defect

- rerun your test to verify that the defect has been fixed

The Ada component test report

The component testing report summarizes all of the test results. It is hyperlinked to the test script (the .ptu file) and

can be browsed using the Report Browser on the left-hand side of the screen..

1. Close the Project Explorer window on the right-hand side of the screen as well as the Output Window at the
bottom of the screen to free up space.

2. Select the Test Report tab to ensure the component testing report is active, and then maximize this window
At the top of the report is an overall summary of test execution. Notice the Passed and Failed items.

1. In the Report Window on the left-hand side of the screen, double-click the node Test 1 (a child node of the
node SIMPLECONDITION:
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= @ Test #rd
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@ Test Coverage
= s Test 2
- /) Element 1
4% Test Coverage
é%'j Service Coverage
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Looking at the component testing report, you can see:

» General test information
« Initial, expected, and obtained values for all variables involved in a test

« Code coverage information

As you can see, both Test 1 and Test 2 failed. By looking at the report, you will find out that they both failed because
RET_SIMPLECONDITION returned a value of 1 whereas the expected value was -1.

You can click the variable name in the report to navigate to the corresponding line in the test script.

Have a look around if you wish. Your next concern should be to look at the code coverage information.

The Code Coverage report

To switch to the Code Coverage report, select the Code Coverage tab. In the Report Browser, expand the
CodeCoverage node. The Report Browser should look like this:

=" "3 Roat
(= = 4% CodeCoverage.adb
[ = '@Endetwerage

i@ TEST

[ % SimpleCondition[= in integer] return integer %
| &) cal
=1 % SimpleConditionwithimplicit{: in integer) retum integer
[ % AndCondition[=: in integer] return integer
[ % OiCondition(x: in integer] retum integer
=] % Sumlx: in integer] return natural
= % CheckCoverageStatement{cond] , cond2, cond?, condd, condS: in boolean) retum float
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Notice how the functions Sum was only partially covered by the test, and call was not covered at all. In the Report
Browser, double-click CheckCoverageStatement. This takes you to the portion of code which has not been covered.

Just as before, non-covered statements are in red.

Click on the loop indicators. This displays a popup showing the coverage depending on the number of loops executed

by the statement.

function Sumlx: ininteger) return natural iz
surihfalue: natural ;= 0;
beain
for ide i reverze 0 [x-1] .
sunm alue: =zurm' alue Logical blocks:
end loop; Ulaop
return [zum' alue); "\ﬂ_n) 1 loop
e 2 loopz or mare

To summarize, the execution of our test produced:

» Two failed tests

« Incomplete coverage of code during the test

The higher the coverage rate, the more complete are the tests. Increasing test coverage can detect more defects,

therefore it is important to aim for a high coverage rate.

Now, let's address these issues.

Updating and running the component test

As you noticed, there are many commented lines in the CodeCoverage2.ptu test script.
To increase the code coverage, let's uncomment all the commented blocks in the script.
To do this, open the CodeCoverage2.ptu test script.

To uncomment multiple lines of code:

1. Select the blocks of code.

2. Click the red -- icon in the editor toolbar.

3. Repeat the operation until all the commented blocks are uncommented.

4. From the File menu, select Save to save your changes to the Unit Testing test script.

5. From the Window menu, select Close All.

To rerun the test:
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1. In the Project Browser tab on the right-hand side of the screen, click the MyAdaTest component testing node
and then click the Build[* toolbar button.

2. The test has finished executing when the green execution light on the lower right of the Ul stops flashing.

You should have now achieved proper code coverage.

Repairing a defect

Fortunately, increased code coverage did not expose any new defects, but TEST 1 and TEST2 of the
SIMPLECONDITION service are still producing a failed result.

To fix the defect:

1. In the Project Browser tab on the right-hand side of the screen, right-click the MyAdaTest component testing

node and then select View Report>Test

A failure is reported in the component testing report, so the effort to improve coverage has resulted in the discovery
of a new defect. The Report Window on the left-hand side of the screen flags this error nicely.

1. In the Report Window, select one of the Element 1 nodes that has a Failed#$ symbol to its left.

Given X equal to 1 or -1, the SIMPLECONDITION function is supposed to return a RET_SIMPLECONDITION value of
-1. However, this did not happen. RET_SIMPLECONDITION has a value of 1, thus creating a defect.

1. Open CodeCoverage.adb and use the Asset Browser to locate the SimpleCondition function and change the

line:
if (x<0) then
to:
if (x>0) then
1. From the File menu, select Save.

This should fix the problem.

Verifying the success of your repairs

As you have now learned, tests always need to be rerun and reports should always be checked.

To validate the repair:
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1. From the Window menu, select Close All.

2. In the Project Browser tab on the right-hand side of the screen, left-click the MyAdaTest component testing
node and then click the Buildl# toolbar button.

3. The test has finished executing when the green execution light on the lower-right of the Ul stops flashing.
4. Double-click the MyAdaTest component testing node to view all of the reports.

5. Select the TestReport tab.
When looking at the Report Windowto the left, you will find that the defect has been repaired.

1. Select the menu item File->Save Project.

Conclusion of Exercise Three

One can never be too vigilant in the embedded industry. Quality just isn't an option, so every care must be taken to
ensure defects don't slip through the cracks. The last thing your team needs are frantic, last-minute code bashing
sessions or - even worse - shipping what you know to be defective code. And of course, that's not even possible in

industries with stringent certification standards.

You need to check everything. But how is this possible when shipping dates don't slip and you're under enormous
pressure to produce? Test Embedded is the answer. All the tedious tasks are automated, and great care has been
taken to ensure you get your job done without losing precious development time.

Is it possible to develop a defect-free product? It's certainly not possible if you don't test. But if you do test, and test

well, who knows...

Proactive Debugging

As software complexity increases, developers must become more responsible for their contribution to the overall
development project. It is becoming harder and harder for the developer to consider robust, end-to-end testing of their

code an unachievable luxury.

In fact, developers need to proactively debug - that is, treat testing as an integral part of the development process,

rather than waiting for defects to force their hand.

And why should this not be achievable? The advantage of proactive debugging is that it is manageable - testing is
only performed on the code known intimately well by the developer (barring the case of inherited code, where the
runtime tracing feature plays such a crucial role). There is little chance for confusion, so the time spent developing
and deploying tests are optimized. Defects are eliminated early, ensuring that any system level defects that

have slipped through the nets won't find their origin deep in the code. And test independence - due to the Target

Deployment Port technology - ensures test reuse despite changes in target architecture.
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Matters improve further when one considers the built-in integration that Test Embedded possess with other products

from software. Test Embedded is integrated with:

« ClearCase - Out-of-the-box integration with ClearCase the industry's clear market leader for version control

software. Go here to access to the ClearCase website:
http://www.ibm.com/software/awdtools/clearcase/

« ClearQuest - Out-of-the-box integration to ClearQuest, the premier change management utility for diversified
software teams. Submit context-sensitive defect reports directly from the Test Embedded interface. Go here

to access to the ClearQuest website:
http://www.ibm.com/software/awdtools/clearquest/

« IBM Rational Unified Process - Tool mentors help you implement various features of Test Embedded,
conceived in the RUP framework - a mature, field-tested guide to the software development process. Go here

to access to the IBM Rational Unified Process website:

http://www.ibm.com/software/awdtools/rup/

Conclusion

Component testing is probably the type of testing that comes to one's mind when considering the minimal amount of
effort one must make to ensure a defect-free product. As these exercises have shown, component testing is a non-

trivial activity.

Imagine a world in which no tool exists that can automate stub, driver, and harness creation, in which no tool can
automate data-driven tests. No wonder that testing is typically viewed negatively by developers. Again, it's not that

anyone feels testing is unimportant. But how repetitive and work-intensive!

To make matters worse, without code coverage the best tests in the world are run in a vacuum. How do you know
when you are finished? How do you know what test cases have been overlooked?

Use Test Embedded to simplify your component testing of C functions and Ada functions and procedures. All the
tedious tasks are automated so you can focus on good tests. Test boundary conditions. Try inputs that would "never"
happen. And let the test scripting API generate an overabundance of inputs; why not, considering no additional effort

is required on your part.

Perhaps now you can see how Test Embedded, combined with the runtime analysis tools reviewed in the last group of
exercises, provides you with full regression testing capabilities without having to sacrifice time better spent creating

quality code.
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Target deployment port tutorial

The aim of this quick example is to demonstrate how to create and validate a new TDP on Windows. The same

principles apply to other platforms: just replace Windows with the native or target platform of your choice.

Tutorial Preparation

An example project for this tutorial, names add.rtp, is provided with Test Embedded in the /examples/TDP/tutorial

directory.

The TDP for this tutorial is based on the MinGW (Minimalist Gnu for Windows) C compiler distribution. MinGW is a
collection of header files and import libraries that allow one to use GCC and produce native Windows32 programs
that do not rely on any 3rd-party DLLs.

The MinGW distribution includes GNU Compiler Collection (GCC), GNU Binary Utilities (Binutils), GNU debugger (Gdb) ,
GNU make, and various other utilities.

To obtain a copy of the MinGW environment:

1. Connect to http:/www.mingw.org
2. Locate and download the latest complete MinGW distribution.

3. Follow the instructions provided with the distribution for installation and configuration.

Tutorial Steps

This Tutorial will guide you through the steps of creating, modifying and debugging TDP, using custom /0 functions, a
debugger and defining a break point strategy.

« Move on the first section: Creating a target deployment port on page 169

Creating a new TDP

In most cases, you will not create a TDP from scratch but rather base your new TDP on an existing TDP template. In
this example, you will adapt an existing TDP gccmingw_template.xdp to your own environment.

The TDP file format is .xdp, as in XML Deployment Port. There are file-naming conventions when creating a new TDP:
« ¢ fora C or C++ TDP, a for an Ada TDP.
« An acronym for the target platform host, in this case call it wingcc for Windows GCC.
« The name of the development environment mingw

Therefore, our TDP filename shall be cwingccmingw.

All TDPs are located in the following directory:

<install_dir>/targets/xml/<tdp_name>.xdp
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where <install_dir> is the installation directory, and <tdp_name> is the name of the TDP.
To start the TDP Editor:

In Test Embedded Studio, from the Tools menu, select Target Deployment Port and Start Editor, or select Target
Deployment Port Editor from the Windows start menu.

or
From the command line, type tdpeditor.

To open a TDP template:

1. In the TDP Editor, from the File menu, select Open.

2. In the targets subdirectory, select the gccmingw_template.xdp TDP file.

3. Right click the Top level node in the tree-view pane: Gnu 2.95.3-5 (mingw).

4. Select Rename.and enter a new name for this TDP: My_MinGW. This name identifies the TDP in Test
Embedded GUI.

5. In the Comment for the root node section, enter contact information such as your name and email address.

This makes things easier when sharing the TDP with other users.
To save the new TDP:

1. From the File menu, select Save xdp As,

2. Save your new TDP as cwingccmingw.xdp.

3. From the File menu, select Save and Generate. The TDP Editor automatically creates a directory named
cwingccmingw and all the files required for the TDP in that location.

4. Move on the next section: Editing a TDP on page 170

Editing a TDP

The TDP Editor is made up of four main sections:

- A Navigation Tree: Use the navigation tree on the left to select customization points.
« A Help Window: Provides direct reference information for the selected customization point.
- An Edit Window: The format of the Edit Window depends on the nature of the customization point.

« A Comment Window: Lets you to enter a personal comment for each customization point.

In the Navigation Tree, you can click on any customization point to obtained detailed reference information for that
parameter in the Help Window.

The Navigation Tree covers all the customization points of the TDP. There are four main sections:
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- Basic Settings: This section specifies default file extensions, default compilation and link flags, environment
variables and custom variables required for your target environment. This section allows you to set all the
common settings and variables used by Test Embedded and the different sections of the TDP. For example,
the name and location of the cross compiler for your target is stored in a Basic Settings variable, which is
used throughout the compilation, preprocessing and link functions. If the compiler changes, you only need to

update this variable in the Basic Settings section.

.

Build Settings: This section configures the functions required by Test Embedded GUI integrated build process.
It defines compilation, link and execution Perl scripts, plus any user-defined scripts when needed. This section

is the core of the TDP, as it drives all the actions needed to compile and execute a piece of code on the target.

.

Library Settings: This section describes a set of source code files as well as a dedicated customization
file (custom.h), which adapt the TDP to target platform requirements. This section is definitively the most
complex and usually only requires customization for specialized platform TDPs (unknown RTOS, no RTOS,

unknown simulator, emulator, etc.)

.

Parser Settings: This section modifies the behavior of the parser in order to address non-standard compiler
extensions, such as for example, non-ANSI extensions. This section allows Test Embedded to properly parse

your source code, either for instrumentation or code generation purposes.

On the right hand side of the TDP Editor window, the embedded Help provides contextual reference information for
the part of the TDP that is selected in the tree-view pane.

To Edit the new TDP:

Use the TDP Editor's tree pane to navigate through the customization points of the TDP, and make the following
changes:

1. Under Basic Settings: Change the ENV_PATH and STD_INCLUDE customization points in both the For C
and For C++ nodes. ENV_PATH updates the PATH environment variable in order to invoke the gcc compiler
directly. STD_INCLUDE specifies the location of the standard GCC libraries.

For example:

ENV_PATH "C:\Gcc\bin";SENV{'PATH'}
STD_INCLUDE "C:\Gcc\lib"

Note:

When you change a customization point in the TDP Editor, it is generally a good idea to add a note in
the Comment box. This makes later modification and TDP sharing much easier.

2. In the same manner, check all the other Basic Settings customization points to ensure that they reflect the
correct paths and filenames used with the MinGW distribution.

3. Under Build Settings: No changes should be required here, but have a look at the Compilation Function.
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4. Locate the corresponding Perl script and have a look at the Help window to understand how the atl_cc routine
works.

5. Next, look at the Link Function to understand the alt_link Perl routine.
Note: All the parameters used by these Perl routines are set in the Basic Settings section of the TDP.

6. Under Library Settings: No changes are required at this point.

7. Under Parser Settings: In this section, you must tell the Test Embedded code parser where the std GCC
libraries are located. Do this as required for each of the features that you plan to use with this TDP.

8. Save the TDP.

Any changes made to the Basic Settings section of a TDP are read from Test Embedded GUI and applied to
the project. For this reason, whenever you modify the Basic Settings of a TDP that is currently used in a Test
Embedded project, you must reload the TDP into the project.

To reload the TDP in Test Embedded:

1. In the From the Project menu, select Configurations.
2. Select the TDP and click Remove.
3. Click New, select the TDP and click OK.

You have created your first TDP. The next step is to validate the new TDP in Test Embedded.

Move on the next section: Validating a New TDP on page 172

Validating a target deployment port

After a TDP has been created or modified, the first step is to validate that it works correctly on the target.
The first step is to change the TDP used by your project.

To make sure that your TDP is working properly, you must create a Component Testing test node and run it with all
the relevant Runtime Analysis tools enabled. Once the following steps are covered, you can consider that your TDP is
fully functional:

- Create a new Configuration Test Embedded
 Apply the new Configuration to a project

- Validate the compilation sequence with the new Configuration

Creating a new Configuration

In Test Embedded, the TDP is part of a Configuration. Each Configuration is based on a TDP, plus the particular

Configuration Settings that are specific for each node of the project.

This means that you can base several slightly different Configurations on a single TDP.
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To create a new Configuration in Test Embedded:

1. In Test Embedded, open the add.rtp example project.

This example project provides a series of test nodes for demonstration of Test Embedded features. For
this tutorial, concentrate on the add test node, which contains a simple add.c source file as well as the
corresponding add.ptu test script.

2. From the Project menu, select Configurations. Click New.
3. In the New Configuration box, enter a name for the new Configuration, and select the TDP on which it shall be
based.

For our example, select your newly created MinGW TDP. Notice that two items appear in the list, one for C,
another for C++ followed by the same name. Select the C version of the TDP.

4. Click OK, Close and save the project. Update the TDP in the project.
Applying a Configuration to a Project
Now that the new Configuration has been created, based on your TDP, you need to select it for use in your project.

Although a project can use multiple Configurations, as well as multiple TDPs, there must always be at least one active
Configuration.

TDP is used when selected from the Build combo-box, but remember that you have to be consistent between the TDP

programming language selection and the source files used within your test environment.

To change the current Configuration of a project:

1. From the Build toolbar, select the Configuration you wish to use in the Configuration box.
2. Update any project settings if necessary.

Validating the Compilation Procedure

In order to validate the compilation sequence, the idea is to successfully compile the current project with the new

Configuration.

To validate the compilation procedure:

1. In the Project Explorer, select a single source file.

2. From the Build toolbar, click the Build Options~ button and clear all Runtime Analysis features (Memory
Profiling, Performance Profiling, Code Coverage and Runtime Tracing) to ensure that these do not affect the
build sequence.

3. Select the add.c source file.

4. From the Build toolbar, click Build[>.
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The compilation should end with a Passed status. If not, restart the TDP Editor and change the atl_cc Perl

procedure accordingly.

You can repeat the same action for the following Perl procedures:

- atl_cpp: Preprocessing routine for Source Code Insertion
« atl_link: Link routine
- atl_exec: Execution routine

- atl_execdbg: Debugging routine

The compilation procedure is validated. You can now consider using the Test and Runtime Analysis features of Test
Embedded on your project.

The next section provides help about debugging any compilation issues you may have encountered.

- Move on the next section: Debugging a TDP on page 174

Debugging a TDP

If everything does not work as it should, the following method might help you troubleshoot TDP issues with HCL
DevOps Test Embedded (Test Embedded).

To troubleshoot a TDP:

1. Set the ATTOLSTUDIO_VERBOSE environment variable to 1. The exact procedure to do this depends on your
operating system.

2. Test Embedded GUI does not automatically inherit the Windows environment. Therefore you must save the
project, close and relaunch the GUI.

3. Ensure that the correct TDP is selected. From the Project menu, select Configurations and click New to select
the new TDP if necessary.

4. Decompose the complete build process into multiple steps. To do this, click the Build Options () button,
clear the All option and select only the first step of the compilation sequence (Source compilation). Clear any
Runtime Analysis tools.

5. Select the source file under test (add.c in this example) and click BuildL:.

6. Repeat the same operation for each other compilation step and source file until the whole node can be
successfully processed.

This should provide adequate feedback to help you debug each individual step of the compilation sequence.

In the current example, any problems encountered will usually be related to an incorrect file path in the Basic Settings
of the TDP.

Move on the next section: Customizing a target deployment port on page 175
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Customizing a TDP

This section of the Tutorial will demonstrate how to use the customize input-output (I/0) communication and break-

point usage in order to address a target system without standard I/0 functions.
First, create a new TDP based on the one created previously.

To create a new TDP:

1. Open the cwingccmingw.xdp TDP in the TDP Editor
2. Select the top-level node and rename it My MinGW UserMode.
3. From the File menu, select Save xdp As to save the new TDP as cwingccmingw2.xdp.

4. Collapse all the nodes in the Navigation window as this section concentrates only on the Build Settings and
Library Settings nodes of the TDP Editor.

Library Settings

You first need to specify the I/0 user mode, which means disabling the standard 1/0 mode for data retrieval on the

target.

By default, when executing a program compiled with Test Embedded the test data is dumped to a file on the file
system by using the standard fopen, fprintf and fclose functions. On some platforms, these primitives are not

available hence the need to use a set of user-defined I/0 functions that allow the TDP to access the File System.

To change Library settings:

1. Expand Library Settings, Data retrieval and error message output and select Data retrieval to locate the
RTRT_IO macro definition.

In the combo-box for RTRT_IO you can select:
2. o RTRT_NONE: No I/0 available
o RTRT_STD: Standard I/0 functions (fopen, fprintf and fclose)
o RTRT_USR: User-defined 1/0. This option enables the customization tabs.
3. Select RTRT_USR. Look at the user defined 1/0 primitives used to access the File System: usr_open,
usr_writeln and usr_close.

Notice that usr_writeln() contains the following statement

printf("$s",s);
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1. From the File menu, select Save and Generate.
2. Update the Configuration in Test Embedded to use the My MinGW UserMode TDP, and Build[> your sample
project.

This build should fail. The message console should display the following information, or similar:
Executing gcc_step1\Histo.exe ...

gcc_step1\Histo.exe

PU "Histo"

HO".."

01

NT "Initialization" 0 0

DTO

A32 OKRA=T

NT "Termination" 61 41

DT O

FT 91e544¢5DC 0b72d3c1

PT "Termination"

PS000

PYOOO

QT "Termination"

QS 91e544c5 7965f082

NO "2 (Max Calling Level reached)"
Cl Oh

Splitting 'gcc_step1\THisto.rio' traces file...
Traces file successfully split.

No RIO instruction found.

Errors have occurred.
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This message shows that:

« ASCII character data was dumped from the program directly to the standard output of the executable through
the printf directive.

- Test data output is encoded information that only the Test Embedded Report Generator is able to understand.

- The trace file is empty. Although the split is successful, no instructions are found and an error message is

produced.

Therefore, for the build to be successful, you must provide the Report Generator with a valid trace file.

Build Settings
The Execution function is a basic command that produces an output file that redirects the standard output to Sout.

To change Build settings:

1. In the TDP Editor, expand the Build Settings and select Execution function.
The following code is displayed:
sub atl_exec($%$)
{my ($exe,$out,Sparameters) = @_;
unlink($out) ;

SystemP("$exe $parameters");

}

2. Change the SystemP line to:

SystemP ("Sexe $parameters >$out");

3. Save the TDP, update the Configuration in Test Embedded and Buildl* your sample project.

This time, the execution should run smoothly and produce complete reports. If not, rework the above functions until

the execution is successful.

Move on the next section: User-defined 1/0 Primitives on page 177

User-defined 1/0 primitives
This section demonstrates how to define your our own 1/0 primitives for the dump phase.
Again, create a new TDP based on the one created previously.

To create a new TDP:

1. Open the cwingccmingw2.xdp TDP in the TDP Editor
2. Select the top-level node and rename it My MinGW UserMode2
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3. Save the current TDP as cwingccmingw3.xdp.
4. Collapse all the nodes in the Navigation window as this section concentrates only on the Build Settings and
Library Settings nodes of the TDP Editor.

To set up user-defined I/0 primitives:

1. Expand Build Settings and select the Execution function.
2. Delete the >Sout parameter that was added to the SystemP statement:

SystemP("Sexe $parameters");

1. Expand Library Settings, Data retrieval and error output and select Data retrieval to locate the RTRT_IO macro
definition.

2. Select the RTRT_USR entry.

3. On the Settings tab, in RTRT_FILE_TYPE, change int to FILE*.

4. Add your own code for the following functions:

o usr_open function:

printf("...0pening file...\n");
return(fopen(fileName,"w"));Add your own code for the usr_init function:
return(null); Add your own code for the usr_w

> usr_init function:
return(null); Add your own code for the usr_writeln function:

printf("...Dumping : %s\n",s);
fprintf(f,"%s",s);

> usr_close function:

printf("...Closing file...\n");
fclose(f);

5. Save the TDP, update the Configuration in Test Embedded and Build[> the add.c example.

The examples described here make no sense in real life as they are functionally identical the standard 1/0
mechanism. However, they show how easy it is to map user-defined I/0 primitives to the data retrieval mechanism

implemented by the TDP.

Move on the next section: Using a Debugger

Using a Debugger

Before moving to the next step we need to understand how HCL DevOps Test Embedded (Test Embedded) uses the
GDB debugger command. This function is called when the Debug build option is selected in the GUI.

Note This is NOT a break-point strategy. The Debug option merely allows you to manually inspect application

execution.

To build a node in Test Embedded Debug mode:
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1. In the Project Explorer, select the project node.

2. From the Build toolbar, click the Build Options+ button and select Debug in the Build Options window.
3. In the Project Explorer, select the add.c node.

4. From the Build toolbar, click the Build [ button.

This runs a command line window with the GDB up and running.
Using the Debugger

In the GDB window, type the following commands:

break priv_writeln

break priv_close

display atl_buffer

run

If you type ¢ or cont for continue you should see the atl_buffer contents changing and showing information similar to

what you obtained in the Message Console with the printf command.

Debug Results

The priv_writeln and priv_close primitives are implemented within the TDP. The former is interpreted as a dump
request event, whereas the latter is an end of execution event.

The atl_buffer symbol (default size is 1024 bytes) dynamically gathers information from the test execution.

The objective is to produce a file on the file system just as we did with the standard 1/0 functions or the user-defined
1/0 functions. When a break point strategy is required, the manual process you have just accomplished must be

somehow automated.

Move on the next section: Break Points on page 179

Break point mode

Using Break Point mode can be summed up as the following tasks:

» Compile, link and load the executable in the debugger. This is typically handled by the GUI, so no action is
required.

« Dump the content of atl_buffer each time the break point on priv_writeln is met.
« Quit the debugger when the priv_close is reached

« Ensure sure that the file produced is ASCII
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To do this, you must specify a break point for I/0. This means that you will no longer use the standard I/0 or the user-

defined 1/0 functions.

To disable I/0 functions:

1. Expand Library Settings, Data retrieval and error output and select Data retrieval to locate the RTRT_IO macro

definition.
In the combo-box for RTRT_IO you can select:
2. o RTRT_NONE: No I/0 available
o RTRT_STD: Standard I/0 functions
o RTRT_USR: User-defined I/0. Only this option allows you to access the customization tabs.

3. Select RTRT_NONE. This is the typical choice when on limited target platforms with no operating system and

no file system.

Dumping the Buffer

You need to dump the content of atl_buffer each time the break point on priv_writeln is encountered. The way to do
this, without a file system, is to specify how to use the gdb debugger command line in the atl_exec Perl script.

The debugger documentation explains how to call gdb and how to automate the use of the debugger through a

command script.
To invoke the debugger from the atl_exec:
1. Expand Build Settings and select Execution function to locate the atl_exec Perl function.
2. Comment the existing command line with a # character.
3. Add the following lines to invoke gdb:
my Scmd="STARGETDIT\\cmd\\run.cmd";
SystemP("gdb -se=Sexe -command=$cmd > stdout.log");
1. Right-click Build Settings and select Ascii File. Rename the created file to run.cmd.
2. Copy the contents of the run_example.cmd file, provided in the example directory, into the run.cmd file.

3. Save the TDP, update the TDP in the project, and Build[>* the add.c node.
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Converting Data to ASCII

Depending on the cross development environment, the format of the dumped data can vary largely from one target to
another. In most cases, the results must be decoded and converted to ASCII data in order to be processed by the Test

Embedded Data Splitter and Report Generators.
You need to decode the dump data to ASCII with a Perl routine by using the Perl subroutine named decode.pl.

To decode dump data to ASCII:
1. Save the TDP, update the Configuration in Test Embedded and Build[> the add.c node.

Test Embedded returns an error: the dump accomplished by the debugger does not produce a plain ASCII file as

expected.

1. Look at the result file created by GDB. The relevant data is present but is represented in hex and mixed with

other information.
2. Open the decode.pl Perl script in a text editor, provided with the example.
3. In the TDP Editor, expand Build Settings and select Execution function to locate the atl_exec Perl function.
4. Copy-paste the contents of the decode.pl Perl script into the atl_exec Perl function after execution of gdb.

5. Save the TDP update the TDP in the project, and Build(> the add.c node.

This time, everything should work as expected and you should be able to view the reports generated by the execution.

Congratulations! You have completed what is probably the most complex part building a TDP.
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This guide describes tasks that you can perform to test application code in HCL DevOps Test Embedded for Eclipse
IDE. This guide is intended for testers or test execution specialists.

Testing with DevOps Test Embedded for Eclipse IDE

Read these topics to learn how to use the product.

Getting started with DevOps Test Embedded for Eclipse IDE

HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE) is designed to integrate into your
existing Eclipse-based tool chain. Use this section as a guide to a typical workflow for testing and evaluating your C

source code in the Eclipse CDT environment.
Before you begin

These guidelines assume that you have some familiarity with the following concepts and tools:

» The Eclipse CDT development environment.
« The features and tools provided by Test Embedded.
« The target platform on which you plan to run the tests.

About this task
It is important to understand the concepts and assets used by the product.

To start using Test Embedded:

1. Familiarize yourself with the features and tools provided by the product. See Overview on page 29 and Test
assets overview on page 365.
2. Choose whether you are going to create a new project or import an existing CDT project.
Choose from:
o If you already have an Eclipse CDT project, import the project into Test Embedded for Eclipse IDE and
convert it into a Test Embedded project. See Importing C projects on page 183.
> If you are starting a new C project or if want to import an unmanaged C project into Eclipse, create a

new Test Embedded project and import the source files. See Creating test projects on page 367.

Note: There is currently no migration path from Test Embedded Studio test scripts and command line

tools into the Test Embedded for Eclipse IDE environment.

3. Verify that the C source files build and run correctly.
Resolve any compilation errors if necessary.

4. Open the call graph to view the structure of your source code and create a new test harness. See Creating test
harnesses from the call graph on page 380.

The generated test harness contains a test case, and optionally a stub behavior.
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5. Open the test case and edit the initial and expected expressions for the each variable check. See Editing test
cases on page 371.

6. Run the test harness and compare the obtained values with the expected values for each variable in the test
case editor. See Running a test harness on page 387.
If necessary, repeat from step 4 to ensure that you obtain a passed test result.

7. Generate a test report from the results. See Generating test reports on page 1176.

8. Deploy and run your test on the target platform by changing the test configuration and running the test again.
See Switching test configurations on page 384.

What to do next
Once your test harness is running correctly, you can use more of the features of the product:

» Measure code coverage, memory profiling, performance profiling, and static metrics with the runtime analysis
tools. See Runtime analysis overview on page 184.

- Include test data sets from data pools and create data dictionary to reuse data sets. See Creating data pools
on page 378 and Data dictionary overview on page 377.

- Create more test harnesses or add test cases and stubs to existing test harnesses.

« Create test suites to run multiple test harnesses and compare their results. See Creating test suites on
page 385.

* Integrate test suites into IBM® Engineering Test Management. See Engineering Test Management integration
on page 70.

Importing C projects

You can either create a new C project with the Eclipse CDT tools or you can import your existing C source files or
Eclipse projects into your HCL DevOps Test Embedded (Test Embedded) workspace.

About this task
Test Embedded can only work with its own CDT managed build toolchain. Therefore, imported projects must be

converted to Test Embedded projects.

To import an existing C project:

. Click File > Import > General > Existing projects into workspace.

. Follow the wizard to import the project into the workspace.

. After importing, right-click the project and select Convert to Test Embedded Project.
. Select the default target deployment port (TDP) for the project and click Finish.

a A WON =

. If you have not already enabled CDT indexing, click Window > Preferences > C/C++ > Indexer, select Index

unused headers and click OK.

Results

After conversion, the toolchain of the project is configured to use Test Embedded instead of the default toolchain. If
necessary, you can temporarily switch to the original toolchain in the project properties. However, you must switch
back to the Test Embedded toolchain to use Test Embedded runtime analysis and component testing tools.
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0 Tip: You can edit the CDT managed build toolchain to use environment variables with the UNIX notation $$.

This can be useful when you are sharing projects with other users.

Related information

Importing DevOps Test Embedded examples on page 184
Creating test projects on page 367

Target deployment port overview on page 34

Importing DevOps Test Embedded examples
Test Embedded is provided with several sample projects to help you get started.

To import the sample projects:

1. In the C/C++ perspective, click File > Import > General > Existing projects into workspace and click Next.

2. Click Select root directory, Browse, and choose a project folder in the following directory: <pr oduct
installation directory>/exanpl eskcli pse/.

3. Click Select All and select Copy projects into workspace.

4. Click Finish.

Related information
Importing C projects on page 183
Creating test projects on page 367

Target deployment port overview on page 34

Analyzing source code

Analyzing source code involves the systematic examination and evaluation of a computer program's written
instructions in a programming language. This process is crucial for understanding, improving, and ensuring the
quality of software.

Runtime analysis overview

The runtime analysis tools are designed to closely monitor the behavior of your application for debugging and
validation purposes. These features use source code insertion to instrument the source code providing dynamic
analysis of the application while it is running, either on a native or embedded target platform.

The following tools are available:

« Code coverage performs code coverage analysis.

« Memory profiling analyzes memory usage and detects memory leaks.
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- Performance profiling provides metrics on execution time for each procedure/function/method of the
application. For C language, it also provides an estimation of WCET.

« Control Coupling provides coverage information on Control Coupling that represent the interactions between
modules (C language only).

- Data Coupling provides coverage information on def/use pairs identified in the application (C language only).

 Worst Stack Size computes an estimation of the maximum of the application stack size (C language only).

 Runtime tracing draws a real-time UML sequence diagram of your application.

Each of these runtime analysis tools can be used alone or together with the component testing features. When the
source code is run with any of the runtime analysis tools engaged, either alone or in a component test, the source
code is instrumented. The resulting instrumented code is then executed and the result is dynamically displayed in the
corresponding reports.

Note: Instrumentation of the source code generates a certain amount of overhead, which can impact
application size and performance.

Runtime analysis tools can analyze source code that complies with ANSI 89, ANSI 99, C99, and K&R C specifications.

Code coverage

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test
cases applied to a software application.

The code coverage tool can provide the coverage information for the following source code elements:

« Statement blocks, decisions, and loops.

« Function or procedure calls.

« Basic conditions, modified conditions/decisions (MC/DC), multiple condition, and forced condition.
« Procedure entries and exits.

» Terminal or potentially terminal statements

» Statements that can't be covered in C.
For more information, see Code review on page 230.

Memory profiling

Runtime memory errors and leaks are among the most difficult errors to locate and the most important to correct.
The symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The
errors often remain undetected until triggered by a random event, so that a program can seem to work correctly when

in fact it's only working by accident. Memory profiling helps you detect HEAP memory allocation problems and leaks.
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After execution of an instrumented application, the Memory Profiling report provides a summary diagram and a
detailed report for both byte and HEAP memory block usage. The summary diagrams give you a quick overview of
HEAP memory usage in blocks and bytes, including:

« The total HEAP memory allocated during the execution of the application.
- The HEAP memory that remains allocated after the application was terminated.

« The maximum HEAP memory usage encountered during execution

The detailed section of the report lists memory usage events identified as errors or warnings.

For more information, see Memory profiling overview on page 208.

® Restriction: With Test Embedded for Eclipse IDE, static and stack memory are not checked, only dynamically
allocated memory is checked.

Performance profiling

The performance profiling tool provides performance data for each software component so that you can locate the
performance bottlenecks. With this information, you can concentrate your optimization efforts on those portions of

code, which can lead to significant improvements in performance.

The Performance Profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. A Top Functions graph provides a high level view of the
largest time consuming functions in your application. The Performance Summary section of the report indicates, for
each instrumented function, procedure, or method (collectively referred to as functions), the number of calls and the
time spent in the function and in its descendants. And for C language, it provides the Worst Case Estimation Time.

For more information, see Performance Profiling Results on page 217.

Runtime tracing

Runtime Tracing is a tool for monitoring real-time dynamic interaction analysis of your source code by generating
trace data, which is dynamically turned into a UML sequence diagram. The diagram displays a lifeline of the

interactions of the source code components. For more information, see Runtime tracing overview on page 222.

Control Coupling

Test Embedded introduces a new coverage level called “Control Coupling” for C language that consists in verifying
that all the interactions between modules have been covered by at least one test. This new coverage level is

implemented in Test Embedded as follows:

« Modules on C language and compilation units (example: C files that are independently compiled).
« Interactions are calls between 2 functions that are in 2 different compilation units.
- Control Coupling is not a simple interaction. It is a control flow in the calling module that ends with an

interaction with another module.
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For more information, see Control Coupling overview on page 338.

Data Coupling

Test Embedded introduces a new coverage level called “Data Coupling" for C language that consists to verify that all
the global variables of the application under test has been consumed in read (also called use) and write (also called

def) during the tests, as following:

- For each global variable, Test Embedded identifies the def and use. Then it considers all the possible def/use
pair as a data coupling.
« To cover a Data Coupling, i.e. a def/use pair, it should exist at least one test that has executed this def and this

use.
For more information, see Data Coupling on page 348.

Worst Stack Size
Static analysis and Dynamic analysis are used to provide an estimation of the worst stack size.

For more information, see Worst Stack Size overview on page 355.

Enable runtime analysis tools

When the source code is run with any of the runtime analysis tools enabled, either alone or in a component test, the

source code is instrumented and the results are displayed in a report.

Before you begin
Before running a test with any of the runtime analysis tools enabled, ensure that the correct Target Deployment Port
(TDP) is selected.

To enable runtime analysis tools on your source code:

1. In the project explorer, right-click the project on which you want to enable the runtime analysis tools and click
Properties.
Result

The Properties window is displayed.

g
Alternatively, you can select the project, and then click the settings icon *w= on the toolbar.

2. Click C/C++ Build > Settings and select the Build TDP page to check that the correct TDP is selected.
If necessary, click the Target Deployment Port value to change the TDP.
3. Select the Build Instrument page and select Settings > General > Selective instrumentation.
4. Select the Build Options line and click Edit.
5. In the Build Options window, select the runtime analysis tools that you want to enable.
o Memory Profiling detects memory leaks and allocation problems.

- Performance Profiling locates performance issues and bottlenecks.
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- Code Coverage provides coverage information of the source code as it is run.
> Runtime Tracing displays a dynamic UML sequence diagram of the run.
- Static Metrics evaluates the complexity of the source code.
> Code Review assesses compliance to coding rules.
> Debug enables the workbench debug mode.
6. Click OK, Apply the changes and close the Properties window.
7. Click Project > Clean > Clean all projects.
Result
If the project is successfully built, in the project explorer, the Binaries folder contains the compiled binary
executable for the project. If the project did not build successfully, see the Troubleshooting section for help on

resolving compilation issues.

Related information

Runtime analysis overview on page 184

Running instrumented applications

To run a program with runtime analysis tools enabled, you must run it as an instrumented application.

About this task
If you run the program with a standard C/C++ run configuration, the program is not instrumented and the runtime

analysis tools are not used.

To run an instrumented application:

1. Click Project > Clean > Clean all projects.
Result
If the project is successfully built, in the project explorer, the Binaries folder contains the compiled
instrumented program for the project.

2. Right-click the instrumented program and click Run As > Run Instrumented Application.

Results
After running the instrumented application, in the Project Explorer, the Test > Application Result folder contains the
application execution result with all the runtime analysis and static analysis reports. To view the results of the run,

see Opening runtime analysis reports on page 1178.

Running static analysis
You can use the Run Static Analysis menu in project explorer to analyze the application with static analysis tools

such as Code Review and Static Metrics without running the application.

1. Select the Static analysis tools in the settings. See Enable runtime analysis tools on page 187

2. Right-click the project and then click Run Static Analysis from the menu in the Project Explorer,
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Results

After you run the analysis, you can view the results in the Project Explorer > Project > Test > Application Result. See

Opening runtime analysis reports on page 1178

Related information

Enable runtime analysis tools on page 187

Opening runtime analysis reports on page 1178

Estimating Instrumentation Overhead

Instrumentation overhead is the increase in the binary size or the execution time of the instrumented application,

which is due to source code insertion (SCI) generated by the Runtime Analysis features.

Source code insertion technology is designed to reduce both types of overhead to a bare minimum. However, this

overhead may still impact your application.
The following table provides a quick estimate of the overhead generated by the product.

Code Coverage Overhead

Overhead generated by the Code Coverage feature depends largely on the coverage types on page 547 selected for

analysis.
A 48-byte structure is declared at the beginning of the instrumented file.

Depending on the information mode selected, each covered branch is referenced by an array that uses

« 1 byte in Default mode
« 1 bit in Compact mode

« 4 bytes in Hit Count mode

The actual size of this array may be rounded up by the compiler, especially in Compact mode because of the 8-bit

minimum integral type found in C and C++.
See Information Modes on page 546 for more information.

Other Specifics:

- Loops, switch and case statements: a 1-byte local variable is declared for each instance

» Modified/multiple conditions: one n-byte local array is declared at the beginning of the enclosing routine,

where n is the number of conditions belonging to a decision in the routine
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I/0 is either performed at the end of the execution or when the end-user decides (please refer to Coverage Snapshots

in the documentation).

As a summary, Hit Count mode and modified/multiple conditions produce the greatest data and execution time
overhead. In most cases you can select each coverage type independently and use Pass mode by default in order to
reduce this overhead. The source code can also be partially instrumented.

Memory and Performance Profiling and Runtime Tracing
Any source file containing an instrumented routine receives a declaration for a 16 byte structure.

Within each instrumented routine, a n byte structure is locally declared, where n is:

* 16 bytes
« +4 bytes for Runtime Tracing
- +4 bytes for Memory Profiling

- +3*t bytes for Performance Profiling, where t is the size of the type returned by the clock-retrieving function
For example, if t is 4 bytes, each instrumented routine is increased of:

« 20 bytes for Memory Profiling only
« 20 bytes for Runtime Tracing only
- 28 bytes for Performance Profiling only

- 36 bytes for all Runtime Analysis features together

Memory Profiling Overhead
This applies to Memory Profiling for C and C++. Memory Profiling for Java does not use source code insertion.

Any call to an allocation function is replaced by a call to the Memory Profiling Library. See the Target Deployment

Guide for more information.

These calls aim to track allocated blocks of memory. For each memory block, 16+12*n bytes are allocated to contain
a reference to it, as well as to contain link references and the call stack observed at allocation time. n depends on the
Call Stack Size Setting, which is 6 by default.

If ABWL on page 607 errors are to be detected, the size of each tracked, allocated block is increased by 2*s bytes
where s is the Red Zone Size Setting (16 by default).

If FFM on page 606 or FMWL on page 608 errors are to be detected, a Free Queue is created whose size depends

on the Free Queue Length and Free Queue Size Settings. Queue Length is the maximum number of tracked memory
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blocks in the queue. Queue Size is the maximum number of bytes, which is the sum of the sizes of all tracked blocks

in the queue.

Performance Profiling Overhead
For any source file containing at least one observed routine, a 24 byte structure is declared at the beginning of the file.

The size of the global data storing the profiling results of an instrumented routine is 4+3*t bytes where t is the size of

the type returned by the clock retrieving function. See the Target Deployment Guide for more information.

Runtime Tracing Overhead

Implicit default constructors, implicit copy constructors and implicit destructors are explicitly declared in any
instrumented classes that permits it. Where C++ rules forbid such explicit declarations, a 4 byte class is declared as

an attribute at the end of the class.
Related Topics

Reducing Instrumentation Overhead on page 191 | Source code instrumentation overview on page 32

Reducing Instrumentation Overhead

HCL DevOps Test Embedded (Test Embedded) Source Code Insertion (SCI) technology is designed to reduce both
performance and memory overhead to a minimum. Nevertheless, for certain cross-platform targets, it may need to be

reduced still further. There are three ways to do this.

Limiting Code Coverage Types

When using the Code Coverage feature, procedure input and simple and implicit block code coverage are enabled by

default. You can reduce instrumentation overhead by limiting the number of coverage types.
Note The Code Coverage report can only display coverage types among those selected for instrumentation.

Instrumenting Calls (C Language)

When calls are instrumented, any instruction that calls a C user function or library function constitutes a branch
and thus generates overhead. You can disable call instrumentation on a set of C functions using the Selective Code
Coverage Instrumentation Settings.

For example, you can usually exclude calls to standard C library functions such as printf or fopen.

Optimizing the Information Mode

When using Code Coverage, you can specify the Information Mode which defines how much coverage data is

produced, and therefore stored in memory.

Related Topics
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Estimating Instrumentation Overhead on page 189 | Selecting Coverage Types on page 547 | Information Modes

on page 546

Code coverage

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test
cases applied to a software application.

Code coverage overview

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test
cases applied to a software application.

The code coverage tool can provide the coverage information for the following source code elements:

« Statement blocks, decisions, and loops.

« Function or procedure calls.

« Basic conditions, modified conditions/decisions (MC/DC), multiple condition, and forced condition.
« Procedure entries and exits.

« Terminal or potentially terminal statements

» Statements that are considered non-coverable in C.
See Coverage levels on page 193 for more details about each coverage level.

Information modes

The information mode is the method used to code the trace output. This has a direct impact of the size of the trace
file as well as on CPU overhead. You can change the information mode in the coverage type settings. See Changing

code coverage settings on page 200.

There are three information modes:

- Default mode: Each branch generates one byte of memory. This offers the best compromise between code
size and speed overhead.

« Compact mode: This is functionally equivalent to Pass mode, except that each branch needs only one bit of
storage instead of one byte. This implies a smaller requirement for data storage in memory, but produces a
noticeable increase in code size (shift/bits masks) and execution time.

« Hit Count mode: In this mode, instead of storing a Boolean value indicating coverage of the branch, a specific
count is maintained of the number of times each branch is executed. This information is displayed in the code

coverage report.

Count totals are given for each branch, for all trace files transferred to the report generator as parameters. In the code
coverage report, branches that have never been executed are highlighted with an asterisk "*'. The maximum count in
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the report generator depends on the amount of memory available on the computer running the tests. If this maximum
count is reached, the report signals it with a Maximum reached message.

Note: The last bracket (}) in a function after a return statement is always displayed in red in the coverage

report, even if the function reports 100% coverage.

On-the-fly display

By default, code coverage generates a report when the execution ends. The on-the-fly mode generates code coverage
results dynamically during the execution. This is useful for applications that never exit or to interact with the
execution during the analysis, for example if you want to stop the code coverage when you reach a specified coverage
rate threshold.

Coverage levels

The product provides coverage information for various levels of statements, decisions, loops, calls, conditions.

Block coverage

When running the code coverage feature on C source code, the following coverage types are analyzed.

+ Statement blocks (simple blocks): Simple blocks are the main blocks of the C function, introduced by decision
statements:
°if and el se statements
o for,whileanddo ... while blocks
o Non-empty blocks introduced by switch case or default statements.
> True and false outcomes of ternary expressions (<expr essi on> ? <expression> : <expression>).

- Blocks following a potentially terminal statement.

Each simple block is a branch. Every C function contains at least one simple block corresponding to its main
body.

« Decisions (implicit blocks): Implicit blocks are introduced by ani f statement without an el se or a swi tch
statement without a def aul t . Each simple block is a branch. Every C function contains at least one simple
block corresponding to its main body.

« Loops (logical blocks): Logical blocks are defined by loop statements f or, while,and do ... while.

A typical f or or whi | e loop can reach three different conditions:
> The statement block contained within the loop is executed zero times. The output condition is True
from the start
> The statement block is executed exactly once. The output condition is False, then True the next time
o The statement block is executed at least twice. The output condition is False at least twice, and

becomes True at the end.
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In a do. . . whi | e loop, because the output condition is tested after the block has been executed, two further
branches are created:
> The statement block is executed exactly once. The output is condition True the first time.
> The statement block is executed at least twice. The output condition is False at least once, then True
at the end.

Call coverage

Code coverage provides coverage of function or procedure calls by counting as many branches as it encounters

function calls while running the program. This type of coverage ensures that all the call interfaces can be shown to

have been exercised for each C function, which may be a pass or failure criterion in software integration test phases.

You can exclude specific C functions whose calls you do not want to measure coverage in the configuration settings

of the project. This can be useful for C library functions for example.

Condition coverage

194

For conditions, the following coverage types are analyzed:

- Basic condition coverage: Conditions are operands of either | | or && operators wherever they appear in
the body of a C function, i f statements and ternary expressions, and tests for for,while,anddo ... while
statements even if these expressions do not contain | | or & operators.

Two branches are involved in each condition, causing the sub-condition to be true or false. In a switch

statement, one basic condition is associated with every case and def aul t, whether implicit or not.

Two branches are enumerated for each condition, and one per case or def aul t .

Modified condition/decision coverage (MC/DC): A modified condition (MC) is defined for each basic condition
enclosed in a composition of | | or && operators, proving that the condition affects the result of the enclosing
composition. For example, in a subset of values affected by the other conditions, if the value of this condition
changes, the result of the entire expression changes. Because compound conditions list all possible cases,
you must find the two cases that can result in changes to the entire expression. The modified condition is

covered only if the two compound conditions are covered.

You can associate a modified condition with more than one case. Code Coverage calculates matching cases
for each modified condition. The number of modified conditions matches the number of Boolean basic
conditions in a composition of | | and && operators.

Multiple condition coverage: A multiple (or compound) condition is one of all the available cases for the | |
and && logical operator compositions, whenever it appears in a C function. It is defined by the simultaneous
values of the enclosed Boolean basic conditions. Remember that the right operand of a | | or && operator is

not evaluated if the evaluation of the left operand determines the result of the entire expression.



Chapter 6. Test Execution Specialist Guide

Code Coverage calculates every available case for each composition. The number of enumerated branches is

the number of distinct available cases for each composition of the | | or && operators.

« Forced condition coverage: Forced conditions are multiple conditions in which the instrumentation replaces
any occurrence of the | | or && logical operators in the code, with | and & binary operators. You can use this
coverage type, after evaluating all modified conditions, to make sure that every basic condition has been
evaluated. With this forced condition coverage, you can ensure that only the basic condition has changed

between two tests.

Function coverage

When analyzing C source code, Test Embedded can provide the following function coverage:

« Procedure entries: Inputs identify the C functions that are executed. One branch is defined per C function.

« Procedure exits: These include the standard output (if coverable), and all return instructions, exits, and other
terminal instructions that are instrumented, as well as the input. At least two branches are defined per C
function.

The input is always enumerated, as is the output if it can be covered. If it cannot, it is preceded by a terminal
instruction involving returns or an exit. In addition to the terminal instructions provided in the standard definition file,

you can define other terminal instructions using the pragma attol exit_instr.

Additional statements
Some statements are identified as terminal, potentially terminal, or non-coverable.

A C statement is terminal if it transfers program control out of sequence (r et ur n, got o, br eak, cont i nue), or if it stops
the execution (exi t ). By extension, a decision statement (i f or swi t ch) is terminal if all branches are terminal; that is
if the non-emptyif ... else, case, anddefaul t blocks all contain terminal statements. Anif statement without an
el se and a swi t ch statement without a def aul t are never terminal, because their empty blocks necessarily continue

the program sequence.

The following decision statements are potentially terminal if they contain at least one statement that transfers

program control out of their sequence (r et urn, got o, br eak, cont i nue), or that stops the execution (exi t ):

« i f without an el se
*switch
e for

*whileOrdo ... wile

Some C statements are considered non-coverable if they follow either a terminal instruction, a cont i nue, or a br eak,
and are not a got o label. Code coverage detects non-coverable statements during instrumentation and produces a

warning message that specifies the source file and line location of each non-coverable statement.
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Note: User functions whose purpose is to terminate execution unconditionally are not evaluated. Furthermore,
code coverage does not statically analyze exit conditions for loops to check whether they are infinite. As a
result,for ... whileanddo ... whileloops are always assumed to be non-terminal, able to resume program

control in sequence.

Justification of non-covered lines of code

You can enter justification statements in uncovered branches of a program so that they are considered as exceptions
to the coverage rules. Thus, you identify in the source code the branches that are not covered and explain why they
are not covered. The justification text must be declared in the attol cov_justify pragma line of the uncovered branch
with one or multiple attributes.

SYNTAX:

The justification pragma syntax is the following one:

#pragma attol cov_justify (<lineOffset>, <type>, <what>, <justification text> ) [ (w.) [ (w.) w..1]
#pragma attol cov_justify is the pragma, and <lineOffset>, <type>, <what>, and <justification text> are the attributes.
Multiple statements can be specified in the same pragma line, with four attributes for each.

Each justification statement in a pragma line can cover only one branch of the code starting from a specified line of
the source code.

Double-quotes can be added if the attribute includes commas.

The attributes are the following ones:

- <type> attribute:

This attribute is mandatory. It is used to determine what kind of code must be covered and how it must be

covered.

You can use the following <type>values:
o proc: to justify that a function or a method is not covered.
o return: to justify that a return statement is not covered.
> branch or block: to justify that a block of code is not covered.
- implicit: to justify that an implicit else statement is not covered.
> logical, or for, or while: to justify that a loop is not covered (the loop number is given in the <what>
attribute).
- case: to justify that a case statement in a switch is not covered.

- call: to justify that a function call or method call is not covered.
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- cond: to justify that a simple condition is not covered (the value true or false of the condition is given
in the <what> attribute).
- medc: to justify that a MC/DC is not covered (the description of the MD/DC is given in the <what>
attribute).
- <lineOffset> attribute:

This attribute is optional.

<lineOffset> attribute represents the number of lines between the pragma and the branch that must be
justified. The value can be '+ if the branch is located after the pragma, or -' if the branch is located before the

pragma.

If the <lineOffset> attribute is omitted <lineOffset> is considered as "0". It means that the justification applies
to the closest type of branch (attribute <type>) from the pragma. If there are multiple branches at a same

distance of the pragma, <lineOffset> helps distinguish between branches which branch should be justified.

The <lineOffset> attribute specifies the line where the branch or condition to justify starts, it is relative to the

pragma line (+/-), allowing to write this pragma line anywhere in the source file.
Note: For the <block> value, the target block of lines is the block where the pragma is declared.

« <what> attribute:

The <what> values are used to help specify some of the branches to be justified. It depends on the attribute
<type> values being used:

- For block or branch <type>: The value is a string that describes the logical position of the block in the
function, like ‘/then/else/seq’.

> For logical, for and while <type>: The value is a list of ‘0’ (the loop is not executed), ‘1’ (the loop is
executed only once) or 2+’ (the loop is executed more that once) separated by *;, each of them could
be prefixed with the block description string.

> For cond <type>: The value is <expression>:<value>, <value> is true or false and <expression>.

> For medc <type>: The value is a list of impossible combinations of the conditions separated by *;,
each value of the conditions are set with ‘T’ for true, ‘F’ for false, or ‘X’ if the condition is not evaluated.
For example, if the MC/DC consists of 3 conditions, the <what> value could be the following one:
“TEX;FXX".

- <justification text> is the reason why this part of code can't be covered by a test.

<justification> is mandatory. It is presented as a free text in the coverage report that justifies a uncovered
branch. It explains why it is not covered.

Example:

#pragma attol cov_justify (call, ”my justification”) (block, ”myjustification”) (cond, ”:true”,
”my justification”) (for, ”0;1” ,”my justification”)
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The following table lists the parameters that can be entered in the “<lineOffset>" and <what> attributes depending on
the parameters indicated in the <type> attribute.

<type> attribute <lineOffset> attribute <what> attribute

proc For the <type>=proc, the pragma line
declared above or inside the body, or
just after the end of the body justifies
the function/procedure entry.

return For <type>=return, the pragma line,
must be just before or just after the

return line.

branch/block For <type>=branch or block. It starts

The “branch to cover" attribute is
on the first { of that block or on the

. . used for a branch=<type> The branch
line of the unique statement.

string format is a list of :
/then/ el se/ seq Or /

It is used to indicate which branch
to cover when there are multiple
branches on the same line.

It can be empty is there are no ambi-

guity with the line number.

implicit For <type>=implicit, the pragma line

. . The “branch to cover" attribute is
must be just before the decision, or

at the else place. used for <type>= <branch>.

The branch string format is a list of: /

then/ el se/ seq Or/

It is used to indicate which branch
to cover when there are multiple

branches on the same line.

It can be empty is there are no ambi-

guity with the line number.

logical/for/do/while For <type>=logical/for/while, the

This attribute i d for <t =log-
pragma line must be just before the IS atiribute Is used for <type>=log

ical, th h string f look
“for' or ‘while’, or ‘do’ keyword. ical, the branch string format looks

like ‘branch depth/instruction type/

value’ with :
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<type> attribute

<lineOffset> attribute

<what> attribute

instruction type is:
/for Or/while Or/do

The valueis /o or /1 or/2+to specify
which part must be covered and jus-
tified. It is mandatory and can speci-
fy multiple parts if separated by ; e.g.
“/0; /1"

Branch depth is a suite of strings like
/then /else /for /while etc. clari-
fying the code depth of the branch

where the loop has been found.

e.g. “I el se/then/for/whilel/ 1" or

”

“I'while/1” or “/1

case For <type>=case, the pragma line
Used for <type>=case, the string de-
must be just before or just after the yp g
. tails the case expression (between
case line.
‘case’ and the ") to cover into the
A case is both a block and a condi- switch block.
tion. If you enter a justification for a
- . .| It can be empty is there are no ambi-
case <type>, it is the condition that is
uity with the line number.
justified. You need to declare another gurty
pragma to justify the corresponding
block.
call For <type>=call, the pragma line
. . Used for type=call, the string details
must be just before or just after the yP g
. the called method name to cover.
call line,
It can be empty is there are no ambi-
guity with the line number.
cond For <type>=cond, the pragma line

must be just before or just after the

condition line.

“condition expression:value” is used
for “<type>"=cond.The string indi-
cates the condition expression to
cover into the decision with the value
to cover, true or false. The “condition
expression” can be empty if there is

no ambiguity with the line number
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<type> attribute <lineOffset> attribute <what> attribute

but the value must always be spec-
ified after a colon at the end of the

string.
Example: “var>5: fal se” or “: true”.

Multiple values can be justified, sepa-

rated by ;" such as “true ; :false”

mcdc For <type>=mcdc, the pragma line
. “combinations” is used for type=
must be just before or after the first vP
e . mcdec. It is a series of patterns sepa-
condition line, or just before or after

o rated by a semi-colon ";". It cannot be
the last condition line.

empty.

Once the source code is built, you can see the results of the non-coverage justification statements in the Code

Coverage report, on the Source page.

For more information about the code coverage reports, see About coverage reports on page 1180.

Changing code coverage settings

You can edit the configuration settings for code coverage to explicitly include or exclude files, change the information

mode, coverage level, and other settings.

To change the code coverage settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Code coverage to access the settings and set the required coverage level for functions, calls, blocks

and conditions, as well as any other required settings.
Instrumentation control

You can use the coverage type settings to declare various types of coverage. See Coverage
levels on page 193 for more information about these settings.

Coverage level functions
Select between function Entries, With exits, or None.
Coverage level calls

Select Yes or No to toggle call code coverage.
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Coverage level blocks

Select the desired block code coverage type. You can combine, enable, or disable
any of these coverage types before running the application node. All coverage

types selected for instrumentation can be filtered out in the coverage viewer.
Exclude for loops

Select Yes to exclude for loops from instrumentation. Only while and do loops are
instrumented.

Coverage level conditions

Selects the condition level of code coverage to be included in the report:

- None: The coverage report ignores conditions.

> Basic: Only basic conditions are included in the coverage report.

> Modified (MC/DC): Only modified conditions are included in the coverage
section of the test report.

- Modified and Multiple: Both modified and multiple conditions are included
in the coverage report.

- Forced Modified (MC/DC): The report includes modified conditions where
all operators are replaced with bitwise operators.

- Forced Modified and Multiple: The report includes modified and multiple
conditions where all operators are replaced with bitwise operators.

Condition in expressions

Select Yes to consider relational operators in an expression (for example: y =

(a>0)) as conditions.
Bitwise as logical

Select Yes to instrument bitwise operators as logical when both operands are
booleans.

Ternary coverage

When this option is selected, code coverage reports ternary expressions as
statement blocks.

Information mode

This setting specifies the information modes to be used by code coverage.
- Default (Optimized for Code Size and Speed): This setting uses one byte
per branch to indicate branch coverage.
- Compact (Optimized for Memory): This setting uses one bit per branch.
This method saves target memory but uses more CPU time.
> Report Hit Count: This adds information about the number of times each

branch was executed. This method uses one integer per branch.
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Excluded function calls

Specifies a list of functions to be excluded from the call coverage instrumentation
type, such as printf or fopen. Use the Add, Remove buttons specify the functions to

be excluded.
Not returning functions

Type the identifiers (not signatures) of the functions that do not return (functions

that execute a longjmp or exit).
Advanced options
Trace file name (.tio)

this allows you to specify a path and filename for the . t i o dynamic coverage

trace file.
Key ignore source file path

Identifies source files based only on the filename instead of the complete path.
Use this option to consolidate test results when a same file can be located in
different paths. This can be useful in some multi-user environments that use
source control. If you use this option, make sure that the source file names used by

your application are unique.
User comment

This adds a comment to the code coverage report. This can be useful for
identifying reports produced under different configurations. To view the comment,
click the a magnifying glass symbol that is displayed at the top of your source

code in the coverage viewer.
Report summary

Select Yes to add the coverage summary to the summary text file of the selected

node.
On-the-fly frequency dump

Specify the function call number after which the coverage results are updated

dynamically during execution. 0 means no update during execution.

Coverage Report Template
An HTML coverage report is automatically generated after each execution. This
report is based on a template that is by default <i nstal I ati on fol der>/1i b/

reports/ covreport . tenpl at e.You can make a copy of this template and modify it.

This option is used to point to the new template file.
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Generate raw data in JSON

Select Yes if you want to generate the coverage raw data in a JSON file, Yes, in
compressed mode if you want to compress this file, No if you do not need this
JSON file. The name of this file is the same as the name of the HTML report file
where . ht ni is replaced by . j son.

4. Click OK, Apply the changes and close the Properties window.

Related information

Coverage levels on page 193

Engaging runtime analysis tools on page 187

Code coverage for assembler source files

Assembler code coverage is essential primarily because embedded software often cannot be entirely written in high-

level languages. In many projects, manually written assembler code are required for two main reasons

 Accessing Hardware
« There are scenarios where exceptionally fast and optimized routines are required, which high-level languages
does not allow. In such cases, assembler code can be utilized to achieve the desired level of efficiency.

Some development standards require to proof the traceability between the source code and the generated
assembler code in order to avoid hidden code that is not tested during unit test phase. For example, the
DO178B/C states in paragraph 6.4.4.2b for level A application:

The structural coverage analysis may be performed on the Source Code, unless the software level is A and

the compiler generates object code that is not directly traceable to Source Code statements. Then, additional
verification should be performed on the object code to establish the correctness of such generated code
sequences. A compiler-generated array-bound check in the object code is an example of object code that is not
directly traceable to the Source Code.

This holds particularly true for programming languages such as C++ and Ada. Ensuring traceability can, in
some cases, be guaranteed by the compiler provider through the use of specific options, although this is not
a common practice. One potential solution, as suggested in CAST-12, involves a comprehensive analysis of
high-level language constructs to demonstrate that the resulting assembly code can be traced back. However,
this approach can be quite challenging and time-consuming.

Another solution, also outlined in CAST-12, is to compute the code coverage at the assembler level to confirm
that all generated assembly code is covered by the tests, just like the coverage achieved at the high-level
language.
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Solution provided by DevOps Test Embedded

DevOps Test Embedded integrates an assembler code coverage for ARM 32 bits and 64 bits processor, with the
following characteristics:

 Support the following levels:

> Function: This level focuses on function, which serve as an entry point in the assembler code identified
by the directive .function or by a reference in an instruction BR (routine call).

- Function and exit: This level includes the function coverage and the exit point coverage. An exit point
is identified by the instructions such as MOV LR,PC and POP PC in the assembler code.

- Statement block: A statement block is a set of instructions between a block entry that can be a label
or an instruction just after a conditional jump and a block exit that can be a jump or the instruction just
before another block entry.

o Call: A call is identified by the BR instruction.

Note: There is no need for additional levels since assembler code does not involve decision with

multiple conditions like you find in C/C++ and Ada languages.

« Reports are compatible with high-level language reports and can be mixed in a single report.
» A new tool named attolgas is provided that instruments assembler code based on the gcc-like assembler
listing format.

RERRORRORRRDRNN

In addition,DevOps Test Embedded offer a new TDP with the following characteristics:

> Compiler gcc for ARM
o Target Raspberry Pi
> Two usage modes:
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= Use case 1: Instrument assembler code files identified by the .s extension found in a project
and merge the generated coverage report with existing C/C++ coverage reports.

= Use case 2: instrument the assembler files issued from C/C++ source files and generate a
report for all assembler codes.

This TDP can be easily adapted to other targets, provided that the compiler used is gcc for ARM.

This tool comes with its own qualification kit that is available for both 32 bits and 64 bits.

CONFIGURATION

Code coverage for assembler source files requires the use of an appropriate TDP. You can use the
cl i nCr ossRaspi Renot e. xdp and cwi nCr ossRaspi Renot e. xdp that are delivered, for example.

There two use case scenarios:

« For a project that uses both C and assembler source files, you only have to add the assembler .asm source
files to the list of sources to be compiled. The .asm files are then instrumented, built, and linked with the other
C sources to produce an executable file.

« For C code source files that are instrumented in assembler mode, the C source files are converted into
assembler files by using the gcc -S command. Then, they are instrumented in assembler mode, they are

converted into assembly language, and linked.
To implement this use case scenario, you must set the INSTR_C_AS_ASM=1 environment variable.

To add this environment variable in Studio, proceed as follows:
o Right-click on your project in the Project Explorer, and select Properties.
> Select C/C++ Build > Environment.
o Click Add, give a name to the variable, and enter INSTR_C_AS_ASM=1 in Value.
> Apply and close the window.
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See the following example:

| a Environment v v w

» Resource
Bullders Configuration: | build [ Active ] ~ || Manage Configurations...
v C/C++ Build

Build Variables

m Environment variables to set Add...

Value

Logaing ‘ | i . . - Select...
Settings CWD /home/pierre/testasm: BUILD SYSTEM
Tool Chain Editor INSTR-C_AS_ASM 1 USER: CONFIG
b C/IC++ General PWD /home/pierre/testasm: BUILD SYSTEM
Project Facets
Project References
Run/Debug Settings
Server ) Append variables to native environment
Service Policies Replace native environment with specified one
Task Tags
» Validation Restore Defaults Apply
'f?/' Cancel Apply and Close

Note: In some case, when the assembler code increased due to the code coverage level, it might be
necessary to re-organize the assembler code (Example: you can move data pools), or to decrease the level of
code coverage (Example: you can delete code coverage for some functions calls in libraries).

Using the Code Coverage Viewer to view reports
Code Coverage for Ada, C and C++

The Code Coverage Viewer allows you to view code coverage reports generated by the Code Coverage feature. Select

a tab at the top of the Code Coverage Viewer window to select the type of report:

« A Source report that displays the source code under analysis, highlighted with the actual coverage

information.

- Arates report that provides detailed coverage rates for each activated coverage type.

You can use the Report Explorer to navigate through the report. Click a source code component in the Report Explorer

to go to the corresponding line in the Report Viewer.

You can jump directly to the next or previous Failed test in the report by using the Next Failed Test or Previous Failed

Test buttons from the Code Coverage toolbar.
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You can jump directly to the next or previous Uncovered line in the Source report by using the Next Uncovered Line or

Previous Uncovered Line buttons in the Code Coverage feature bar.

When viewing a Source coverage report, the Code Coverage Viewer provides several additional viewing features for

refined code coverage analysis.
To open a Code Coverage report:

1. Right-click a previously executed test or application node.
2. If a Code Coverage report was generated during execution of the node, select View Report and then Code
Coverage.

Coverage types

Depending on the language selected, the Code Coverage feature offers the following choices:

- Function or Method code coverage: select between function Entries, Entries and exits, or None.
- Call code coverage: select Yes or No to toggle call coverage for Ada and C.
- Block code coverage: select the block coverage method you need.

- Condition code coverage: select condition coverage for Ada and C.

Any of the Code Coverage types selected for instrumentation can be filtered out in the Code Coverage report stage if

necessary.

To filter coverage types from the report, proceed as follows:

1. From the Code Coverage menu, select Code Coverage Type.

2. Toggle each coverage type in the menu.

For example, to filter out multiple conditions (MC) from the report, select Code Coverage > > Code Coverage

Type, and clear Multiple conditions.

3. Alternatively, you can filter out coverage types from the Code Coverage toolbar by toggling the Code Coverage
type filter buttons.

Test by test analysis mode

The test by test analysis mode allows you to refine the coverage analysis by individually selecting the various tests
that were generated during executions of the test or application node. In Test-by-Test mode, a Tests node is available
in the Report Explorer.

When test by test analysis is disabled, the Code Coverage Viewer displays all traces as one global test.

To toggle test by test mode, proceed as follows:

207



208

HCL DevOps Test Embedded

1. In the Code Coverage Viewer window, select the Source tab.

2. From the Code Coverage menu, select Test-by-Test.
To select the Tests to display in Test-by-Test mode, follow these steps:

1. Expand the Tests node at the top of the Report Explorer.
2. Select one or several tests. The Coverage Viewer provides code coverage information for the selected tests.

Opening the HTML report
You can open the code coverage report in an HTML format if it is available.
To open the HTML report, select Open HTML report in the Coverage Viewer menu.

The HTML coverage report has been generated in the build folder with the extension .cov.html. The root name of the

report is the name of the application, or the name of the test harness, or the name of the test suite result.

Note: The HTML report is created from a template file: covr eport . t enpl at e located in the folder
<installation folder>/1ib/report. Youcan modify this template. This is the default template that

can be used as a string point for a new template.

To select a new template file, select Code coverage > Advanced options in the build settings. Then, click Coverage

Report Template to select the new template file.

Memory profiling

Memory profiling is the process of analyzing a program's memory usage to identify and address issues related to
memory consumption and management. Memory profiling help to understand how a program utilizes memory, detect

memory leaks, and optimize resource usage.

Memory profiling overview

Memory profiling helps you detect memory allocation problems and leaks.

Runtime memory errors and leaks are among the most difficult errors to locate and the most important to correct.
The symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The
errors often remain undetected until triggered by a random event, so that a program can seem to work correctly when

in fact it's only working by accident.

After execution of an instrumented application, the memory profiling report provides a summary diagram and a
detailed report for both byte and memory block usage. The summary diagrams give you a quick overview of memory

usage in blocks and bytes, including:
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- The total memory allocated during the execution of the application.
- The memory that remains allocated after the application was terminated.
« The maximum memory usage encountered during execution

The detailed section of the report lists memory usage events identified as errors or warnings.

Related reference

Memory profiling warnings on page 1213

Memory profiling errors on page 1211

Checking for ABWL and FMWL errors

You can insert pragma macros into your source code to check for Late Detect Array Bounds Write (ABWL) and Late
Detect Free Memory Write (FMWL)

About this task

By default, memory profiling checks for ABWL and FMWL errors whenever the routines are called or whenever the free
queue is actually flushed. In some cases, you might want to manually specify when to check for ABWL and FMWL
errors, and on which functions. You can use the ABWL and FMWL check frequency setting to perform a check at the

following times:

« Each time the memory is dumped (by default).
« Each time a manual check macro is encountered in the code.

- Each function return.
The checks can be performed either on all memory blocks or only a selection of memory blocks.

1. To indicate where you want an ABWL or FMWL check to occur in your source code, insert an _ATP_CHECK( )

macro at the corresponding location.
Use the following syntax for the pragma macro:
#pragma attol insert _ATP_CHECK(@RELFLINE)
Each time this macro is encountered during execution, memory profiling checks for ABWL and FMWL errors

on the specified blocks. The @RELFLINE parameter allows navigation from the memory profiling viewer to the

corresponding line in the source code.
2. To create a selection of blocks that you explicitly want to verify, create a list in your source code using the

_ATP_TRACK() macro variable. The syntax for this macro is:

Use the following syntax for the pragma macro:

#pragma attol insert _ATP_TRACK(<pointer>)
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Related reference

Memory profiling warnings on page 1213

Memory profiling errors on page 1211
Related information

Memory profiling overview on page 208

Engaging runtime analysis tools on page 187

Memory profiling user heap

Memory profiling can use heap management routines on target hardware platforms where there are no or only partial

provisions for memory management instructions.

When using Memory profiling on some embedded or real-time target platforms, you might encounter one of the

following situations:

- Situation 1: There are no provisions for malloc, calloc, realloc or free functions on the target platform. The
program uses custom heap management routines that may use a user API. Such routines could, for example,
be based on a static buffer that performs memory allocation and free functions. In this case, you need to
customize the memory heap parameters RTRT_DO_MALLOC and RTRT_DO_FREE in the target deployment port
(TDP) to use the custom malloc and free functions. In this case, you can access the custom API functions.

- Situation 2: There are partial implementations of malloc, calloc, realloc or free functions on the target platform,
but other functions provide methods of allocating or freeing heap memory. In this case, you do not have
access to any custom API. This requires customization of the TDP. Refer to the documentation provided in the

target deployment port editor for customization options.

In both of the above situations, memory profiling can use the heap management routines to detect memory leaks,

array bounds and other memory-related defects.

Note: Application pointers and block sizes can be modified by memory profiling in order to detect Late
Detect Array Bounds Write (ABWL) errors. Actual-pointer and actual size refer to the memory data handled by
memory profiling, whereas user pointer and user size refer to the memory handled natively by the application-

under-analysis. This distinction is important for the memory profiling ABWL and red zone settings.

Target deployment port API

The TDP library provides the following API for memory profiling:

void * _PurifyLTHeapAction ( _PurifyLT_API_ACTION, void *, RTRT_U_INT32, RTRT_U_INT8 );
In the function _Puri f yLTHeapAct i on, the first parameter is the type of action that will be or has been performed on the
memory block pointed by the second parameter. The following actions can be used:

typedef enum {
_PurifyLT_API_ALLOC,
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_PurifyLT_API_BEFORE_REALLOC,
_PurifyLT_API_FREE
} _PurifyLT_API_ACTION;

The third parameter is the size of the block. The fourth parameter is either of the following constants:

#define _PurifyLT_NO_DELAYED_FREE 0
#define _PurifyLT_DELAYED_FREE 1

If an allocation or free instruction has a size of 0, this fourth parameter indicates a delayed free in order to detect Late
Detect Free Memory Write (FWML ) and Freeing Freed Memory (FFM) errors. See the Build configuration settings on
page 1199 section for the memory profiling settings.

A freed delay can only be performed if the block can be freed with RTRT_po_FReE (for the situation 1 described
previously) or ANSI C free (for situation 2). For example, if a function requires more parameters than the pointer
to deallocate, then the FMWL and FFM error detection cannot be supported and FFM errors will be indicated by a
Freeing Unallocated Memory (FUM) error instead.

The following function returns the size of an allocated block, or 0 if the block was not declared to Memory Profiling.
This allows you to implement a library function similar to the msize from Microsoft™ Visual 6.0.

RTRT_SIZE_T _PurifyLTHeapPtrSize ( void * );
The following function returns the actual-size of a memory block, depending on the size requested. Call this function

before the actual allocation to find out the quantity of memory that is available for the block and the contiguous red
zones that are to be monitored by memory profiling.

RTRT_SIZE_T _PurifyLTHeapActualSize ( RTRT_SIZE_T );

Exemple

Example

In the following examples, my_nal | oc, ny_real | oc, ny_free and ny_nsi ze demonstrate the four supported memory heap
behaviors. The following routine declares an allocation:

void *my_malloc ( int partId, size_t size )
{
void *ret;
size_t actual_size = _PurifyLTHeapActualSize(size);
/* Here 1is any user code making ret a pointer to a heap or
simulated heap memory block of actual_size bytes x/

/* Then comes the memory profiling action x/

return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 );
/* The user-pointer 1is returned */

In situation 2, where you have access to a custom memory heap API, replace the "..." with the actual malloc API
function.
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For a my_calloc(size_t nelem, size_t elsize), pass on nelem*elsize as the third parameter of the _PurifyLTHeapAction
function. In this case, you might need to replace this operation with a function that takes into account the alignments
of elements.

To declare a reallocation, two operations are required:

void *my_realloc ( int partId, void * ptr, size_t size )
{
void *ret;
size_t actual_size = _PurifylLTHeapActualSize(size);
/* Before comes first Memory Profiling action */
ret = _PurifyLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, ptr, size, 0 );
/* ret now contains the actual-pointer x/
/* Here is any user code making ret a reallocated pointer to a heap or
simulated heap memory block of actual_size bytes x/

/* After comes second Memory Profiling action x/
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 );
/* The user-pointer 1is returned */

To free memory without using the delay:

void my_free ( int partId, void * ptr )

{
/* Memory Profiling action comes first */
void *ret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 0 );
/* Any code insuring actual deallocation of ret */

To free memory using a delay:

void my_free ( int partId, void * ptr )

{
/* Memory Profiling action comes first */
void *ret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 1 );
/* Nothing to do here x/

To obtain the user size of a block:

size_t my_msize ( int partId, void x ptr )
{
return _PurifyLTHeapPtrSize ( ptr );

Use the following macros to save customization time when dealing with functions that have the same prototypes as
the standard ANSI functions:

#define _PurifyLT_MALLOC_LIKE(func) \
void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T size ) \
{\
void *ret; \
ret = func ( _PurifylLTHeapActualSize ( size ) ); \
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 ); \
}
#define _PurifyLT_CALLOC_LIKE(func) \
void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T nelem, RTRT_SIZE_T elsize ) \
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\

void *ret; \

ret = func ( _PurifylLTHeapActualSize ( nelem * elsize ) ); \

return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, nelem * elsize, 0 ); \

#define _PurifyLT_REALLOC_LIKE(func,delayed_free) \
void *RTRT_CONCAT_MACRO(usr_,func) ( void *ptr, RTRT_SIZE_T size ) \

{

}

\
void *ret; \
ret = func ( _PurifylLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, \
ptr, size, delayed_free ), \
_PurifyLTHeapActualSize ( size ) ); \
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 ); \

#define _PurifyLT_FREE_LIKE(func,delayed_free) \
void RTRT_CONCAT_MACRO(usr_,func) ( void *ptr ) \

{

\
if ( delayed_free ) \
{\
_PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ); \
A\
else \
{\
func ( _PurifylLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ) ); \
A\

Changing memory profiling settings

You can edit the configuration settings for memory profiling to specify the errors and warnings that you want to

detect and to set other advanced options.

To change the memory profiling settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Memory profiling to access the settings and set the error and warning detection options as well as
any other required options.
The following settings are available:

Instrumentation control

You can specify the type of memory errors and warnings that you want to detect. See Memory
profiling errors on page 1211 and Memory profiling warnings on page 1213 for more

information about these settings.
Detect File in Use (FIU)
When the application exits, this option reports any files left open.
Detect Memory in use (MIU)

When the application exits, this option reports allocated memory that is still
referenced.
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Free Invalid Memory (FIM)
This option activates the detection of invalid free memory instructions.
Detect Signal (SIG)

This option indicates the signal number received by the application forcing it to

exit.
Detect Freeing Freed Memory (FFM) and Detect Free Memory Write (FMWL)
Select Yes to activate detection of these errors.
Free queue length (blocks)
Specifies the number of memory blocks that are kept free.
Free queue size (bytes)
Specifies the total buffer size for free queue blocks.
Largest free queue block size (bytes)
Specifies the size of the largest block to be kept in the free queue.
Detect Array Bounds Write (ABWL)
Select Yes to activate detection of ABWL errors.
Red zone length (bytes)

Specifies the number of bytes added by Memory Profiling around the memory

range for bounds detection.
Number of functions in call stack

Specifies the maximum number of functions reported from the end of the CPU call

stack. The default value is 6.
Only show memory leaks with call stack

Select this option to only record memory leaks that are associated with a call
stack. Memory allocations that occurred before the application started do not have
a call stack and are not included in the Memory Profiling report.

Line number link

Select Statement to link the line number in the report to the corresponding
allocation or free statement in the function. Select Function to link only to the

function entry and to improve performance.
Only show new memory leaks in each dump

In multi-dump report, Memory leaks (MLK) and potential leaks (MPK) are only
reported once.
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Advanced options
Trace File Name (.tpf)
This setting allows you to specify a filename for the generated . t pf trace file.
Exclude block tracking before init

Disables memory profiling for any memory blocks allocated before the first
execution of instrumented code. Use this option to prevent crashes when the
system uses memory allocations that cannot be tracked.

Excluded global variables

Specifies a list of global variables that are not to be inspected for memory leaks.
This option can be useful to save time and instrumentation overhead on trusted

code. Use the Add and Remove buttons to add and remove global variables.
Exclude variables from directories

Specifies a list of directories from which any variables found in files are not to be
inspected for memory leaks.

Break on error

Use this option to break the execution when an error is encountered. The break
point must be set to priv_check_failed in debug mode.

ABWL and FMWL check frequency

Use this to check for ABWL and FMWL errors:

> Each time the memory is dumped (by default).

> Each time a manual check macro is encountered in the code.

- Each function return.
These checks can be performed either on all memory blocks or only a selection of
memory blocks. See Checking for ABWL and FMWL errors on page 209 for more

information.
Preserve block content

Set this setting to Yes to preserve the content of memory blocks freed by the
application. Use this setting to avoid application crashes when memory profiling
is engaged. When this setting is enable, reads to freed blocks of memory are no
longer detected.

4. Click OK, Apply the changes and close the Properties window.
Related reference

Memory profiling errors on page 1211

Memory profiling warnings on page 1213
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Related information

Memory profiling overview on page 208
Memory profiling user heap on page 210

Enable runtime analysis tools on page 187

Performance profiling overview

The performance profiling tool provides performance data for each software component so that you can locate the
performance bottlenecks.

With performance profiling, you can concentrate your optimization efforts on those portions of code, which can lead

to significant improvements in performance.

The performance profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. A Top Functions graph provides a high level view of the
largest time consuming functions in your application. The Performance Summary section of the report indicates, for
each instrumented function, procedure, or method (collectively referred to as functions), the number of calls and the
time spent in the function and in its descendants. For C language, it also provide an estimation of WCET. Optionally, it
includes the WCET calculation (Worst Case Execution Time) results.

Related information

About performance profiling reports on page 1187

Performance profiling settings

You can configure the performance profiling settings before running your application in HCL DevOps Test Embedded
for Eclipse IDE (Test Embedded for Eclipse IDE).

Build settings

All the following options must be set from the Build settings tab in the Properties window. To open this tab:

« In the Project Explorer, right-click on the project and click Properties. Alternatively, you can select the project,

[ =
and then click the settings icon “w~ on the toolbar.
« In the Properties window, click C C++ Build > Settings.

Enable the Performance Profiling

« In the Build Settings tab, click Settings > General > Selective instrumentation.
« In the right pane, click the Value field in Build options and click ... to open the Build options
window.

- In the Build options list, click Performance Profiling to enable the feature.
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Generate a trace file

« In the Build Settings tab, click Settings > Performance profiling.
« In Trace file name (.tqgf), click ... to open the editor window and specify a filename for the

generated .tgf trace file for performance profiling.

To get an evaluation of the Worst Case Execution Time in the report, you must set the WCET option.

Select the Worst Case Execution Time and/or the maximum execution time for each function and descendants:

« In the Build Settings tab, click Settings > Performance profiling.
« In the right pane, click Compute F max and F+D max time and select a value depending on the
execution time that you want to be calculated for your project:
> No: Does not calculate the maximum execution time for each function and descendants.
> Yes: Calculate the maximum execution time for each function and its descendants.
> Yes + WCET: Calculate the maximum execution time for each function and descendants,
and the Worst Case Execution Time. With this option selected, the report indicates the

number of time a function is called.

To get the performance profiling per entry point, you must enter the list of entry point threads of your application.
Entry points

To get the performance profiling per entry point, you must enter the list of entry points for each thread of
your application.

« In the Build Settings tab, click General > Multi-thread options.
» Click ... to open the editor and enter the list of entry points for each thread of your application .

Use commas to separate the thread names.

Then, run the application and see the Performance report.

Performance Profiling Results

The Performance Profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. When the configuration settings are set and the test

application is run, you can see the Performance Profiling report.

The default Performance report is in HTML format. It is generated from a template named wcetreport.template

provided as text file that you can modify to customize the report. It uses the following online JavaScript libraries:

» Bootstrap,

« JQuery,

« Font Awesome,
* VisJS.

« Chart.js
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The JavaScript libraries are now provided in the installation folderi nst al | ati on directory>/1ib/web. The

JavaScript libraries are downloaded from the internet as default. However, if you have no access to the internet, the
template uses the JavaScript libraries that are in your installation folder. If you want to share the report with someone
who does not have access to the internet, you might not install Test Embedded, make sure that the disk contains the

same folders and files as yoursin<i nst al | ati on directory>/1ib/web.

The Performance profiling report is made of Summary, Functions and the Call Graph parts.

SUMMARY

218

Summary table

The Summary table displays the total number of functions and the number of functions that have

never been executed and for which we have no data. If the instrumentation has been done with the
WCET option (Worst Case Execution Time), then the table contains the list of the entry points with an
evaluation of the WCET for each of them. This information can be empty (and the cell is red) if the
WCET could not be computed. This can occur when one of the called functions in the call graph starting

with this entry point has never been executed.

The WCET is given for each entry point if you have entered the list of entry point of your application in

the Settings. For more details, see Performance profiling settings on page 216.

Summary

# Functions and Entry Points

# Functions

29
# Never called Functions _

main

omput quationOfMime [ main obliquityCorrected mair recherche_elevation_Maxi [l recherche_elevation_X

iy

% Function Time Average Function Time

Function time graphs

The Summary is followed by two graphs that provide a high level view of the largest time consumers

detected by Performance Profiling in your application.

* % Function Time: It gives the five top functions with the greatest percentage of Function Time.
« Average Function Time: It gives the five top functions with the greatest Average Function Time.
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FUNCTIONS

The Functions section of the report displays a table with the instrumented functions, procedures or methods

(collectively referred to as functions) found in the application with the following information:

« Functions: Name of the function (in red if the function has never been executed).

If you have selected the WCET option, the chevron in front of the name allows the user to see how many times

this function calls other functions. This can help to understand how the WCET is calculated.

« EP: Indicate if this function is an entry point or not. You can provide the list of the entry points, or, if not, they
are deduced from the call graph (all the functions that are never called).

« # Calls: Number of times the function is called. If this value is 0, there is no more information for this function
in the table because it has never been executed.

« Function Time: Total time spent for executing the function, excluding its descendants.

- Function + Descendants Time: Total time spent for executing the function, including its descendants.

» % Function Time: Percentage of time spent in this function against the total execution time.

» % Function + Descendants Time: Percentage of time spent for executing the function and its descendants
against the total execution time.

- Average Function Time: Average time spent for executing this function, excluding its descendants.

» Max Function Time: Only if you set the option Compute F max and F + D max. Indicates the maximum time
spent in a call while executing this function, excluding its descendants.

» Max Function + Descendants Time: Only if you set the option Compute F max and F + D max time, see
Performance profiling settings on page 216. This is the maximum time spent in a call while executing this
function, including its descendants.

« WCET: Only if you set the option WCET, see Performance profiling settings on page 216. It gives an
evaluation of the Worst Case Execution Time. This information can be empty if the WCET could not be

calculated during the execution. It is the case when one of the function and its descendants has never been

executed. Click the chevron icon to deploy the list of functions that are not called.

Functions
% Max
Function % Function  Average Max Function
Function  + Desc. Function  + Desc. Function  Function  + Desc.
Functions Time Time Time Time Time Time “ Time
> main v o 13310us 153967us 8.64% 100% 13310us 13310us 153967us
write_st_elevation_time 1 445us 445us 0.29% 0.29% 445us 445us 445us 445us
Call Graph

The Call Graph part displays all the functions in an interactive call graph that can be moved from left to right or from
top to bottom. If the option WCET has been set, a tooltip on each function (node of the graph) gives the WCET. For

more information, see Performance profiling settings on page 216.
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Customize the Performance Report

You can customize a Performance report.

The Performance report is based on a template called wcetreport.template that you can find in the following folder:

* In Windows:

<installation_directory>\HCL\ DevOpsTest Enbedded\ | i b\reports

« In Unix:

<installation_directory>/ HCL/ DevOpsTest Enbedded/ | i b/ reports

Raw data

This template is made of three sections:

« The HTML section that is the common part of all reports,
« A JavaScript section that sets the tables and call graph depending of 2 variables dynamically initialized while

the report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
Raw data is composed of three sections at the top level:

« The list of the modules, each of them has the following information:
- Name is the short name of the C file,
o Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the function calls that are not in the known modules),
> functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules: {
"f5b5579edeacaB2df478a6780c0c4c92™: {
"name™: "USAGE.C"
“fullname™ "..."
"yuid": "f5b5579edeacal2df478a6780c0c4c92",
"unknown": \
"functions”™; [

"ba%b05ad703046fed306b4271b7ead7"”

]
b
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« The list of functions including following information:
> name is the name of the C function,
- line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
- module is a unique identifier of the module in which the function is declared,
o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
- maxLocal is the maximum time spent in the function, excluding its descendants.
- maxTotal is the maximum time spent in the function, including its descendants.
- sumLocal is the time spent in the function, excluding its descendants.
- sumTotal is the time spent in the function, excluding its descendants.
> weet is the Worst Case Execution Time of the function (this value is negative if it has not been
calculated).
« Functions are listed as hashmap with the uuid, as following:

"functions”; {
"bafebl5ad703046fed306b4 27 1bTead?™: {
“name": “wrile usage”,
“line™; 9,
"id™: 1,
"slacksize” -1,
"ypid": "bafeb(5ad703046fed 3060427 1b7ead?",
"module”; “fSb55 7 Yedeacal2df4 7 BabiB0clcdcs2”,
"calls"; [

"caling uuid” "bafeb0dad703046fed 3060427 1hFfeadi”,
"called _uuid™: “Fbicd643b5b44e 12051030627 20eba",
"line": 10,

"col™ 2,

"same. medule™
}

“-Ic'.rct" 1,

"calledby” |
"3bEb2065IcIbT Ofcid01baT97abae 1"

1,

“maslocal” 27,
“maxlalal’: 28,
"suml.ocal™: 3190,
"sumJatal’: 3853,
"averagel.ocal” O,
“weet”: 60
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- The final section contains the following information:
- entrypoints is the list of entry points of the application; each of them contains:
= name is the name of the entry points.
= module is the uuid of the module where is the entry point.
= wcet is the Worst Case Execution Time of the entry points (this value is negative if it has not
been calculated).
- timeunit is the unit of time used in the report (us is for micro-second, ms for millisecond, s for

second).
> level is the setting for performance (0 when there is no "compute F max + D max time", 1 when this

option is not set to yes, 2 when it is set to yes + WCET).

An example of this section:
"entrypoints™ [

"name”; "main”,
"module™: "57f1afe89e0ar74b786aab75cd448db9b",

"weet": -10
}
I
"timeunit': "us’,

"level": 2

Runtime tracing overview

Runtime Tracing is a feature for monitoring real time interaction of your code in a dynamic UML sequence diagram.

Runtime tracing uses source code instrumentation to generate trace data, which produces a UML sequence diagram.

UML sequence diagrams

The lifeline of an object is represented in the trace viewer as shown below. The instance creation box displays
the name of the instance. For more information about UML sequence diagrams, see the UML sequence diagram

reference on page 1211.

Step-by-step mode

When tracing large applications, it may be useful to slow down the display of the UML sequence diagram. You can do

this by enabling the step-by-step mode in the trace viewer.

Triggers

Sequence diagram triggers allow you to predefine automatic start and stop parameters for the trace viewer. The
trigger capability is useful if you only want to trace a specific portion of an instrumented application. Triggers can be

inactive, time-dependent, or event-dependent.
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Notes®

You can manually add your own notes inside your source code to make them display in the UML sequence diagram
when runtime tracing is enabled. To do this, you must insert the following instrumentation pragma macro, into the C

source code of the program:

#pragma attol att_insert_ATT_USER_NOTE("Text")

Advanced runtime tracing

On some platforms or for some specific applications, these settings might be useful.

Multithreaded programs

™

Runtime tracing can be configured for use in a multithreaded environment such as Posix, Solaris and Windows™.
Multithread mode protects target deployment port global variables against concurrent access. This causes a

significant increase in target deployment port size as well as an impact on performance.

To enable multithreaded mode, change the Maximum number of threads and Record and display thread info
configuration settings. See Changing runtime tracing settings on page 224 for more information about these

settings.

Partial trace flush

When using this mode, the target deployment port only sends messages related to instance creation and destruction,
or user notes. All other events are ignored. This can be useful to reduce the volume of the trace dump file. When
partial trace flush mode is enabled, message dump can be toggled on and off during trace execution. The partial

trace flush settings are located in the runtime tracing settings.

To do this manually, use the runtime tracing pragma user directives:

o _ATT_START_DUMP
« ATT_STCP_DUMP
o ATT TOGGLE DUMP

+ _ATT_DUMP_STACK

For example, add the following line to the source code to toggle the trace dump on or off:

#pragma attol insert _ATT_TOGGLE_DUMP

Trace item buffer

Buffering allows you to reduce formatting and processing at time-critical steps by instructing the target deployment
port to only output trace information when its buffer is full or at explicitly specified points in the program. This can

prove useful when using runtime tracing on embedded platforms with limited resources.

A smaller buffer optimizes memory usage on the target platform, whereas a larger buffer improves performance of

the real-time trace. The default value is 64.
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It can be useful to flush the buffer before entering a time-critical part of the application-under-trace. You can do this

by adding the _ATT_FLUSH | TEMS user directive to the source-under-trace. For example:

#pragma attol insert _ATT_FLUSH_ITEMS

Splitting trace files

During execution, runtime tracing generates a dynamic trace file (. t df ). When a large application is instrumented, the
size of the trace file can impact the display of the sequence diagram.

Splitting trace files allows you to produce multiple smaller files, resulting in better performance of the sequence
diagram viewer and lower memory usage. However, split trace files cannot be used simultaneously with the on-the-fly

tracing mode.

When displaying split trace files, synchronization elements are added to the UML sequence diagram to ensure that all

instance lifelines are synchronized.

Note: The total size of split trace files is slightly larger than the size of a single trace file because each file

contains additional context information.

Related reference
UML sequence diagram reference on page 1211
Related information

Runtime tracing overview on page 222

Changing runtime tracing settings

You can edit the configuration settings for runtime tracing to specify how the trace dumps are performed and how the

UML sequence diagram is drawn during or after the execution of the program.

To change the runtime tracing settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.

2. Click C/C++ Build > Settings and select Build Settings.

3. Expand Runtime tracing to access the runtime tracing settings and set the required options for dumping trace
data and drawing UML sequence diagrams.

Instrumentation control
Runtime Tracing file name (.tdf)

This allows you to force a filename and path for the dynamic . t df file. By default,
the . t df carries the name of the application node.
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Show data classes

When this option is disabled, structures or classes that do not contain methods
are excluded from instrumentation. Disable this option to reduce instrumentation
overhead.

Trace control
Split trace file

When you use several runtime analysis tools together, the executable produces a
multiplexed trace file, containing the output data for each tool. Use this option to

split the generated at | out . spt output trace file into multiple files.
Maximum size (Kbytes)

This specifies the maximum size for a split . t df file. When this size is reached, a

new split . t df file is created.
File name prefix:

By default, split files are named as at t _<nunber >. t df , where <number> is a 4-
digit sequence number. This setting allows you to replace the at t _ prefix with the
prefix of your choice.

Automatic loop detection

Loop detection simplifies UML sequence diagrams by summarizing repeating
traces into a loop symbol. Loops are an extension to the UML sequence diagram
standard and are not supported by UML.

Additional options

This setting allows you to add command line options. Normally, this line should be
left blank.

Display maximum call level

When selected, the target deployment port records the highest level attained by
the call stack during the trace. This information is displayed at the end of the
UML sequence diagram in the runtime tracing viewer as Maximum calling level
reached.

Runtime options
Disable on-the-fly mode

When selected, this setting stops on-the-fly updating of the dynamic . t df file. This

option is primarily for target deployment ports that use printf output.
Runtime tracing buffer and Partial Runtime Tracing flush

See Advanced runtime tracing on page 223 for more information about these
settings.
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Maximum buffer size (events)
The maximum number of events recorded in the buffer before it is flushed.
User signal action

Specify an action to be performed when a user signal is detected:
> No action: nothing.
- Flush call stack: the call stack is flushed to the trace file.

> Runtime tracing on/off: toggles the runtime tracing feature on or off.
Record and display time stamp

This setting adds timestamp information to each element in the UML sequence
diagram generated by runtime tracing.

Record and display heap size

This setting enables the heap size bar in the UML sequence diagram generated by

runtime tracing.
Record and display thread info

This setting enables the Thread Bar in the UML sequence diagram generated by

runtime tracing.

4. Click OK, Apply the changes and close the Properties window.

Related reference
Build configuration settings on page 1199
Related information

Runtime tracing overview on page 222

Advanced runtime tracing on page 223

Installing the Recommended GNU Compiler on Windows

Since the Tutorial requires access to both a C and C++ compiler, if you are working on a Windows operating system
and you do not have Windows Visual C++ 6.0 installed, you are advised to install the following, recommended GNU C
and C++ compiler. It is free to use and simple to install.

Name: MinGW

Home Page: MinGW - Minimalist GNU for Windows


https://osdn.net/projects/mingw/
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1. Locate and download the latest distribution archive to your machine.

2. Install the distribution as described in the MinGW documentation.

3. To verify a successful installation, open a DOS window, type gcc -v, then press the Enter key. You should see
output close to the following:

Reading specs from c:/mingw/bin/../lib/gcc-lib/mingw32/2.95.3-5/specs

Note that your base installation directory may differ.

The Target Deployment Port for the MinGW compiler needs to properly reference the location of certain MinGW
folders. To do this, you will open the TDP template for the MinGW compiler, make the proper path modifications,
and then create the actual TDP for use on your machine. For more information about the Target Deployment Port

technology, see Host-based Testing vs Target-based Testing.

1. Using the Start menu on your computer, select:

Programs > IBM DevOps Test Embedded > Target Deployment Port Editor

. Maximize the TDP Editor window.
. Select the menu item File->Open.
. Open the TDP template gccmingw_template.xdp

a A WODN

. The fields you need to modify - in order to reflect the MinGW installation location on your machine - are
highlighted in a large text box in the lower-right of the Editor, entitled Comment for the root node. If you can
not see this edit box, left-click any node in the tree browser to the left other than the topmost node - named
Gnu 2.95.3-5 (mingw) - and then click the topmost node. (This topmost tree node contains the name you will
see in the Test Embedded interface.)

6. Make the corrections specified in the edit box entitled Comment for the root node. Every use of the text C:

\Gcc must be replaced by the path to the top level folder of your machine's MinGW installation.

7. Select the menu item File->Save As...

8. In the File Name edit box, type the name cwinmingw, and then click the Save button.

You just created a Target Deployment Port customized for your machine's MinGW installation - the files for this TDP
were saved in the targets folder (which contains the TDP templates folder) in a folder named cwinmingw. Proceed

with the tutorial.

Static metrics overview

Statistical measurement of source code properties is an extremely important matter when you are planning your test
work for a software project. HCL DevOps Test Embedded (Test Embedded) provides a static metrics report, which

displays complexity data and statistics for your source code.
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Halstead metrics

Halstead complexity measurement was developed to measure a program module's complexity directly from source
code, with emphasis on computational complexity. The measures were developed by the late Maurice Halstead as a

means of determining a quantitative measure of complexity directly from the operators and operands in the module.
Halstead provides various indicators of the module's complexity

Halstead metrics allow you to evaluate the testing time of any C/C++ source code. These only make sense at the

source file level and vary with the following parameters:

Table 7.
Para-
meter Meaning
N Number of distinct operators
ny Number of distinct operands
N4 Number of operator in-
stances
N, Number of operand instances

When a source file is selected in the metrics report, the following results are displayed:

Table 8.

Metric Meaning Formula

n Vocabulary nq+ny

N Size N7 + Ny

\Y Volume N *log2 n

D Difficulty n1/2 * No/ny
E Effort V*D

B Errors V /3000

T Testing E/k

time

In the above formulaeg, k is the stroud number, which has an arbitrary default value of 18. With experience, you can
adjust the stroud number to adapt the calculation of the estimated testing time (T) to your own testing conditions:
team background, criticity level, and so on.

When the project is selected, the metrics viewer displays the total testing time for the entire project.
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V(g) or cyclomatic number

The V(g) or cyclomatic number is a measure of the complexity of a source code function that is correlated with
difficulty in testing. The standard value is between 1 and 10. A value of 1 means the code has no branching. A

function's cyclomatic complexity should not exceed 10.

The static metrics report displays the V(g) of a function in the Metrics tab when a source file or function is selected.
When the type of the selected node is a source file, the sum of the V(g) of the contained function, the mean, the
maximum and the standard deviation are calculated.

At the project level, the same statistical treatment is provided for every function in any source file.

Changing static metric settings
You can edit the configuration settings for static metrics to specify how the source code statistics are generated.

To change the static metric settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.

2. Click C/C++ Build > Settings and select Build Settings.

3. Expand Static metrics to access the runtime tracing settings and set the required options for dumping trace
data and drawing UML sequence diagrams.

One level metrics

By default, . met static metric files are produced for source files as well as all dependency files
that are found when parsing the source code. Set to Yes to restrict the calculation of static

metrics only to the source files displayed in the navigator.
Analyzed directories

This setting allows you to restrict the generation of . met metric files only to files which are

located in the specified directories.
Generate metrics in source directories

By default, all . et files are generated in the project directory, and use the same name as the
source file. Select Yes on this setting to compute metrics for source files that have the same
name but are located in different directories. In this case, each . net is generated in the source

directory of each file.
Additional options
Use this setting to specify extra command line options. In most cases, this should be empty.

4. Click OK, Apply the changes and close the Properties window.

Related information

Static metrics overview on page 227
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Code review

Automated source code review is a method of analyzing code against a set of predefined rules to ensure that the
source adheres to guidelines and standards that are part of any efficient quality control strategy. HCL DevOps Test
Embedded (Test Embedded) provides an automated code review tool, which reports adherence to guidelines for your

C source code.

Test Embedded code review tool implements rules from the MISRA-C: 2004 and MISRA C-: 2012 standards, which are
guidelines for the use of the C language in critical systems.

Code review is part of the runtime analysis tools and can be enabled during a test run or in the project configuration
settings.

When an application or test node is built, the source code is analyzed by the code review tool. Code review can be
performed each time a node is built, but can also be calculated without executing the application. The tool checks the

source file against the predefined rules and produces an HTML report and a .crc report.

Report

When the build is complete, the code review report lists the following elements:

« The Outline window displays a list of rules that were not compliant for each source file and function. You can
use the elements in this view to navigate through the report.

- A summary provides information about the general configuration, the date and the number of analyzed files. It
also lists the number of errors and warnings that were encountered.

« The code review report lists the rules for which errors or warnings were detected. It also provides information
about the location of the error. You can click the title to go directly to the corresponding line in the source

code.

Related reference
Code review MISRA 2004 rules on page 238
Related information

Enable runtime analysis tools on page 187

Configuring code review rules

The code review tool uses a set of predefined rules. You can select the default rule configuration file for the code
review tool. MISRA 2004 and MISRA 2012 from HCL DevOps Test Embedded (Test Embedded) 8.2.0 are the default
installed rule configuration files. You can disable or set the severity level to Warning. You can also configure the entry-
point option if your application is multi-threaded.

About this task
By default all rules are enabled and produce either an error or a warning in the code review report. You can
save multiple customized rule policies. The default rule policy files MISRA 2004 and MISRA 2012 are located
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in:<i nstal | ation directory>/plugins/ Comon/|ib/confrul e.xm . Do not modify the default rule
configuration files. The only change that can be done in the default rule configuration files is to change or disable the

severity level of the rule.

Note: For all new projects, you must select the configuration file that must be used. When you make any
changes to the rule policy file, you can save the new policy file in the project.

To select the configuration file and disable or set the severity level of code review rules:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.

i
Alternatively, you can select the project, and then click the settings icon W on the toolbar.
2. Expand C/C++ Build in the left panel, select Settings.
3. In the right panel, in the Build tab, expand Settings and select Code Review.
4. Expand Code review to access the code review settings.

@ Properties for myProject O *
type filter text smings =14 v w
» Resource
L)
Builders
« C/C++ Build Configuration: 'build [ Active ] ~ | Manage Configurations...

Build Variables

Environment - .
Build Artifact ki Binary Parsers @ Error Parsers Build TDP Build Settings 4 | *

Logging
settings Enable HCL OneTest Embedded instrumentation.
Tool Chain Editor = ;
» CfC++ General Al Name Value
Project Facets General Rule configuration | confrule| ., |_| X
Project References - Code coverage Additional includ...

+ Memaory Profilin
Run/Debug Settings v . g
Application Profiling )
Task Tags » Include files
Validation Performance Profiling Disolay E All
Coupling isplay Errors/W...
» Runtime tracing
Static metrics

Code Review

Review included .. No

Naming script file
Report Template

@ Apply and Close Cancel

5. Click in the value on the Rule configuration row and click ... to select a rule configuration file.

Note: If your configuration file is an out-of-date version, you are prompted to update it. Click ok to

select the rules that are missing in your configuration file. The selected rules are added with their
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pg default severity levels to your configuration file. Unselected rules are added to your configuration file

as disabled rules.

6. Select the default MISRA 2004 or MISRA 2012 rule configuration file that are installed with the product.
Alternatively, click + to select a new rule configuration in your browser.

7. Click OK.
Result

The path to the selected rule configuration is displayed in the value column on the Rule Configuration line.

0=
8. On the Rule configuration row, click the to open the Rule Configuration window.

B ' Rule configuration X

DATESTRT\Mew folder\myProject\confrule_2012.xml

~ MISRA C:2012 ~ | MName
« 1- A standard C environment
Rule M1.1 (Errar)
Rule M1.1W (Error)

| Rule M1.2 (Warning)
Rule E1.1 (Error) Functions should have less than S6param:’

Rule E1.2 (Error) parameters (current value : S%enamesc).

|

Rule E1.12

Description:

Rule E1.3 (Error) Severity
Rule E1.4 (Error) () Disable () Waming @) Error
Rule E1.

ule E1.5 (Error) Pt
Rule E1.6 (Error)
Rule E1.7 (Error) Function number of parameters
Rule E1.8 (Error) 5

Rule E1.9 (Error)

Rule E1.10 (Error)

Rule E1.11 (Error)

Rule E1.12 (Error)
= 2- Unused code

] Only show the first occurrence for each file

Find next

Save & Close Cancel Save As..

9. In the Rule configuration window, select the rule that you want to configure.
Rules are grouped into categories. You can filter the rules by labels from the Find field. Search is not case
sensitive.
When a rule is selected, its description is displayed on the right panel with the parameter description and value
if any parameter is available for the selected rule.

10. On the right panel, select the severity level:
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a. Disabled: The selected rule is ignored and is not displayed in the code review report.
b. Warning: When the rule condition is found, a warning is displayed in the code review report.

c. Error: When the rule condition is found, an error is displayed in the code review report.

Note: Multiple user-custom rules (from Rule U99.1 to Rule U99.10) can be defined for MISRA
2004 and MISRA 2012 with their own severity level.

11. Select Show only the first occurrence to only show the first occurrence of a rule condition in a file. Any

subsequent occurrences of the condition are not reported.

Note: If your application is multi-threaded, you can provide the list of entry points to avoid that the

rules about 'non-used functions' are raised.

To configure the Multi_thread option, follow these steps:

12. In the Project Explorer, right-click the project on which you want to change the settings and click Properties.
13. Click C/C++ Build > Settings and select Build Settings.

14. In the right panel, click SettingsGeneral > Multi-Thread option.

15. Click ... in the value field of the Entry points option to open the editor.

16. In the editor, enter the list of entry points for each thread and click OK.

17. Click OK, Apply the changes and close the Properties window.

Note: The Entry point option applies to rule E16.50 (MISRA_2004) and M2.2.2 (MISRA 2012).

Related reference
Code review MISRA 2004 rules on page 238
Related information

Code review on page 230

Using a customized Naming script file

In HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE), you can utilize the capabilities of
Code Review to edit and customize a Perl Naming script file, adapting it to comply with your specific naming rules.

With this feature, you have the flexibility to verify only the symbols found within the sources under test.

Testing symbols name with a customized script file

In Test Embedded or Test Embedded Studio, you can use Code Review to perform naming rule checks on the symbols

in your source code under test.

233



HCL DevOps Test Embedded

These symbol can be:

* Enum names
« Struct/union fields names
» Variables names

« Functions names

Exemple

These checks are performed using a Perl Naming script file that you can customize to your specific naming rules. The
Rules raised can be Rule U99.1 to Rule U99.10. You have the flexibility to adjust their level (error/warning) within the
confure_2012. xni and confrul e. xni files. The rule description is passed as a parameter, that allow you to set it inside

the Perl script.

The build phases are:

1. Generate a .xob for each source
> Use the crccc to create a .xob file for each source, incorporating symbols such as @ars, @ ypes,
@i el ds, @nuns, @cts, @i | es, and @aset ypes. This process results in the generation of the Naming
database in Perl.
2. Generate a cross reference file in Perl format
o Utilize crcl d with the -xref option to generate a cross-reference file in Perl format (<xref_file_name.pl>),
which includes information on files, types, variables, and functions.
3. Create a Perl script with custom rules
- Create a Perl script that incorporates specific rules, by using the database created
(<xref_file_name.pl>). See the database array description in the example script "NamingRules1.pl"
located in<I nstal | ati on fol der>\1ib\scripts. The Perl script creates an additional .xob file
containing the application of your user-defined rules to the existing database.
4. Generate the Code Review report
o Utilize crcl d on all .xob files, which include those generated by crccc and your custom script file.
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Setting the path to a customized Naming script file:

1. From the Project Explorer view, select the project node.

L C—
o &Testing_c
SR>
: - Results
o &3doublepty
@ E"@sc:lunma-.t:
f & E‘&ﬂud
Results
v o é"@ﬂaat.pm
4 R T

2. Right-click and select Settings.

L Settmgs .
' o P L~
o B "ﬂ‘ View Report ¥
# [> Build Ctrl+B
Rebuild Ctrl+R
@ 3 Clean

o 4 % Execute Testing_C
Y| #F Debug Testing C

Settings...

+ z z
Source Control

g Project Bn  Properties

Chapter 6. Test Execution Specialist Guide

3. Select Code Review > Naming script file and then select the Perl script checking your naming rules.
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5. Select the sample file that you installed: Example “NamingRules1.pl".

6. Click Apply.

Modifying the naming rules

You are provided with a tool along with the file 'NamingRules1.pl, located in the folder <l nstal | ati on fol der>

\lib\scripts.
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The 'NamingRules1.pl' file contains several examples of Naming Rule checkers, all linked to the first rule, U99.1. You
can copy and edit this example. Modify existing rules or add new rules based on the documentation found in the
header file (database array description).

Using naming script from the command line in Makefile

Analyze C source code under test and generate an object file (.xob).
crccc <source> <xob> <def> <opp> [<options>]

where:

<source> is the C source file under analysis.

<xob> is the name of the generated object file.

<def> is the standard definitions file. This file is searched in the SATLTGT directory.
<opp> is the parser options file. This file is searched in the SATLTGT directory.

For example,
crccc mysource.c output.xob atus_c.def atl.opp rule=$TESTRT_DIR/plugins/Common/Llib/confrule.xml

For more information about the options, see C Code Review Compiler - crccc on page 1345.

You can use crcld in the following manner:

crcld -xref="<model_file>.pl" "<crccc_result_file>.xob" -RULE="<confrule file>.xml" -TEST

» <model _fil e>. pl : Contains data needed for custom namecheck rules.
e <model _fil e>. R99. 1. xob: File to be used in the final launch of crcl d.

You can use this xob file as usual on next call to crcld:

crcld -crc="<crc_file_name>.crc" "<all other xob file name>.xob" "<model_file>.R99.1.x0b"
-RULE="<confrule_file>.xml" -TEST

Code review deviations

In some cases, it can be useful to temporarily ignore a rule non-compliance on a short portion of source code, while

documenting the reason why you are allowing this deviation.

About this task

You can justify why you are allowing the deviation in a text. The text is added to the non-compliance in the
source code. You can declare a deviation in the source code, for a specified number of lines and for the first or all
occurrences of the error, by adding pragma lines to your source code.

1. Open the source file in the Text editor and find the lines of code that you want the rule to ignore.
2. Before the section of code for which compliance to the rule should be ignored, add one of the following lines:
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> To justify non-compliance of a rule to the following pragma statement in the first occurrence:

#pragma attol crc_justify (<rule>[,<lines>],"<text>")

> To justify non-compliance of a rule to the following pragma statement in all occurrences:

#pragma attol crc_justify_all (<rule>,<lines>,"<text>")

o To justify the first occurrence of non-compliance of a rule in all the files of the current project,

including in traps located before the pragma statement:

#pragma attol crc_justify_everywhere (<rule>,"<text>")

> To specify what type is used as boolean type, include this pragma in a separate file and use the crccc

option -preinclude. In Studio and Visual Test, this option can be set by setting Include file in the Code

Review section

#pragma attol type_boolean=<myType>

For all the pragma statements: <rule>

The recommended usage for crc_j usti fy_ever ywher e is to create a specific source file containing only the list

o <rul e> is the name of the code review rule (for example: 'Rule M8.5").

o <lines> is the number of lines.

o <t ext > is the reason why the rule is ignored.

of pragma statements and add this file to the project.

Code review MISRA 2004 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be

individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules

also have parameters that can be changed. Among other guidelines, the code review tool implements most rules

from the MISRA-C:2004 standard, "Guidelines for the use of the C language in critical systems". These rules are

referenced with an M prefix. In addition to the industry standard rules, Test Embedded provides some additional

coding guidelines, which are referenced with an E prefix.

Code Review for C - MISRA 2004 rules

Table 9. MISRA 2004 rules

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

Code compliance

M1.1 Rule 1.1 All code shall conform to ISO ANSI C error: <error> Required
9899:1990.

M1.1w ANSI C warning: <warning>
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
No reliance shall be placed on

M1.2 Rule1.2 Required |U -

uie undefined or unspecified behav- equire nsup
. ported
iour.
Rule1.3 Multiple compilers and/or lan-

M1.3 Required |U -
guages shall only be used if equire nsup
there is a common defined in- ported
terface standard for object code
to which the languages/compil-
ers/assemblers conform.

M1.4 Rule1.4 The compiler/linker shall be Required | Unsup-
checked to ensure that 31 char- ported
acter significance and case sen-
sitivity are supported for external
identifiers.

M 1.5 Rule1.5 Floating-point implementations Required | Unsup-
should comply with a defined ported
floating-point standard.

Language extensions

M2.1 Rule 2.1 Assembly language shall be en- Required | Unsup-
capsulated and isolated. ported
Source code shall only use /* ...

M2.2 Rule 2.2 Source code shall only use /* ... | Required
*/ style comments.

*/ style comments.

M2.3 Rule 2.3 | The character sequence /* shall | The character sequence /* shall | Required
not be used within a comment. | not be used within a comment.

M2.4 Rule 2.4 | Sections of code should not be Advisory | Unsup-
“commented out” ported
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Table 9. MISRA 2004 rules (continued)

with the provisions of this docu-
ment, and shall have been sub-

ject to appropriate.

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

Documentation
All usage of implementation-de- )

M3.1 Rule 3.1 fined behaviour shall be docu- Required | Unsup-

ported
mented.

M3.2 Rule 3.2 | The character set and the corre- Required | Unsup-
sponding encoding shall be doc- ported
umented.

M3.3 Rule 3.3 |The implementation of integer Advisory | Unsup-
division in the chosen compil- ported
er should be determined, docu-
mented and taken into account.

Use of #pragma <name> should
M3.4 Rule 3.4 | All uses of the #pragma direc- Required
always be encapsulated and ex-
tive shall be documented and ex- .
plained.
plained.
Rule 3.5

M3.5 If it is being relied upon, the im- Required | Unsup-
plementation-defined behaviour ported
and packing of bitfields shall be
documented.

Rule 3.6

M3.6 All libraries used in production Required | Unsup-

code shall be written to comply ported

Character sets
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Only escape sequences that are | Only ISO C escape sequences
M4.1.1 Rule 4.1 Required
uie defined in the ISO C standard are allowed. equire
hall b d.
shalibe use Only ISO C escape sequences
M4.1.2
are allowed(\v).
M4.2 Rule 4.2 | Trigraphs shall not be used. Trigraph <name> should not be | Required
used.
Identifiers
M5.1 Rule 5.1 Identifiers (internal and external) | Identifiers <name> and <name> | Required
shall not rely on the significance | are identical in the first <value>
of more than 31 characters. characters. The number of char-
acters can be specified.
M5.2 Rule 5.2 Identifiers in an inner scope Identifier <name> in an inner Required
shall not use the same name as | scope hides the same identifier
an identifier in an outer scope, in an outer scope : %location%.
and therefore hide that identifier.
A typedef name shall be a
M5.3.1 Rule 5.3 . . . The typedef name <name> Required
unique identifier.
should not be reused except for
its tag. Name already found in
%location%.
The typedef name '<name>"'
M5.3.2 .
should not be reused even for its
tag. Name already found in %lo-
cation%.
Rule 5.4 A struct and union cannot use
M5.4 A tag name shall be a unique Required
the same tag name.
identifier.

241



HCL DevOps Test Embedded

Table 9. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Rule 5.5
M5.5 No object or function identifi- The static object or function Advisory
er with static storage duration <name> should not be reused.
should be reused. Static object or function already
found in %location%.
M5.6 Rule 5.6 | No identifier in one name space | Avoid using the same identifier | Advisory
should have the same spelling <name> in two different name
as an identifier in another name | spaces. Identifier already found
space, with the exception of in %location%.
structure and union member
names.
M5.7 Rule 5.7 No identifier name should be The identifier <name> should Advisory
reused. not be reused. Identifier already
found in %location%.
Types
M6.1.1 Rule 6.1 The C language plain char type | The C language plain char type | Required
should only be used for charac- | should only be used for charac-
ter values. ter values.
M6.1.2 Rule 6.1 Case char value is applicable on- | Required
ly if the switch statement value
is plain character variable.
M6.1.3 Rule 6.1 Avoid using comparison opera- | Required
tors on plain char.
M6.2 Rule 6.2 | The C language signed char or | The C language signed char or | Required
unsigned char types should only | unsigned char types should only
be used for numeric values. be used for numeric values.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M6.3 Rule 6.3 | typedefs that indicate size and | The C language numeric type Advisory
signedness should be used in <name> should not be used di-
place of the basic types. rectly but instead used to define
typedef.
Bit fields should only be of type
M6.4.1 Rule 6.4 . . . . Bit fields should only be of type | Required
unsigned int or signed int
‘unsigned int' or 'signed int'.
M6.4.2 Bit fields should not be of type
‘enum’.
M6.4.3 Bit fields should only be of ex-
plicitly signed or unsigned type.
M6.4.4 Bit fields should not be of type
'boolean’ outside c99.
M6.4.5
M6.5 Rule 6.5 |Bit fields of type signed int must | Bit fields of type 'signed int' must | Required
be at least 2 bits long. be at least 2 bits long.
Constants
Octal constants (other than ze- | Octal constants and escape se-
M7.1 Rule 7.1 Required
ro) and octal escape sequences | quences should not be used.
shall not be used.
Declarations and definitions
M8.1.1 Rule 8.1 Functions shall have prototype | A prototype for the static func- | Required
declarations and the prototype |tion <name> should be declared
M8.1.2 shall be visible at both the func- | before defining the function.
tion definition and call.
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Table 9. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M8.1.3
M8.2.1 Rule 8.2 | Whenever an object or function | The type of <name> should be Required
is declared or defined, its type explicitly stated.
M8.2.2 shall be explicitly stated. Required
Rule 8.3 | For each function parameter the | Parameters and return types
M8.3 . . . Required
type given in the declaration and | should use the same type
definition shall be identical, and | names in the declaration and in
the return types shall also be the definition, even if basic types
identical. are the same.
Rule 8.4 | If objects or functions are de- If objects or functions are de- Required
M8.4 . . . . . .
clared multiple times their types | clared multiple times their types
should be compatible. should be compatible.
Rule 8.5 | There shall be no definitions of | The body of function <name>
M8.5.1 Required
objects or functions in a header |should not be located in a head- equire
file. er file.
The memory storage (definition)
M8.5.2 .
for the variable <name> should
not be in a header file.
Rule 8.6 | Functions should not be de- Functions should not be de-
M8.6 Required
clared at block scope. clared at block scope. equire
Rule 8.7 | Objects shall be defined at block | Global objects should not be de-
M8.7 . . Required
scope if they are only accessed | clared if they are only used from
from within a single function. within a single function.
Static function <name> should
M8.8.2 Rule 8.8 Required
uie only be declared in a single file. equire
Redundant declaration found at:
M8.8.3 %location%.
Identifiers <name> that declare
M8.8.4 . . .
objects or functions with exter-
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
nal linkage shall be declared
once in one and only one file.
Identifiers <name> that declare
M8.8.5 objects or functions with exter-
nal linkage shall be unique.
An identifier with external link- The global object or function
M8.9.1 Rule 8.9 age shall have exactly one exter- | <name> should have exactly one Required
nal definition. external definition. Redundant
definition found in %location%.
The global object or function
M8.9.2 <name> should have exactly one
external definition. No definition
found.
Rule 8.10 |All declarations and definitions | Global object <name> that are
M8.10.1 of objects or functions at file only used within the same file Required
scope shall have internal link- should be declared using the
M8.10.2 age unless external linkage is re- | static storage-class specifier.
quired.
M8.11 Rule 8.11 | The static storage class speci- | Global objects or functions that | Required
fier shall be used in definitions | are only used within the same
and declarations of objects and | file should be declared with
functions that have internal link- | using the static storage-class
age. specifier.
M8.12 Rule 8.12 | When an array is declared with | When a global array variable can | Required
external linkage, its size shall be |be used from multiple files, its
stated explicitly or defined im- size should be defined at initial-
plicitly by initialisation. ization time.
Initialisation
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Table 9. MISRA 2004 rules (continued)

floating type shall not be implic-

ing expression is not allowed.

Only constant expressions can

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Variables with automatic stor- )
M9.1 Rule 9.1 age duration should be initial- Required
ized before being used.
Nested braces should be used to | Required
M9.2 Rule 9.2 initialize nested multi-dimension
arrays and nested structures.
M9.3 Rule 9.3 In an enumerator list, the “=" Either all members or only the Required
construct shall not be used to first member of an enumerator
explicitly initialize members oth- | list should be initialized.
er than the first, unless all items
are explicitly initialized.
Arithmetic type conversions
Implicit conversion of a complex
M10.1.1 Rule 10.1 | The value of an expression of in- | . . Required
integer expression to a smaller
teger type shall not be implicitly sized integer is not allowed.
M10.1.2 | Rule 101 converted to a different underly-
ing type if:
- a) itis not a conversion
to a wider integer type of
the same signedness, or
* b) the expression is
complex, or
« c) the expression is not
constant and is a func-
tion argument, or
« d) the expression is not
constant and is a return
expression.
M10.2 Rule 10.2 | The value of an expression of Conversion of a complex float- | Required
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constants of unsigned type.

stants should use the 'U' suffix.

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
itly converted to a different type | be implicitly converted and on-
if: ly to a wider floating type of the
same signedness.
- a) itis not a conversion
to a wider floating type,
or
* b) the expression is com-
plex, or
- ¢) the expression is a
function argument, or
« d) the expression is a re-
turn expression.
M10.3 Rule 10.3 | The value of a complex expres- | Type cast of complex integer Required
sion of integer type may only expressions is only allowed in-
be cast to a type that is narrow- |[to a narrower type of the same
er and of the same signedness [ signedness. Type cast of com-
as the underlying type of the ex- [ plex floating expressions is only
pression. allowed into a narrower type of
the same signedness.
M10.4 Rule 10.4 | The value of a complex expres- Required
sion of floating type may only be
cast to a narrower floating type.
M10.5 Rule 10.5 |If the bitwise operators ~ and << | When using operator '~' or '<<' Required
are apply to an operand of un- on 'unsigned char' or 'unsigned
derlying type unsigned char or int, you should always cast re-
unsigned int, the result shall be | turned value.
immediately cast to the underly-
ing type of the operand.
M10.6 Rule 10.6 | A “U" suffix shall be applied to all | Definitions of unsigned type con- | Required

Pointer type conversions
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M11.1 Rule 11.1 | Conversions shall not be per- A function pointer should not Required
formed between a pointer to a be converted to another type of
function and any type other than | pointer.
an integral type.
M11.2 Rule 11.2 | Conversions shall not be per- An object pointer should not be | Required
formed between a pointer to ob- | converted to another type of
ject and any type other than an | pointer.
integral type, another pointer to
object type or a pointer to void.
M11.3 Rule 11.3 | A cast should not be performed | Casting a pointer type to an inte- | Advisory
between a pointer type and an ger type should not occur.
integral type.
M11.4.1 Rule 11.4 | A cast should not be performed | Casting an object pointer type Advisory
between a pointer to object type |to a different object pointer type
and a different pointer to object [ should not occur.
type.
Casting an object pointer type
M11.4.2 to a different object pointer type
should not occur, especially
when object sizes are not the
same.
M11.5 Rule 11.5 | A cast shall not be performed Casting of pointers to a type that [ Required
that removes any const or removes any const or volatile
volatile qualification from the qualification on the pointed ob-
type addressed by a pointer. ject should not occur.
Expressions
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence

M12.1 Rule 12.1 |Limited dependence should be | Implicit operator precedence Advisory
placed on C's operator prece- may cause ambiguity. Use
dence rules in expressions. parenthesis to clarify this ex-

pression.

M12.2 Rule 12.2 | The value of an expression shall Required |Unsup-
be the same under any order of ported
evaluation that the standard per-
mits.

Required

M12.3 Rule 12.3 | The sizeof operator should not | The size of operator should not
be used on expressions that be used on expressions that
contain side effects. contain side effects.

M12.4.1 Rule 12.4 | The right-hand operand of a log- | An expression that contains a Required
ical && or || operator shall not side effect should not be used in
contain side effects. the right-hand operand of a logi-

cal && or || operator.
M12.4.2 The function in the right-hand
operand of a logical && or || op-
erator might cause side effects.
Required

M12.5 Rule 12.5 | The operands of a logical && or | Parenthesis should be used

[| shall be primary-expressions around expressions that are
operands of a logical && or ||.

M12.6 Rule 12.6 | The operands of logical opera- | Only Boolean operands should | Advisory
tors (&&, || and !) should be ef- be used with logical operators
fectively Boolean. Expressions | ( &&, | and!).
that are effectively Boolean
should not be used as operands
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
to operators other than (&&, ||
and!)

M12.7 Rule 12.7 |Bitwise operators shall not be Bitwise operators should only Required
applied to operands whose un- | use unsigned operands.
derlying type is signed.

M12.8 Rule 12.8 | The right-hand operand of a shift | The right-hand operand of a shift | Required
operator shall lie between zero | operator should not be too big or
and one less than the width in negative.
bits of the underlying type of the
left-hand operand.

M12.9 Rule 12.9 | The unary minus operator shall | Only use unary minus operators | Required
not be applied to an expression | with signed expressions.
whose underlying type is un-
signed.

M12.10 Rule The comma operator shall not Do not use the comma operator. | Required

12.10 be used.
Evaluation of constant expres- | Advisory

M12.11 Rule Evaluation of constant unsigned | .

sions should not lead to un-
12.11 integer expressions should not . .
signed integer wrap around.
lead to wrap around.

M12.12 Rule12.12 | The underlying bit representa- Required | Unsup-
tions of floating-point values ported
shall not be used.

M12.13 Rule The increment (++) and decre- | The increment (++) or the decre- | Advisory

12.13 ment () operators should not | ment (--) operators should not
be mixed with other operators in | be used with other operators in
an expression. an expression.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Control statement expressions
M13.1.1 Rule 13.1 | Assignment operators shall not | Boolean expressions should not | Required
be used in expressions that yield | contain assignment operators.
a Boolean value .
M13.1.2 Boolean expressions should not
contain side effect operators.
M13.2 Rule 13.2 | Tests of a value against zero Non-Boolean values that are Advisory
should be made explicit, un- tested against zero should have
less the operand is effectively an explicit test.
Boolean.
M13.3 Rule 13.3 |Floating-point expressions shall | The equal or not equal opera- Required
not be tested for equality orin- [ tor should not be used in float-
equality. ing-point expressions.
Floating-point variables should
M13.4 Rule 13.4 | The controlling expression of a Required
not be used to control a for
for statement shall not contain
statement.
any objects of floating type.
Only loop counter should be ini-
M13.5.1 Rule 13.5 | The three expressions of a for . . e Required
tialized in a loop initialization
statement shall be concerned
part.
with loop control only.
M13.5.2 In the 'update part' of a 'for
statement, only 'loop counter'
should be updated.
There should be one and only
M13.5.3
one loop counter for loop state-
ment.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M13.6 Rule 13.6 | Numeric variables being used Loop counter of a 'for statement' | Required
within a for loop for iteration should not be modified within
counting shall not be modified in | the body of the loop.
the body of the loop.
M13.7 Rule 13.7 | Boolean operations whose re- Invariant Boolean expressions Required
sults are invariant shall not be should not be used.
permitted.
Control flow
M14.1 Rule 14.1 | There shall be no unreachable Unreachable code Required
code.
A non-null statement should ei-
M14.2 Rule 14.2 | All non-null statements should . Required
ther have a side effect or change
either: a) have at least one side-
the control flow.
effect however executed, or b)
cause control flow to change.
M14.3 Rule 14.3 | Before preprocessing, a null A null statement in original Required
statement shall only occur ona | source code should be on a sep-
line by itself; it may be followed | arate line and the semicolon
by a comment provided that the |should be followed by at least
first character following the null | one white space and then a
statement is a white-space char- | comment.
acter.
M14.4 Rule 14.4 | The goto statement shall not be | Do not use the goto statement. | Required
used.
M14.5 Rule 14.5 | The continue statement shall not | Do not use the continue state- Required
be used. ment.

252




Table 9. MISRA 2004 rules (continued)

Chapter 6. Test Execution Specialist Guide

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M14.6 Rule 14.6 |For any iteration statement there | Only one break statement Required
shall be at most one break state- | should be used within a loop.
ment used for loop termination.
M14.7.1 Rule 14.7 | A function shall have a single Only one exit point should be de- | Required
point of exit at the end of the fined in a function.
function.
M14.7.2 The return keyword should not
be used in a conditional block.
M14.8.1 Rule 14.8 | The statement forming the body | The switch statement should be | Required
of a switch, while, do ... while or [ followed by a compound state-
for statement shall be a com- ment {}.
pound statement.
M14.8.2 The while statement should be
followed by a compound state-
ment {}.
M14.8.3 The do..while statement should
contain a compound statement
{
M14.8.4 The for statement should be fol-
lowed by a compound statement
{.
M14.9.1 |Rule 14.9 |Anif (expression) construct The if (expression) construct Required
shall be followed by a com- should be followed by a com-
pound statement. The else key- [ pound statement {}.
word shall be followed by either
M14.9.2 a compound statement, or an- The else keyword should be fol-
other if statement. lowed by either a compound
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represent a value that is effec-

tively Boolean.

a switch expression.

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
statement or another if state-
ment.
M14.9.3 The else keyword should be fol-
lowed by a compound state-
ment.
M14.10 Rule Allif ... else if constructs shall be | All if ... else if sequences should | Required
14.10 terminated with an else clause. | have an else block.
Switch statements
The MISRA C switch syntax shall | A switch block should start with
M15.0 Rule 15.0 Required
be used. a case.
M15.1 Rule 15.1 | A switch label shall only be used | A case or default statements Required
when the most closely-enclos- | should only be used directly
ing compound statement is the [ within the compound block of a
body of a switch statement. switch statement.
M15.2 Rule 15.2 | An unconditional break state- The break statement should only | Required
ment shall terminate every non- | be used to terminate every non-
empty switch clause. empty switch block.
M15.3.1 Rule 15.3 | The final clause of a switch The switch statement should Required
statement shall be the default have a default clause.
clause.
The default clause should be the
M15.3.2 .
last clause of the switch state-
ment.
M15.4.1 Rule 15.4 | A switch expression shall not A Boolean should not be used as | Required
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Required
M15.4.2 A constant should not be used
as a switch expression.
M15.5 Rule 15.5 | Every switch statement shall At least one case should be de- | Required
have at least one case clause. fined in the switch.
Functions
M16.1 Rule 16.1 | Functions shall not be defined The function <name> should not | Required
with a variable number of argu- | have a variable number of argu-
ments. ments.
M16.1.2 The library functions 'va_list, va_-
arg, va_start, va_end, va_copy'
should not be used.
M16.2.1 |Rule 16.2
Functions shall not call them- Recursive functions are not al- Required
selves, either directly or indirect- | lowed. The function <name> is
ly Functions shall not call them- | directly recursive.
selves, either directly or indirect-
M16.2.2 ly. Recursive functions are not al-
lowed. The function <name> is
recursive when calling <name>.
M16.3 Rule 16.3 |Identifiers shall be given for all | The function prototype should Required
of the parameters in a function | name all its parameters.
prototype declaration.
M16.4 Rule 16.4 | The identifiers used in the dec- | The identifiers used in the proto- | Required
laration and definition of a func- |type and definition should be the
tion shall be identical. same.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M16.5 Rule 16.5 |Functions with no parameters Functions with no parameters Required
shall be declared with parameter | should use the void type.
type void.
M16.6 Rule 16.6 | The number of arguments used | The number of arguments Required
in the call does not match the passed to a function shall match
number declared in the proto- the number of parameters.
type.
M16.7 Rule 16.7 | A pointer parameter in a func- Use the const qualification for Required
tion prototype should be de- parameter <name> which is
clared as pointer to const if the | pointer and which is not used to
pointer is not used to modify the | change the pointed object.
addressed object.
M16.8 Rule 16.8 | All exit paths from a function The return should always be de- | Required
with non-void return type shall fined with an expression for non-
have an explicit return statement | void functions.
with an expression.
M16.9 Rule 16.9 | A function identifier shall only be | Function identifiers should al- Required
used with either a preceding & | ways use a parenthesis or a pre-
or with a parenthesized parame- | ceding &.
ter list, which may be empty.
M16.10 Rule If a function returns error infor- | When a function returns a value, | Required
16.10 mation, then that error informa- | this value should be used.
tion shall be tested.
Pointers and arrays
Pointer arithmetic shall only be
M17.1 Rule17.1 . . Required | Unsup-
applied to pointers that address
ported
an array or array element.
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

M17.2 Rule17.2 | Pointer subtraction shall only be Required | Unsup-
applied to pointers that address ported
elements of the same array.

M17.3 Rule17.3 | >, >=, <, <= shall not be applied to Required | Unsup-
pointer types except where they ported
point to the same array.

Pointer arithmetic except array

M17.4 Rule 17.4 | Al indexi hall be the on- . . Required

uie ray indexing shafi be the on indexing should not be used. equire
ly allowed form of pointer arith-
metic.

M17.5 Rule 17.5 | A declaration should not use The declaration of objects Advisory
more than two levels of pointer | should contain no more than 2
indirection. levels of pointer indirection.

M17.6 Rule 17.6 | The address of an object with Required | Unsup-
automatic storage shall not be ported
assigned to another object that
may persist after the first object
has ceased to exist.

Structures and unions

M18.1 Rule 18.1 | Structure or union types %name | Structure or union types should | Required
% should be finalized before the | be finalized before the end of
end of the compilation units. the compilation units.

M18.2 Rule 18.2 | An object shall not be assigned Required | Unsup-
to an overlapping object. ported
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M18.3 Rule 18.3 | An area of memory shall not be
reused for unrelated purposes.
M18.4 Rule 18.4 | Unions shall not be used Do not use unions. Required
Preprocessing directives
M19.1 Rule 19.1 | #include statements in a file Only preprocessor directives or | Advisory
should only be preceded by oth- | comments may occur before the
er preprocessor directives or #include statements.
comments.
M19.2 Rule 19.2 | Do not use non-standard charac- | Non-standard characters should | Advisory
ters in included file names. not occur in header file names in
#include directives.
M19.3 Rule 19.3 |Filenames with the #include di- | The #include directive shall be Required
rective should always use the followed by either a <filename>
<filename> or "filename" syntax. | or'filename" sequence.
Required
M19.4 Rule 19.4 | A C macro should only be ex- C macros shall only expand to a
panded to a constant, a braced | braced initialiser, a constant, a
initializer, a parenthesised ex- parenthesised expression, a type
pression, a storage class key- qualifier, a storage class specifi-
word, a type qualifier, or a do- er, or a do-while-zero construct.
while-zero block.
M19.5 Macro definitions or #undef
Rule 19.5 I Macros shall not be #define'd Required
should not be located within a
or#undef’d within a block.
block.
M19.6 Rule 19.6 | Do not use the #undef directive. | #undefshall not be used. Required
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M19.7 Rule 19.7 | Function should be used instead | A function should be used in Advisory
of macros when possible. preference to a function-like
macro.
M19.8 Rule 19.8 | A function-like macro shall not | Missing argument when calling | Required
be invoked without all of its ar- | the macro.
guments.
M19.9 Rule 19.9 | The preprocessing directive Arguments to a function-like Required
%name% should not be used as [ macro shall not contain tokens
argument to the macro. that look like preprocessing di-
rectives.
M19.10 Rule The parameter %name% in the | In the definition of a function-like | Required
19.10 macro should be enclosed in macro each instance of a pa-
parentheses except when it is rameter shall be enclosed in
used as the operand of # or ##. | parentheses unless it is used as
the operand of # or ##.
M19.11 Rule Undefined macro identifier in the | All macro identifiers in pre- Required
19.11 preprocessor directive. processor directives shall be de-
fined before use, except in #ifdef
and #ifndef preprocessor direc-
tives and the defined() operator.
M19.12 Rule The # or ## preprocessor oper- | There shall be at most one oc- Required
19.12 ator should not be used more currence of the # or # preproces-
than once. sor operators in a single macro
definition.
The # and ## preprocessor op-
M19.13 Rule erator should be avoided. The #and #preprocessor opera- | Advisory
19.13 tors should not be used.
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used on identifier beginning with

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M19.14 Rule Only use the 'defined' preproces- | The defined preprocessor oper- | Required
19.14 sor operator with a single identi- | ator shall only be used in one of
fier. the two standard forms.
M19.15 Rule Header file contents should be | Precautions shall be taken in or- | Required
19.15 protected against multiple inclu- | der to prevent the contents of a
sions. header file being included twice.
Preprocessing directives shall
M19.16 Rule Possible bad syntax in prepro- . ) Required
be syntactically meaningful even
19.16 ing directive.
cessing clrective when excluded by the preproces-
sor.
M19.17 Rule A #if, #ifdef, #else, #elif or #en- | All #else, #elif and #endif pre- Required
19.17 dif preprocessor directive has processor directives shall re-
been found without its matching | side in the same file as the #if or
directive in the same file. #ifdef directive to which they are
related.
Standard libraries
M20.1 Rule 20.1 | %name% should not be defined, |Reserved identifiers, macros and | Required
redefined or undefined. functions in the standard library,
shall not be defined, redefined or
undefined.
M20.2.1 |Rule 20.2 | #define and #undef shall not be Required
used on a reserved identifier or
reserved macro name: Identi-
fier %name% already found in
%name%
M20.2.2 #define and #undef shall not be
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tion shall not be used.

functions calloc, malloc, realloc

free and strdup. There is a whole

range of unspecified, undefined
and implementation-defined be-
haviour associated with dynam-
ic memory allocation, as well as
a number of other potential pit-
falls. Dynamic heap memory al-
location may lead to memory
leaks, data inconsistency, mem-
ory exhaustion, non-determinis-
tic.

Note that some implementa-

tions may use dynamic heap

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
an underscore or on 'defined’
keyword: %name%

M20.2.3 Declared identifier should not be
a reserved identifier or reserved
macro name: Identifier %name%
already found in %name%

M20.2.4 Declared identifier should not
begin with an underscore or be
'defined’ keyword: %name%

M20.2 The names of standard library Unsup-
macros, objects and functions ported
shall not be reused.

| The validity of values passed

M20.3 Rule20.3 to library functions shall be Unsup-
checked. ported

M20.4 Rule 20.4 | Dynamic heap memory alloca- | This precludes the use of the Required
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Code re-
view ref-

erence

MISRA-C:
2004 ref-

erence

Description

Message

Level

Note

memory allocation to implement
other functions (for example
functions in the library string.h).
If this is the case then these
functions shall also be avoided.

M20.5

Rule 20.5

The variable %name% shoud not

be used

errno is a facility of C, which

in theory should be useful, but
which in practice is poorly de-
fined by the standard. A non ze-
ro value may or may not indicate
that a problem has occurred; as
aresult it shall not be used. Even
for those functions for which
the behaviour of errno is well de-
fined, it is preferable to check
the values of inputs before call-
ing the function rather than re-

ly on using errno to trap errors
(seeRule 16.10).

Required

M20.6

Rule 20.6

The macro '‘%»name%' should not

be used.

Use of this macro can lead to
undefined behaviour when the
types of the operands are in-
compatible or when bit fields are
used.

Required

M20.7

Rule 20.7

The library macro or function

‘%name%' should not be used.

The setjmp macro and the
longjmp function shall not be
used.

Required

M20.8

Rule 20.8

Signal handling contains imple-
mentation-defined and unde-
fined behavior.

Required
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
The signal handling facilities of <
%name%> shall not be used.

M20.9 Rule 20.9 | The input/output library <%name | The input/output library Required
%> shall not be used in produc- | <stdio.h>shall not be used in
tion code. production code.

M20.10 Rule The library macro or function The library functions atof, atoi Required

20.10 '‘%»name%' should not be used. and atol from library <stdlib.h>
shall not be used.
M20.11 Rule The library macro or function The library functions abort, exit, | Required
20.11 ‘%»name%' should not be used. getenv and system from library
<stdlib.h> shall not be used.
M20.12 Rule The time handling functions of | The time handling functions of li- | Required
20.12 library <%name%> shall not be brary <time.h> shall not be used.
used.

M21.1 Rule 21.1 | Minimisation of run-time failures Required | Unsup-
shall be ensured by the use of at ported
least one of:

(a) static analysis tools/tech-
niques;

(b) dynamic analysis tools/tech-
niques;

(c) explicit coding of checks to
handle run-time faults.

In addition to the MISRA rules, Test Embedded includes extended rules that you can select or not select to complete

your static analysis.
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Code re-
view ref- | Code review message Level
erence
Language extensionsRequired
E2.3.1 The character sequence // should not be used within a 'C-style' comment except for URL. Advi-
sory
E2.3.2 Line-splicing shall not be used in // comments. Advi-
sory
E2.3.3 The character sequence // should not be used within a 'C-style' comment even for URL. Advi-
sory
E2.6 A function should not contain unused label declarations. Advi-
sory
Advi-
E2.7 There should be no unused parameters in functions. sory
E2.8 Macro <name> is never used Advi-
sory
E2.9 Type <name> is never used Advi-
sory
E2.10 Tag <name> is never used. Advi-
sory
E2.50 Functions should have less than 100’ lines. Note The number of lines can be specified. Advi-
sory
E2.51 Functions should have less than '15' V(g) complexity. Note: The complexity limit of lines can be | Advi-
specified. sory
E2.52 Functions should have less than '‘%param%' lines, outside empty lines (current value: <name>).
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
E2.53 Functions should have less than '%param%' lines, outside empty lines or comment lines (current
value : <name>).
E2.54 Functions should have less than '‘%»param%' lines not counting empty lines, comments or brackets
(current value: %name%).
E2.55 Compilation units should have less than '%param%' functions (current value: %name%).
Op-
E2.56 Compilation units should have less than '%param%' variables (current value: %name%). tional
E2.57 Compilation unit should have less than '%param%' lines (current value: %name%). Op-
tional
E2.58 Compilation unit should have less than '%param%' lines not counting empty lines (current value: | Op-
%name%). tional
E2.59 Compilation unit should have less than '%param%' lines not counting empty lines or comments | Op-
(current value: %name%). tional
E2.60 Compilation unit should have less than '%param%' lines not counting empty lines, comments or | Op-
brackets (current value: %name%). tional
E2.61 Functions should have less than '%param%' parameters (current value: %name%).
Identifiers
E5.1.1 Identifiers '%name%' and '%name%' are ambiguous because of possible character confusion. Advi-
sory
E5.1.2 Possible typing mistake between the variables '%name%' and '‘%»name%' because of repeating char- | Advi-
acter. sory
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Code re-
view ref- | Code review message Level
erence
E5.1.3 Identifiers <name> and <name> are identical in the first %param% characters ignoring case. Advi-
sory
E5.1.4 Macros '%name%' and '%»name%" are identical in the first '%param%' characters. Advi-
sory
E5.1.5 Macro '%»name%' and identifier '%name%' are identical in the first '%param%' characters. Advi-
sory
E5.1.6 Macros '%name%' and '%name%" are identical in the first ‘%param%' characters ignoring case. Advi-
sory
E5.1.7 Macro '‘%name%' and identifier '%name%' are identical in the first ‘%param%' characters ignoring | Advi-
case. sory
E5.3 The tag name '%name%' should not be reused. Name already found in %location%. Advi-
sory
Types
Re-
E6.3 The implicit 'int' type should not be used. .
quired
E7.1 Octal and hexadecimal escape sequences shall be terminated. Re-
quired
E7.2 The lowercase character 'I' shall not be used in a literal suffix. Re-
quired
E7.3 A string literal shall not be assigned to an object unless the object's type is pointer to a const-qual- | Re-
ified char. quired
Declarations and definitions
Re-
E8.1.1 A prototype for the global object '%name%' should be declared before defining the object. quired
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
Re-
E8.3 Parameters and return types should use compatible type in the declaration and in the definition. quired
E8.10 Inline function '‘%name%' should be static
Re-
E8.14 The restrict type qualifier shall not be used. .
quired
Re-
E.8.50 Use the const qualification for variable '%name%' which is pointer and which is not used to change quired
the pointed object.
Re-
E.8.51 The object '%name%' is never referenced. .
quired
Initialization
Re-
E9.1 An element of an object shall not be in itialized more than once. quired
Re-
E9.2 Arrays shall not be partially initialized
y partially initializ quired
Re-
E9.3 Enumeration member '%name%' have a not unique implicitly-specified value. quired
Re-
E9.4 The global variable '%name%' is not initialized. .
quired
Re-
E9.5 Where designated initializers are used to initialize an array object the size of the array shall be quired
specified explicitly
Arithmetic type conversions
Re-
E10.1 Constraint violation: can't use floating type as operand of '[], %, <<, >>, ~, & |, * quired
Re-
E10.2 Operand should be boolean. .
quired
Re-
E10.3 Can't use a boolean as a numeric value. .
quired
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
Re-
E10.4 Can't use a char as a numeric value. .
quired
Re-
E10.5 Can't use a not anonymous enum as a numeric value. .
quired
Re-
E10.6 Shift and bitwise operations should be performed on unsigned value. quired
Re-
E10.7 Right hand operand of shift operation should be an unsigned value. quired
Re-
E10.8 Unary minus operation should not be performed on unsigned value. quired
Re-
E10.9 Expressions of essentially character type shall not be used inappropriately in addition and subtrac- quired
tion operations.
Re-
E10.10 |The value of an expression shall not be assigned to an object with a narrower essential type quired
Re-
E10.11 The value of an expression shall not be assigned to an object with a different essential type cat- quired
egory.
Re-
E10.12 |Both operands of an operator in which the usual arithmetic conversions are performed shall have quired
the same essential type category.
Re-
E10.13 | The value of an expression should not be cast to an inappropriate essential type. quired
The value of a composite expression shall not be assigned to an object with wider essential type | Re-
E10.14
quired
If a composite expression is used as one operand of an operation in which the usual arithmetic | Re-
E10.15 . . . .
conversions are performed then the other operand shall not have wider essential type quired
The value of a composite expression shall not be cast to a different essential type category or a | Re-
E10.16
wider essential type quired
Pointer type conversions
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence

Re-
E11.1 Conversions shall not be performed between a pointer to an incomplete type and any other type. quired

Re-
E11.2 A conversion should not be performed from pointer to void into pointer to object quired

Re-
E11.3 A cast shall not be performed between pointer to void and an arithmetic type quired

Re-
E11.4 A cast shall not be performed between pointer to object and a non-integer arithmetic type quired

Re-
E11.5 The macro NULL shall be the only permitted form of integer NULL pointer constant quired
Expressions

Advi-
E12.11 Implicit bitwise operator precedence may cause ambiguity. Use parenthesis to clarify this expres- sory

sion.

Advi-
E12.51 E12.51 Ternary expression '?:' should not be used. sory

Advi-
E12.54 | Expressions should not cause a side effect assignment. sory

Advi-
E12.61 The operator on a Boolean expression should be a logical operator. ( &&, || or !). sory
Control statement expressions

Re-
E13.1 The result of an assignment operator should not be used in an expression. quired
Control flow

Re-
E14.4.1 | The goto statement shall jump to a label declared later in the same function. quired

Re-
E14.4.2 | Any label referenced by a goto statement shall be declared in the same block, or in any block quired

enclosing the goto statement.
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
Re-
E14.4.3 | There should be no more than one break or goto statement used to terminate any iteration state- quired
ment.
Switch statements
Re-
E15.10 | Flexible arrays members shall not be declared. .
quired
Functions
Re-
E16.50 | The function <name> is never referenced. .
quired
Structures and unions
Re-
E18.1 Flexible arrays members shall not be declared. .
quired
Re-
E18.3 The declaration of an array parameter shall not contain the static keyword between the []. quired
Preprocessing directives
Re-
E19.18 | The controlling expression of a #if or #elif preprocessing directive shall evaluate to 0 or 1. quired
Re-
E19.19 | A macro parameter immediately following a # operator shall not immediately be followed by a ## quired
operator.
Re-
E19.20 |Macro parameter <name> used as an operand to the # and ## operators shall not be used else- quired
where in this macro.
Standard libraries
A macro shall not be defined with the same name as a keyword: %name% Re-
E20.1
quired
The standard header file <setjmp.h> shall not be used Re-
E20.7 .
quired
The signal handling facilities of <signal.h> shall not be used. Re-
E20.8 .
quired
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Table 10. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
The library macro or function 'bsearch, gsort' should not be used Re-
E20.11 .
quired
The input/output library <wchar.h> shall not be used in production code Re-
E20.12 .
quired
The standard header file <tgmath.h> shall not be used Re-
E20.13 .
quired
The library macro or function 'feclearexcept, fegetexceptflag, feraiseexcept, fesetexceptflag, fetes- | Re-
E20.14
texcept, FE_INEXACT, FE_DIVBYZERO, FE_UNDERFLOW, FE_OVERFLOW, FE_INVALID, FE_ALL_EX- | quired
CEPT' should not be used

Note: Applies to Test Embedded Studio only:

The code review references in bold in this table are disabled when they are run from the code review link
checker in test mode. To verify these rules, you must run the code review from the application node in
Test Embedded Studio. For more information, see Running complete verification of MISRA rules from an

application node on page 535.

Code review MISRA 2012 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be
individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules
also have parameters that can be changed. Among other guidelines, the code review tool implements most rules
from the MISRA-C:2012 standard, "Guidelines for the use of the C language in critical systems". These rules are
referenced with an M prefix. In addition to the industry standard rules, Test Embedded provides some additional
coding guidelines, which are referenced with an E prefix.

Code Review - MISRA 2012 rules

Misra rules can be categorized as either Decidable or Undecidable:

» A Decidable rule can be checked by a static analyzer, and so, is totally covered within the capabilities of the
tool.

« An Undecidable rule cannot, in theory, be checked by a static analyzer. If an undecidable rule is covered within
the capabilities of the tool, then this rule is partially covered.
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Table 11. MISRA rules

unreachable

code.

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
A standard C environment
M1.1 Rule 1.1 Decidable The program | ANSI C error: | Required
shall contain %name%
no violations
M1.1W ofthestan- | ANsi ¢ warn-
dard C syn- ing: %name%
tax and con-
straints, and
shall not ex-
ceed the im-
plementation’s
translation lim-
its.
Partially sup-
M1.2 Rule 1.2 Undecidable Language Use of #prag- |Advisory ported
extensions ma %name%
should not be | should always
used. be encapsulat-
ed and docu-
mented.
Partially sup-
M1.3 Rule 1.3 Undecidable There shall be | For more in- Required ported
no occurrence | formation,
of undefined |see Annex to
or critical un- [ MISRA 2012
specified be- |Rule 1.3 on
haviour. page 317.
Unused code
Partially sup-
M2.1 Rule 2.1 Undecidable A project shall | Unreachable Required ported
not contain code.
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
Partially sup-
M2.2.1 Rule 2.2 Undecidable There shall be | A non-null Required ported
no dead code. |statement
should either
have a side ef-
fect or change
the control
flow.
M2.2.2 The function
%name% is
never refer-
enced.
M2.2.3 The object
%name% is
never refer-
enced
M2.3 Rule 2.3 Decidable A project Type %name% | Advisory
should not is never used.
contain un-
used type dec-
larations.
M2.4 Rule 2.4 Decidable A project Tag %name% | Advisory
should not is never used.
contain un-
used tag dec-
larations.
M2.5 Rule 2.5 Decidable A project Macro %name | Advisory
should not % is never
contain un- used.
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Table 11. MISRA rules (continued)

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
used macro
declarations.

M2.6 Rule 2.6 Decidable A function A function Advisory
should not should not
contain un- contain un-
used label dec- | used label dec-
larations. larations.

M2.7 Rule 2.7 Decidable There should | There should | Advisory
be no unused |be no unused
parameters in | parameters in
functions. functions.

Comments

M3.1.1 Rule 3.1 Decidable The character | The character |Required
sequences /* | sequence /*
and // shall not | should not be
be used within |used within a
a comment. comment.

M3.1.2 The character

sequence //
should not be
used within a
'C-style' com-
ment.

M3.2 Rule 3.2 Decidable Line-splicing Line-splicing Required
shall not be shall not be
used in // com- [ used in // com-
ments. ments.

Character sets and lexical conventions
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M4.1 Rule 4.1 Decidable Octal and Octal and Required
hexadecimal |hexadecimal
escape se- escape se-
quences shall | quences shall
be terminated. | be term inated.
M4.2 Rule 4.2 Decidable Trigraphs Trigraphs Advisory
should not be | should not be
used. used.
Identifiers
M5.1.1 Rule 5.1 Decidable External iden- [ External iden- |Required
tifiers shall be |tifiers %name
distinct in the | % and %name
first 31 charac- | % are iden-
ters. tical in the
first %param%
characters.
External iden-
M5.1.2 tifiers shall be
distinct in the
first 6 charac-
ters ignoring
case.
M5.2 Rule 5.2 Decidable Identifiers de- | Identifiers Required
clared in the %name% de-
same scope clared in the
and name same scope
space shall be |and name
distinct. space shall
be distinct.
Identifier iden-
tical in the
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Table 11. MISRA rules (continued)

Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

first %param%
characters al-
ready found in

%location%.

M5.3

Rule 5.3

Decidable

An identifier
declared in an
inner scope
shall not hide
an identifier
declared in an

outer scope.

Identifier
%name% de-
clared in an
inner scope
shall not hide
an identifier
declared in an
outer scope.
Identifier iden-
tical in the
first %param%
characters al-
ready found in

%location%

Required

M5.4.1

M5.4.2

Rule 5.4

Decidable

Macro identi-
fiers shall be

distinct.

Macros
%name% and
%name% are
identical in the
first %param%

characters

Macros
%name% and
%name% are
identical in the
first %param%
characters ig-

noring case.

Required
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M5.5.1

M5.5.2

Rule 5.5

Decidable

Identifiers
shall be dis-
tinct from

macro names.

Macro %name
% and iden-
tifier %name
% are iden-
tical in the
first %param%
characters.

Macro %name
% and iden-
tifier %name
% are iden-
tical in the
first %param%
characters ig-

noring case.

Required

M5.6

Rule 5.6

Decidable

A typedef
name shall be
a unique iden-

tifier.

The typedef
name %name
% should not
be reused ex-
cept for its tag.
Name already
found in %lo-

cation%

Required

M5.7.1

Rule 5.7

Decidable

The tag name
%name%
should not be

reused.

The tag name
%name%

should not be
reused. Name
already found

%location%

Required
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
MS5.7.2 A struct and
union cannot
use the same
tag name.
M5.8 Rule 5.8 Decidable Identifiers that | Identifiers Required
define objects | '%name%' that
or functions defines ob-
with external |jects or func-
linkage shall tions with ex-
be unique. ternal link-
age shall be
unique. Iden-
tifier already
found in %lo-
cation%
M5.9 Rule 5.9 Decidable Identifiers that | Identifiers or | Advisory
define objects | macro '‘%name
or functions %' and '%name
with internal %'are ambigu-
linkage should | ous because
be unique. of possible
character con-
fusion.
Types
Bit- fields shall
M6.1.1 Rule 6.1 Decidable only be de- Bit fields Required
clared with an should only
appropriate be of type 'un-
ype. signed int' or
'signed int'.
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M6.1.2

M6.1.3

M6.1.4

M6.1.5

Bit fields
should not be
of type 'enum’.

Bit fields
should only

be of explicit-
ly signed or un-
signed type.

Bit fields
should not

be of type
'‘boolean’ under
c99.

Bit fields
should not

be of type
'boolean’ under
c99.

M6.2

Rule 6.2

Decidable

Single-bit
fields shall not

be of a signed
type.

Bit fields of
type 'signed
int' must be
at least 2 bits

long.

Required

Literals and constants

M7.1

Rule 7.1

Decidable

Octal con-
stants shall
not be used.

Octal con-
stants shall
not be used.

Required
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Table 11. MISRA rules (continued)

shall be in pro-
totype form

prototype
should name

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M7.2 Rule 7.2 Decidable A "u" or "U" suf- [ Definitions of | Required
fix shall be ap- | unassigned
plied to all inte- | type constants
ger constants | should use the
that are repre- | "U" suffix.
sented in an
unsigned type.
M7.3 Rule 7.3 Decidable The lowercase | The lowercase | Required
character I character “I"
shall not be shall not be
used in a literal | used in a literal
suffix. suffix.
M7.4 Rule 7.4 Decidable A string liter- | A string liter- | Required
al shall not be [al shall not be
assigned to assigned to an
an object un- | object unless
less the ob- the object’s
ject's type is type is “pointer
pointerto a to const-quali-
const-qualified | fied char”.
char.
Declarations and definitions
M8.1 Rule 8.1 Decidable Types shall be [ The type of Required
explicitly spec- | '%name%'
ified. should be ex-
plicitly stated.
M8.2.1 Rule 8.2 Decidable Function types | The function Required
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
with named all its parame-
parameters. ters.

M8.2.2 Functions with
no parameters
should use the
void type.

M8.2.3 The type of
parameter
%name%
should be ex-
plicitly stated.

M8.3.1 Rule 8.3 Decidable All declara- Parameters Required
tions of an ob- | and return
ject or function | types should
shall use the | use compati-
same names | ble type in the
and type quali- | declaration
fiers. and in the defi-

nition.

M8.3.2 The identi-
fiers used in
the prototype
and definition
should be the
same.

M8.4.1 Rule 8.4 Decidable A compatible | A prototype Required
declaration for the glob-
shall be visible | al function
when an ob- %name%
ject or function | should be de-
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Table 11. MISRA rules (continued)

Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M8.4.2

M8.4.3

with external
linkage is de-
fined.

clared before
defining the
function.

A prototype for
the global ob-
ject %name%
should be de-
clared before
defining the

object.

If objects or
functions are
declared multi-
ple times their
types should
be compatible.

M8.5

Rule 8.5

Decidable

An external ob-
ject or func-
tion shall be
declared once
in one and only

one file.

Identifiers
%name% that
declare ob-
jects or func-
tions with ex-
ternal linkage
shall be de-
clared once in
one and only

one file.

Required

M8.6

282

Rule 8.6

Decidable

An identifier
with external
linkage shall
have exactly

Identifiers
%name% that
declare ob-
jects or func-

tions with ex-

Required
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
one external ternal link-
definition. age shall be
unique.

M8.7.1 Rule 8.7 Decidable Functions and | Global ob- Advisory
objects should | ject %name
not be defined | % that are on-
with exter- ly used with-
nal linkage if | in the same
they are refer- | file should be
enced inonly |declared us-
one translation | ing the static
unit. storage-class

specifier.

M8.7.2 Global func-

tion %name
% that are on-
ly used with-
in the same
file should be
declared us-
ing the static
storage-class
specifier.

M8.8 Rule 8.8 Decidable The static Global ob- Required
storage class |jects or func-
specifier shall |tions %name
beusedinall |% thatare on-
declarations ly used within
of objects and | the same file
functions that | should be de-
have internal | clared with us-
linkage. ing the static
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
storage-class
specifier.
M8.9 Rule 8.9 Decidable An object Global objects | Advisory
should be de- [ should not
fined at block |be declared
scope if its if they are on-
identifier on- | ly used from
ly appearsin | within a single
a single func- | function.
tion.
M8.10 Rule 8.10 Decidable An inline func- | Inline func- Required
tion shall be tion %name%
declared with | should be sta-
the static stor- |tic.
age class.
M8.11 Rule 8.11 Decidable When an array | When a global | Advisory
with external | array variable
linkage is de- | can be used
clared, its size | for multiple
should be ex- [files, its size
plicitly speci- | should be de-
fied. fined at initial-
ization time.
M8.12 Rule 8.12 Decidable Within an enu- | Enumera- Required
merator list, tion member
the value of '‘%name%' have
an implicit- a not unique
ly-specified implicitly-spec-
enumeration | ified value.
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
constant shall
be unique.
Unsupported

M8.13 Rule 8.13 Undecidable | A pointer Advisory

should point to

a const-quali-

fied type when-

ever possible.
M8.14 Rule 8.14 Decidable The restrict The restrict Required

type qualifier | type qualifier

shall not be shall not be

used. used.
Initialization

Unsupported

M9.1 Rule 9.1 Undecidable The value of Mandatory

an object with

automatic

storage dura-

tion shall not

be read before

it has been set
M9.2 Rule 9.2 Decidable The initializ- Nested braces | Required

er for an ag- should be

gregate or used to initial- & Note

union shall be |ize nested mul- Excep-

ti-dimension tion
arrays and not
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sential type.

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
enclosed in nested struc- cov-
braces. tures. 2 ered
M9.3 Rule 9.3 Decidable Arrays shall Arrays shall Required
not be partially | not be partially
initialized. initialized. V4 Note
Excep-
tion
not
cov-
ered
M9.4 Rule 9.4 Decidable An element of [ An element of |Required
an object shall | an object shall
not beinitial- | not be initial-
ized more than | ized more than
once. once.
M9.5 Rule 9.5 Decidable Where desig- [ Where desig- | Required
nated initializ- | nated initializ-
ers are used ers are used t
to initialize an | o initialize an
array object array object
the size of the |the size of the
array shall be | array shall be
specified ex- | specified ex-
plicitly. plicitly.
The essential type model
M10.1.2 Rule 10.1 Decidable Operands shall | Operand Required
not be of an in- | should be
appropriate es- | boolean.




Table 11. MISRA rules (continued)

Chapter 6. Test Execution Specialist Guide

Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M10.1.3

M10.1.4

M10.1.5

M10.1.6

M10.1.7

M10.1.8

Can'tusea
boolean as a

numeric value.

Can'tusea
char as a nu-

meric value.

Can't use a not
anonymous
enum as a nu-

meric value.

Shift and bit-
wise opera-
tions should
be performed
on unsigned

value.

Right hand
operand of
shift operation
should be per-
formed on un-

signed value.

Unary minus
operation
should not be
performed on
unsigned val-

ue.
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M10.2 Rule10.2 Decidable Expressions Expressions Required
of essentially | of essentially
character type | character type
shall not be shall not be
used inappro- | used inappro-
priately in ad- | priately in ad-
dition and sub- | dition and sub-
traction opera- | traction opera-
tions. tions.
M10.3.1 Rule10.3 Decidable The value of The value of Required
an expression | an expression
shall not be as- | shall not be as-
signed to an signed to an
object witha | object with a
narrower es- | narrower es-
sential type or | sential type.
of a different
M10.3.2 essential type | e yalye of
category. an expression
shall not be as-
signed to an
object with a
different es-
sential type
category.
M10.4 Rule 10.4 Decidable Both operands | Both operands | Required
of an opera- of a n opera-
tor in which tor in which
the usual arith- | the usual arith-
metic conver- | metic conver-
sions are per- | sions are per-
formed shall | formed s hall
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ite expression
is used as one
operand of an
operation in
which the usu-
al arithmetic
conversions
are performed
then the other
operand shall
not have wider

essential type.

ite expression
is used as one
operand of an
operator in
which the usu-
al arithmetic
conversions
are performed
then the other
operand shall
not have wider

essential type.

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
have the same | have the same
essential type | essential type
category. category.
M10.5 Rule 10.5 Decidable The value of The value of Advisory
an expression |an expression
should not be | should not be
casttoanin- |casttoanin-
appropriate es- | appropriate es-
sential type. sential type.
M10.6 Rule 10.6 Decidable The value of The value of Required
a composite an expression
expression should not be
shall not be castto anin-
assigned to appropriate es-
an object with | sential type.
wider essential
type.
If a compos-
M10.7 Rule 10.7 Decidable If a compos- Required
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tween a point-
er to object
type and a
pointer to a dif-

ferent object
pointer type

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M10.8 Rule 10.8 Decidable The value of a [ The value of a | Required
composite ex- | composite ex-
pression shall | pression shall
not be castto |not be castto
a different es- | a different es-
sential type sential type
category ora |categoryora
wider essential | wider essential
type. type.
Pointer type conversions
M11.1 Rule 11.1 Decidable Conversions A function Required
shall not be pointer should
performed be- | not be convert-
tween a point- | ed to another
er to a function | type of pointer.
and any other
type.
M11.2 Rule 11.2 Decidable Conversions Conversions Required
shall not be shall not be
performed be- | performed be-
tween a point- |tween a point-
er to an incom- | er to an incom-
plete type and | plete type and
any other type. | any other type.
M11.3.1 Rule 11.3 Decidable A cast shall Casting an ob- | Required
not be per- ject pointer
formed be- type to a dif-




Table 11. MISRA rules (continued)

Chapter 6. Test Execution Specialist Guide

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
ferent object | should not oc-
type. cur.

M11.3.2 Casting an ob-
ject pointer
type to a dif-
ferent object
pointer type
should not oc-
cur, especial-
ly when object
sizes are not
the same.

M11.3.3 An object
pointer should
not be convert-
ed to another
type of pointer.

M11.4 Rule 11.4 Decidable A conversion | A conversion | Advisory

should not be |should not be
performed be- | performed be-
tween a point- | tween a point-
er to object er to object
and an integer | and an integer
type. type.

M11.5 Rule 11.5 Decidable A conversion | A conversion | Advisory

should not should not

be performed | be performed
from pointer to | from pointer to
void into point- | void into point-
er to object. er to object.
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M11.6 Rule 11.6 Decidable A cast shall A cast shall Required
not be per- not be per-
formed be- formed be-
tween point- tween point-
erto void and |erto void and
and an arith- | an arithmetic
metic type. type.
M11.7 Rule 11.7 Decidable A cast shall A cast shall Required
not be per- not be per-
formed be- formed be-
tween point- tween point-
er to object er to object
and a non-inte- | and a non-inte-
ger arithmetic | ger arithmetic
type. type.
M11.8 Rule 11.8 Decidable A cast shall Casting of Required
not remove pointers to
any const or a type that
volatile quali- [ removes
fication from | any const or
the type point- | volatile qualifi-
edtobya cation on the
pointer. pointed object
should not oc-
cur.
M11.9 Rule 11.9 Decidable The macro Required
NULL shall be
the only per-
mitted form
of integer null
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
pointer con-
stant.
Expressions
M12.1.2 Rule 12.1 Decidable The prece- Implicit bit- Advisory
dence of op- wise operator
erators with- precedence
in expressions [ may cause
should be ambiguity. Use
made explicit. | parenthesis to
clarify this ex-
pression.
M12.1.3 Parenthe-
sis should
be used
around expres-
sions that are
operands of a
logical &am-
p;amp;&am-
p;amp; or ||
M12.1.4 Parenthesis
should be
used around
expression
that is operand
of 'sizeof' op-
erator.
Unsupported
M12.2 Rule 12.2 Undecidable The right hand Required
operand of a
shift operator
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

shall lie in the
range zero to
one less than
the width in
bits of the es-
sential type of
the left hand
operand

M12.3

Rule 12.3

Decidable

The com-

ma operator
should not be
used.

The com-

ma operator
should not be
used.

Advisory

M12.4

Rule 12.4

Decidable

Implicit bit-
wise operator
precedence
may cause
ambiguity. Use
parenthesis to
clarify this ex-

pression.

Evaluation

of constant
expressions
should not
lead to un-
signed integer

wrap-around.

Advisory

Side effects

M13.1

Rule 13.1

Undecidable

Initializer lists
shall not con-

tain persistent
side effects.

Required

Unsupported

M13.2
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Rule 13.2

Undecidable

The value of
an expression
and its persis-
tent side ef-

fects shall be

Required

Unsupported
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
the same un-
der all permit-
ted evaluation
orders.

M13.3 Rule 13.3 Decidable afull expres- | The increment | Advisory
sion contain- [ '++' or decre-
ing an incre- ment '-' opera-
ment (++) or | tors should not
decrement be used with
(-) operator other opera-
should have no | tors in an ex-
other potential | pression.
side effects
other than that
caused by the
increment or
decrement op-
erator.

M13.4.1 Rule 13.4 Decidable The result of | Boolean ex- Advisory
an assign- pressions
ment operator | should not
should not be | contain as-
used. signment oper-

ators.

M13.4.2 The result of
an assign-
ment operator
should not be
used in an ex-
pression.
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date part' of

a 'for state-

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
Unsupported
M13.5 Rule 13.5 Undecidable The right hand Required
operand of a
logical && or ||
operator shall
not contain
persistent side
effects
M13.6 Rule 13.6 Decidable The operand | The sizeof op- | Mandatory
of the sizeof | erator should
operator shall | not be used on
not contain expressions
any expression | that contain
which has po- | side effects.
tential side ef-
fects.
Control statement expressions
Partially sup-
M14.1.1 Rule 14.1 Undecidable A loop counter | Floating-point | Required ported
shall not have |variables
essentially should not be
floating type. |used to con-
trol a for state-
ment.
Partially sup-
M14.2.1 Rule 14.2 Undecidable | A for loop Only loop Required ported
shall be well- | counter should
formed. be initialized in
a for loop ini-
tialization part.
M14.2.2 In the 'up-
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Code review
reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M14.2.3

M14.2.4

ment’, only
'loop counter'
should be up-
dated.

There should
be one and
only one loop
counter for
loop state-

ment.

Loop counter
of a 'for state-
ment' should
not be modi-
fied within the
body of the

loop.

M14.3.1

Rule 14.3

Undecidable

Controlling ex-
pressions shall
not be invari-

ant.

Invariant
Boolean ex-
pressions
should not be

used.

Required

Partially sup-
ported

M14.4

Rule 14.4

Decidable

The control-
ling expression
of an if state-
ment and the
controlling ex-
pression of an
iteration- state-
ment shall

have essen-

Non-Boolean
values that are
tested against
zero should
have an explic-
it test.

Required
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
tially Boolean
type.
Control flow
M15.1 Rule 15.1 Decidable The goto state- | Do not use Advisory
ment should the goto state-
not be used. ment.
M15.2 Rule 15.2 Decidable The goto state- | The goto state- | Required
ment shall ment shall
jump to a label | jump to a label
declared lat- declared lat-
er in the same |erin the same
function. function.
M15.3 Rule 15.3 Decidable Any label refer- | Any label refer- | Required
enced by a go- | enced by a go-
to statement | to statement
shall be de- shall be de-
clared in the clared in the
same block, same block,
orin any block | orin any block
enclosing the |enclosing the
goto state- goto state-
ment. ment.
M15.4 Rule 15.4 Decidable There should | There should | Advisory
be no more be no more
than one break | than one break
or goto state- | or goto state-
ment used to | ment used to
terminate any |terminate any
iteration state- | iteration state-
ment. ment.
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M15.5

Rule 15.5

Decidable

A function

should have a
single point of
exit at the end.

Only one exit
point should
be defined in a

function.

Advisory

M15.6.1

M15.6.2

M15.6.3

M15.6.4

M15.6.5

Rule 15.6

Decidable

The body of an
iteration-state-
ment or a se-
lection-state-
ment shall

be a com-
pound-state-
ment.

The switch
statement
should be fol-
lowed by a
compound

statement.

The while
statement
should be fol-
lowed by a
compound

statement.

The do..while
statement
should contain
a compound

statement.

The for state-
ment should
be followed by
a compound

statement.

The if (expres-
sion) construct
should be fol-

Required
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used when the
most close-
ly-enclosing
compound
statement is
the body of a

ments should
only be used
directly with-
in the com-
pound block of

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
lowed by a
compound
statement.
M15.6.6 The else key-
word should
be followed by
either a com-
pound state-
ment or an-
other 'if' state-
ment.
M15.7 Rule 15.7 Decidable Allif ... else All'if ... else Required
constructs if constructs
shall be ter- shall be ter-
minated with | minated with
an else state- | an else state-
ment. ment.
Switch statements
M16.1 Rule 16.1 Decidable All switch A switch block | Required
statement should start
should be well | with a case.
formed.
M16.2 Rule 16.2 Decidable A switch label | A case orde- |Required
shall only be | fault state-




Table 11. MISRA rules (continued)

Chapter 6. Test Execution Specialist Guide

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
switch state- | a switch state-
ment. ment.
M16.3 Rule 16.3 Decidable An uncondi- The break Required
tional break statement
statement should be
shall terminate | used to ter-
every switch- | minate every
clauses. non-empty
switch-block.
M16.4 Rule 16.4 Decidable Every switch Every switch Required
statement statement
shall have a shall have a
default label. | default label.
M16.5 Rule 16.5 Decidable A default la- The default Required
bel appear clause should
as either the be the first or
first or the last | the last clause
switch label of | of a switch
a switch state- | statement.
ment.
M16.6 Rule 16.6 Decidable Every switch Every switch Required
statement statement
shall have shall have
at least two at least two
switch-claus- | switch-claus-
es. es.
M16.7 Rule 16.7 Decidable A switch ex- A Boolean Required
pression should not
shall not have |beusedasa
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
essentially switch expres-
Boolean type. |sion.
Switch statements
M17.1.1 Rule 17.1 Decidable The features | The function | Required
of <stdarg.h> |'%name%'
shall not be should not
used. have a variable
number of ar-
guments.
M17.1.1 The va_list, The library
va_arg,va_s- |function
tart, va_end %name%
and va_copy | should not be
functions of used.
&lt;stdarg.h>
shall not be
used.
Partially sup-
M17.2.1 Rule 17.2 Undecidable Functions shall | Recursive Required ported
not call them- | functions are
selves, either | not allowed.
directly or indi- | The function
rectly. '‘%name%' is
directly recur-
sive.
M17.2.2 Recursive
functions are
not allowed.
The function
'‘%name%' is re-
cursive when
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
calling '%name
%'
M17.3 Rule 17.3 Decidable A function A prototype Mandatory
shall not be for the func-
declared im- tion '%name
plicitly. %' should be
declared be-
fore calling the
function.
M17.4 Rule 17.4 Decidable All exit paths [ All exit paths | Mandatory
from a func- from a func-
tion with non- | tion with non-
void return void return
type shall have | type shall have
an explicitre- | an explicit re-
turn statement | turn statement
with an expres- | with an expres-
sion. sion.
Unsupported
M17.5 Rule 17.5 Undecidable The function Advisory
argument cor-
responding
to a parame-
ter declared to
have an array
type shall have
an appropriate
number of ele-
ments.
M17.6 Rule 17.6 Decidable The declara- | The declara- Mandatory
tionof anar- |tion of an ar-
ray parameter |ray parameter
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

shall not con-
tain the stat-
ic keyword be-
tween the [].

shall not con-
tain the stat-
ic keyword be-
tween the [].

M17.7

Rule 17.7

Decidable

The value re-
turned by func-
tion having
non-void return
type shall be

used.

When a func-
tion returns a
value, this val-
ue should be

used.

Required

M17.8

Rule 17.8

Undecidable

A function pa-
rameter should
not be modi-
fied.

Advisory

Unsupported

Pointers and arrays

M18.1

Rule 18.1

Undecidable

A pointer re-
sulting from
arithmetic

on a pointer
operand shall
address an el-
ement of the
same array as
that pointer
operand.

Required

Unsupported

M18.2
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Rule 18.2

Undecidable

Subtraction
between point-
ers shall only
be applied to

pointers that

Required

Unsupported
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

address ele-
ments of the

same array.

M18.3

Rule 18.3

Undecidable

The relation-
al operators
> >= <and <=
shall not be
applied to ob-
jects of point-
er type except
where they
point into the

same object.

Required

Unsupported

M18.4

Rule 18.4

Decidable

The +, -, += and
-= operators
should not be
applied to an
expression of
pointer type.

Pointer
arthimetic ex-
cept array in-
dexing, should

not be used.

Advisory

M18.5

Rule 18.5

Decidable

Declarations
should contain
no more than
two levels of

pointer nest-

ing.

A declaration

should not use
more than two
levels of point-

er indirection.

Advisory

M18.6

Rule 18.6

Undecidable

The address
of an object
with automatic
storage shall
not be copied
to another ob-

Required

Unsupported
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
ject that per-
sists after the
first object has
ceased to ex-
ist.
M18.7 Rule 18.7 Decidable Flexible ar- Flexible ar- Required
rays members | ray members
shall not be shall not be
declared. declared.
M18.8 Rule 18.8 Decidable Variable-length | Variable-length | Required
array types array types
shall not be shall not be
used. used.
Overlapping storage
Unsupported
M19.1 Rule 19.1 Undecidable An object Mandatory
shall not be
assigned or
copied to an
overlapping
object / unsup-
ported.
M19.2 Rule 19.2 Decidable The union key- | Do not use Advisory
word should unions.
not be used.
Preprocessing directives
M20.1 Rule 20.1 Decidable #include direc- | Only pre- Advisory
tive should on- | processor di-
ly be preceded | rectives or
by preproces- | comments
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
sor directives | may occur be-
or comments. |fore the #in-
clude state-
ments.

M20.2 Rule 20.2 Decidable The ', or \ char- [ Do not use Required
acter and the / | non-standard
* or // charac- |charactersin
ter sequences |included files
shall not occur | names.
in a header file
name"

M20.3 Rule 20.3 Decidable The #include |Filenames Required
directive shall | with the #in-
be followed by | clude directive
either a &lt;file- | should always
name> or a use the <file-
filename" se- | name> or "file-
quence” name" syntax.

M20.4 Rule 20.4 Decidable A macro shall | A macro shall |Required
not be defined | not be defined
with the same | with the same
name as a key- | name as a key-
word. word %name%

Do not use the
M20.5 Rule 20.5 Decidable #undef should . Advisory
#undef direc-
not be used. ive.

M20.6 Rule 20.6 Decidable Token that The prepro- Required
look like a pre- | cessing direc-
processing di- |tive %name%
rective should | should not be
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
not occur with- | used as argu-
ing a macro ar- | ment macro
gument. argument.
M20.7 Rule 20.7 Decidable Expressions The parameter | Required
resulting from | %name% in the
the expansion | macro should
of macro pa- | be enclosed in
rameters shall | parentheses
be enclosed in | except when it
parenthesis. is used as the
operand of #
or ##.
The controlling
M20.8 Rule 20.8 Decidable The controlling expression of Required
expression of a #i f or #elif
a #if or #eli.f preprocessing
Preprocessing 1 yirective shall
directive shall evaluate to 0
evaluateto 0 or 1
or1.
M20.9 Rule 20.9 Decidable All identifiers [ Undefined Required
used in the macro iden-
controlling ex- | tifier in the
pression of #if | preprcessor di-
or #elif prepro- | rective.
cessing direc-
tives shall be
#define'd be-
fore evalua-
tion.
M20.10 Rule 20.10 Decidable The #and ## |The #and ## |Advisory
preproces- preproces-
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
sor operators | sor opera-
should not be |tors should be
used. avoided.

M20.11 Rule 20.11 Decidable A macro para- | A macro para- | Required
meter immedi- | meter imme-
ately following | diately fol low-

a # operator ing a # oper-
shall not im- ator shall not
mediately be | immediately
followed by a | be followed by
## operator. a ## operator.

M20.12 Rule 20.12 Decidable A macro para- | Macro para- Required
meter used as | meter %name
anoperandto |% used as an
the # and ## | operandto the
operators shall | # and ## oper-
only be used ators shall not
as an operand | be used else-
to these opera- | where in this
tors. macro.

M20.13 Rule 20.13 Decidable A line whose Possible bad | Required
first token is # | syntax in pre-
shall be a valid | processing di-
preprocessing | rective.
directive.

M20.14 Rule 20.14 Decidable All #else, #elif | All #else, #elif | Required
and #endif and #endif
preproces- preproces-
sor directives | sor directives
shall reside shall reside
in the same in the same
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served macro
name: ldentifi-

er %name% al-

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
file as the #if, |file a s the #if,
#ifdef or #ifn- | #ifdef or #ifn-
def directive to | def directive to
which they are | which they are
related. related.
Standard libraries
M21.1.1 Rule 21.1 Decidable #define and #define and Required
#undef shall #undef shall
not be used not be used
onareserved |onareserved
identifier or re- | identifier or re-
served macro | served macro
name: ldentifi- | name.
er %name% al-
M21.1.2 ready found in #define and
<%name%>. #undef shall
not be used
on identifi-
er beginning
with an under-
score or on
'defined' key-
word %name%
M21.2.1 Rule 21.2 Decidable A reserved Declared iden- | Required
identifier or tifier should
macro name | not be are-
shall not be served iden-
declared. tifier or re-
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
ready found in
<%name%>.
M21.2.2 Declared iden-
tifier should
not begin
with an under-
score or be
‘defined' key-
word %name%
M21.3 Rule 21.3 Decidable The memory | Dynamic Required
allocation and | heap mem-
deallocation ory alloca-
functions of tion:'%name%'
shall not be shall not be
used. used.
M21.4 Rule 21.4 Decidable The standard | The standard | Required
header file header file
<setjmp.h> <%name%>
shall not be shall not be
used. used.
M21.5 Rule 21.5 Decidable The standard | The signal Required
header file handling fa-
<signal.h> cilities of <
shall not be %name%>shall
used. not be used.
M21.6.1 Rule 21.6 Decidable The input/out- | The input/out- | Required
put library put library <
<stdio.h> shall [ %name%>
not be used shall not be
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
in production | used in pro-
code. duction code.
M21.6.2 The input/out- | The input/out-
put library put library <
<wchar.h> %name%>
shall not be shall not be
used in pro- used in pro-
duction code. |duction code.
M21.7 Rule 21.7 Decidable The atof, atoi, | The library Required
atol and atoll | macro or
functions of %name% shall
shall not be not be used.
used.
M21.8 Rule 21.8 Decidable The library The library Required
functions macro or func-
abort, exit, tion %name%
getenv and should not be
system of used.
shall not be
used.
M21.9 Rule 21.9 Decidable The library The library Required
macro or func- | macro or func-
tions bsearch |tion %name
and gsort of % shall not be
<stdlib.h> shall | used.
not be used.
M21.10 Rule 21.10 Decidable The Standard | The time han- | Required
Library time dling func-
and date func- |tions of library
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only be freed if
it was allocat-
ed by means
of a Standard
Library func-

tion.

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence

tions shall not | %name% shall

be used. not be used.
M21.11 Rule 21.11 Decidable The standard | The standard | Required

header file <tg- | header file

math.h> shall | %name% shall

not be used. not be used.
M21.12 Rule 21.12 Decidable The exception | The library Advisory

handling fea- | macro or func-

tures of should | tion %name%

not be used. should not be

used.
Resources
Unsupported

M22.1 Rule 22.1 Undecidable All resources Required

obtained dy-

namically by

means of Stan-

dard Library

functions shall

be explicitly re-

leased.

Unsupported

M22.2 Rule 22.2 Undecidable A block of Mandatory

memory shall
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M22.3

Rule 22.3

Undecidable

The same file
shall not be
open for read
and write ac-
cess at the
same time
on different

streams.

Required

Unsupported

M22.4

Rule 22.4

Undecidable

There shall
be no attempt
to write to a
stream which
has been
opened as
read-only.

Mandatory

Unsupported

M22.5

Rule 22.5

Undecidable

A pointer to
a FILE object
shall not be
referenced.

Mandatory

Unsupported

M22.6

Rule 22.6

Undecidable

The value of

a pointerto a
FILE shall not
be used after
the associat-
ed stream has
been closed.

Mandatory

Unsupported

In addition to the MISRA rules, Test Embedded includes extended rules that you can select or not select to complete

your static analysis.
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Table 12. Extended rules

Code review | Message

reference

E1.1 Functions should have less than '%param%' lines (current value: %name%).

E1.2 Functions should have less than '%param%' V(g) complexity (current value: %name%).

E1.3 Functions should have less than '‘%param%' lines, outside empty lines (current value: %name%).

E1.4 Functions should have less than '%param%' lines, outside empty lines or comment lines (current value:
%name%).

E1.5 Functions should have less than '%sparam%' lines, outside empty lines, comment lines or bracket lines
(current value: %name%).Lines are not counted in the following cases:

E1.6 Compilation units should define less than '%sparam%' functions (current value: %name%).

E1.7
Compilation units should define less than '%param%' variables (current value: %name%).

E1.8 Compilation units should have less than '%param%' lines (current value: %name%).

E1.9 Compilation unit should have less than '%param%' lines, not counting empty lines (current value: %name

%).

E1.10 Compilation unit should have less than '‘%param%' lines not counting empty lines or comments (current
value: %name%).

E1.11 Compilation unit should have less than '%param%' lines not counting empty lines, comments or brack-
ets (current value: %name%).

E1.12 Functions should have less than '%param%' parameters (current value: %name%).

E3.1 A null statement in original source code should be on a separate line and the semicolon should be
followed by at least one white space and then a comment

E4.1 Only ISO C escape sequences are allowed

E.4.2 Only ISO C escape sequences are allowed(\v)

ES5.1 Identifiers or macro '%name%' and '%name%' are ambiguous because of possible character confusion.

E5.2 Possible typing mistake between the macro or identifier ‘%name%' and ‘%»name%' because of repeating
character.

E5.3 The identifier '%name%' should not be reused. Identifier already found in %location%.

E5.4 Identifier %name% in an inner scope hides the same identifier in an outer scope: %location%.

ES.5 The typedef name %name% should not be reused even for its tag. Name already found in %location%.

E6.1 The C language numeric type %name% should not be used directly but instead used to define typedef.
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Table 12. Extended rules (continued)

Code review | Message

reference

E6.2 The implicit 'int' type should not be used.

E.8.1 Parameters and return types should use exactly the same type names in the declaration and in the
definition.

E.8.2 A prototype for the static function %name% should be declared before defining the function..

E.8.3 Static function %name% should only be declared in a single file. Redundant declaration found at: %name
%.

E.8.4 Static object %name% should only be declared in a single file. Redundant declaration found at: %loca-
tion%.

E.8.5 Either all members or only the first member of an enumerator list should be initialized.

E.8.6 The body of function %name% should not be located in a header file.

E.8.7 The memory storage (definition) for the variable %name% should not be in a header file.

E.8.8 Functions should not be declared at block scope

E.8.10 The global object or function %name% %name% should have exactly one external definition. No defin-
ition found.

E.8.11 Use the const qualification for variable %name% which is pointer and which is not used to change the
pointed object.

E9.1 Variables with automatic storage duration should be initialized before being used.

E9.2 The global variable %name% is not initialized.

E10.1 When using operator '~' or '&amp;|t;&amp;lt; on 'unsigned char' or 'unsigned int', you should always cast
returned value.

E12.1 The operator on a Boolean expression should be a logical operator ( &amp;&amp;, || or !).

E12.2 Ternary expression '?:' should not be used.

E12.3 Expressions should not cause a side effect assignment.

E12.4 The equal or not equal operator should not be used in floating-point expressions.

E13.1 Boolean expressions should not contain side effect operators.

E13.2 An expression that contains a side effect should not be used in the right-hand operand of a logical
&amp;&amp; or || operator.

E13.3 The function in the right-hand operand of a logical && or || operator might cause side effects
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Table 12. Extended rules (continued)

Code review | Message

reference

E15.1 Do not use the continue statement

E15.2 Only one break statement should be used within a loop

E15.3 The return keyword should not be used in a conditional block

E15.4 The else keyword should be followed by a compound statement.

E16.1 Case char value is applicable only if the switch statement value is plain character variable.

E16.2 A constant should not be used as a switch expression.

E16.3 The switch expression should not have side effects.

E17.1 The number of arguments used in the call does not match the number declared in the prototype.

E17.2 Use the const qualification for parameter '%name%' which is pointer and which is not used to change
the pointed object.

E17.3 Function identifiers should always use a parenthesis or a preceding &amp;

E19.1 Structure or union types '%name%' should be finalized before the end of the compilation units.

E20.1 Header file contents should be protected against multiple inclusions.

E20.2 The # or ## preprocessor operator should not be used more than once.

E20.3 Missing argument when calling the macro.

E20.4 Only use the 'defined' preprocessor operator with a single identifier.

E20.5 Macro definitions or '#undef' should not be located within a block.

E20.6 A C macro should only be expanded to a constant, a braced initialiser, a parenthesised expression, a
storage class keyword, a type qualifier, or a do-while-zero block.

E21.1 The variable 'errno’ should not be used.

E21.2 The macro 'offsetof' should not be used.

E21.3 The library macro or function 'setjmp,longjmp,sigsetjmp,siglongjmp' should not be used.

Annex to MISRA 2012 Rule 1.3

This annex gives details about MISRA 2012 Rule 1.3.

This table identifies the undefined and critical unspecified behaviors that are notified by Rule 1.3.

In the columns,
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» C90 Id is the number of the undefined behavior in 'Annex G' of 'The C90 Standard' where the behavior is

» C99 Id is the number of the undefined behavior in ‘Annex J' of 'The C99 Standard'

mentioned in the body of 'The Standard' but not listed in 'Annex G', a * character is shown.

- Decidable: Yes or No, whether detecting instances of the behavior is, in general, decidable or not

+ Guidelines lists the MISRA C Guidelines which, if complied with, avoid the undefined behavior

» Entension lists the MISRA C extended rules

« Notes provides additional notes on the behavior including information on rules that might help avoid the

behavior, even if it cannot be totally avoided

If a particular undefined behavior has no entry in the Guidelines column, then an instance of the behavior in a

program is a violation of Rule 1.3.

Note: it is assumed that any code that is written in another language and linked to the program does not

directly or indirectly produce undefined behavior. For example, assembly language modules might define

overlapping objects which, if accessed from C, can lead to undefined behavior even though this might not be

apparent from the C source code.

Critical unspecified behavior (H2):

Id Decidable Guideline Extension Notes
C90 Cc99
1 1 No Rule E9.1, rule E9.2
2 No
2 3 No Rule 21.16
3 4 No Rule 21.16
4 5 No Rule 21.16
5 6 No Rule 21.16 Rule E4.2
7 Yes Rule 5.1
6 Yes
7 Yes
9 Yes Rule E19.1
10 Yes Rule 19.1 Rule E19.1
11 Yes
12 Yes
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Id Decidable Guideline Extension Notes
C90 C99
13 Yes Rule E10.1, rule E12.4 | Compliance with Rule 10.1
avoids generation of negative
zeros when operating on ex-
pressions that have a signed
type before promotion.
14 Yes Rule 7.4
7.8 15 Yes Rule 13.2 Rule E13.1, Rule 12.3
9 16 Yes Rule 13.2
17 Yes Rule 13.1
7 18 Yes Rule 13.2 Rule E12.3
10 19 No
20 Yes Rule 8.10
21 Yes Rule 13.6, Rule 18.8
7 22 Yes Rule 13.1
11 23 No
* 24 Yes Rule E20.6
12 25 Yes Rule 20.10, Rule 20.11 | Rule E20.2
13 26 No Rule E21.1
27 Yes Rule 21.12
28 Yes Rule 21.12
29 No
30 Yes Dir 4.11
31 Yes Dir 4.11
14 32 No Rule 21.4 Rule E21.3
15 33 No Rule 17.1
34 Yes Rule 21.6
16 35 Yes Rule 21.6
17 36 Yes Rule 21.6
18 37 Yes Rule 21.6
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Id
Decidable Guideline Extension Notes
Cc90 Cc99
38 No
19 39 No Rule 18.1, Rule 18.2, Compliance with either Rule
Rule 18.3, Rule 21.3 21.3 or all of Rule 18.1, Rule
18.2 and Rule 18.3 will avoid
this unspecified behavior
40 Yes Rule 21.3
20 41 Yes Rule 21.9
21 42 Yes Rule 21.9
22 43 Yes Rule 21.10
22 43 Yes Rule 21.10
44 Yes Rule 21.10
45 Yes
46 Yes
47 Yes
48 Yes Dir 4.11
49 Yes Dir 4.11
50 Yes Dir 4.11
Undefined behavior (H1):
Id
Decidable Guideline Extension Notes
Cc90 Cc99
1 N/A This behavior is listed in C99 but
each such instance is also given its
own entry in Annex J. The entry for
this behavior is therefore redundant.
1 2 Yes
3 Yes
4 Yes
2 Yes Rule E4.1, Rule E4.2
5 Yes Rule E4.1, Rule E4.2
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41

C90

C99

10

11

12

13

Decidable

Yes

Yes

Yes

Yes

Yes

No

No

No

No

No

No

No

No

Guideline Extension

Rule 20.10

Rule 5.2

Rule 17.3

Dir 4.12, Rule 18.6,
Rule 21.3

Dir 4.12, Rule 18.6,
Rule 21.3

Dir 4.12, Rule 18.6,

Rule 21.3
Rule 9.1 Rule E9.1

Rule E9.1

Rule 11.2, Rule
11.3,Rule 11.4,
Rule 11.5

Notes

Compliance with Rule 9.1 avoids a
common cause of this undefined be-
havior but it is not sufficient to avoid
all situations in which an indetermi-

nate value might arise.

The following rules are used to avoid
this behavior: Rule 9.1, Rule 11.2,
Rule 11.3, Rule 11.4, Rule 11.5 and
Rule 19.1. However, if a trap rep-
resentation is copied into an ob-

ject that does not have character
type, for example using 'memmove’,
‘memcpy’ or via a pointer to a char-
acter type as permitted by the excep-
tion of Rule 11.3, it is not possible to

avoid this behavior.

The following rules are used to avoid
this behavior: Rule 9.1, Rule 10.1,
Rule 11.2, Rule 11.3, Rule 11.4, Rule
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10

16

17

11

12

13

14

18

19

C90

C99

14

15

16

17

18

19

20

25

26

27

28

29

30

31

32

33

Decidable

Yes

No

No

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

Yes

Yes

Yes

No

No

Guideline Extension

Rule 5.6, Rule 5.7,
Rule 8.3

Dir 4.1, Rule 10.3
Dir 4.1, Rule 10.3

Rule 9.1, Rule

11.2, Rule 11.3,
Rule 11.4, Rule
11.5, Rule 19.1

Rule 5.1, Rule 5.2,
Rule 5.3, Rule 5.4,
Rule 5.5

Rule 21.2

Rule E4.1, Rule E4.2

Rule 7.4, Rule
11.4,Rule 11.8

Rule 20.2
Rule 20.2

Rule 13.2, Rule
13.3,Rule 13.4

Dir 4.1

Notes

11.5, and Rule 19.1. However, if the
Exception of Rule 11.3 is used then it
is not possible to prevent generation

of a negative zero.
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C90

20

21

22

25

23

24

26

28

29

30

C99

34

35

36

37

38

39

40

41

42

43

44

Decidable

No

No

Yes

Yes

no

No

No

No

No

No

No

No

Yes

Yes

No

No

No

Guideline Extension

Rule 11.3, Rule
11.4,Rule 11.5

Rule 11.3, Rule
11.4,Rule 11.5

Rule 8.2, Rule 17.3 Rule E17.1

Rule 8.4, Rule 5.5, Rule E8.10
Rule 11.1, Rule
21.2,Rule 17.3

Rule 8.4, Rule 5.5,
Rule 11.1, Rule
21.2

Rule 8.2, Rule 17.3 Rule E8.10
Rule 8.2

Rule 5.6, Rule 5.7,
Rule 8.3, Rule 8.4,
Rule 8.5, Rule
11.1, Rule 21.2

Rule 5.6, Rule 5.7,
Rule 8.2, Rule 8.3,
Rule 8.4, Rule 8.5,
Rule 11.1, Rule
21.2

Dir 4.1
Rule 11.1

Rule 11.1, Rule
11.2,Rule 11.6,
Rule 11.7

Dir 4.1
Rule 18.1

Rule 18.1

Notes

Rule 17.3 is only applicable to, and
only required for C90
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Id
Decidable
C90 C99

31 45 No

46 No
* 47 No
32 48 No
32 48 No

49 No
33 50 No
34 51 No
* 52 Yes
* 54 Yes
* 55 yes
35 56 Yes
36 57 Yes
37 58 Yes
38 Yes

59 No

60 Yes
39 61 No
40 62 No
* 63 Yes
* 64 Yes

65 No

66 No

324

Guideline

Rule 18.2

Rule 18.1

Rule 12.2

Rule 18.3

Rule 19.1

Rule 6.1

Rule 18.7

Rule 8.14

Rule 8.14

Extension

Rule E10.1

Rule E19.1

Rule E8.8

Rule 11.4, Rule 11.8,

Rule 19.2

Rule 11.4, Rule 11.8,

Rule 19.2

Notes

Compliance with
Rule 10.1 avoids
this undefined be-
havior except when
the expression is
left-shifted
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42

44

45

43

46

47

48

49

50

51

52

53

54

C90

C99

67

68

69

70

71

72

73

74

75

76

77

78

79

80

81

82

83

84

85

86

87

88

89

90

91

92

93

Decidable

Yes

Yes

No

No

No

Yes

Yes

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Guideline Extension

Rule 8.10

Rule 18.8
Rule 18.8

Rule 17.6

Rule 8.2, Rule 11.1

Rule 9.2
Rule 9.2
Rule 9.2
Rule 8.6 Rule E8.9, Rule E8.10

Rule 8.2

Rule 17.1

Rule 17.4

Rule 20.3

Rule 20.6
Rule 20.10

Rule 20.10

Rule 21.1

Notes
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55

56

57

60

61

62

63

58

326

C90

C99

94

95

96

97

98

99

100

101

102

103

104

105

106

107

Decidable

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

No

Yes

Yes

Yes

Yes

No

Yes

Guideline

Rule 17.3, Rule
20.1, Rule 20.4,
Rule 21.2

Rule 20.1

Rule 20.1, Rule
21.2

Rule 20.4

Rule 21.1, Rule
21.2

Rule 21.2

Rule 21.1, Rule
21.2

Rule 21.1
Dir 4.11
Dir 4.11

Rule 17.3, Rule
21.2

Dir 4.11

Dir 4.11

Rule 21.1

Extension

Rule E21.1

Notes

Compliance with Rule 19.1 avoids a
common cause of this undefined be-
havior but does not prevent copying
part of an object to another part of
the same object, such as an array.

Compliance with Rule 21.1 prevents
non-definition of the macro but no
rule prevents the macro expansion
removal, ex by means of (assert)(E)
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0

94

64

65

66

67

C90 C99

108

108

110

111

112

113

114

115

116

117

118

119

120

121

122

123

Decidable

Yes

No

No

No

No

No

No

No

No

No

Yes

Yes

Yes

Yes

No

No

No

No

No

No

Guideline

Rule 21.12
Rule 21.12
Dir 4.11

Rule 21.7

Rule 21.1, Rule
21.2

Rule 21.1, Rule
21.2,Rule 21.4

Rule 21.1, Rule
21.2,Rule 21.4

Rule 21.4
Rule 21.4
Rule 21.4

Rule 21.4, Rule
21.5

Rule 21.5

Rule 21.5

Extension

Rule E21.1

Rule E21.3

Rule E21.3

Rule E21.3
Rule E21.3
Rule E21.3

Rule E21.3

Notes

Compliance with Rule 21.1 prevents
non-definition of the macro but no
rule prevents the macro expansion
from being removed, ex. by means of
‘errno’ if it is implemented as a func-
tion-like macro. Compliance with
Rule 21.2 prevents definition of the
identifier 'errno’.

Compliance with either rule is suffi-
cient to avoid the undefined behav-

ior.
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C90

68

69

70

71

75

76

73

74

72

59

328

C99

124

125

126

127

128

129

130

131

132

133

134

135

136

137

138

139

Decidable

No

No

No

No

No

No

No

Yes

Yes

No

No

No

Yes

No

No

No

No

Yes

Yes

Yes

No

No

Guideline

Rule 21.5
Rule 21.5
Rule 21.5
Rule 21.5
Rule 21.5
Rule 21.5

Rule 21.5

Rule 17.1

Rule 17.1, Rule
21.1,Rule 21.2

Rule 17.1, Rule
21.1,Rule 21.2

Rule 17.1
Rule 17.1
Rule 17.1
Rule 17.1
Rule 17.1
Rule 17.1
Rule 17.1
Rule 17.1

Rule 17.1

Rule 21.6

Rule 21.6

Extension

Rule E21.2

Notes

Compliance with Rule 17.1 avoids in-
stances of this undefined behavior
that arises through improper use of
the features of <stdarg.h>.
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77

78

79

85

83

84

82

87

81

97

80

86

89

C90

C99

140

141

142

143

144

145

146

147

148

149

150

151

152

153

154

155

156

157

Decidable

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

Guideline

Rule 21.6

Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6

Rule 21.6, Rule
21.10

Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.10

Rule 21.6, Rule
21.10

Rule 21.6
Rule 21.6

Rule 21.6

Extension

Notes

If Rule 21.6 is deviated then Rule
22.6 provides protection against this
undefined behavior. Rule 21.6 is pre-

ferred as it is 'decidable’.
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C90

88

91

92

93

95

96
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C99

158

159

160

161

162

163

164

165

166

167

168

169

170

171

172

173

174

175

176

177

178

179

180

181

182

Decidable

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

Guideline

Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.6
Rule 21.3
Rule 21.3

Rule 21.3, Rule
22.2

Rule 21.3
Rule 21.3
Rule 21.8

Rule 21.4

Rule 21.8
Rule 21.9
Rule 21.9

Rule 21.9

Dir 4.11

Dir 4.11

Extension

Notes

Compliance with Rule 21.8 avoids
this undefined behavior in respect of

'getenv' only.

Compliance with Rule 21.10 avoids
this undefined behavior except in re-

spect of 'wesxfrm'.
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. Decidable Guideline Extension Notes

C90 C99

183 No Dir 4.11

184 Yes Rule 21.11

185 Yes Rule 21.11

186 No Rule 21.6

187 No Dir 4.11

188 No

189 No Dir 4.11

190 No

191 No

Code review settings
You can configure the code review settings before running your application in HCL DevOps Test Embedded (Test

Embedded).

The following options must be set from the Build settings tab in the Properties window. To open Build settings tab:

« In the project explorer, right-click the project on which you want to change the settings and click Properties.

Alternatively, you can select the project, and then click the settings icon %7 on the toolbar.
« Expand C/C++ Build in the left panel, select Settings.
« In the right panel, in the Build tab, expand Settings and select Code Review.

- Expand Code review to access the code review settings.

Additional included system directories
This option provides additional directories where system include files that is, include files between ‘<’
and ">' found.

For example Additional included system directories is required if your TDP is not complete .

Review included system files

Select ‘Yes' if you want that the system include files that is include files between ‘<’ and >’ must be
analyzed. The default value is ‘No’.

Pre-include files

This option allows to select one or several file that are analysed before starting the code review. This is

useful to define some pragmas used by the analyser.
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Display errors/warnings

This option allows to control the number of error and warning messages the tool can display for each

analyzed file as following:

- ‘All’ display all error and warning message.
« ‘N0’ hide the error and warning message.
« ‘Max n' display only the n first error and warning message.

Naming script file
This option provide a perl script file for your naming rules.

Report Template

An HTML code review report is automatically generated after each execution. This report is based on a
template as default<i nstal l ati on fol der>/1ib/reports/msrareport.tenplate.Youcan
make a copy of this template and modify it. This option is used to point to the new template file.

Executing the code review

You can use the code review tool on any test, application node, or a single source file. The code review tool is run on

the source code whenever you build the file.
Before you begin

For all new projects, you must have selected the rule configuration file. You can configure the code review rules if

necessary. See Configuring code review rules on page 230.
About this task
To perform a code review without compiling and executing the application:

1. In the Project Explorer, select the node that you want to check.

2. Click the Code Review icon \) to enable code review in the build and click the Launch icon o .
3. If your rule configuration file is an out-of-date version, you are prompted to update it. Click ok and select the

rules that are missing.

Note: The selected rules are added with their default severity levels to your configuration file.
Unselected rules are added as disabled rules.

4. In the Project Explorer view, right-click on the result file under the Test Result node, select Open with > HTML

Reports > Code Review to see the report.
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Customizing the code review report

The default code review report is generated in an HTML format from a template named misrareport.template as that

you can modify to customize the code review reports.

The code review HTML reports are generated from a template named misrareport.template that you can find in the

following folder as a text file:

* On Windows: <instal |l ati on_directory>\lib\reports

*OnUnix:<instal lation_directory>/lib/reports
The template file uses the following JavaScript libraries:

» Bootstrap

» JQuery

» Font Awesome
* VisdS

e Chart.js

The JavaScript libraries are now provided in the installation folderi nst al | ati on directory>/1ib/web. The
JavaScript libraries are downloaded from the internet as default. However, if you have no access to the internet, the
template uses the JavaScript libraries that are in your installation folder. If you want to share the report with someone
who does not have access to the internet, you might not install Test Embedded, make sure that the disk contains the

same folders and files as yoursin<i nst al | ati on directory>/1ib/web.

The following sections give the list of elements that you can use in the raw data and the JavaScript functions to

customize your report file.

Data format

The misrareport.template template consists of two sections:

« The HTML section that is common to all reports,
A JavaScript section that sets tables depending on two variables that are initialized dynamically when the

report is created:

var data = {{json}}; // the raw data, 1in json format
var d = new Date({{date}}) // the generation date

Raw data contains the following information at the top level:

- output is the name of the json file that contains the raw data

« title is the nternal title of the report (displayed in the “crc” file format)

« configurationTitle is the title of the used configuration file

« systemLevel is the C level norm used. The possible values are "C90", "C90 and Normative Addentum 1", "C99
or"C11"
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- configuration is the configuration file used to generate this report
- date is the generation date of raw data
- nbAnalyzedFiles is the number of analyzed files

nbFileskO is the number of files containing errors

nbFilesOK is the number of files without errors

- nbError is the total number of all errors in all analyzed files
- nbWarning is the total number of all warnings in all analyzed files
- files is the array of file element (each one represents a physical file) or array of deactivated element

- statistics is the array of rule statistics element

Example:
{

"output": "../build/fullreport_l.crc.json",

"title": " DevOps Test Embedded MISRA C:2012 Report using C90",
"configurationTitle": "MISRA C:2012",

"systemLevel": "C90",

"configuration": "C:\\Program
Files\\HCL\\DevOpsTestEmbedded/plugins/Common/Llib/confrule_2012.xml",
"date": "Mon Oct 19 15:52:07 2020",

"nbAnalyzedFiles": 5,

"nbFilesk0": 4,

"nbFilesOK": 1,

"nbError": 49,

"nbWarning": 68,

"files": [

])

"statistics": [

]

}

Each file element represents an analyzed source file. It contains the following information at the top level:

« source is the physical location of source file

- fileDate is the date of last editing of this source

« nbErrorOrWarning is the total of error or warning in this file

« content is an array of rule element (if the rule is directly raised at file level) or function element. It is always

available but it can be empty (file with no function and with no error or warning)

Each function element represents a function. It contains the following information at the top level:
o function is the name of the function
- kind is the analysis result of this function. The possible values are 'Failed' or 'Passed'
- content is an array of rule element (rules that are raised inside this function). It is always available
but it can be empty (function with no error or no warning)

Examples:

file element
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0 {

"source": "C:\\workspace\\project\\src\\core.h",
"fileDate": "Mon Sep 07 10:31:50 2020",
"nbErrorOrWarning": 25,

"content": [
]
}

function element:

{

"function": "win",
"kind": "Failed",
"content": [

]

}

Each rule element represents a triggered rule, justified or not. It contains the following information at the top level:

« rule is the name of the rule, corresponding to its label defined in the configuration file

- group is the family of this rule, it corresponds to the label of the rule’s group that is defined in the configuration
file

« kind is the severity of the rule. The possible values are 'error', 'warning' or 'info, depending on the error level in
the configuration file and on the possible justification (the justified rules have an 'info' type value)

« line is the line of the current file where the rule was triggered

« column is the column of the current file where the rule was triggered

« text is the rule description. It is related to the rule text in configuration file

« justification is the justification text for the rule. This field is optional, and is present only if the rule is justified

Example:
{

"rule": "M21.6.1",
"group": "21- Standard libraries",

"kind": "info",

"line": 21,

"column": 10,

"text": "The 1input/output library <stdio.h> shall not be used in production code.",
"justification": "This rule does not apply to the following line"

3

Each deactivated element represents a group of rules that is deactivated for a specific reason. It contains the
following information at the top level:

- deactivated_rules_by_user is used for all the rules that are deactivated when it is used in the configuration file
with the error set to level 0. This field is optional, it can be empty, or you can enter an array of deactivated rule

element

Example:

335



336

HCL DevOps Test Embedded

S {
/ "deactivated_rules_by_user": [
]
}

- deactivated_rules_by_test_option is used for all the rules that are deactivated by using the “test” option. This

field is optional, it can be empty, or you can enter an array of deactivated rule element

Example:
{

"deactivated_rules_test_option": [
]
}

Each deactivated rule element represents a deactivated rule for any reason. It contains the following information at
the top level:

- rule is the name of the rule, it corresponds to the rule label that is defined in the configuration file

- text is the rule description, it corresponds to the rule text in configuration file

Example:
{

"rule": "E15.3",
"text": "The return keyword should not be used in a conditional block."

3

Each rule statistics element represents global statistics for the rule raised during test. It contains the following

information at the top level:

- ruleStatistics is the array of the statistic rule element

Example:
{

"rulesStatistics": [
]
}

Each statistic rule element contains a rule that was raised one or several times. It contains the following information

at the top level:

- rule is the name of the rule. It corresponds to the rule label that is defined in the configuration file
« kind is the severity of the rule. The possible values are ‘error' or 'warning' that correspond to the error level in
the configuration file
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» occurences is the number of times that the rule was raised

Example:
{

"rule": "M17.7",

"kind": "error",

"text": "When a function returns a value, this value should be used.",
"occurences": 4

}

Javascript functions
You can find in the misrareport.template template a set of JavaScript functions.

Some of the helper functions simplify access to “raw data”:

« isFct(element) checks whether an element is a function or not

- isFile(element) checks whether an element is a file or not

- isFilelnError(element) checks whether an element is a file that contains an error or a warning
« isFctPassed(element) checks whether an element is a passed function or not

« isFctFailed(element) checks whether an element is a failed function or not

- isRuleError(element) checks whether a rule level is error or not

- isRuleWarning(element) checks whether a rule level is warning or not

« isRulelnfo(element) checks whether a rule level is an information or not

- isRuleJustified(element) checks whether a rule is justified or not
Other functions are used to display each section of the report:

» emptyLine() displays an empty line (helper function)

- startFile(element) is called at start of a file element.

- endFile() is called at end of a file element.

- startFileRules() is called at the beginning of a group of rules that is relative to a file. Used to display array
headers

- endFileRules() is called at end of a group of rules relative to a file.

- startFileFunctions() is called at the beginning of a function

« rule(element) is called to display details of a raised rule.

The last section is a set of functions that is used to display summaries:

- displayDeactivatedbytest(elem) displays all deactivated rules by using the "-test' option
« displayDeactivatedbyuser(elem) displays all deactivated rules that are used in the configuration file

- displayrulesstatistics(elem) displays statistics for all rules that are raised during the test

The main algorithm dispatches the function calls by parsing the raw data.
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Coupling Analysis

Coupling Analysis consists of Control Coupling and Data Coupling.

Control Coupling

Control Coupling is defined as “the manner or degree by which one software component influences the execution
of another software component" in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'.
Control Coupling is used to verify that all the interactions between modules have been covered by at least one test.

Test Embedded introduces a new coverage level called “Control Coupling” for C language that consists in verifying
that all the interactions between modules have been covered by at least one test. This new coverage level is
implemented in Test Embedded in two ways:

» Modules are compilation units, in this case:
> Control Couplings are calls between two functions that are in two different compilation units.
= Control Coupling is not a simple interaction. It is a control flow in the calling module that ends with an
interaction with another module.
> Groups of compilation units can be defined as a single module. This will increase the number of calls
between modules but also increase the number of control flows in the calling modules.
> The report contains a button to display:
= All the Control Couplings (default option).
= Only the shortest Control Couplings (only the last calls between modules are taken into
account)
= Only the longest Control Couplings (the sub-control flows are ignored)
» Modules are Functions, in this case:
> Control Couplings are considered as all the calls between two functions, in the same compilation unit
or not.
> Each Control Coupling is only a call, and not a control flow as previously defined.

So, to identify the Control Couplings, Test Embedded analyzes all the external calls between modules (definition of
the modules could be different depending on the option) and statically identifies all the possible paths in the calling
module that end with each external call, excluding the one that starts with a static function (ex: a function that can't
be called from another module). This constitutes the set of Control Coupling of the application.

For each of them, Test Embedded provides the following information:

* The calling modules.
« The complete control flow (example: the set of successive calls, the last one is the external call). If the option
"module as function” is set, each control flow has two functions only.

« In case of option module as "compilation unit":

338


https://www.faa.gov/aircraft/air_cert/design_approvals/air_software/cast/cast_papers/media/cast-19.pdf
https://www.faa.gov/aircraft/air_cert/design_approvals/air_software/cast/cast_papers/media/cast-19.pdf

Chapter 6. Test Execution Specialist Guide

> |s it the longest one that leads to this external call (it is not the longest when there is another Control
Coupling that includes the current one).
o |s it the shortest one that leads to this external call (it is not the shortest when there is another Control
Coupling that is included by the current one).
* It is covered or not.
- The list of test cases that each Control Coupling covered.
« The list of requirements that are related to the test cases.

How Control Coupling Works

When an application node or a test is executed, the source code is instrumented by the Instrumentor (attolcc4 for
C language) that produces a static file with the extension .tsf containing information on the Control Couplings. The
resulting source code is then compiled, linked and executed and the Control Coupling feature outputs a dynamic file

with the extension .tgf.

These 2 types of files are the input of the report generator that produces a report in HTML format (and optionally
the raw data can be generated in a Json file). A template is provided for this generator. You can provide your own

template to modify the report.

If the Control Coupling feature is used with unit testing feature, the report generator can take the .tdc files as input
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by their execution date, and there is no

requirement.

Note:

To visualize your report in Test Embedded for Eclipse IDE, if you are using the default browser option, be sure
that JavaScript is enabled. Otherwise, you can choose another browser that is compatible with your version of
JavaScript by changing it in Window > Preferences > General > Web Browser .

Set Control Coupling options

You can set options for Control Coupling to build your project in HCL DevOps Test Embedded for Eclipse IDE (Test
Embedded for Eclipse IDE). Control Coupling feature must be enabled to be selected in the build settings before

running the build.

Enable Control Coupling
- In the Project Explorer, right-click on the project and click Properties. Alternatively, you can

select the project, and then click the settings icon *.+* on the toolbar.

Alternatively, you can select the project, and then click the settings icon ¥+ on the toolbar.

- In the Properties window, click C C++ Build > Settings.
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- In the Build Settings tab, click Settings > General > Selective instrumentation.
- In the right pane, click the Value field in Build options and click ... to open the Build options
window.

« In the Build options list, click Performance Profiling to enable the feature.

Control Coupling

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build

Settings tab, under the Coupling menu, select Control Coupling.

From this setting page, you can change the following choices:

« Trace file name (.tgf): Sets the name of the trace file dedicated to control coupling, click the edit button to
change the name. By default, this name is the base name of the test with the extension .tgf.

+ Exclude libraries: Include (No) or exclude (Yes) the control couplings must be included or excluded. that end
with a call to a function that is not part of the application .

- Report Template: changes the template of the report generator. By default, this template is ccreport.template.

- Generate raw data in JSON : Select Yes if you want to generate the control coupling raw data in a JSON file,
Yes, in compressed mode if you want to compress this file, No if you do not need this JSON file. The name of
this file is the same as the name of the HTML report file where . ht i is replaced by . j son.

» Module as: Select the choice that corresponds the best to your definition of a module. A module can be
defined as a function or a compilation unit. Test Embedded offers two ways to interpret Control Coupling,
depending on how the "module" in CAST-19 is interpreted:

> Module as function: Each call between each function is considered as Control Coupling.

> Module as compilation unit: Only the calls between two functions in two different compilation units
are considered as Control Coupling. Moreover, the different called stacks in the calling module are
also considered as different Control Couplings. With the previous option set, the user can group two
or more compilation units in a single module (called component) in order to ignore the calls between
these compilation units.

- Components List: Select a file that contains a list of components. This option is used only when the option
"module as compilation unit" is selected. This file is in a JSON format and contains a list of components with

their associated compilation units as follows:

{

"component_name" : [ “filel", “file2",..],

Set Control Coupling Options

You can set the options for Control Coupling to build your project in HCL DevOps Test Embedded Studio (Test
Embedded Studio).
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Execute a build with Control Coupling

« In Test Embedded Studio, open the Settings of the project and click the Configuration Properties > Build >
Build options menu.

« In the right panel, click on the Build options and edit the options by clicking on the ... button.

- In the dialog window that shows up on the right, you can select the different tools that can be used for the

build. Select Ctrl Coupling analysis to enable the control coupling feature.

Control Coupling options

Options for Control Coupling can be updated in the following menu of the settings: Configuration Properties >

Runtime analysis > Control coupling

From this setting page, you can change the following choices:

- Trace file name (.tgf): sets the name of the trace file dedicated to control coupling. By default, this name is
the base name of the test with the extension .tgf.

« Exclude libraries: Include or exclude the control couplings that end with a call to a function that is not part of
the application (sets the -noccext option of the report generator if it is set to yes).

» Report Template: changes the template of the report generator. By default, this template is ccreport.template.

- Generate raw data in JSON : Select Yes if you want to generate the control coupling raw data in a JSON file,
Yes, in compressed mode if you want to compress this file, No if you do not need this JSON file. The name of
this file is the same as the name of the HTML report file where . ht ni is replaced by . j son.

» Module as: Select the choice that corresponds the best to your definition of a module. A module can be
defined as a function or a compilation unit. Test Embedded offers two ways to interpret Control Coupling,
depending on how the "module" in CAST-19 is interpreted:

> Module as function: Each call between each function is considered as Control Coupling.

> Module as compilation unit: Only the calls between two functions in two different compilation units
are considered as Control Coupling. Moreover, the different called stacks in the calling module are
also considered as different Control Couplings. With the previous option set, the user can group two
or more compilation units in a single module (called component) in order to ignore the calls between

these compilation units.

Control Coupling Report

After you build a project with HCL DevOps Test Embedded (Test Embedded), you can get a Control Coupling report

with compilation unit module or a Control Coupling report with function module, depending on the build settings.

The default Control Coupling report is in HTML format. It is generated from a template named ccreport.template (for
the module as compilation unit option ), or ccfreport.template (for the module as function option). The templates are

provided as text files that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,
« JQuery,

341



HCL DevOps Test Embedded

* Font Awesome,
« VisJS.

These libraries are not provided. You must have an internet connection when you open the report. If not, download the

libraries (.css and .js files), copy them in the same folder than your report, and modify the template file as follows:

Replace the following lines with the lines from the second text block:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc1l2p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q817/X+965Dz00rT7abK41JStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WVCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnISK3+MXmPNIYE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

Replacement lines:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

If you set a module as a compilation unit in the control coupling properties, you get a control coupling report with
compilation units in output of your project build. If you set a module as a function, you get a control coupling report
with function in output. For more details about the control coupling settings, see Set Control Coupling options on
page 339 for Test Embedded for Eclipse IDE. In a report with function as module, the report shows all the function

calls (internal and external).
The Control Coupling report includes three parts.

Summary

In the Summary section, you find the number of Control Couplings for your application that are covered, given the

information that you provided and the percentage of Control Couplings that are covered.

A graph displays the total percentage of covered and non covered control couplings for the entire application.
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The Summary table displays the following information:

- The percentage of Control Couplings of your application by module pairs that have not been covered,
depending on the information that you provided.

 The percentage of Control Couplings that are covered by module pairs.

Filter Modules I m Show Hide Graphs Show Hide Requirements

Summary
# Contrel Coupling 98 (filtered W)
% Control Coupling covered 33%
Control Coupling covered
Details

The Details table lists all the Control Couplings and displays the following information for each of them:

* The calling compilation unit.

 The control flow, for example: the successive calls in the module that end with the external call in the called
module. Note that the called module is mentioned in the last function of the control flow. In case of option
"module as function’, this control flow contains only two functions.

« A check mark if it is a longest Control Flow but only if the "module as compilation unit" option is set.

« A check mark if it is a shortest Control Flow but only if the "module as compilation unit" option is set.

« The list of test cases that covered this control flow. If the Control Coupling feature is set with the unit testing
feature, the test cases are the one in the . pt u files named as <service>/<test>.

- The associated requirements. If the Control Coupling feature has been set with the unit testing feature, the
requirements are those that have been described in the . pt u files with the keyword REQUIREMENT for each
test cases that covered this Control Coupling.

- A check mark if the control coupling has been covered.

Call Graph

For each compilation unit, a partial call graph displays all the functions in an interactive call graph from left to right or

from top to bottom, depending on the selector button position on the top of the call graph.

You can select a control coupling in the table to highlight it in the call graph.
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At the end of the report, a complete call graph displays all the functions calls.

Filters

You can apply filters in the report by selecting different options at the top:

- If the option “module as compilation unit" option is set, you can choose first to display all Control Couplings,
the longest (only the Control Couplings that have the longest control flow in the calling module) or the
shortest (only the Control Couplings that have the shortest control flow in the calling module). The summary
tables and the details table are updated accordingly to your selection. This option applies to reports with
compilation unit as module only.

« You can select the calling modules and the called modules. It filters the Control Couplings depending on
their calling and called modules. The summary tables and the details table are updated accordingly to your
selection.

* You can choose to display all graphs or hide them in the report.

« You can show or hide the Requirements.

Customization of Control Coupling Reports

The Control Coupling report is created from a template called ccreport.template (if option “module as compilation
unit" is set), or ccfreport.template (if option “module as function” is set) that you can find in the folder <install>/lib/

reports.

The template file uses the following JavaScript libraries:

» Bootstrap

» JQuery

» Font Awesome
* VisdS

« Chart.js
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The JavaScript libraries are now provided in the installation folderi nst al | ati on directory>/1ib/web. The
JavaScript libraries are downloaded from the internet as default. However, if you have no access to the internet, the
template uses the JavaScript libraries that are in your installation folder. If you want to share the report with someone
who does not have access to the internet, you might not install Test Embedded, make sure that the disk contains the

same folders and files as yoursin<i nst al | ati on directory>/1ib/web.

This template is made of two parts:

» The HTML part that is the common part of all reports,
- A JavaScript part that sets the tables and call graph depending of two variables initialized dynamically when
the report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation

Raw data

Raw data is composed of 4 sections at the top level:

« A summary of the Control Coupling metrics:
> nbec is the number of Control Coupling found in the application,
> nbcovered is the number of Control Coupling found in the application that have been covered by at
least one test,
> nbccShortest and nbcoveredShortest are the same for the shortest Control Coupling,
> nbccLongest and nbcoveredLongest are the same for the longest Control Coupling,
- filtered is set to true if the report has been generated with a filter (shortest or longest),
- filtered_longest is set to true if the report has been generated with a filter longest (set only if filter is

true).

"filtered": ,
"filtered longest": ,
"nbcc": 112,

"nbcovered”: 48,
"nbccshortest”: 32,
"nbcoveredShortest": 25,

"nbcclLongest™: 58,
"nbcoveredLongest": 23

« The list of the modules, each of them has the following information:
- Name is the short name of the C file,
> Fullname is the name and path of the C file,

o uuid is a unique identifier of the module,
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- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),
- functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules": {
"f5b557%edeacal2df478a6780c0cd4c92": |
"name": "USAGE.C",
"uuid": "fObS579%edeacal82df478a6780c0c4c92",
"unknown": ;

"functions": [
"ba9%eb05ad703046fed306b4271b72ad7"

]
by

« The list of functions including following information:
> name is the name of the C function,
o line is the first line of the function in the module,
> id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
> module is a unique identifier of the module in which the function is declared,
- calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
o level is a number that represent the level of the function in the call graph, starting to 0.

- calledby is the list of unique identifiers of functions that call this one.
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- Functions are listed as hashmap with the uuid, as following:

"functions": |
"bateb05ad703046fed206b4271b7ead": |

"name": "write usage",

"line™: 9,

Tlid'rl . l_,

"gtacksize": L,

"ouid": "bal9ehb05ad703046fed306b4271b72ad?",
"module": "fibELTVOedeacalfidlrd78ae780c0cdcB2",
"calls™: [

i
"calling uuid": "ba9eb05ad703046fed306b4271b7ead7",
"called uuid": "7bécdbd3bbbddelebl0f3056272%ba™,
"line™: 10,
"col": 2,
"same module":

}

1,

"level™: 1,

"calledby": [
"Ifh6bZ206509c8bT0fchd01ba797abacl "
1

bro

- The list of the Control Couplings, each of them have the following information:
o calls is the list of successive calls that composed this control coupling, each of them have the
following information:
= calling_uuid is the unique identifier of the calling function.
= called_uuid is the unique identifier of the called function.
= isShortest is set to true if the control coupling is a shortest one.
= isLongest is set to true if the control coupling is a longest one
= line is the line number of the call in the module.
= col is the column number of the call in the module.
= same_module is set to true if the called function is in the same module that the calling
function.
- testcases is the list of test cases that covered the control coupling, each of them have the following
information:
= name is the name of the test case.
= requirements is the list of requirements that is covered by this test case.
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Control couplings are listed as an array, as follows:

"controlcouplings": [
1
"isLongest": '
"calls™: [

{
"calling uuid": "3fb6b20659c9b70fcéd01ba797abaclf",

"called uuid": "0ddedlfbch09e237ch0600£451d27d59",
"line™: 100,

"col™: 19,

"zame module":

}
1,

"teskcases": [

i
"name": "fct &8/1",
"requirements™: [

{
"name": "REQ PTU 123"

Data Coupling

Data Coupling is defined as “the manner or degree by which one software component influences the execution of
another software component” in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'. Data
Coupling is used to verify that all the global variables of the application under test have been consumed in read (also

called use) and write (also called def) during the tests.

Test Embedded introduces a new coverage level call “data coupling” for C language that consists to verify that all the
global variables of the application under test has been consumed in read (also called use) and write (also called def)

during the tests, as following:

« For each global variable, Test Embedded identifies the def and use. Then it considers all the possible def/use
pair as a data coupling.
- To cover a Data Coupling, i.e. a def/use pair, this def and this use must be executed from at least one test.

Test Embedded provides a new interactive HTML-based report for Data Coupling.
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To identify Data Coupling instances, Test Embedded analyzes all the global variables of the application, where they

are read and written. For one global variable, each pair of write and read constitutes an instance of Data Coupling.

For each data coupling, Test Embedded provides the following information:

« The name of the global variable.

+ The def position (file name, line, and column).

» The use position (file name, line, and column).

- The list of test cases that covered the Data Coupling.

« The list of requirements that are relative to these test cases.

How Data Coupling works

Test Embedded identifies the position if the def/use using coverage information. When you select the Data Coupling
option, some coverage options are set automatically: blocks, calls and conditions.

Coverage files (.fdc and .tio) are the input of the report generator that produces a report in HTML format (and
optionally the raw data can be generated in a Json file). A template is provided for this generator. You can provide

your own template to modify the report.

If the Data Coupling feature is used with unit testing feature, the report generator could take as input the .tdc
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by its execution date, and there is no
requirement.

Set Data Coupling Options

You can set the options for Data Coupling to build your project in HCL DevOps Test Embedded for Eclipse IDE (Test
Embedded for Eclipse IDE).

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build
Settings tab, under the Coupling menu, select Data Coupling.

From this setting page, you can change the following choice:

« Report Template: You can change the template of the report generator. By default, this template is
ccreport.template.

- Generate raw data in JSON : Select Yes if you want to generate the control coupling raw data in a JSON file,
Yes, in compressed mode if you want to compress this file, No if you do not need this JSON file. The name of
this file is the same as the name of the HTML report file where . ht ni is replaced by . j son.

Data Coupling report

From Test Embedded V8.2.0, you can get a HTML interactive Data Coupling report as a result to your project build.

The default Data Coupling report is in HTML format. It is generated from a template named dcreport.template

provided as a text file that you can modify to customize the report. uses the following online JavaScript libraries:
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» Bootstrap

» JQuery

» Font Awesome
* VisdS

¢ Chart.js

The JavaScript libraries are now provided in the installation folderi nstal | ati on directory>/1i b/ web. The
JavaScript libraries are downloaded from the internet as default. However, if you have no access to the internet, the
template uses the JavaScript libraries that are in your installation folder. If you want to share the report with someone
who does not have access to the internet, you might not install Test Embedded, make sure that the disk contains the
same folders and files as yoursin<i nst al | ati on directory>/Iib/web.

The Report is made of three parts.

Summary

In the summary section, a table displays the following information:

» The number of global variables in your application.

» The number of Data Couplings in your application.

 The number and the list of global variables without Data Coupling. If you get this information,
it means that Test Embedded has identified global variables that are read but never written,
or written but never read. This could be due to the fact that only a part of the application is
analyzed.

Two charts display the following information:

- The percentage of Data Coupling in a pie graph.
« A two-colored horizontal graph that provides a number of covered and uncovered Data

Couplings for each global variable.

» Data Coupling covered { 2 P 15 40
Details
A table lists all the Data Couplings and displays the following information for each of them:

« Variable: The name of the global variable.

» Def: The Def position of the column: file name [line] and (column).

+ Use: The Use position of the column: file name [line] and (column).
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- Test Cases: The list of cases that covered the Data Coupling.
 Requirements: The list of requirements relative to these test cases.
» Covered: This option is checked if the Data Coupling has been covered.

They are grouped by global variables.

Details

Varable Def Use Test Cases Requirements Covered
Global Variable "currentDate’

currentDate main [MAIN.C] (33:2) main [MAIN.C] (118:T) « no name &1 [Thu Nov 14 14:06:14 2019) W
currentDate main [MAIN.C] (33:2) main [MAINC] (123:2) ] r‘T;ilrrn' #7 [Thu Nov 14 14:06:14 2019) W
currentDate  DiffDays [DIFFDATES.C) (74:28)  main [MAIN.C] (118:T)
currentDate  DiffDays [DIFFDATES.C) (74:28) main [MAIN.C] (123:2)

Global Variable "updated’

This variable ‘updated’ is written but never read within the selected compilation units

Call graph

The call graph displays all the global variables with their interactions with one or more functions of the

application that read or/and write them.

+ Incoming arrows are 'Def' (write).

« Outcoming arrows are 'Use' (read).

The arrows between them represent a 'Def' or a 'Use’ (depending of the sense of the arrow). It is green
if the corresponding 'Def' or 'Use' has been covered. These arrows are not representing Data Coupling.
A Data Coupling instance is a couple of incoming and outcoming arrows that reach the same global

variables.

Filters

Buttons can be used to filter different sections of the report.

- Show/Hide Graph: It is used to show or hide the call graph at the end of the report.
« Show/Hide Requirements: It is used to show or hide the Requirements column in the Details

section of the report.
Customize Data Coupling Report

The Data Coupling report is based on a template called ccreport.template that you can find in the following folder:
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* In Windows:

<install ation_directory>\HCL\ DevOpsTest Enbedded\ | i b\reports

« In Unix:

<installation_directory>/ HCL/ DevOpsTest Enbedded/ | i b/ reports

Raw data

This template is made of 2 parts:

e The HTML part that is the common part of all reports,
A JavaScript part that sets the tables and call graph depending of 2 variables initialized dynamically when the

report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
Raw data is composed of 4 sections at the top level:

« A summary of the Data Coupling metrics:
- nbGlobalVariables is the number of global variables found in the application.
- nbDefUses is the number of Def/Use pairs found in the application.
- nbDefUsesCovered Def/Use pairs found in the application that have been covered by at least one test.
> nbVariablesWithoutDefUse is the number of global variables that have no Def/Use pairs in the
application.
- variablesWithoutDefUse is the list of global variables that have no Def/Use pairs in the application.

‘nbGlobalVariables™ 2,

"nbDefUses™ 4,

"nbDefUsesCovered™: 2,

"nbVariablesWithoutDeflse™ 1,

"vanablesWithoutDeflse™: [
"updated"

|

« The list of the modules, each of them has the following information:
> Name is the short name of the C file,
> Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),

- functions is the list of the unique identifiers of functions of the module.
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Modules are listed as hashmap with the uuid, as follows:

"modules™; {
"f5b5579edeaca82df478a6780c0c4c92™: {
"name”: "USAGE.C",

"fullname™ "..."
"yuid": "f5b5579%edeacal2df478a6780c0c4c92",
"unknown™

]

"functions™ [
"ba9eb05ad703046fed306b4271b7ead7"

]
..

« The list of functions including following information:
- name is the name of the C function,
o line is the first line of the function in the module,

o id is the number used in .tsf file to identify this function,
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- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),

- uuid is a unique identifier of the function,

> module is a unique identifier of the module in which the function is declared,

o calls is the list of the calls in this function. Each of them have the following information:

= calling_uuid is the unique identifier of the calling function,

= called_uuid is the unique identifier of the called function,

= line is the line number of the call in the module,

= col is the column number of the call in the module,

= same_module is set to true id the called function is in the same module that the calling

function.

o level is a number that represent the level of the function in the call graph, starting to 0.

- calledby is the list of unique identifiers of functions that call this one.
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- Functions are listed as hashmap with the uuid, as following:

“functions™: {
"ba%ebl5adT03046fed306b42 T 1bVead ™ {

“name”: Wiile. usage”,

“line™; 9,

Sid™; 1,

“slacksize’ -1,

“yyid™ "bafeb0fad703046fad 3060427 1h7eadi",
“module™; THbHSTSedeacab2df478a6780c0c4e92",
“calls™ [

{
“calling_wuid": "ba%eb(5ad703046fed306b427 1bTead?™,
“called_uuid™ “ThEod643bob44e1e05T1INMB2T20aba”,
“lina™: 10,
“col™: 2,
"same._moduls™

1

1.

“level™: 1,
"calledby [
"IhEb20659cHh 7 Metad0Tbal 97 abae 1

1
L.

« In the list of variables, each variable contains the following information:
> name is name of the global variable.
- line is line number of the declaration of the global variable in the compilation unit.
> moduleid is the unique identifier of the compilation unit where this variable is declared.
- defs is an array of defs of this global variable. Each def has the following information:
= variablename is the name of the global variable.
= linelocal is the line number of the declaration of the local variable in the compilation unit (-1 if
this variable is not a local variable).
= line is the line number of the def in the compilation unit.
= col is the column number of the def in the compilation unit.
= function is the name of the function where there is this def.
= moduleid is the unique identifier of the compilation unit where there is this def.
= isdef is true if it is a def, otherwise false.
= where is "bloc", "cond" or "case_" depending of where this def is.
= variabletype is "global", "local" or "param" depending of the type of variable.
= covered is true if it is covered by at least one test, otherwise false.
o uses is an array of uses of this global variable. Each use has the same information than a def.
- nbDefUses is the number of def/use pair for this variable.
- testcases is an array of array of test case descriptions. It is a two-dimension array as the first
diemnsion is for the defs and the second for the uses. Each test case contains the following

information:
= name is the name of the test case.
= requirements is an array of requirement id that this test case covered.
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Control couplings are listed as an array, as follows:

“vanables": |

{
“name” "curentate”,
“line™ 7,

"moduleuuid™: "e60218b872e86cTd154af4e30629160a",

"defs” [
{

“linglocal™ -1,
"line”. 33,

"col™ 2
"function™: "main"”,

"medulewud™ "4306a1f32e1b1400a35d13acteelcei™,

"isdef” true,
"where™. "bloc”,
“yarabletype™ "global”,
"covered. true
|
l.
"uses™ [
{
“vanablename": “cumeniDate”,
"linglocal™ -1,
"line”: 118,
=
"function”. "man”,

"medulewud™: "4306aifdZe1b1400a3sd13acteefcei™,

"isgef’. false,
“where”. "cond”,
“varaibletype” "global”,
"covered™: true
N
‘nhDeflises” 4,
“festcases” [
|
[
{
"name”. “fot 817,
"requirements”; [

"name”; "REQ_PTLI 123"

Application Profiling
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Application Profiling is gathering the main features that provide profiling information at the application level: the

Worst Stack Size feature and the Worst performance (coming soon) feature.

Worst Stack Size

HCL DevOps Test Embedded (Test Embedded) introduces the Worst Stack Size feature to compute an estimation of

the maximum stack size of the application under test.

Overview
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To implement this feature, HCL DevOps Test Embedded (Test Embedded) uses two mixed technologies:

- Static analysis that computes the call graph of the application (Example: all the calls between functions are
analyzed and computed as a graph),

« Dynamic analysis that provides the stack size of each functions when executing them.

This information is used to provide an estimation of the worst stack size. This estimation is accurate under the
following conditions:

« All the functions of the application should have been executed at least once in order to have the stack size for
each of them.

« Your application should not have recursive calls, because the number of loops in the recursive calls being
unpredictable, it is impossible to compute the stack size.

« If your application used libraries (Example: call functions for which we have not the source code), you should
provide an additional file that gives an estimation of the stack size for each of them. These estimations do not
need to be precise, but should be an upper bound of the exact stack size.

« If your compiler optimizes the Stack Size, you might have different Stack Sizes for the same function. In this
case, the Worst Stack Size is computed with the maximum value found in the different runs.

- If your application is multi-threaded, you can provide the list of entry points so that Test Embedded can
calculate the worst total stack size and compare it to the maximum memory stack available on your target to
produce a pass/failed verdict.

For the Worst Stack, Test Embedded provides a brand-new interactive HTML-based report. This report identifies if one

or more of these conditions are not met.
How Worst Stack Size Works

When an application node is executed, the source code is instrumented by the Instrumentor (attolcc4
for C language) that produces a static file with the .tsf extension that contains information on the
functions (this file is common with Control Coupling feature). The resulting source code is then
compiled, linked and executed and the Control Coupling feature outputs a dynamic file with the
extension .tzf.

These 2 types of files are used in input of the report generator that produces a report in HTML format
(and optionally the raw data can be generated in a Json file). A template is provided for this generator.
You can provide your own template to modify the report. An addition file could be provided to this report
generator in order to specify the stack size of the external functions.

Note:

To visualize your report in Eclipse, if you are using the default browser option, be sure that JavaScript is enabled.
Otherwise, you can choose another browser that is compatible with your version of JavaScript by changing it in
Window> Preferences> General > Web Browser.
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Enable Worst Stack Size
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« In the Project Explorer, right-click on the project and click Properties. Alternatively, you can

select the project, and then click the settings icon :
« In the Properties window, click C C++ Build > Settings.

" on the toolbar.

« In the Build Settings tab, click Settings > General > Selective instrumentation.

- In the right pane, click the Value field in Build options and click ... to open the Build options

window.

« In the Build options list, click Application Profiling to enable the Worst Stack Size feature.

Multi-thread option

« In the Project Explorer, right-click on the project and click Properties.
« In the Properties window, click C C++ Build > Settings.
« In the Build Settings tab, click Settings > General > Multi-thread options.

« In the right pane, click the ... in the value field of the Entry points option to open the Entry points editor.
« In the Entry points editor, enter the list of entry points for each thread and click OK.

Worst Stack Size options

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build

Settings tab, under the Application Profiling menu, select Stack Size.

In the setting page, you can change the following options:

- Trace file name (.tzf): set the name of the trace file dedicated to worst stack size. By default this name is the

base name of the test with the extension .tzf.

- Report Template: change the template of the report generator. By default this template is wssreport.template.
- Generate raw data in JSON : Select Yes if you want to generate the worst stack size raw data in a JSON file,

Yes, in compressed mode if you want to compress this file, No if you do not need this JSON file. The name of

this file is the same as the name of the HTML report file where . ht m is replaced by . j son

- External functions stack size: This is a file that contains the stack size of the external functions (generally

functions that are in libraries and used by your application). The format of this file should be in Json, with the

extension .tzfe, as follows:

[
{llnameu
{"name"
{Ilnameu
{"name"

]

"printf", "stacksize'":4},

:"sin", "stacksize":4},
:"cos", "stacksize":4},
:"tan", "stacksize":4}

« Maximum Stack Size (byte): Enter the maximum stack size in bytes that the application should not exceed.
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- Percentage of available Stack Size for security: Enter a percentage of available Stack Size for security.

If you provide the maximum Stack Size allowed and a percentage of available Stack Size for security, the

report displays the total Stack Size and verify if this size does not go over the available Stack Size.
Worst stack size report

The default Worst stack size report is in HTML format. The Worst stack size report is generated from a template
named wssreport.template provided as a text file that you can modify to customize the report. Worst stack size
report uses the following online JavaScript libraries:

» Bootstrap,

» JQuery,

» Font Awesome,
* VisJS.

¢ Chart.js

The JavaScript libraries are now provided in the installation folderi nstal | ati on directory>/1ib/web. The
JavaScript libraries are downloaded from the internet as default. However, if you have no access to the internet, the
template uses the JavaScript libraries that are in your installation folder. If you want to share the report with someone
who does not have access to the internet, you might not install Test Embedded, make sure that the disk contains the
same folders and files as yoursin<i nst al | ati on directory>/Iib/web.

Summary

Worst Stack Size per Entry Point table

Summary

Worst Stack Size per Entry Point
# Control Flows

# Control Flows without Stack Size

# Recursive Computed Control Flows 0 0

# Functions 37 3

The Summary section displays a table with the Worst Stack Size calculated by the tools, given the

information you provided in the build settings. This number is provided in bytes.

The Worst Stack Size is given per entry point and per thread if you have entered the list of entry point
threads of your application in the Build Settings. You can set the list of entry point threads of your
application in the Build Settings.

The table displays the following information:
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 The number of control flows found in your application. A control flow is a set of successive calls
starting from an entry point (each function that is never called by another one is considered as
an entry point) to a function with no call or to an external function.

The number of control flows for which we have no estimation of the stack size. This happens
when one of the functions in this control flow has not been executed or if it is an external

function for which no estimation of the stack size is provided.

If this number if greater than 0, it is highlighted in red because there is no way to be sure that the

worst stack size is really the worst regarding the missing information.

The number of recursive control flows found in the application. If this number if greater than 0,
it is highlighted in red because there is no way to be sure that the worst stack size is really the

worst.

The number of functions in your application.

The number of functions without stack size estimation. These are the functions that have not
been executed or the external functions for which we have not provided an estimation of the
stack size. If this number if greater than 0, it is highlighted in red because we can't be sure that
the worst stack size is really the worst.

The information is given for each entry thread.

If you don't provide the list of entry points in the build settings, the information is displayed only

for the control flow and gives the Worst Stack Size.

Total Stack Size vs. Maximum Stack Size graph

Total Stack Size vs. Maximum Stack Size

Total Worst Stack Size 1616 bytes
Maximum Stack Size 3000 bytes
% Stack Size for Security 30 %

Maximum Stack Size Allowed 2100 bytes

If you provide in the Settings the list of entry points, optionally you can provide the maximum Stack Size
allowed and a percentage of available Stack Size for security. In such case, the report displays the total

Stack Size and verifies if this size does not go over the available Stack Size.

The Maximum Stack Size and Percentage of available Stack Size for security options can be set in the
Build Settings.

In the report, you can compare the Stack Size or the sum of Stack Size with the maximum of Stack
Size allowed and the percentage of available Stack Size for security if both options are provided in the

settings.
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In the toolbar that is under the graph, you can select the information to display or hide (all entry points, or for only one

thread) and the number of control flows in the table. You can also show or hide the graph in the report from a button.

Details

The Details table lists by default the 10 first control flows with the biggest Stack Size and displays for each of them
the following information:

« The control flow, for example, the successive functions starting from an entry point (any function that is never
called by another one is considered as an entry point) to a function with no call, or to an external function.
Each function is identified by its name, its module (example: C file) between brackets, and by the line and
column where this call to the next function calls appear in the code in parenthesis.

- The estimation of the Stack Size. The information is blank if the tool has not been able to calculate the Stack
Size for this control flow. In this case, the functions in the control flow that prevent us from computing the

Stack Size are highlighted in red.
A drop down menu at the top of the table allows you to choose 10, 20, 30, 50, 100 or all the control flows to display.

Functions

The Functions table lists all the functions of your application, including external functions. The following information

is provided for each function:

« The module name (i.e. the C file) where the function is saved.,

» The function name. This name is in red if there is no stack information for this function,
« The number of functions called in the current one.

« The Stack Size of the function in bytes.

Call Graph

The Call Graph part displays all the functions as an interactive call graph from left to right or from the top to the
bottom, depending on the selector button position on the top of the call graph.

You can select a control flow in the table to highlight it in the call graph.
Customize the Worst Stack Size Report

The Worst Stack Size report is based on a template called wssreport.template that you can find in the folder

<install>/lib/reports.

This template is made of 2 parts:

« The HTML part that is the common to all reports,
« A JavaScript part that sets the tables and call graph depending on 2 variables dynamically initialized when the

report is created:
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o var data = {{json}}; // the raw data

o var d = new Date({{date}}); // the date of the generation

Raw data

Raw data is made of four sections at the top level:

« A summary of the Worst Stack Size metrics:

- worstStackSize is the worst stack size computed by the tools, depending on the information you
provided. This number is provided in bytes.

> nbFlows is the number of control flows found in your application. A control flow is a set of successive
calls starting from an entry point (each function that is never called by another one is considered as an
entry point) to a function without calls or to an external function.

> nbFlowsWithoutStack is the number of control flows for which there is no estimation of the stack
size. This happens when one of the functions in this control flow has not been executed, or if it is an
external function for which we have not provided an estimation of the stack size.

- nbRecursiveFlows is the number of recursive control flows found in the application.

> nbFunctions is the number of functions in your application.

- nbFunctionsNoValue is the number of functions without stack size estimation. These are the
functions that have not been executed, or the external functions for which there is no estimation of the
stack size provided.

"worstStackSize": 2139,
"nbFlows": 167,
"nbFlowsWithoutStack™ 70,
"nbRecursiveflows"™ 0,
‘nbFunctions™ 40,
“nbFunctionsNoValue": 10

The list of the modules, each of them has the following information:

* name is the short name of the C file,

« fullname is the name and path of the C file,

- uuid is a unique identifier of the module,

« unknown is set to true if the module is not part of the information you provided (there is only one unknown
module that gathers all the function calls that are not in the known modules),

« functions is the list of the unique identifiers of functions of the module.

Modules are listed as Hashmap with the uuid, as following:
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"modules”: {
"f5b5579edeaca82df478a6780c0c4c92": {
"name”: "USAGE.C",

"fullname™ "..."
"uuid": "f5b5579%edeaca82df478a6780c0c4c92",
"unknown": .
“functions™: [
"ba%eb05ad703046fed306b4271b/ead7"
]
e

The list of functions, each of them have the following information:

» name is the name of the C function.
« line is the first line of the function in the module.
« id is the number used in .tsf file to identify this function.
« stacksize is the stack size computed during the execution if this option has been set (otherwise -1).
« uuid is a unique identifier of the function.
» module is a unique identifier of the module in which the function is declared.
« calls is the list of the calls in this function. Each of them have the following information:
- calling_uuid is the unique identifier of the calling function.
- called_uuid is the unique identifier of the called function.
o line is the line number of the call in the module.
o col is the column number of the call in the module.
- same_module is set to true if the called function is in the same module that the calling function.
- level is a number that represents the level of the function in the call graph, starting from 0.
- calledby is the list of unique identifiers of functions that call the function.

Functions are listed as hashmap with the uuid, as following:
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"functions”; {
"ba9eb05ad703046fed306b4271b7ead 7" {
"name": "wrile_usage”,
"line™: 9,
“id™ 1,
“slacksize’ -1,
“yuid™: "ba%eb05ad703046fed306b427 1b7eadi ",
"module™; "fabs57%edeacal2df478a6780c00c4c92”,
“calls™ |
{
“calling_uuid™ "bafeb05ad703046fed306b427 1b7ead7",
“called_uuid”™: “7b6cd643b5b44e1e0510f30f627 29eba”,
“line™; 10,
"col"; 2,
"same..module”
}
1,
“level™ 1,
“calledby” |
"3b6b20659cHbi7fc6d01bar97abae 1

]
he..

The list of the Control Flows, each of them have the following information:

- stacksize is the size of the stack computed for the control flow. This value is -1 if the tool was unable to
compute it.
« calls is the list of successive calls that composed this control flow, each of them is including the following
information:
- calling_uuid is the unique identifier of the calling function.
- called_uuid is the unique identifier of the called function.
o line is the line number of the call in the module.
o col is the column number of the call in the module.
- same_module is set to true id. The called function is in the same module that the calling function.
- alternates is a list of line & column in case of the calling function is called several times in this
function.
- isRecursive is set to true if a recursive call has been found in this control flow.
« missingFunctions is the list of functions (name and unique identifier) in the control flow for which we have not

the stack size.

Control flows are listed as an array, as follows:
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"controlflows™ [
{
"isRecursive”: false,
"slacksize™ 2139,
"calls™ [
{
"calling_uyid" "3fbBb20659cob70fc6d01ba797abaelf”,

"called . uvid": "0dd641fbc509e237cb0600f451d27d59",
"line™; 97,
"col" 19,
"same.module™ false,
altemates” [
{

"line"; 100,
"col™ 19
}
]
b
]

"

h;asnnﬂiungtlaﬂs"' I,

Testing software components

Component testing provides a unique, fully automated, and proven solution for applications written in C/C ++,
dramatically increasing test productivity.

Component testing in HCL DevOps Test Embedded (Test Embedded) supports C ++ ANSI C89 and C99.

A test case contains code blocks which call the methods under test and check blocks for variable checks, which
verify that the values of a variable are within a specified set of requirements during the run. The test harness is the
execution unit producing the executable. It contains the test cases, the source code under test and any files required
to run the application, including libraries, stubs, and the runtime of the Target Deployment Port (TDP), which allows
the test to run on a target platform. When you run the test harness, the code is compiled and tested. If any runtime
analysis tools are engaged on the test harness, then the source code is also instrumented.

During the run, the test cases interact with the source code, producing test results, and if engaged, coverage and

runtime analysis results.

After the run, you can open the test results in the test editor to check which test cases passed or failed, and to view
the actual values obtained for each variable during the run.

A test suite is a list of test harnesses to run automatically. It generates an additional test suite report and a merged
coverage report. The test suite can be executed in batch mode or interactively. Each test suite allows you to select
one or two different configurations. When the two different configurations are selected, the tool generates the result

report in comparison mode so that you can have the obtained values in both configurations.
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Test assets overview

HCL DevOps Test Embedded (Test Embedded) several types of assets, which each describe different levels of the
test environment.

These test assets include the following items:

- Test cases contain the verification actions for source code functions.

« Stubs are dummy components that allow you isolate the components under test or to replace components
that do not exist.

« Test harnesses contain test cases and the associated source files and stubs required to run the test.

- Test suites contain multiple test harnesses that are run sequentially.

Test cases

A test case applies to a function and describes the checks that are performed against the variables contained in the
component under test.

For each variable, array, or struct, you can specify an initialization value and an expected value. These values can be
finite values, sets, or ranges, with multiple comparison types. When the test case is run, each check compares the

expected value to the actual value and generates a Passed or Failed verdict.

The data used to specify initialization and expected values can be provided by native code, function calls, data

pools or linked to a data dictionary. A data pool is a table, typically imported from a spreadsheet, containing multiple
associated data sets. A data dictionary is a list of initialization and expected values for each variable type that can be
reused by multiple test cases in the project.

You create a test case by selecting a function in the project explorer or the call graph. The test case is generated with
the variables that are visible from outside the function. For each variable, a default check is added to the test case.
You can use the test case editor to specify the initialization and expected values of each variable check.

Stubs

A stub is a dummy software component designed to replace a component that the component under test relies

on, but cannot use in the test because it is not practical or available. A stub simulates the response of the stubbed
component. Stubs can also be used to isolate the behavior of the component under test to provide more reliable test
results or to simulate specific input values that cannot be practically simulated with the actual component. Stubs can

be used in the following roles:

- Retrieving and storing input values to stubbed functions from a function under test.
« Assigning output values from the stubbed functions to a function under test.

Stubs generate passed or failed results based on the number of times that they are called.

You create a stub by selecting a function in the project explorer or the call graph. The stub is generated with the same

interface as the stubbed function.
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You can use the stub editor to specify the behavior of the stubbed function. You can also add additional blocks of

code and conditions to structure the behavior of the test case.

Test configurations

The test configuration is an instance of a target deployment port (TDP) and its associated configuration settings.
Configuration settings are the particular properties assigned to each test harness for a given test configuration.

For example, you can create a test configuration for each compiler involved in your project. If you are developing
for an embedded platform, you can have one test configuration for native development on your Unix or Windows™

development platform and another test configuration for running and testing the same code on the target platform.

You can set up several test configurations based on the same TDP, but with different libraries, compilers or settings.
The configuration settings allow you to customize test and runtime analysis options for each test asset in the project.
You can reach the configuration settings for each test asset by right-clicking any node in the project explorer window

and selecting Properties > C/C++ Build > Settings and Build TDP or Build Instru.

Test harnesses

The test harness contains all the test assets that are required to compile and run the test. These test assets include:

» Test cases
* Stubs
 Required source files, including:

> Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

- Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

o Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

The test harness can also contain header code and global declarations that are required to run the test and

instantiates the parameters of the test case.

You can use the test harness editor to add and remove test assets from the test harness and to graphically arrange
the order in which the test cases are run. You can also add additional blocks of code and conditions to structure the

behavior of the test harness.

To run a test harness, it must be associated with a test configuration. You can do this in a run configuration or in a

test suite.

Test suites

A test suite contains multiple test harnesses that are run sequentially to provide global results for a project.
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In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings) and can be run a second time with another test configuration to provide comparison results. For example,

this can be useful for certification purposes.

Creating test projects

In HCL DevOps Test Embedded (Test Embedded), projects are similar to C/C++ projects, but contain extra folders and
a specific toolchain for component testing and runtime analysis.

About this task
Test Embedded can only work with its own managed build toolchain. You can also import and convert existing

Eclipse CDT projects to work with Test Embedded.

To create a new project:

1. In the C/C++ perspective, click File > New > C Project/C ++ Project . Or you can work in Test Embedded
perspective, and click File > New > Project, and in the New project window, click C/C++, then C Project or C ++
Project.

2. In the C Project or C ++ Project wizard, type a Project name.

3. In Project type, select Executable > Empty project and in Toolchains, select . Click Next.

4. On the Select Configurations page, ensure that the correct configuration is selected and click Next.

You can select multiple configurations for the project.

5. On the Target Deployment Port, select a TDP that you want to use as the native target platform for your
project.

6. Click Finish.

What to do next
After creating a project, you can import an existing C/C++ project into the product or use the Eclipse CDT tools to

create a new project.

Related information
Importing C projects on page 183
Creating test harnesses from the call graph on page 380

Creating a test case from the project explorer on page 371

Test cases
The main objective of a test case is to define the variable checks that will compare the values obtained during the run

with the expected values defined in the test case.

During the run, the test case performs a call to the C function using a set of initialization expressions and compares

the return values with expected value expression. Each variable check is defined by:
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- The name of the variable in the function.

« An initial expression: this is the expression of a value, or a set of values, that is submitted to the function
during the test. You can express multiple initialization values, which causes multiple iterations of calls to the
function under test.

- An expected expression: this is the expression of a value, or a set of values, that is compared to the actual
value obtained during the test. Compliance with the expected expression produces either a failed or passed
verdict for the test.

Activity diagram

The Activity diagram displays a flow chart describing the blocks that are required in the test case. If necessary,
you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test case criteria are

contained in one or several Check blocks.

The graphical flow chart allows you to add decision blocks and native C code to the test. For example, you can use
decision blocks to run specific checks when a variable matches a specific value, or you can write a code block to

define a counter and associate it with a decision block to create a loop.

Initialization and stubs
The Init & Stubs block summarizes the initialization values from all the check blocks and stub behaviors in the test

case.

Code
By default, the Code block contains code that performs the call to the function under test.

The code block enables you to add native code to a test. This can be useful to run a specific portion of code in the
middle of a test case. For example, you can change a hardware configuration before running a test or between two
check blocks that verify the same function.

You can also write a code block to define a counter and associate it with a decision block to create a loop.

Variable checks

The main objective of editing a test case is to define the variable and structure checks. This is done in the Checks
block by using the Variable checks table.

Variable initial expressions

The initial expressions are used to assign an initial value to a variable under test. The initial expression for each
variable check is displayed in the test case.

Initial expressions can be among any of the following types:

» Numeric (integer or floating-point), character, or character string literal values, expressed using standard C
syntax.

« Native constants, which can be numeric, characters, or character strings.
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- Series of values, with a From and To value, and a Step.

* Global variables that are declared by the program under test.

« A null pointer.

« Arrays and structures, any of the above-mentioned expressions between braces ({}').

- C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses.

- Multiple arbitrary values, which can be specified in the test case editor, randomly picked between a given
range, or extracted from a datapool (read from a linked CSV file).

- No Change, which indicates that the test case does not set the value for the test.

« No Dump indicates that the variable initial value is not taken into account in the report, it is the same as
‘unchanged’. This option is used so that the variable is not read during the initialization phase of the test case
execution.

The data type of the variable defines what is a valid initial expression.

Initial expressions can be synchronized, which means that a list of multiple values for one variable will be
synchronized with a matching number of values for another variable. See Synchronizing multiple values on
page 374 for more information.

Additional notes
The number of values inside an initialization expression is limited to 100 elements in a single variable.

If variables are used in the initialization expression, the test evaluates the initialization value with variable values from
after the execution.

Related information

Variable expected value expressions on page 369

Editing test cases on page 371

Variable expected value expressions

The expected expressions are used to specify a test criteria by comparison with the value of a variable. The test
receives a passed verdict when the actual obtained value matches the expected value expression.

The expected expressions can be among any of the following values:

» Numeric (integer or floating-point), character, or character string literal values. Strings can be delimited by
single or double quotes.

« Native constants, which can be numeric, characters, or character strings.

» Ranges with lower and upper values and inclusive or exclusive bounds.

« Global variables that are declared by the program under test.

« A null pointer or a non-null pointer.
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« Arrays and structures, any of the above-mentioned expressions between braces ('{}').

- C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses. The + operator allows to concatenate character string
variables.

« No Check, which specifies that no check is performed on that variable.

« Same As Init, which specifies that the expected variable equals the initialization expression.

- Data sets that are synchronized with a multiple initialization expression.

The data type of the variable defines the acceptable values for the expected value.
Numeric values can be associated with a comparison operator in the test case editor.

Expected expressions can be synchronized, which means that a list of multiple values for one variable will be
synchronized with a matching number of values for another variable. See Synchronizing multiple values on

page 374 for more information.

Additional notes

Any integers contained in an expression must be written either in accordance with native lexical rules, or under the

form:

« hex_integerH for hexadecimal values. In this case, the integer must be preceded by 0 if it begins with a letter.

« binary_integerB for hexadecimal values.

Ranges are not allowed for pointers.
The number of values inside an expected expression is limited to 100 elements in a single variable.

If variables are used in the expected expression, the test evaluates the initialization value with variable values from

after the execution.

Euclidean divisions performed by the test case round to the inferior integer. Therefore, writing -a/b returns a different

result than -(a/b), as in the following examples:
* -(9/2) returns -4

* -9/2 returns -5

Related information

Variable initial expressions on page 368

Editing test cases on page 371
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Creating a test case from the project explorer

You can create a test case from the project by simply selecting a source file or a function. Each test case focuses on

a particular function.

To create a test case from the project explorer:

1. In the project explorer, right-click the project, source file, or a function, and click New > Test Case.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. On the Select Test Assets page, select the function or variable that you want to test and click Next.
You can choose to only display Only functions, Only variables, or you can filter the list by typing characters in
Filter. Click Clear to clear the filter list.
3. On the Test Documentation page, you can edit the description of the test, and click Next.
The Published description contains information that you want to display in the test report. Use the Internal
notes to add personal notes and comments that can be viewed and edited in the test editor.
4. On the Test Case Location page, select a folder and a type a file name for the test case and click Finish.
5. Choose whether you want to create a new test harness or use an existing one.
A test harness contains one or several test cases and is necessary to run the test.
Choose from:
o If you want to add the test case to an existing test harness, in the click No. You must edit the test
harness to add the new test case.

o If not, click Yes and create a test harness with the Create Test Harness wizard.

Results
The test case and test harness are generated in the project explorer and the test case editor opens. Editing test cases

on page 371 for information about the test case editor.

Editing test cases

The test case editor enables you to visually design test cases associated with your source code and to create variable

checks.
About this task

The test case editor is made of two panes:

« The Activity diagram displays a flow chart describing the blocks that are required in the test case. If
necessary, you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test
case criteria are contained in one or several Check blocks.

« The Details pane contains information about the selected block. For example, click the Inits & Stubs block to

edit the initialization parameters, headers, and stubs required to run the test case.
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o Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current test case and expands

automatically all parent nodes.

The main objective of editing a test case is to define the variable and structure checks in the Check block.

1. In the project explorer, open a test case.
2. In the Activity diagram, create the necessary blocks for the test case and connect them with connector lines.
The default flow chart contains an Init. & Stubs block, followed by a Code block, followed by a Check block.

a. Click Create Code Block \J or Create Check Block 'J buttons to create new blocks.
Code blocks can be used to run portions of C code inside the test case. Check blocks contain the test
criteria for the variables under test.

b. Click Create Decision Block Q to make the execution of other blocks conditional.

You can combine code blocks and decision blocks to create loops.

c. Click Create Connector “- to connect new blocks in the diagram.

Ensure that all blocks are properly connected.

3. On the Requirements page, document requirements that are specific to your program or quality process. You
can enter the name, a comment, and if a web page exists in your requirement management tools, enter the

link to the web page that displays the requirement. You can also add requirements that come from a .cvs file.

a. To add a requirement, click & and enter a name for the requirement. You can modify the name. The
table is editable, you can modify the name of the requirement, add a comment and add a link to a web
page that is used as requirement in the table.

b. Click "% to duplicate a requirement in the table.
c. Click & to view the requirement in a browser.

d. Click ¥ to add a requirement from a list. This button is available only if you previously set the
preferences to retrieve the requirements from a .cvs, .xml, or .reqif file. For more information, see Link
Tests to Requirements. The requirements are filtered by name and comment. In the test reports, you
can find the list of tests associated with the list of requirements.
4. In the Activity diagram, select a check block.
The Checked Variables table displays the variables and structures contained in the function under test.
5. For each variable or structure, specify an initial value and an expected value.
These values can be simple values, multiple values (ranges, series) or C structures.

a. In the Checked Variables table, select a variable Initial Expression cell that you want to set and click
the menu button (=) to specify a single Value, Multiple values, a Series, whether to Use Structure
Fields, or to apply No Change to the initial value. You can also choose constructor in the list, which

means that you choose a constructor other than the default one. A constructor is a set of methods
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that has the same name as the class it belongs to. It is used to initialize the current instance and it is
available only for a variable which is an instance of C ++ class.

See Variable initial expressions on page 368 for more information.

b. To edit single values, multiple values, or series, type the values in the quick edition area line above
the table. To specify structure values, edit the individual fields of the structure. To select a new
constructor, click the menu button (=) and select a value in the drop-down list.

The quick editor area adapts to the selected data type or entry mode.

c. In the Checked Variables table, select a variable Expected Expression cell that you want to set and
click the menu button = to specify an expected value or range.

See Variable expected value expressions on page 369 for more information.

Note: By default, the Obtained Value column displays the actual value for the variable obtained during
the last run. Use the Available Runs list, located at the top of the test case editor, to display the actual

values obtained during a specific run.

6. When you have finished editing the test case, click Save and close the test case.

Defining series value sets in initialization values

When a series is defined as the initial expression, the variable check generates one call to the function under test (or
iteration) for each step in the series.

To create a series value set.

1. In the test editor, select a Check block to edit the variable checks.
2. In the Initial Expression column of one variable, click the menu button (=) and select Series.

The quick edition area switches to series edition mode.

|i E] From To By Step

3. In the quick edition area, type the starting and end values of the series and the step.

The number of iterations is evaluated and displayed on the Iterations line of the test editor.

4. Press ENTER or click - to apply the changes.

Specifying multiple value sets in initialization values

When a multiple initialization value is defined, the test generates one call to the function under test (or iteration) for
each element in the set.

To create a multiple value set.

1. In the test editor, select a Check block to edit the variable checks.
2. In the Initial Expression column of one variable, click the menu button (=) and select Multiple.

3. In the Multiple Initial Expression window, specify the number of values in the set, and click OK.
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The number of iterations is evaluated and displayed at the top of the test editor and the quick edition area
switches to multiple edition mode.
Enter initial and expected values for checked variables
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4. In the quick edition area, type a value for each element in the set.
> Press TAB to move to the next value in the set.
> Click the Previous % and Next * buttons to scroll through the elements of the set.
> You can increase and decrease the number of elements in the set.

o Click the ... button to open the advanced editor window

5. Press ENTER or click % to apply the changes.

Synchronizing multiple values
In a variable check, when multiple values have been defined for a variable, you can create a synchronized set of
values, with the same number of elements, which can be synchronized.

Before you begin

Synchronizing values requires that at least two sets of values (series, multiple, datapool) have been defined in the test

case. Both value sets must have the same number of elements.
About this task

Without synchronization, each combination of all the values from all sets generates one call to the function under
test, or iteration. The number of iterations is displayed in the test case editor. Using multiple sets can rapidly generate
a large number of iterations, which can cause tests to run for long periods. For example, for the values in the
following table, the test generates 5 x 5 x 2 = 50 iterations.

Vari-

able Initialization value  Number of elements
a [0.0,1.0,2.0,3.0,4.0] 5
b [0.0,0.1,5.0,10.0,10.1] 5
c [0, 1] 2

When two or more sets are synchronized, elements of each set are run together. In the previous example, if the
initialization values for a and b are synchronized, a=0 is called with b=0.0, a=2 is called with 0.1, and so on. The test
generates 5 x 2 = 10 iterations.

Synchronizing variables enables you to run two or more sets of values in parallel, such as linked curves or sets of
coordinates.

To create a synchronized multiple value set.
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1. In the test editor, select a check block to edit the variable checks.

2. In the Initial Expression column of one variable, click the Menu button and select Multiple.

3. In the Multiple Initial Expression window, select Synchronized with and select the variable which is initialized
with another multiple set.
The number of iterations is evaluated and displayed on the Iterations line of the test editor and the quick
edition area switches to multiple edition mode.
Enter initial and expected values for checked variables
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4. In the quick edition area, type a value for each element in the set.
> Press TAB to move to the next element in the set.
o Click the Previous % and Next * buttons to scroll through the elements of the set.
o Click the ... button to open the advanced editor window. The advanced editor provides an expanded

table view of the values.

5. Press ENTER or click % to apply the changes.

Defining ranges in expected values

When a range expected expression is defined, the test checks that the obtained value is within the bounds of the

range.
To create a range expected expression.

1. In the test editor, select a check block to edit the variable checks.

2. In the Expected Expression column of one variable, click the menu button (=) button and select Range >

Native Expression.
The quick edition area switches to range edition mode.

EEIION .. i

3. In the quick edition area, type the lower and upper bound values for the range and click the [ and ] buttons to

set each bound as inclusive or exclusive.

4. Press ENTER or click - to apply the changes.

Defining a synchronized expected value

When a multiple initialization value is defined, you can specify a synchronized set of expected values. The test checks
that for each initialization value element in the multiple set, the obtained result matches the corresponding element in

the synchronized expected value set.

To create a multiple value set.

1. In the test editor, select a Check block to edit the variable checks.

2. In the Expected Value column of one variable, click the menu button (=) and select Synchronized.
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3. In the Multiple Initialization Expression window, specify the number of values in the set, and click OK.
The quick edition area switches to multiple edition mode.
Enter initial and expected values for checked variables
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4. In the quick edition area, type an expected value for each element in the set.
The number of synchronized expected values matches the number of multiple initialization values.
> Press TAB to move to the next value in the set.
> Click the Previous % and Next * buttons to scroll through the elements of the set.
> You can increase and decrease the number of elements in the set.
o Click the ... button to open the advanced editor window

5. Press ENTER or click % to apply the changes.

Using values from a data pool

Data pools contain a series of values, or data patterns, that can be used as initialization or expected values for use in

a test case or the data dictionary.

Before you begin
The values contained in the data pool must match the type of the variable that you want to initialize.

About this task
Data pools do not import the data contained in a CSV file. When a CSV file is updated externally, any tests that refer to
the data pool will use the data contained in the updated CSV file.

To use values from a data pool:

1. In the test editor, select a Check block to edit the variable checks.

2. In the Initial Expression column of one variable, click the menu button (=) and select Data pool.

3. In Data pool, select a data pool that is in the project.
Values number indicates the number of rows contained in the CSV table.

4. In Column, select the column number of the data set that you want to use to initialize the variables and click
OK.

Results
The number of iterations displayed in the test case editor is updated to incorporate the number of values of the data

pool (or rows in the CSV file).
Related information

Creating data pools on page 378

Generating 2D and 3D chart data on page 1176
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Data dictionary overview

The data dictionary contains data sets, which are user-defined sets of values, multiples, ranges, series, or structures

that can be applied to initialization and expected values.

The data dictionary enables you to create, modify and reuse data sets in variable checks of the same type throughout

your project. You can also export data dictionaries, import them into other projects, or share them with a team.

For example, if your application frequently uses values representing the speed of a vehicle, you can predefine a data
set speed in the data dictionary, which will use a range from 0 to 200 kilometers per hour with a step of 20. You can
then apply this data set to any variable check in your project that represents speed.

The data dictionary maintains links between the data set and the variables that are linked to it. Variables that are
linked to a data set in the data dictionary are highlighted in green in the test editor.

When you modify an initial or expected value that is linked to the data dictionary, the changes automatically affect the
data set stored in the data dictionary and any other variables that are also linked to the data set.

The Data Dictionary view

The Data Dictionary view lists the data sets that you have created. Each data set has a name, a type and a set of initial

and expected values.

You can edit data sets in the data dictionary. Any changes to the initial or expected values affect the variable checks

in the same project that are linked to the data set.

If you delete a data set from the data dictionary, all variable checks that are linked to the data set retain the last

known values, but the links are removed.

Adding data sets to the data dictionary

Data sets are user-defined values that can be used as initial values or expected values in variable checks.

About this task
Data sets in the data dictionary can be linked to variables or structures in the test case editor. Once a data set is
created, it can be linked to a variable or structure. When you update the data set of a variable check that is linked to

the data dictionary, all other variable checks linked to the same data set are updated.

To add and edit data sets:

1. In the variable check table of the test case editor, select a variable or a structure and specify its initial value
and expected value.
For a structure, specify the initial values and expected values of its components.

2. Right-click the variable or structure and select Add Initial Expression to Dictionary or Add Expected
Expression to Dictionary.
Alternatively, you can drag and drop the variable or structure into the Data Dictionary view. You can also
choose to only add the initial value or the expected value.
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3. Type a name for the data set and click OK.
By default, the name of the variable or structure is used.
4. The variable or structure is listed in the Data Dictionary view and the value that is linked to a data set is
highlighted in green in the test case editor.
Choose from:
- To dissociate a highlighted value in the test case editor from its data set in the data dictionary, right-
click the value and select Remove Link from Data Dictionary.
> To associate a data set to an existing variable of the corresponding type, drag and drop the data set
from the data dictionary on to the variable check in the test case editor.
- To delete a data set, right-click the data set in the data dictionary and select Delete. All variable checks
that are linked to the data set retain the last values, but the links are removed.

Creating data pools

Data pools are links to a CSV file that is either in the file system or in the workspace.
About this task

The data pool contains series of values, or data patterns, that can be used as initialization or expected values for
use in a test case or the data dictionary. The data pattern can also be used to produce a 2D or 3D chart with the test

results.

Data pools do not import the data contained in a CSV file. When a CSV file is updated externally, any tests that refer to

the data pool will use the data contained in the updated CSV file.

To create a datapool link to a CSV file:

1. Click File > New > Other > > Data Pool.
2. In the Create Data Pool wizard, click Browse to locate the CSV file, click Open, and click Next.
3. Select a folder in the workspace, type a name for the new data pool, and click Finish.
Result
The data pool editor opens.
4. In the data pool editor, select the Import parameters and Separator options.
Ensure that the selected language matches the locale settings used to generate the CSV file.

5. When the Preview area displays the correct data, save the data pool and close the editor.

Related reference
Data pool editor reference on page 1210
Related information

Using values from a data pool on page 376

Generating 2D and 3D chart data on page 1176
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Test harness structure

Test harnesses contains all the information required to compile and run a test. This includes, test cases, source files

under test, stubs, and Target Deployment Port (TDP) configuration settings.

These test assets include:

« Test cases
« Stubs
» Required source files, including:

> Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

o Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

o Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

To run a test harness, you must associate it with a test configuration from a run configuration for a standalone run
or from a test suite if you want to run multiple test harnesses in a step. For more information, see Running a test

harness on page 387 and Running a test suite on page 388.

You can use the test harness editor to add and remove test assets from the test harness and to graphically arrange
the order in which the test cases are run. You can also add additional blocks of code and conditions to structure the

behavior of the test harness.

Activity flow chart

The Activity area is located on the left of the test harness editor and contains a flow chart, which describes the

behavior of the test harness. You can use this flow chart to define the order in which each test case is run.

The Activity flow chart can contain blocks of native code, which can be run before or between test cases. This can be

useful for setting parameters or changing hardware to a specific configuration before running the test case.
You can also add decision blocks, making the execution of paths in the flow chart conditional.

The calls of test cases in a test harness are all taken into account by default when a test harness is run but you can

deactivate a test case from the activity flow chart so that it is not taken into account in the generation.

Test harness details

In addition to the behavior of the test, the test harness includes information that is required to run the test. The
Details section contains the following pages:
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- Context Definitions: This page lists the source code assets that are required to run the test.

- Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

o Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

o Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

- Libraries: These are libraries that are required for the link. For example: math libraries.

- Build Instrumentation: This page contains the configuration settings that are used to build the test. These
settings override the default configuration settings of the project.

« Stubs: This page specifies any stub files that simulate functions that are required by the functions under test.
Stubs can be used to replace functions that are under development or not practical to use for testing. They
can also be used to inject specific values or conditions into the test.

« Requirements: This page allows you document the requirements for the test case.

» Header Code: This page contains code that is run before the test cases are executed.

- Declarations: This page specifies global and local variables that must be declared in the test harness.

Creating test harnesses

Use the New Test Harness wizard to create new test harnesses. A test harness contains one or several test cases
and is required to run the test, it also includes source files under test, stubs, and Target Deployment Port (TDP)

configuration settings.

To create a test harness from the project explorer:

1. In the project explorer, right-click the project and click New > Test Harness.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. In the Create Test Harness wizard, select one or several test cases that you want to run together and click
Next.
If no test cases exist, you can click New Test Case to create a new one.

3. On the Test Harness Location page, select the folder and name for the test harness and click Finish.

Results
The test harness is created in the specified folder and opens in the test harness editor.

Creating test harnesses from the call graph

The call graph provides a visual diagram that helps you select the functions that require testing in your project. You
can use this diagram to create a test harness that contains a test case, stubs, and other test assets required to run
the test.
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1. In the project explorer, right-click the project, source file, or a function, and click Open Call Graph.
Result
The call graph displays a diagram representing the function calls in the selected component.

2. In the call graph toolbar, click Create Test Harness '
Result
This opens the Test Creation Activity view, which details the steps to create the test harness.
3. Under Test Asset Selection, select a function to test and click Next.
You can take advantage of the call graph display to locate the functions that are critical to your application.
4. If some functions require stubbing, under Stub Selection, select a function to simulate, and click Next. If the
test does not require stubs, click Next.
See Stubbing overview on page 398 for more information about stubs.
5. Under Test Case Creation, select a folder or create a new one, type a file name for the test case, and click
Next.
6. Under Test Harness Creation, select a folder or create a new one, type a file name for the test harness, and
click Finish.
The test harness contains one or several test cases and is necessary to run the test.

Results
The test cases, stubs, and test harness are generated in the project explorer and the test harness editor opens.

Editing test harnesses on page 381 for information about the test harness editor.

Editing test harnesses

Use the test harness editor to edit test harnesses.
About this task

The test harness editor is made of two panes:

 The Activity diagram displays a flow chart describing the blocks that are required in the test harness. If
necessary, you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test
case criteria are contained in one or several Check blocks. You can also activate or deactivate a test case call
in a test harness. Click a test case block in the Activity diagram, and click the < icon in the test case block to
deactivate a test case call, or click the Pf icon to activate a test case call.

 The Details pane contains information about the selected block. For example, click a code block to edit the
C/C++ source code that you want to insert into the test harness or click the black initialization circle to define
the properties of the test harness. If you click a test case block in the Activity diagram, the pane displays all

functions/methods and variables used by the test harness.
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o Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current test harness and expands
automatically all parent nodes.

To edit a test harness:

1. In the project explorer, open a test harness.
2. In the Activity diagram, create the necessary blocks for the test harness and connect them with connector
lines.

The default flow chart contains a test case.
a. Click Insert Test Case " to add an existing test case into the test harness.

b. Click the Create Code Block & to add a block containing native C code that can be run between test

cases.

c. Click Create Decision Block g to make the execution of other blocks conditional.
You can combine code blocks and decision blocks to create loops.

d. Click Create Connector “ to connect new blocks in the diagram.

Ensure that all blocks are properly connected.

3. On the Context Definition page, ensure that all the source files and libraries required to compile and run the
test harness are properly defined.

> Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

- Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

o Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

4. On the Build Settings page, you can override the project the build settings.
See Build configuration settings on page 1199 for information about each of these settings.

5. On the Stubs page, specify any stub behaviors that you want to replace a function with.
See Stubbing overview on page 398 for information about stub simulation.

6. On the Requirements page, document requirements that are specific to your program or quality process. You
can enter the name, a comment, and if a web page exists in your requirement management tools, enter the

link to the web page that displays the requirement. You can also add requirements that come from a .cvs file.
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a. To add a requirement, click € and enter a name for the requirement. You can modify the name. Table
is editable, you can modify the name of the requirement, add a comment and add a link to a web page

that is used as requirement directly in the table.
b. Click % to duplicate a requirement in the table.
c. Click & to view the requirement in a browser.

d. Click ¥ to add a requirement from a list. This button is available only if you previously set the
preferences to retrieve the requirements from a .cvs, .xml or .reqif file. For more information, see Link
Tests to Requirements. The requirements are filtered by name and comment. In the test reports, you
can find the list of tests associated with the list of requirements.

7. On the Header Code page, add native C source code that might be required run as a header for the test
harness. For example, you could add code to initialize or set the hardware to a specific state before running
the test cases.

8. On the Declarations page, add any global or local variables that need to be set before running the test

harness.

a. Click Add application variable (&) to initialize a variable in the test harness.

Select one of the variables that are declared in the application.

b. Click Add application variable to simulate (%) to simulate a variable in the test harness.

Select one of the variables that are declared in the application.

c. Click Add local variable (&) to create a local variable for the test harness.

Specify a name and a type for the new variable.

9. In the Details pane, select the icon corresponding to the feature that you want to add to the settings of your
project: Code coverage, Memory profiling, Performance profiling, Application profiling, Control coupling, Data
coupling, Runtime tracing, Static metrics, and Code review.

10. When you have finished editing, save the test harness.

Note: You can run the test harness from the editor. For details, see Running a test harness on

page 387.

Creating test configurations

Test configurations contain the settings required to apply a target deployment port (TDP) to your compiler, linker,

debugger, and target deployment.

About this task
A test configuration can be understood as the base target deployment port settings, augmented with the various build
and settings for the project.

To create a new test configuration:
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1. In the project explorer, right-click the project and click Properties.
Result
The Properties window is displayed.

Alternatively, you can select the project, and then click the settings icon %7 on the toolbar.

2. Expand C/C++ Build, select Settings, and click Manage Configurations.
Result
The Manage Configurations window for the project is displayed.
3. Click New.
4. Type a Name and Description for the new configuration.
Example
For example, use the name of the compiler or target platform.
5. Specify the source settings to use to create the new configuration.
Choose from:
- Select Existing configuration to base this configuration on one of the previously created
configurations for this project.
- Select Default configuration to base the configuration on the default configurations for the project.
- Select Import from projects to copy the configuration from another project in the workspace.
- Select Import predefined to copy the configuration from one of the predefined configurations provided
with the product.
6. Click OK. If you want to use the new configuration, click Set Active.

7. Click OK to close the Manage Configurations window.

What to do next
To make any changes to the test configuration, edit the Build TDP and Build Settings pages of the Properties window.

See the Configuration Settings reference for more information.

Note: It is possible to rename test configurations. However, when the configuration is renamed, the previous

directory of the configuration is not renamed and a new one is created. To build the new makefiles for the
renamed configuration, you must edit the managed build to point to the source files that are in the new

configuration directory.

Related information

Switching test configurations on page 384

Switching test configurations

Although a project can use multiple configurations, as well as multiple TDPs, there must always be at least one active

configuration. You can switch from one configuration to another at any time, except during build activity.

About this task

384



Chapter 6. Test Execution Specialist Guide

The active configuration affects compiler and deployment options for each resource in the project.

Note: You can also run a test harness with two different test configurations by creating a test suite. See

Creating test suites on page 385.

To change the active test configuration:

1. In the project explorer, right-click the project and click Properties.
2. Expand C/C++ Build, select Settings, and click Manage Configurations.
Result
The Manage Configurations window for the project opens.
3. Select the configuration that you want to use to build and run the test and click Set Active.

4. Click OK to close the Manage Configurations window.

Related information

Creating test configurations on page 383

Test suite

A test suite contains multiple test harnesses that are run sequentially to provide global results for a project. When you
create a test suite, you select the test harnesses that will be used in the test suite run. You can also select test scripts

that can be run from a test suite.

Creating test suites

A test suite contains multiple test harnesses that are run sequentially to provide global results for a project. When you
create a test suite, you select the test harnesses that will be used in the test suite run. You can also select test scripts
that can be run from a test suite.

About this task

In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings). In the test suite editor , you select the main test configuration, that is an instance of a target deployment
port (TDP) and its associated configuration settings and usually carries the name of the TDP. A test harness can
optionally be run a second time with another test configuration to provide comparison results. This can be useful for

certification purposes or to compare the results of a test on two different hardware platforms.

The Test Suite Content wizard automatically displays all the files that are available in your project and that can be run
with the selected test harnesses: main test configuration files for test harnesses, .ptu files for PTU test scripts, .otd
files for OTD test scripts, .bat files for Windows scripts, .pl files for Perl scripts, .py files for Python scripts (.py files),

or .shell for Linux scripts.

To create a test suite:
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1. In the project explorer, right-click the project and select New > Test Suite.
2. In the Create Test Suite wizard, select the test harnesses that you want to run together and the test scripts
located in your project. Then, click Next.

B ' New Test Suite O X

Test Suite Content

Select the test harnesses that you want to add to the test suite.

Filter: (enter at least a char to get the list filled in)

Test harnesses:

v E]F| maze New Test Harness
v | | src
E/’.} checkTypes.ptu
p main.bat
[ | mainpl
E Pl main.py
[ ] th_main

@ ; Next > nis! Cancel

3. Select the main test configuration files for the test harnesses that are compatible with your test suite.

4. If you want to compare the test results with another test configuration, select Compare with and choose a
secondary test configuration.
This will run the test suite twice, using both the main configuration and the secondary configuration. You can
use this option to run the same test suite on a native platform and an embedded platform, to ensure that
results are consistent.

5. Click Next.

6. Specify a location and file name for the test suite, and click Finish.

Results

The test suite is created in the selected location in the project, under the test suite folder in the Project Explorer.

Related information

Running a test suite on page 388
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Configuring the Jenkins environment to run test suites

You must configure Jenkins to be able to run test suites created with HCL DevOps Test Embedded for Eclipse IDE
(Test Embedded for Eclipse IDE) in a Jenkins environment.

Before you begin
About this task
Test Embedded for Eclipse IDE command line interface facilitates the integration of Jenkins in Test Embedded.

To configure Jenkins:

1. On the Jenkins dashboard, click Configure.

2. Under Build, click Add build step where you want to insert your test execution.

3. Select Execute Windows batch command for Windows, or Execute shell for UNIX.

4. Setup your command as follows to execute your test suite: rtrteclipse -WORKSPACE= <your workspace> <your
test suite>.

For more details, see Running test suites from the command line on page 389.

Running a test

A test run in HCL DevOps Test Embedded (Test Embedded) involves the execution of predefined test scenarios
designed to validate the functionality, performance, and reliability of real-time and embedded systems. The tool
provides an environment for creating and managing test scripts tailored for real-time applications. During a test run,
these scripts are executed to interact with the target system, simulate real-world conditions, and monitor the system's
response.Test Embedded offers capabilities for detailed logging, result analysis, and debugging to identify potential
issues, such as memory leaks or runtime errors. The test run process is integral to ensuring that the embedded or
real-time software meets the specified requirements and functions correctly within the constraints of its operating

environment.

Running a test harness
The test harness contains everything required to run the test.

About this task

The test harness associates the test cases with the source code and other required components to a test
configuration. The test configuration is an instance of a target deployment port (TDP) with its association

configuration settings.

To run a test harness:

1. In the project explorer, in the Test Harness folder, right-click the test harness and click Run As > Run Test
Harness.
2. Alternatively, you can run a test harness from the test harness editor.
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Note: In some environments, if you have installed the product in an existing Eclipse, the test result
timestamps and verdicts are not properly displayed in the package explorer. To correct this, in the
project explorer, click View Menu > Customize View > Content and ensure that only Working Sets,
Test Embedded Elements, CDT Elements, and Resources are selected.

Note: To run multiple test harnesses in a step, you must create a test suite, select the test harnesses
that will be run from the test suite and then run the test suite. For more information, see Creating test

suites on page 385 and Running a test suite on page 388.

Results
The Test Result folder in the Project Explorer contains the test harness result file. To open the reports, right-click the

Test result, select Open with > HTML reports and select the appropriate report.

Running a test suite

Test suites enable you to run multiple test harnesses or test scripts in a single step. You can update the list of test

harnesses and test scripts to be run, and the build configuration from the Test Editor before running a test suite.
About this task

In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings) and can be run a second time with another test configuration to provide comparison results. This can be

useful for validation purposes.

To run a test suite:

1. In the project explorer, open the Test Suite folder and double-click the test suite to open the Test Suite editor.
2. In the Test harness section of the test editor window, to update the test harness list, you can:

a. Select or deselect test harnesses and test scripts (examples: .ptu, .otd,.py, .pl, .bat) that are available in
your project

b. Add to the test suite other resources that are not displayed in the list by using one of the following
procedures:
= You can drag the test script files from the Project Explorer and drop them in the test harness
list in the Test harness section of the test suite editor.
= Click the Add test harness icon to select resources compatible with your project: supported
scripts and test harnesses.

X+ 4| 2|0
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c. Click the Delete icon to remove a test harness or a test script file from the test suite.

d. Click the 'Up arrow' and 'Down arrow' icons to modify the order of resources in the list. The test

harnesses and test scripts will be run in the order they are listed.

3. Save and click Run.
Result
After running the test suite, you can see the run result details in the Run results for selected test harnesses

with the run status (success, failed, inconclusive) in the test suite editor.

The Test Result folder in the Project Explorer contains the test results for each test harness and the generated
test scripts within the test suite. You can generate a common, merged result file, which includes the results
of all the test harnesses and the runtime analysis results by selecting multiple test suite results in the Project

Explorer, and then right click and select Merge... from the menu.

4. To open reports, right-click a Test result, select Open with > HTML reports and select the appropriate report.
5. To order the test results, select Sort result files by ascending date in Window > Preferences > DevOps Test

Embedded > Navigator

Note: In some environments, if you have installed the product in an existing Eclipse, the test result
timestamps and verdicts are not properly displayed in the package explorer. To fix this issue, in the
project explorer, click View Menu > Customize View > Content and ensure that only Working Sets,

Test Embedded Elements, CDT Elements, and Resources are selected.

Running test suites from the command line

You can integrate test suites created with HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse

IDE) into your command line tool chain.
About this task

To run the test suite in command line mode, a Perl launcher script launches the Eclipse workbench silently. In this

mode, the Eclipse workbench is not started and there is no user interaction. All information is output to the console.

The launcher script is located in the bin folder of the Test Embedded installation directory. This folder directory is

added to the PATH environment variable when the product is installed.

To run a test suite from the command line:

1. Close Test Embedded for Eclipse IDE.
The Eclipse workspace must not be in use when you run the command line.
2. Type the following command line:
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rtrteclipse [-WORKSPACE={wor kspace directory}] [testsuite_pathname [{testsuite_pathnanme}]]
[-BU LD _PROQIECT={project_nanme | all}][-BIND R={directory}][-TDPDl R={directory}]

[ - REPORTDI R={di rectory}]

o <workspace> is the path to the workspace that contains the test suite. For example "C:\ t enp
\ wor kspace" .

o <test suite_pathname> is the path and filename of the test suite in the workspace. You can run multiple
test suites in the same workspace.

o <bin directory> optionally indicates the location of ecl i pse. exe. By default, the product uses the
following path:

"C:\ Program Fi | es\ HCL\ DevQpsTest Enbedded"

o <tdp directory> optionally indicates the location of the target deployment port directory. By default, the
product uses:

"C:\ Program Fi | es\ HCL\ DevOpsTest Enbedded\t ar get s"

o <reportdir directory> indicates the location where all the .xml report files are saved.
Example
For example:
ortrteclipse - WORKSPACE={wor kspace} {testsuitePathFromtrkspace} [{testsuite}] [options]
ortrteclipse {testsuiteWthAbsol utePath} [{testsuite}] [options] #. In this case, the workspace
and the directory where are located the test suites, are deducted from the first test suite path.
3. When the test is complete, start Test Embedded for Eclipse IDE to view the results or open the directory

reports in a web browser.

Starting a test from the command line

You can run tests suites or a test harness by using the command-line interface of eclipse. The command line

supports a set of options. You can enter -help in the command line to view all the supported options.
Before you begin

You must have completed the following tasks:

» Read and been familiar with the command line arguments

» You must have closed Test Embedded

1. Go to the directory that contains the eclipse.exe file.
For example,
C:\ Program Fi | es\ HCL\ DevOpsTest Enbedded.
2. Run the following command to start the tests from the command line:
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eclipse -nosplash -application com.ibm.rational.testrt.test.campaign.launcher.TestLaunchers -data

<workspace> <test_to_launch> [<test_to_launch>] [options]

For example, if you place visual_test_kit/test_elements/harness/harness_simple_call.test_harness for the test

to run, it will run the test harness named "harness_simple_call.test_harness" located in folder "/test_elements/

harness" of project "visual_test_kit"

Note: On windows, run eclipsec instead of eclipse. eclipsec is available in the installation folder.

. Run the following command to list the help options:

eclipse -nosplash -application com.ibm.rational.testrt.test.campaign.launcher.TestLaunchers -data <your

workspace> -help

The following table lists the supported options with description:

Option Description

-help This option displays the help options and then returns you to the command line inter-
face.

-version This option displays the product version and then returns you to the command line in-
terface.

-forcerefresh This option refreshes the eclipse whenever there is an update to the project that con-
tains the test to be run.

-xmlreports This option generates xml reports for the test suites and the test harnesses.

-xmlfile="<file path>

This option is used to set a name of the report. If this option is set, then -xmlreports
option is not needed.

xmlencoding="<en-

coding>"

This option sets the encoding to use for XML generation. The default character encoding
value is UTF-8. If this option is set, the -xmlIreports option is not required.

-bindir="<folder

path>"

This option enables you to specify the folder path that is used when running the tests.

-tdpdir="<folder
path>"

This option indicates the relative path of the target deployment port directory.

outputfolder="<fold-
er path>"

This option indicates the location where the .xml report files are copied.
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Option Description

- This option runs the test harness with the specified configuration. When the configura-
buildconfig="<con- |tion does not exist, the default configuration is used. This option has no effect on the

fig name>" test suite.

- This option builds the project in the workspace. When the project name is defined as
build_- all, all the projects in the workspace gets build.

project="<project>"

-tdp="<tdp to use>" | This option overwrites the tdp from launch configuration.
For example,

tdp=C:\Program Files\HCL\DevOpsTestEmbedded\targets\cvisual2019

Results

You have run the test from the command line and can view the test result.

Testing with PTU test scripts

You can add and configure PTU test scripts and execute them in a standalone mode or from a test suite in HCL
DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE).

About this task

You must import a PTU file in a project to be able to execute the test script.

1. To import a PTU file, select File > Import and choose General > File System to select the file. You can import
the file in any folder at any file structure level.

2. To configure a PTU test script file, see Configuring .ptu or .otd test scripts on page 393.

3. To execute PTU file, use one of the following method:

a. To execute one PTU test script, right-click on a PTU file and choose Run as > Script test file.

b. Alternatively, select Run Configurations and Test Script file in the dialog box that opens. Right-click
and select New to create a new launch configuration. Then proceed as follows:
= Set a name to your launch configuration.
= In the Testing Script tab, select your PTU file in Select Application panel.
= Select your configuration in the Configurations panel and click Run.

c. To execute multiple PTU test scripts, create a test suite and select the PTU test scripts before running
the test suite. For more details, see Creating test suites on page 385 and Running a test suite on

page 388.
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Result
A test report and runtime analysis reports are generated. The test result and the test script results are
displayed in the Test Result folder. From these files, you can open the appropriate HTML reports.

4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Testing with .otd test scripts

You can add, configure and execute .otd test scripts in a standalone mode or from a test suite in HCL DevOps Test
Embedded for Eclipse IDE (Test Embedded for Eclipse IDE).

About this task

You must import the .otd file in a project and configure the test script to be able to execute it and see the results.

1. Select File > Import and choose General > File System and select the files that you want to import.
Note: You can import these files in any folder at any file structure level.

2. Follow the instructions that are described in the Configuring .ptu or .otd test scripts on page 393 page to
configure .otd test scripts.
3. To execute .otd files, use one of the following methods:
o Right-click the .otd file and choose Run as > Test script file.
> Alternatively, proceed as follows:
a. Select Run Configurations.
b. Select the .otd file under Test Script file, in the dialog that opens.
c. Right-click and select New to create a new launch configuration.
d. Set a name to your launch configuration.
e. Select your .otd file in Select Application panel, in the Testing Script tab.
f. Select your configuration in the Configurations panel and click Run. The reports are available
into the Test Result folder.
> To execute multiple .otd test scripts from a Test Suite, see Running a test suite on page 388.
Result
A test report and runtime analysis reports are generated. The reports are available into the Test Result folder.
From these files, you can open the appropriate HTML reports.
4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Configuring .ptu or .otd test scripts

You can add additional options in a .ptu or .otd test script before executing.

About this task
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A .ptu or an .otd file test script might need additional files and additional options before running that must be

specified into the .ptu or the .otd file itself, as follows:

1. Enter instructions with specific lines starting with --%f and --%o located on top of the file, before the HEADER
keyword setting.
2. In the line starting with %0, enter build options. Options format must follow the one used for attolcc.
3. In the line starting with %f, enter the list of additional source files that must be taken into account into the
build.
4. Set relative paths to specify the test scripts location.
5. Set the PATH environment variable as follows to make the test scripts portable:
a. ${workspace_loc:/myproject/src/sub.c}
b. $workspace_loc:/myproject/src/sub.c

c. $(project_loc)/src/sub.c

Note: When the Path environment variable is configured and the test script run, the build automatically
creates the three following environment variables:
o 'workspace_loc' corresponding to the workspace location
o 'project_loc' corresponding to the project location
o 'tstscript_loc' corresponding to the test script location

Testing with Python, Perl, Windows or Linux scripts

In HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE), you can import and execute PTU and
OTD test scripts but also other scripts such as Batch (Windows only), Shell (Linux only), Perl or Python.

Before you begin

To be able to run Python (.py files) scripts, you must install the PyDev plugin in Eclipse and configure Python
Interpreter preferences. You can download the plug-in from this page https://www.python.org/downloads/.

About this task

This task applies to users who want to test with .bat files (Windows only), .pl files (Perl), .py files (Python), and .sh
(Shell for Linux only). You must import the script files in a project to execute them.

1. To import a test script file, proceed as follows: select File > Import and choose General > File System to
select the files. You can import these files in any folder at any file structure level.

2. To configure Python, Perl, Windows or Linux script files, see Configuring Python, Perl, Windows or Linux
scripts on page 395.

3. To execute the test script file, use one of the following methods:
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a. To execute a test in a standalone mode in Test Embedded for Eclipse IDE, right-click the script file and

choose Run as > Script test file.

b. Alternatively, select Run Configurations. In the dialog that opens, under Script test file, select a script
file. Right-click and select New to create a new launch configuration. Then proceed as follows:
= Set a name to your launch configuration.
= In the Testing Script tab, select your test script file in Select Application panel.
= Select your configuration in the Configurations panel and click Run. The reports are available

into the Test Result folder.

c. To execute test scripts from a Test Suite in Test Embedded for Eclipse IDE, see Running a test suite on
page 388.
Result
A test report and runtime analysis reports are generated. The reports are available into the Test Result

folder. From these files, you can open the appropriate HTML reports.

0 Tip: The default execution timeout is set to 20 seconds but some scripts can take more time
to execute. You can modify the script execution timeout from Window > Preferences > Test

Embedded installation settings.

4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Configuring Python, Perl, Windows or Linux scripts

To run Python, Perl, Windows or Linux scripts in a standalone mode, you must configure your scripts by using the java
runtime that is delivered with HCL DevOps Test Embedded (Test Embedded).

Ajava runtime named Scri pt Report . j ar is availableinthel i b/ j ava folder when you install Test Embedded. It is
used by default to ensure that test script results are displayed directly in your test suite, and in your workspace after

a manual refresh when the script is executed in a standalone mode. You must use some of the runtime commands in
your .py, .pl, .sh or .bat files to customize your reports.

Note: Using runtime commands in scripts requires advanced user level.

initreport

initreport <logfile>
This command is used in a script when all result files are created by the script.
It initializes necessary resources needed to create a log file.

This log file will contain the list of all intermediate files that are needed to create a result file.
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<logfile> parameter is the name of this log file.
By convention, the extension is .xtp.
This log file will be generated if this command is used in a script that is executed in a standalone mode.

If this command used in a script that is executed from a test suite, the name of the test suite is taken into account,
and the parameter is ignored.

addreport
addreport <logfile> -path=<ressource path> [-kind=<ressource kind>]

<ressource path> : Resource to be added to the report. The resource path can be a relative path that points to the

script location, or an absolute path.

<ressource kind>: Kind of resource (optional)

This command registers a resource to be added to a logfile.

If you add a folder as a resource, this folder will be the used as relative resource path.

For very advanced users: If you have a resource with an unusual extension, you can enter your own <resource kind>
option.

The following table gives the list of file extensions that are recognized in Test Embedded for Eclipse IDE and the
corresponding <ressource kind> options that must be entered in the script file.

File extension <resource kind> option Resource added to the log file

.ccf CCF ccf file

.crc CRC crc file for MISRA report

.crc.json CRJ crj file

.crx.html CRX MISRA code review report in html for-
mat

.dcp DCP dcp file

DCJ dcj file

.dcp.json

.dex.html DCX dcx file in html format for data cou-
pling report

<executable without any extension> | EXE

.exe EXE exe file

fdc FDC fdc file for coverage report
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File extension

<resource kind> option

Resource added to the log file

<folder> DIR new reference for further relative
path
.html HTM .html user file in html format
log LOG log file
.met MET met file for metrics report
OBJ object file
.0
.obj
.req REQ req file
rio RIO rio file
.tx RTX rtx file for charts report
Adf TDF tdf file for trace report
.tgj.json TGJ tgj file
tgx.html TGX tgx file for control coupling report in
html format
tio TIO tio file
Apf TPF tpf file for memory profiling report
Aqf TQF tqf file
Agf.html TQX tgx file for performance profiling re-
port in html format
.tqf.json TQJ tqj file
sf TSF tsf file for trace
Azf TZF tzf file
TZJ tzj file
tzf.json
TZX tzx file for stack profiling report
tzx.html
.xob X0B xob file
xrd XRD xrd file for test report
Xtp XTP xtp file
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genresult

genresult <logfile> [-path=<path>] [-name=<basename>]
<logfile> : Log file containing reports
<path>: Location where the result is generated (optional, the default value is <logfile folder>).
This command generates a result file from a logfile.
By default, it is the same location as the log file, with the same base name.
You can change this default behavior with optional parameters.

This command is supposed to be the last one, any resource added after this one will be ignored.

getconfig

getconfig <key> [<env key> <default value>]
Note: This command should be used by very advanced users only.

This command returns a key from the config file if it is executed from a test suite.

The command returns "<not found>" if the key is not found or executed in a standalone mode.
If the key is "<not found>", it returns an environment variable <env key>.

If the environment variable <env key> is not found, the command returns the <default value>.

This command is used to retrieve preferences from Test Embedded for Eclipse IDE, when you call your script from a
test suite.

If it is executed in a standalone mode, you can enter an environment variable as optional parameter or a default value

if there is no environment variable.
For example, you can retrieve “ conf r ul e” file when you use Code Rule Checker.

You can retrieve the multiple keys that are existing in a generated file named “ envTest RTcc. pl " that is located in
the %honme%folder.

You can find examples in the Exanpl esEcl i pse folder under the product installation files. The folder contains a
set of sources and three scripts (perl, bat and python). Theses scripts perform Code Rule Checker on sources and
produce reports. They all use relative locations for sources and results so that they can be executed in a standalone

mode or from a test suite, by using a the runtime commands.

Stubbing overview

Stubs are simulations of actual functions, which can be used to isolate the function under test and to check that calls

to the stubbed function are correctly formulated.



Chapter 6. Test Execution Specialist Guide

Stub simulation is based on the idea that certain functions are simulated and are replaced with stubs generated in the
test harness. Stubs provide the same interface as the simulated functions, but the body of the functions is replaced
with a basic behavior. From the point of view of other functions in the test harness, the stub looks identical to the
actual function that it simulates.

Stubs can be used in the following roles:

« Retrieving and storing input values to stubbed functions from a function under test.

- Assigning output values from the stubbed functions to a function under test.
Stubs are described with the following elements:

« A variable array for the input parameters of the stub.
- A variable array for the output parameters of the stub.

« A body declaration for the stub behavior.

To create a stub, the source code of the stubbed function must be included in the project. Test Embedded analysis
the prototype of the stubbed function to generate a stub with the same interfaces. Once the stub is created, you use
the stub editor to define the stub checks, which verify that each parameter in the call to the stubbed function matches
an expected expression.

Stub checks are based on the sequential number of the call, which typically reflects the iteration of the calling
function in the test case. The sequential call number is expressed as a range. For example a stub check for a
parameter a can be set to match an expected expression x for the first 10 calls received by the stub (range 0 to 10),

an expression y for the 11th to 20th calls (range 10 to 20), and an expression z for any following calls (range Others).

Stub expected value expressions

The expected expressions are used to specify a test criteria by comparison with the value of a call parameter received

by a stub. The test receives a passed verdict when the actual obtained value matches the expected value expression.

The expected expressions for a stub can be among any of the following values:

» Numeric (integer or floating-point), character, or character string literal values. Strings can be delimited by
single or double quotes.

« Native constants, which can be numeric, characters, or character strings.

- Ranges with lower and upper values and inclusive or exclusive bounds.

« Global variables that are declared by the program under test.

« A null pointer or a non-null pointer.

« Arrays and structures, any of the above-mentioned expressions between braces ('{}').

- C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses. The + operator allows to concatenate character string
variables.

» No Check, which specifies that no check is performed on that variable.
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- Same As Init, which specifies that the expected variable equals the initialization expression.

« Data sets that are synchronized with a multiple initialization expression.

The data type of the variable defines the acceptable values for the expected value.

Numeric values can be associated with a comparison operator in the stub editor.

Stub return value

Return values are used for parameters and functions if a return value is defined in the signature of stubbed function.
A special line named return in the parameter table is added to define the value for the return value of the function.

A return value can be defined for ouput parameters or input/output parameters. Change this setting in the Mode

column. The return value is a C native expression as numeric, character, or string...

The function's return value can be replaced by a special user source code. In this case, write the appropriate C source
code and add the return statement so that the function returns a value to the calling expression. To activate this
feature, select the return line and click the Use source code rather than return type tool button. The user source code

panel is activated and the C source code can be added.

Stub memory usage

For each STUB, the test harness allocates memory for the following tasks:

« Storing the expected expression of the input parameters during the test.
- Storing the obtained value of the input parameters during the test when an error is detected.

- Storing the values assigned to output parameters before the test.

A stub can be called several times during the execution of a test. The test harness allocates memory for expected

and returned values in accordance to the maximum number of calls to the stub in the test harness.

You can reduce the stub memory allocation value to a lower value in the configuration settings when running tests on

a target platform that is short on memory resources.

Creating stubs from the project explorer

You can create a stub from the project by simply selecting a source file or a function. Each stub simulates and

replaces a particular function.

To create a stub from the project explorer:

1. In the project explorer, right-click the project, source file, or a function, and click New > Stub Behavior.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. On the Stubbed function page, enter the function name that you want to test in the Filter field. You can choose

the functions displayed into the list.
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3. On the Stub Behavior page, type a name for the stub behavior, an optional Description, and click Next.
The description contains information that can be viewed and edited in the test editor.
4. On the Stub Location page, select a folder and a type a file name for the stub and click Finish.

Results
The stub is generated in the project explorer and the stub editor opens. See Editing stubs on page 401 for
information about the stub editor. To use the stub in a test, you must add it to a test case, and add the function in the

stubbed function list of the test harness.

Editing stubs

The stub editor enables you to visually describe the stub behavior and to define input and output parameters for the
stub.

About this task

The test case editor is made of three panes:

« The Stub Behaviors list displays one or several behaviors for the stub function. You can add new behaviors or
duplicate existing behaviors.

- The Calling Function pane displays the names of components that call the stubbed function.

« The Details pane contains the input and output values for the selected behavior.

« The User source code pane contains the user code added to compute a return value for the stub.

0 Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current stub and expands

automatically all parent nodes.

The main objective of editing a test case is to define the checks for each stub's call in the tested code.

1. In the project explorer, open a stub.
2. In the Stub Behaviors list, select the default behavior or create new one.
3. In the Details section, select a check block.
The Checked Variables table displays the variables and structures contained in the function under test.
4. For each variable or structure, specify an expected value and a return code.
These values can be simple values, multiple values (ranges, series) or C structures.

a. In the Stub call definition table, select a variable Expected Value cell that you want to set and click the
menu button = to specify an expected value or range.

See Variable initial expressions on page 368 for more information.

b. To edit single values, multiple values, or series, type the values in the quick edition area line above the
table. To specify structure values, edit the individual fields of the structure.

The quick editor area adapts to the selected data type or entry mode.
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c. In the Stub call definition table, select a variable return cell that you want to set and click the menu

button = to specify a return value. This value can be a C native expression. If you want to replace a

single value by a section of source code, click on the = button. The User source code is activated and
you can enter your special source code for the stub. Don't forget the return statement to return a value
for the calling expression.

5. When you have finished editing the test case, click Save and close the stub editor.

Tests linked to requirements

With HCL DevOps Test Embedded (Test Embedded), you can link a test case and a test harness to one or several

requirements that come from another tool to create a traceability matrix between requirements and test results.

From Test Embedded9.0.0, you can import requirement files in a project (instead of importing requirements in the
window ). Then, the testers can link one or several requirements to the test cases and the test harnesses. When the

test suite run is complete, a requirement traceability matrix is generated.

The task flow for linking a test case or a test harness to one or several requirements in Test Embedded for Eclipse IDE

is as follows:
Tasks Information
Importing requirements into your project. See Importing requirement files on page 402.
Linking a test case or a test harness to requirements. See Linking tests to requirements on page 404.

Opening a requirement traceability matrix report thatis ~ See Opening a requirement traceability matrix report on

generated after a test suite runs. page 405.

Importing requirement files

To link test cases or test harnesses to the requirements in HCL DevOps Test Embedded (Test Embedded), you must

first import requirements that come from other tools to be able to link.
Before you begin

Test Embedded supports the following requirement file formats:

* ReqlF format (see https://en.wikipedia.org/wiki/Requirements_Interchange_Format). The extension is
.reqif.
« ReqlFz format: A zip file is required and it must contain at least one ReqlF file. The extensionis. reqi f z.
« CSV format: In the CSV file, the first row must contain the column names and the next rows must contain the
data. The CVS file must contain the following columns:
- Id: Identifier of the requirements. This column is mandatory.
o Parent: Id of the parent requirement. This column is optional (if this column is not present, all
requirements are set at the top level)

- Name: Name of the requirement. This column is optional.
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- Description: Description of the requirement. This column is optional.

o Other columns can be added.

To import a requirement file, follow these steps:

. Open the project settings.

2. Select Requirements in the left panel.
3. In the right panel, click on the value of the settings Requirement files. The default value is “no file selected”.

Result
The Select Requirement files dialog box opens with the list of requirement files that are already selected.
. Click the appropriate choices to add a requirement file:
o Click Add to add a requirement file from the workspace.
o Click Add (External) to add a requirement file from any location on the disk.
> Click Remove to delete the selected requirement file.

> Click OK to close the dialog box.

When the requirement files are selected, you can still select some attributes of the requirements so that they

are added to the traceability matrix report.

To add, remove or re-organize the list of attributes, proceed as follows:

> In the right panel, click on the value of the settings Attributes.

The Requirement attributes to display dialog box opens with the list of attributes that are already

selected.

o Click the choices as required:
= Click Add to add an attribute.

Then, you can modify the name of the attribute that is displayed in the left panel of the dialog
box by clicking the Name column and in the ReqIF Attribute to select the attribute.

You can also click on the cell Use as ID to specify that the attribute must be used as the ID
instead of the default ID. yes appear in this cell. If another attribute is previously selected as
the default ID, it is deselected. Be sure that every requirement in the requirement file has a non-
empty value for this attribute.

= Click Remove to delete the selected attribute.

= Click Up to move up the selected attribute in the list.

= Click Down to move down the selected attribute in the list.
= Click Save & Close to validate and close the dialog box.

5. Enter the appropriate choices in the following optional settings:
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- Report Template: This setting is used to change the template of the report. By default, the template is
reqreport.tenpl ate anditis savedintheli b/ reports folder.

o All attributes: This setting is used to generate all the attributes in the JSON file.

- Non-terminal requirements covered by children: If you set this setting to Yes', a non-terminal
requirement can be covered if all its children are covered. If you set it set to No, it must be covered at
least by one test case.

What to do next

After you import requirement files into your project, you can link test cases or test harnesses to the requirements in
your project. See Linking tests to requirements on page 404.

Linking tests to requirements

In HCL DevOps Test Embedded (Test Embedded), you can link a test case and a test harness to one or several

requirements to create a traceability matrix between requirements and test results.

About this task

The following procedures describe how to link a test case or a test harness to a requirement:

In a test case

. Open atest case.
. Select the first or the last node in the activity diagram.
. In the right panel, select the Requirements tab.

R

. Click Add requirement from file and select a requirement in the dialog box to add a requirement
to the test case.
5. Optional: You can add a comment in the Comment column to provide additional information

about this test case. This comment is added to the traceability matrix report.
In a test harness

. Open a test harness.
. Select the first or the last node in the activity diagram.

. In the right panel, select the Requirements tab.

A W =

. In this panel, click Add requirement from file and select a requirement in the dialog box to add a
requirement to the test harness.
5. Optional: You can add a comment in the Comment column to provide additional information

about the test case or the test harness. This comment is added to the traceability matrix report.

What to do next

Run the test suite that contains test cases and test harnesses so that a traceability matrix is created between
requirements and test results. You can then open the traceability matrix report that is automatically generated. See
Opening a requirement traceability matrix report on page 405.
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Related information

Editing test harnesses on page 381

Opening a requirement traceability matrix report
When you execute a test suite, a requirement traceability matrix report (HTML format) is automatically generated. You

can open the report from the test suite results in the project explorer.

Before you begin

You must have finished test suite run.

About this task

When you run a test suite, a requirement traceability matrix report (in HTML format) is automatically generated.

To open the requirement traceability matrix report, follow these steps:

1. In the project explorer, click Test > Test Suite Results.
2. Right-click the .HTML results file that was generated and select the Open With > HTML Reports >
Requirement Report menu.

Results

A browser opens with the requirement traceability matrix report.

Related information

Running a test suite on page 388

Application monitoring

With HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE) you can monitor the global
variables of cyclic executive applications and apply user actions.

Monitoring cyclic executive applications:

The monitoring feature applies to cyclic executive applications for software integration testing. A cyclic application is
a long running program. It contains global variables that read input data and set output data.

With the Test Embedded for Eclipse IDE monitoring feature, you can record a monitoring script, modify the script and
run the script to examine the global variables usage while your application is running. These capabilities are available
from Test Embedded for Eclipse IDE 9.0.0.

Monitoring cyclic executive applications is an alternative to unit testing and software integration testing where only
one file of the application is tested (unit testing) or a collection of files is tested (software integration testing), and the

other files are stubbed.
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Monitoring script:

With Test Embedded for Eclipse IDE monitoring feature, you can test all the files of your application. You can manually
modify the input global variables in the Monitoring view and select the output variables that Test Embedded for

Eclipse IDE displays in a graph so that you can observe the behavior of the application when the input values change.

All the user actions and the updated values in the Monitoring view are automatically saved in a monitoring

. test _mt script file. This file opens a graphic that displays the monitoring data and a table that shows the
recorded data of the monitoring script. You can modify the reference data that is recorded in the monitoring script
and re-execute the file. When the . t est _mmt file is run, Test Embedded for Eclipse IDE automatically creates a
repl ay. Dat eNunber . rt x file that you cannot modify but that you can delete.

When a monitoring script run is complete, Test Embedded for Eclipse IDE automatically creates an HTML report.
Monitoring
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You can modify the .test_mnt monitoring script file that contains user actions and recorded

!Bﬁlwhengimﬂmwj-wﬂ.mnlw [ ph enginesi play.1650640277123rtx (% Graph engineSimulator_2 test_mnt
Entry TIME ENGINE.C:internalBitFieldCounter ENGINE.C:gear ENGINE.C:internalState ENGINE.C:rpm
1
-
3
4 Data 5
5 Data 1023
! 6 Data 1229
[ Data 1311
8 Data 1320
9 Data 1413 ['\&
| 10 < - e >
data. Graph Data
Task flow for monitoring an application:
Task Information

See Prerequisites to monitoring applications on

0 monitor your application with Test Embedded for page 407.

Eclipse IDE, you must complete prerequisite tasks.

Recording a monitoring script from the monitoring view  See Recording a monitoring script on page 411 and

in Test Embedded for Eclipse IDE.
Monitoring script files: Edits and updates on page 415.

Modifying and executing the monitoring script file. See Modifying the recorded data in a monitoring script
on page 414.

Executing automated monitoring scripts from command See Test automation commands for running monitoring

lines. scripts and creating reports on page 423.

Analyzing monitoring reports. See HTML monitoring reports on page 425.

Prerequisites to monitoring applications

Before you can monitor a cyclic executive application, you must import your project to HCL DevOps Test Embedded
for Eclipse IDE (Test Embedded for Eclipse IDE), configure Test Embedded for Eclipse IDE and your application, and
build your project.

To monitor an application, you must first complete the following tasks:

- Create or import a project with a source file in C language. A sample monitoring project is delivered with
Test Embedded for Eclipse IDE. You can import it to get started with the monitoring feature. See Importing a

monitoring project example on page 408.

407



408

HCL DevOps Test Embedded

- Enable monitoring in your application. You must enter a dedicated pragma command in the main loop of your
application to enable Test Embedded for Eclipse IDE to access the global variables. See Enabling monitoring
in your application on page 408.

« Configure the build and the monitoring settings in Test Embedded for Eclipse IDE. See Configuring the build
and the monitoring settings on page 409. If you want to use the command line interface to activate the
monitoring feature in Test Embedded for Eclipse IDE, see Test automation commands for running monitoring
scripts and creating reports on page 423.

* Run the application. See the note in Configuring the build and the monitoring settings on page 409.

The monitoring procedure is described in Recording a monitoring script on page 411.

Importing a monitoring project example

A sample project is provided with HCL DevOps Test Embedded (Test Embedded) to help you get started with

monitoring.

1. In the Project Explorer view of the C/C++ perspective, right-click and select Import.

2. In the wizard that opens, select General > Projects from Folder or Archive and click Next.
3. Click Archive, browse to the Test Embedded installation directory.

4. In the Exanpl esEcl i pse folder, select the engi neSi mul at or . zi p file and click Open.
5. Select the engi neSi mul at or. zi p_expanded\ engi neSi nul at or folder.

6. Click Finish.

Enabling monitoring in your application

You must enter a dedicated pragma command in the main loop of your application that is cyclically called to enable
the monitoring requests between HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE) and

the target application.
About this task

In the identified cyclic function of your application, enter the following line at the appropriate location:
#pragma attol mnt_insert mnt_exec_request();

This function can have the following characteristics:

« Called in a timer interrupt
« Located in the main loop of your application
« Any regularly called function in your application

The call frequency of this function becomes the basis frequency used to refresh the cyclic data in the monitor view.
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Configuring the build and the monitoring settings

To monitor your cyclic executive application with HCL DevOps Test Embedded (Test Embedded), you must enable the
compilation and monitoring build settings and configure some parameters related to the communication and libraries

that are used to monitor your application.

About this task

1. Right-click in your project node.
2. Click Properties.
Result

The Properties window is displayed.

Alternatively, you can select the project, and then click the settings icon .7 on the toolbar.

3. Select C/C++ Build > Settings in the Properties window.
4. Click the Build TDP tab, click Target Deployment Port > Linker Options and set the appropriate library in
Libraries to enable compilation with a socket library as follows:
o For Windows, enterws2_32. | i b as the default library operating system.

Note: You must set this option only if you use the default socket communication mode,

otherwise go to step 8 to select another type of communication.

! Attention: If you use Microsoft Visual C++ from version 2015, you must also enter the

following libraries: | egacy_st di o_defi ni ti ons. |i b in Libraries afterws2_32. i b. So,
you must have thews2_32.1i b, | egacy_stdi o_definitions.|ib Libraries.

o For Linux, enter - | wsock32 as the default library operating system.

5. From the Build Settings tab, click Settings > General > Selective instrumentation.

6. In Build options, click Application profiling > ... and select Application profiling in the Build Options dialog
box.

7. From the Build Settings tab, click Settings > Application profiling > Monitoring and set Activate to yes. You
can keep the default settings for the other parameters.

8. Select the Communication type for communication between Test Embedded and the target application.
SOCKET is the default communication mode. To use a customized communication mode, select USER.

9. Select Yes in Cyclic read allowed to allow cyclic reads of the global variables in your application.

Note: You must allocate memory to your application to complete cyclic reads. If you can't allocate

memory to your application, you must select No in the preceding step.
10. Select the default frequency of the streaming process if you enabled a cyclic read. The default scale factor is

set to 10. This value is a multiplying factor that applies to the cyclic read frequency that is set in the function

code with the pragma. This multiplying factor can also be changed in the monitoring view.
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11. Select one of the following modes in Bit Fields support:
> NONE: If your application doesn't use bit fields in order to reduce memory consumption used by the
runtime application, use this option.
> Read only mode: If you want to run the application and read only the values, select this option. You
can't write any values.

- Read and Write mode: If you want to be able to write the variable values, select this option.

12. If you enabled Bit Fields support, select Little endian or Big endian order in Bit Fields Order:
13. Click Apply.

Note: If you change the settings, then you must clean and re-build your project. See Building a project
for monitoring on page 410 for more details.

Result
The monitoring feature is enabled and the settings are configured. You can start building your application.

What to do next

Clean and build your project, and then start your application.

Building a project for monitoring

After you configure HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE) and your
application, you must clean and build your project to instrument the source code of the application with the new

configuration settings.

1. In the Project explorer view, right-click your project folder and select Clean Project.
2. Right-click your project folder and select Build Project after your clean process is complete.

Note: You can alternatively instrument the source code of the application with the attolc4
instrumentor command-line tool. For more details, see Instrumenting and Compiling the Source Code

on page 1225.

Result
When you build your project, two files are created: an executable file (. exefile) with an embedded runtime
script and a. mt file that contains the communication parameters and the description of all the global

variables of your project.

What to do next

Run the application.

Note:
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« If you run your application from the command line, click Properties > Resources to find the location of
the execution file.
« To run your application from the Project Explorer view, right-click the execution file and select Run as

> Instrumented Application.

Recording a monitoring script

With HCL DevOps Test Embedded for Eclipse IDE (Test Embedded for Eclipse IDE), you can monitor a cyclic executive
application that is running on a target computer and connected to Test Embedded for Eclipse IDE. You can apply user

actions while you monitor the application and see the results in a dynamic graph.
Before you begin

Before you can monitor, complete the following tasks:

« Create or import a project that contains the source code file of an application written in the C language. You
can optionally use the sample project that is delivered with Test Embedded for Eclipse IDE to get started
with the monitoring feature. For more information, see Importing DevOps Test Embedded examples on
page 184.

« Enable monitoring in your application. See Enabling monitoring in your application on page 408.

- Enable the monitoring feature and configured the build settings. See Configuring the build and the monitoring
settings on page 409

« Build your project. For more information, see Building a project for monitoring on page 410.

« Start your application.

1. Open the C/C++ perspective.
2. In the Project explorer view, right-click your project file and select Open Monitoring to open the Monitoring

view.

Important: The Open Monitoring menu is available only if you have a. mt file that was created when

you built your project. If you can't see this menu, build your project.

Note: In the Monitoring view, you can view all the global variables of your application that are not
arrays. It is directly connected to the application that is running in background.

3. Right-click your application .exe file in the Project Explorer view and select Run As > Instrumented Application
to start your application.
4. Click Reconnect in the Monitoring view, under Application to connect to your application.
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Note: You can stop the application whenever you want by clicking the Stop button but you must

always restart your application before clicking Reconnect.

5. Select the variable values that must be monitored in your application:

> In the Read value column, select the variables that the application must read and click Read.

By clicking Read, the variable value displays in the Read Value column.

> In Recorded value, select the variables that must be read cyclically in the application and click Record.
You can change the read process frequency in the Record list. The selected value is a multiplier factor
that applies to the cyclic read frequency.

Note: The Recorded value column is displayed only if you set the Cyclic read allowed option
to Yes in the variable monitoring build settings. If the cyclic read is not allowed, the Record
is disabled. For more details, see Configuring the build and the monitoring settings on

page 4009.

o In the Write value column, enter new values and select the variables that the application must read and
click Write.

By clicking Write, the variable value displays in the Read Value column.

Note:

= Some write values can't be modified if you enabled the bit fields. In this case, the
values are presented in gray.

= A control check applies to the write values. The column cell turns red if you enter a
value with an invalid format, it turns yellow if the length of the value exceeds the size
that is defined for the type of value.

Result
A graph view is displayed when you click Record so that you can examine the variable values usage in real-
time in your application while the script is recording. You can work with the different menus that are available
in the toolbar of the Graph view to change the graph format. In the Outline view, you can select the variables
that are displayed in the graph. You can also change the color of the curves in the graph.

6. Click Stop Recording to stop the recording of the monitoring script.
Result
When you stop the monitoring process, the graph is saved in a .test_mnt file in your project.

7. Click Add/Remove and in the Add/Remove dialog box that opens, select the variable values to add or remove

from the monitoring view.
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Note: The default values that are displayed in the Monitoring view are the global variables. You can

remove the values that are not used or add values of an array to monitor, see how to proceed in step 8.

8. In the Add/Remove dialog box, click New Element and enter the element number of the array in the New

Element dialog box. Then click OK to add it to the Monitoring view.

Result

The variable is added to the Variable column of the Monitoring view and is labeled with the following name:

<arrayname>[ <i ndex>] .

9. If your application is rebuilt and the list of global variables changes, the variables in the Monitoring view might

be inaccurate, so click Reload to update the Monitoring view.

All the initial selections are lost, you must select the variables and enter their values again.

10. Double-click the . t est _mmt file in the graph editor or right-click the file and select Open with > Text editor to

see all the variable values that the application read or wrote during the monitoring process.

%] Monitoring

Global Variables from engineSimulator

Edit

“. Add/Remove

Application

@ Disconnected (7778)

# Reload

# Reconnect

Run: engineSimulator_2.test_mnt

& Cj/Usersfjerome.bozier/workspace832_02_05_2022/engineSimulator/engine

| © Run

W ENGIME CiinternalState

B ENGINE.C:speed
[ ENGINE.C:speedAdapter
B ENGIME.C:userAction

Varlable Data Type Recorded Value ~ Write Value
gear int O O
intemalState int (] O
pm float (m] [+7) 0.000000E « 00
speed float O [-#] 0.000000E « 00
speedAdapter int O 0
userAction int (] 0 ] 3
Streaming
1,000
W ENGINE.C:gear
W ENGIME.C:rpm
0 T
10,000 20,000
Time (ms)
Graph Data

Results

Stop @ Settings

OB Er T4
[] TIME [1]
EMGIME.C:gear [
EMGIME.C:internalState
[#] ENGINE.Cxrpm
EMGINE.Cispeed [1
EMGINE.CspeedAdapter
[v] EMGINE.C:userfiction [1]

All the completed actions and the updated values in the Monitoring view are automatically saved in a monitoring

script. t est _mt file that can be modified and replayed.

What to do next

You can modify and run the monitoring script to compare the data received from the application with the reference

data in your script. See Modifying the recorded data in a monitoring script on page 414.

413



HCL DevOps Test Embedded

Modifying the recorded data in a monitoring script

You can modify the user actions and the input values that are recorded in a monitoring script and that persist as the
default values in the script. When you run the updated monitoring script, the new input values and user actions are
used as reference data to monitor the application.

About this task

If you apply user actions and enter values during the recording of a monitoring script while an application is running,
all the completed user actions and the input values that you enter in the Monitoring view are automatically saved in a
.test _mt file. To modify the default data and re-run the monitoring script with the new reference data, follow this

procedure:

1. Apply one of the following procedures to open and modify the recorded script:
> To editthe . t est _mt file in the script editor:
= Double-click the . t est _mmt file in the Project explorer view .
= Click the Data tab in the graph and modify the values directly in the different table cells.

The table displays in green the meta-commands with the user actions (read, write, frequency,
and so on) and the input values. Other values are output values that are sent by the application
when the monitoring script is run. You can modify all the input values and user actions. Then,
when you re-run the updated script, the output data that is received from the application are

compared with the reference data.

= Select the appropriate cells in a row or column and right-click to display the options in the

contextual menu to add, remove, or cut rows or columns in the table.

= Click Save

> To editthe . t est _mmt file a the text editor:

= Right-click the . t est _mmt file @ in the Project explorer view and select Open with > Text
editor.

= Modify the values in the . t est _mmt file and save the updates. See Monitoring script files:
Edits and updates on page 415.

Note:

o The variable values that are not checked are identified by the NaN item (Not a Number) in the
report because they are not requested during the monitoring process. You can monitor the
following data types for the basic data: numeric, integer, or float data. For he collection of data
elements, you can monitor these data types: array, structure, and union. However, the output
format of the data is always numeric.
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> The report gives the time when the variable values were read or written in the application.
> You can extract these values for testing or re-running. To extract these values, remove the lines
that are prefixed with the hash sign (#) and exported a file in the . csv format.

Result
The . t est _mt file is displayed in your project in the Project Explorer and saved in your
workspace. You can create multiple scripts. They are named with the following format:

Proj ect Name_Scri pt Nunber . t est _mmt where the ScriptNumber value is automatically increased.

. Click the updated . t est _mmt file in the Project explorer view to refresh the Monitoring view or click = to
browse to your file and click OK.
The Monitoring and the Project explorer views are refreshed.
. Click Settings in the Monitoring view to set parameters to use while the test script runs:
> Quick start, Start application , and Stop application options are the default selected options in the
settings. When selected, they automatically start and stop the application when you click Run. The
Quick start option is used to start the application from the first write user action in the test. Only write
user actions and new frequencies are played. Other actions are ignored.
> The Start application option is a default selected value. When selected, it automatically runs the
application. You can decide to run a script or re-run a script when it is complete but you don't want to
stop the application? In this case, deselect the Start application option.
> The Disable report generation option is not selected. By default, a report is automatically generated
when the monitoring script run is complete. Click this option, if you want no report when the
monitoring script is played.
. Click Run in the Monitoring view.
Result
The application runs in the background. Each time you run a script file, a Pr oj ect Nane. r epl ay. Dat e. rt x
file is created and displayed. It contains the graph with the updated data and variables. You can delete the
replay.rtx files but you cannot edit them.

What to do next
When the script is complete, an HTML report is created. You can open and examine all the events and information

that the script run generated.

Monitoring script files: Edits and updates

When you monitor an application in HCL DevOps Test Embedded (Test Embedded), multiple files are created. You
can find important information about each file, its use, its format and the parameters that you can use to update the
editable files.

Files description

When you monitor an application in Test Embedded, the following files are created and saved in the

project bui | d folder:
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- <fil enanme>. mt : This file is used to describe all the global variables that can be monitored. It
is automatically generated during the code instrumentation. You must open the file as a text file
to modify.

- envTest RTcc. pl : This file is used to transmit all the Eclipse settings to the compilation tools.
It is automatically generated when the project settings are modified. You must open the file as a
text file to modify.

- <fi | ename>. xt p: This file contains the list of resources that are used when reports are
created. It is automatically generated during the generation of reports. Do not modify this file.

- <fil enane>. t est _mt : This file contains the recording of all events in a script. It can be
displayed as a graph or as a set of data in Test Embedded for Eclipse IDE. You can edit the file in
the Data tab of the .mnt editor or in a text file editor.

- <filename>. replay.[nuneric date].rtx:Thisfile is created when a monitoring script
runs. It contains data from the script that is used as expected values and output data that is
received from application. All variables are duplicated. That is for each script variable, another
“ref” (reference, expected value) is created. It is mainly used for display purposes. Do not modify

this file, it is overwritten when a new monitoring script runs.

- <fil enane>. t est _mt cf g: This file contains the graphical configuration that is used to
display <fi | enane>. t est _mmt as a graph. It is automatically generated during the script
recording process. Do not modify this file. It contains the list of displayed curves.

Note: If you rename this file, do not forget to also rename the t est _mmt cf g file.

Files formats

Rtx file format: The file format is “csv”. Spaces (or tabs) are used as data separator.

The first line of code in the file contains a list of all tested variable names, the first variable is TIME. All

other variables are formatted as <compilation unit name>:<variable name> and they are case sensitive.
! Important: Do not modify this first line.

Example:

TIME ENGINE.C:gear ENGINE.C:1internalState ENGINE.C:rpm
ENGINE.C:speed ENGINE.C:speedAdapter ENGINE.C:userAction

All the other lines in the file have the same format. If a line begins with a hash key “#”, it is a meta
command. Otherwise, the line contains the data.

Data or meta-command parameters are separated by spaces, tabs, or either.
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Data:

Data is just a set of values, one value for each variable. Thus, the first value is always

TIME, and fourth value is the value for fourth variable defined in first script line.

The types of values that the lines of codes can include are as follows:

* Integer value.

Example: 0 1245 -248

« Float value: 0.0 -25.4 0.123456e+07
» No value: NaN

Exanﬁple:42351.0 NaN NaN 1980. 0001 0.0 NaN 3.0

Note: Time is defined in milliseconds, and is initiated when the script run starts.

Metacommand

The metacommand lines begin with a hash key ‘# and are followed by a keyword. If ‘#
is followed by a space or an unknown keyword, it is considered as a being a ‘comment’
and is ignored. Metacommand keywords are case insensitive, they are generated in upper-

cases.

The following table contains the list of available metacommands:

Metacom- L.
Description Example Note
mand name
Comment
It is used to make # hello world It is recommended
. #unknown command
the script easy to to add a space after
read. It is ignored ‘#
during test execu-
tion.
Frequency . H | #FREQUENCY 2.0
requency has only 4 from this
one float parameter. point,
frequency used
The application is 2.0
3.0 NaN NaN 0.0

streams the variable A0 T 0.0

values according to 462.0 NaN NaN
0.0 0.0 NaN 0.0

S 470.0 NaN NaN
cy after this point in 0.0 0.0 NaN 0.0

the defined frequen-

the script. Variables
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418

Metacom-

mand name

Select

Description

can be used several

times in the script.

The number of para-
meters matches the

number of variables.

The Select parame-

teris ‘0’ or ‘1'.

‘0’ means that the

variable is not updat-

ed for each cycle.

‘1’ means that vari-
able is updated for

each cycle.

The ‘TIME’ variable

must be updated, so

the first parameter
must be 1".

Example

479.0 NaN NaN
0.0 0.0 NaN 0.0

493.0 NaN NaN
0.0 0.0 NaN 0.0

#FREQUENCY 10.0

# from this
point,
frequency used
is 10.0

508.0 NaN NaN
0.0 0.0 NaN 0.0

#SELECT 1
0 (0] 1

The preceding row
means that the fol-
lowing values must

be updated:

TIME ENG NE. C: r pm
ENG NE. C: speed EN-

G NE. C: user Action

But the following
ones should not be

updated:

ENG NE. C: gear
ENG NE. C: i n-
ternal State EN

G NE. C: speedAdapt er

You are free to
change your selec-
tion at any time in

your script.

#SELECT 1 0 0 1
101

# from this
point, 'TIME'
'"ENGINE.C:rpm'
'ENGINE.C:spe

ed' and
'ENGINE.C:userA

Note
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Metacom-

mand name

Read

Description

Directs the applica-
tion to read of one or

several values

The first parameter
is always the time
variable, so it must

be set.

The other parame-
ters are related to all

other variables:

* NaN means
that there is
no read re-
quest for this

value.

A float or an
integer val-
ue means
that a read
request is set
for the vari-
able, and the
expected val-
ue is passed
to read meta-

command

Example Note
will be
requested to
application
3.0 NaN NaN 0.0
0.0 NaN 0.0
462.0 NaN NaN
0.0 0.0 NaN 0.0
470.0 NaN NaN
0.0 0.0 NaN 0.0
#SELECT 1 0 1 1
001

ction'

#READ8105 NaN NaN
0 0. 010000E+00 NaN

NaN NaN

The preceding line
means that at time
“8105", the EN-
GINE.C:rpm and
ENGINE.C:speed
must be read at time
“8105", and the ex-
pected value for
ENGINE.C:rpm is

0 and the expect-
ed value for EN-
GINE.C:speed vari-
ables is 0.010000E
+00
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Metacom-

mand name

write

Delta

Description

Arequest is sent to
the application to
write one or several

values.

The first parameter
is always the time
variable and must be

set.

The other parame-
ters are related to all

the other variables.

* NaN means
that there is
no write re-
quest for this

value.

A float or an
integer value
means that a
write request
is set for this
variable val-

ue.

Requests that each
value is compared
with the expected
values and must be
checked.

The check result can
be true or false de-
pending on whether
the testing criteria
are met and the “ex-
pected” values are
not “NaN”.

Example

#WRITE 8105
NaN NaN ©
0.010000E+00
NaN NaN NaN

This example means
that a request to
write '0' in the EN-
GINE.C:rpm variable
at time “8105" write
0.010000E+00 in the
ENGINE.C:speed vari-
able.

An implicit “read” re-
quest is issued im-
mediately after the
“write” request to
verify whether the
write request was

successful.

#DELTA ABSOLUTE
NaN NaN 10.0
5.0 NaN NaN 1.0

This example means
that test fails if the
absolute values that
come out from the
difference between
the expected value
and the obtained val-
ue is lower than the

variable value.

Note
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Metacom-

mand name

Description

The testing crite-
ria can be set with
the delta metacom-

mand.

The first parameter
is either ABSOLUT or
PERCENT.

Other parameters
are float values or
“NaN”, for each vari-
able, except for the

“Time” value.

Example

In the following ex-
ample, all these con-
ditions must be met,
if only one condition
is not met, the test
fails:

|

obtained (ENGINE
.C:rpm) -
expected (ENGINE
.Cirpm) | < 10.0
|

obtained (ENGINE
.C:speed) -
expected (ENGINE
.C:speed) | <
5.0

obtained (ENGINE
.C:

UserAction) -
expected (ENGINE
.C:UserAction) |
< 11.0

#DELTA PERCENT
NaN NaN 10.0
5.0 NaN NaN 1.0

The example means
that the test fails if
value that comes
from the difference
between the expect-
ed and the obtained
value is lower than
the percent value of

the variable.

obtained (ENGINE
.C:rpm) -
expected (ENGINE
.C:rpm) | /

max (|obtained (E
NGINE.C:rpm) |, |
expected (ENGINE
.C:rpm)|) < 10.0

Note
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Metacom-

mand name

Description

Example

|
obtained (ENGINE

.C: speed) -
expected (ENGINE
.C: speed) | /
max ( |obtained (E
NGINE.C:

speed) |, |
expected (ENGINE
.C: speed)|) <
5.0

I
obtained (ENGINE
-C3
UserAction) -
expected (ENGINE
.C: UserAction)

|/

max (|obtained (E
NGINE.C:
UserAction) |, |
expected (ENGINE
oC3
UserAction)|) <
1.0

You can change
delta value at any
time, and mix, both

versions.

The last delta value
that is defined for
a given variable is

used.

See the following ex-
ample where with
the a, b, ¢, dand e
variables, you want
to test a and c vari-
ables with 10" and
'5' as absolute val-
ue, and b and d vari-
ables with '20' and

'30' in percent, and

Note
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Metacom-

Description Example Note
mand name

you don't want to
test the e variable:

# variables a
b c d
e

#DELTA ABSOLUTE

10.0 NaN 5.0

NaN NaN

#DELTA PERCENT

NaN 20.0 NaN

30.0 NaN

Test automation commands for running monitoring scripts and creating reports

You can run automatic monitoring scripts with commands by using a . j ar file that contains libraries. You must set

several parameters to run a monitoring script and generate a report.

To run test scripts and generate result reports from commands, you must use the Moni t ori ngPl ayer . j ar file that
is saved with the installation files in one the following folders:

» Windows: <Test Embedded i nstal | ati on directory>/bin/intel/w n32/
Moni tori ngPl ayer.j ar.

« Linux: <Test Embedded i nstall ati on directory>/bin/intel/linux_64/
Moni t ori ngPl ayer.j ar

In the Windows command line or Linux shell, enter a command to run a script or generate a report.

« Enter the following command to see all the available parameters and options:

java -jar MonitoringPlayer.jar

The command generates a list of files that are used to monitor an application:
> mntfile
> inputfile
> output file
> template file
See Monitoring script files: Edits and updates on page 415 to read the details about each file.
- Enter the following command to run the mnt script. No report is generated. Log traces are displayed when the
connection to the application finishes and when the script run is complete.

java -jar MonitoringPlayer.jar <mnt file> <inputfile>

- Enter the following command to run the mnt script and generate a JSON report. Log traces are displayed to
show when connection to application finishes, and when the test run is complete.

423



424

HCL DevOps Test Embedded

java -jar MonitoringPlayer.jar <mnt file> <inputfile> <outputfile>

See an example of JSON report that can be generated:

« Enter the following command to run the mnt script and generate an HTML report:

java -jar MonitoringPlayer.jar <mnt file> <inputfile> <outputfile> <template file>

! Important: Add quotation marks to the parameter values if they contain spaces.

The default report is saved to <Test Embedded i nstallati on directory>/bin/intel/w n32/
reports/ nmonitoring.tenpl at e or <Test Embedded i nstal |l ati on directory>/bin/intel/

l'i nux_64/reports/nonitoring.tenplate.

See an example of an HTML report:

ENGINE.Crpm Paszed: 1073 Failedt 23 Mb Values: 1054

“
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HTML monitoring reports

When you run a monitoring script while running your application, all events are recorded in an HTML report, which

automatically opens when the script is complete. The . HTM. report file is saved in the Project Explorer view.

The report shows a summary, statistics with details about the global variables, and a chart with the expected values,
returned values and errors. The errors are presented in a table.

DevOps Test Embedded Studio Overview

HCL DevOps Test Embedded Studio (Test Embedded Studio) is the classic user interface that supports C, C++, Ada

test and analysis tools.

The Test Embedded Studio test environment is not compatible with the Test Embedded for Eclipse IDE environment

that was introduced in version 8.0 of the product. The documentation in this section is intended for:

- Users who want to use existing projects with test scripts created in versions 7.5 and earlier of Test Embedded
Studio.
« Users who are testing programs written in Ada.

If you are creating new test projects in C, use Test Embedded for Eclipse IDE. The Eclipse workbench provides many
benefits, including visual test design, a more accessible user interface, and a higher level of compatibility with other

software development environments.

DevOps Test Embedded Studio Overview

HCL DevOps Test Embedded Studio (Test Embedded Studio) is the classic user interface that supports C, C++, Ada
test and analysis tools.

The Test Embedded Studio test environment is not compatible with the Test Embedded for Eclipse IDE environment
that was introduced in version 8.0 of the product. The documentation in this section is intended for:

- Users who want to use existing projects with test scripts created in versions 7.5 and earlier of Test Embedded
Studio.
« Users who are testing programs written in Ada.

If you are creating new test projects in C, use Test Embedded for Eclipse IDE. The Eclipse workbench provides many
benefits, including visual test design, a more accessible user interface, and a higher level of compatibility with other

software development environments.

Analyzing static source code

The static analysis feature set of HCL DevOps Test Embedded (Test Embedded) allows you to analyze your source
code to measure complexity and compliance to standards. Each feature analyzes the source code without compiling

and running it.
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To learn about See

How to perform static analysis on your source code Static analysis overview
on page 426

How to evaluate the complexity of your source code Static metrics overview
on page 427

Verifying compliance with industry-wide coding stan- Code review overview

dards on page 434

Checking with static analysis

The static analysis features of HCL DevOps Test Embedded (Test Embedded) allow you to measure the complexity of

your source code and to check the adherence to coding guidelines.

These tools are able analyze the source code providing without compiling or running the application.

- Static metrics provide statistic indicators of code complexity.

- Code review performs in-depth verification of the source code against a set of rules that implement best

practices, coding guidelines, and standards.

These static analysis features can be used together with any of the automated testing features and runtime analysis

features.
Here is a basic rundown of the main steps to using the runtime analysis feature set.

To use the static analysis features:

1. From the Start page, set up a new project. This can be done automatically with the New Project Wizard.

2. Follow the Activity Wizard to add your application source files to the workspace.

3. Select the source files under analysis in the wizard to create the application node.

4. Select the runtime analysis tools to be applied to the application in the Build options.

5. Use the Project Explorer to set up the test campaign and add any additional runtime analysis or test nodes.
6. Run the application node to build and execute the instrumented application.

7. View and analyze the generated analysis and profiling reports.

The runtime analysis options can be run within a test by simply adding the runtime analysis setting to an existing test

node.

Runtime or static analysis tools do not run on System Testing nodes.
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Related Topics

Static analysis overview on page 426 | Code review overview on page 434

About Static Metrics

Static Metrics for C, C++ and Ada

Statistical measurement of source code properties is an extremely important matter when you are planning multiple
tests or for project management purposes. HCL DevOps Test Embedded (Test Embedded) provides a Metrics Viewer,
which displays detailed source code complexity data and statistics for your C, C++ and Ada source code.

Static Metrics supports the following languages:

» Ada: Ada 83 and Ada 95
« C:C89 and C99

» C++:ISO/IEC 14882:1998

How the static metrics tool works

Metrics are updated each time a file is modified. Static metrics can be computed each time a node is built, but can
also be calculated without executing the application.

The metrics are stored in .met metrics files alongside the actual source files.

To learn about See

Opening a Metrics Report Viewing Static Metrics on
page 427

V(g) or cyclomatic complexity met-  V(g) or Cyclomatic Number

rics on page 434

Halstead metrics Halstead Metrics on
page 433

Customizing metrics reports Metrics Viewer Prefer-

ences on page 1274

Related Topics

Runtime Analysis on page 542 | About Code Coverage on page 192

Viewing static metrics

Static Metrics for C, C++ and Ada

427



HCL DevOps Test Embedded

Use the Metrics Viewer to view static testability measurements of the source files of your project. Source code
metrics are created each time a source file is added to the project.

To compute static metrics without executing the application:

1. In the Project Browser, select a node.

2. From the Build menu, select Options or click the Build Options = button in the toolbar.
3. Clear all build options. Select only Source compilation and Static metrics.

4. Click the Build L= toolbar button.

To open the Metrics Viewer:

1. Right-click a node in the Asset Browser of the Project Explorer.

2. From the pop-up menu, select View Metrics.
To manually open a report file:

1. From the File menu, select Open... or click the Open G2 icon in the main toolbar.
2. In the Type box of the File Selector, select the .met Metrics File file type.

3. Locate and select the metrics files that you want to open.

4. Click OK.

Report Explorer

The Report Explorer displays the scope of the selected nodes, or selected .met metrics files. Select a node to switch
the Metrics Window scope to that of the selected node.

Metrics Window

Depending on the language of the analyzed source code, different pages are available:

- Root Page - File View: contains generic data for the entire scope
- Root Page - Object View: contains object related generic data for C++ only

« Component View: displays detailed component-related metrics for each file, class, method, function, unit,

procedure, etc...

The metrics window offer hyperlinks to the actual source code. Click the name of a source component to open the
Text Editor on page 939 at the corresponding line.

Related Topics

Root Level File View on page 429 | Root Level Object View on page 431 | Static Metrics on page 429 | Exporting
reports on page 951
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Static metrics

Static Metrics for C, C++ and Ada

The Source Code Parsers provide static metrics for the analyzed C and C++ source code.
File Level Metrics

The scope of the metrics report depends on the selection made in the Report Explorer on page 1281 window. This

can be a file, one or several classes or any other set of source code components.

« Comment only lines: the number of comment lines that do not contain any source code

- Comments: the total number of comment lines

« Empty lines: the number of lines with no content

« Source only lines: the number of lines of code that do not contain any comments

- Source and comment lines: the number of lines containing both source code and comments
- Lines: the number of lines in the source file

- Comment rate: percentage of comment lines against the total number of lines

» Source lines: total number of lines of source code

File, Class or Package, and Root Level Metrics

These numbers are the sum of metrics measured for all the components of a given file, class or package.

- Total statements: total number of statement in child nodes

« Maximum statements: the maximum number of statements

» Maximum level: the maximum nesting level

» Maximum V/(g): the highest encountered cyclomatic number

« Mean V(g): the average cyclomatic number

« Standard deviation from V(g): deviation from the average V(g)

 Sum of V(g): total V(g) for the scope.

Root level file view

Static Metrics for C, C++, Ada

At the top of the Root page, the Metrics Viewer displays a graph based on Halstead data.
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On the Root page, the scope of the Metrics Viewer is the entire set of nodes below the Root node.

Halstead Graph

Halstead Metnc - Vocabulary

& VerifyListensr.c

B AssertionFailedEmrore
OCheck ¢
OFrotectable

B Stubinfoc

B Stublistensrc

W StubSequence.c

O Teste

16 17 37 17 62 19 94 19 221 g2 @Testiasec

The following display modes are available for the Halstead graph:

» VocabularySize
* Volume
« Difficulty
« Testing Effort
« Testing Errors
« Testing Time
See the Halstead Metrics on page 433 section for more information.

Metrics Summary

The scope of the metrics report depends on the selection made in the Report Explorer window. This can be a file, one
or several classes or any other set of source code components.

Below the Halstead graph, the Root page displays a metrics summary table, which lists for for the source code
component of the selected scope:

« V(g): provides a complexity estimate of the source code component

« Statements: shows the number of statements within the component

- Nested Levels: shows the highest nesting level reached in the component

« Ext Comp Calls: measures the number of calls to methods defined outside of the component class (C++)

« Ext Var Use: measures the number of uses of attributes defined outside of the component class (C++)
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To select the File View:

1. Select File View in the View box of the Report Explorer.

2. Select the Root node in the Report Explorer to open the Root page.

Note With C and Ada source code, File View is the only available view for the Root page.

To change the Halstead Graph on the Root page:

1. From the Metrics menu, select Halstead Graph for Root Page.

2. Select another metric to display.

Related Topics

Root Level Object View on page 431 | Static Metrics on page 429 | Viewing Static Metrics on page 427

Object view

Static Metrics for C, C++ and Ada

Root Level Summary
At the top of the Root page, the Metrics Viewer displays a graph based on the sum ofdata.

On the Root page, the scope of the Metrics Viewer is the entire set of nodes below the Root node.

Sum of Statements £ Sum of Mested Leve
O AssertionFalledErmor

¥ B Check
E O Stublnfo

O StubSequence

s O TestZaseFnm

o B TestFailure

g o W TestResult

g " O TestShuk

W Testzuite

Sum of Staternents B TestSuitePrim
B TestSvnchroStub

Sum of Mested Leve

File View is the only available view with C or Ada source code. When viewing metrics for C++, an Object View is also

available.

Two modes are available for the data graph:
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» Vocabulary
* Size
* Volume
- Difficulty
- Testing Effort
» Testing Errors
« Testing Time
See the Halstead Metrics on page 433 section for more information.

Metrics Summary

Below the Halstead graph, the Root page displays a metrics summary table, which lists for each source code

component:

« V(g): provides a complexity estimate of the source code component

- Statements: shows the total number of statements within the object

» Nested Levels: shows the highest statement nesting level reached in the object

« Ext Comp Calls: measures the number of calls to components defined outside of the object

 Ext Var Use: measures the number of uses of variables defined outside of the object

Note The result of the metrics for a given object is equal to the sum of the metrics for the methods it contains.

To select the Object View:

1. Select the Root node in the Report Explorer to open the Root page.

2. Select Object View in the View box of the Report Explorer.
To switch the object graph mode:

1. From the Metrics menu, select Object Graph for Root Page.

2. Select ExtVarUse by ExtCompCall or Nested Level by Statement.

Related Topics

Root Level File View on page 429 | Static Metrics on page 429 | Viewing Static Metrics on page 427



Halstead Metrics

Static Metrics for C, C++, Ada

Halstead complexity measurement was developed to measure a program module's complexity directly from source
code, with emphasis on computational complexity. The measures were developed by the late Maurice Halstead as a

means of determining a quantitative measure of complexity directly from the operators and operands in the module.
Halstead provides various indicators of the module's complexity

Halstead metrics allow you to evaluate the testing time of any C/C++ source code. These only make sense at the
source file level and vary with the following parameters:

Parame-

ter

ni

n2

N1

N2

When a source file node is selected in the Metrics Viewer, the following results are displayed in the Metrics report:

Number of distinct operators

Number of distinct operands

Meaning

Number of operator in-

stances

Number of operand instances

Metric Meaning

n

N

In the above formulaeg, k is the stroud number, which has an arbitrary default value of 18. With experience, you can
adjust the stroud number to adapt the calculation of the estimated testing time (T) to your own testing conditions:

team background, criticity level, and so on.

When the Root node is selected, the Metrics Viewer displays the total testing time for all loaded source files.

Vocabulary
Size
Volume
Difficulty
Effort
Errors

Testing

time

Formula
ni+n2
N2+N2
N*log2n
n1/2*N2/n2
V*D

v/ 3000

E/k

Chapter 6. Test Execution Specialist Guide
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Related Topics

Viewing Static Metrics on page 427 | V(g) or Cyclomatic Number on page 434

V(g) or Cyclomatic Number
Static Metrics for C, C++ and Ada

The V(g) or cyclomatic number is a measure of the complexity of a function which is correlated with difficulty in
testing. The standard value is between 1 and 10.

A value of 1 means the code has no branching.
A function's cyclomatic complexity should not exceed 10.
The Metrics Viewer presents V(g) of a function in the Metrics tab when the corresponding tree node is selected.

When the type of the selected node is a source file or a class, the sum of the V(g) of the contained function, the mean,

the maximum and the standard deviation are calculated.
At the Root level, the same statistical treatment is provided for every function in any source file.
Related Topics

Viewing Static Metrics on page 427 | Halstead Metrics on page 433

Code review overview

Code Review for C

Automated source code review is a method of analyzing code against a set of predefined rules to ensure that the
source adheres to guidelines and standards that are part of any efficient quality control strategy. HCL DevOps Test
Embedded (Test Embedded) provides an automated code review tool, which reports on adherence to guidelines for
your C source code.

Among other guidelines, the code review tool implements rules from the MISRA-C:2004 standard, which are
Guidelines for the use of the C language in critical systems.

Code Review supports C89 and C99.

When an application or test node is built, the source code is analyzed by the code review tool. The tool checks the
source file against the predefined rules and produces a .crc report file that can be viewed and controlled from the
Test Embedded graphical user interface (GUI).

Code review can be performed each time a node is built, but can also be calculated without executing the application.
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The default code review report is generated in an HTML format. You can customize the report template that is

available in Test Embedded.

To learn about

The list of rules used by Test Embedded code re-

view

Setting up the rules to used for reviewing code

Performing a code review

Running all of the MISRA rules from an application

node

For advanced users, executing the code review from

the CLI

Viewing and understanding the results of a code re-

view

Customizing the code review report

Customizing the code review report

Interpreting code review reports

Locally disabling a rule

Code review MISRA 2004 rules

See

Code review MISRA 2004 rules on page 238
Code review MISRA 2012 rules on page 271
Configuring code review rules on page 528
Running a code review on page 533

Running complete verification of MISRA rules from an applica-

tion node on page 535

Executing the code review from a script on page 535

Viewing code review results on page 535

Customizing the code review report on page 333
Customizing the code review report on page 333
Understanding code review reports on page 536

Code review deviation on page 237

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be

individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules

also have parameters that can be changed. Among other guidelines, the code review tool implements most rules

from the MISRA-C:2004 standard, "Guidelines for the use of the C language in critical systems". These rules are

referenced with an M prefix. In addition to the industry standard rules, Test Embedded provides some additional

coding guidelines, which are referenced with an E prefix.

Code Review for C - MISRA 2004 rules

Table 13. MISRA 2004 rules

Code re-
view ref-

erence

MISRA-C:
2004 ref-
erence

Description

Message Level
Note

Code compliance
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Table 13. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

M1.1 Rule 1.1 All code shall conform to ISO ANSI C error: <error> Required
9899:1990.

M1.1w ANSI C warning: <warning>
No reliance shall be placed on

M1.2 Rule1.2 Requi -

uie undefined or unspecified behav- equired | Unsup
. ported
iour.
Rule1.3 Multiple compilers and/or lan-

M1.3 Required |U -
guages shall only be used if equire nsup
there is a common defined in- ported
terface standard for object code
to which the languages/compil-
ers/assemblers conform.

M1.4 Rule1.4 The compiler/linker shall be Required | Unsup-
checked to ensure that 31 char- ported
acter significance and case sen-
sitivity are supported for external
identifiers.

M 1.5 Rule1.5 Floating-point implementations Required |Unsup-
should comply with a defined ported
floating-point standard.

Language extensions

M2.1 Rule 2.1 Assembly language shall be en- Required | Unsup-
capsulated and isolated. ported
Source code shall only use /* ...

M2.2 Rule 2.2 Source code shall only use /* ... | Required
*/ style comments.

*/ style comments.
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with the provisions of this docu-

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

M2.3 Rule 2.3 | The character sequence /* shall | The character sequence /* shall | Required
not be used within a comment. | not be used within a comment.

M2.4 Rule 2.4 | Sections of code should not be Advisory | Unsup-
“commented out” ported

Documentation
All usage of implementation-de-

M3.1 Rule 3.1 Required |U -

uie fined behaviour shall be docu- equire nsup
ported
mented.

M3.2 Rule 3.2 | The character set and the corre- Required | Unsup-
sponding encoding shall be doc- ported
umented.

M3.3 Rule 3.3 |The implementation of integer Advisory | Unsup-
division in the chosen compil- ported
er should be determined, docu-
mented and taken into account.

Use of #pragma <name> should
M3.4 Rule 3.4 | All uses of the #pragma direc- Required
always be encapsulated and ex-
tive shall be documented and ex- .
plained.
plained.
Rule 3.5

M3.5 If it is being relied upon, the im- Required | Unsup-
plementation-defined behaviour ported
and packing of bitfields shall be
documented.

Rule 3.6

M3.6 All libraries used in production Required | Unsup-

code shall be written to comply ported
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Table 13. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
ment, and shall have been sub-
ject to appropriate.
Character sets
Only escape sequences that are | Only ISO C escape sequences
M4.1.1 Rule 4.1 Required
uie defined in the ISO C standard are allowed. equire
hall b d.
shalibe use Only ISO C escape sequences
M4.1.2
are allowed(\v).
M4.2 Rule 4.2 | Trigraphs shall not be used. Trigraph <name> should not be | Required
used.
Identifiers
M5.1 Rule 5.1 Identifiers (internal and external) | Identifiers <name> and <name> | Required
shall not rely on the significance | are identical in the first <value>
of more than 31 characters. characters. The number of char-
acters can be specified.
M5.2 Rule 5.2 | Identifiers in an inner scope Identifier <name> in an inner Required
shall not use the same name as | scope hides the same identifier
an identifier in an outer scope, in an outer scope : %location%.
and therefore hide that identifier.
A typedef name shall be a
M5.3.1 Rule 5.3 . . . The typedef name <name> Required
unique identifier.
should not be reused except for
its tag. Name already found in
%location%.
The typedef name '<name>"'
M5.3.2 .
should not be reused even for its
tag. Name already found in %lo-
cation%.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Rule 5.4 A struct and union cannot use
M5.4 A tag name shall be a unique Required
the same tag name.
identifier.
Rule 5.5
M5.5 No object or function identifi- The static object or function Advisory
er with static storage duration <name> should not be reused.
should be reused. Static object or function already
found in %location%.
M5.6 Rule 5.6 No identifier in one name space | Avoid using the same identifier | Advisory
should have the same spelling <name> in two different name
as an identifier in another name | spaces. Identifier already found
space, with the exception of in %location%.
structure and union member
names.
M5.7 Rule 5.7 | No identifier name should be The identifier <name> should Advisory
reused. not be reused. Identifier already
found in %location%.
Types
M6.1.1 Rule 6.1 The C language plain char type | The C language plain char type | Required
should only be used for charac- | should only be used for charac-
ter values. ter values.
M6.1.2 Rule 6.1 Case char value is applicable on- | Required
ly if the switch statement value
is plain character variable.
M6.1.3 Rule 6.1 Avoid using comparison opera- | Required
tors on plain char.
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Table 13. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M6.2 Rule 6.2 | The C language signed char or | The C language signed char or | Required
unsigned char types should only | unsigned char types should only
be used for numeric values. be used for numeric values.
M6.3 Rule 6.3 | typedefs that indicate size and | The C language numeric type Advisory
signedness should be used in <name> should not be used di-
place of the basic types. rectly but instead used to define
typedef.
Bit fields should only be of type
M6.4.1 Rule 6.4 . . . . Bit fields should only be of type | Required
unsigned int or signed int
‘unsigned int' or 'signed int'.
M6.4.2 Bit fields should not be of type
‘enum’.
M6.4.3 Bit fields should only be of ex-
plicitly signed or unsigned type.
M6.4.4 Bit fields should not be of type
'boolean’ outside ¢99.
M6.4.5
M6.5 Rule 6.5 |Bit fields of type signed int must | Bit fields of type 'signed int' must | Required
be at least 2 bits long. be at least 2 bits long.
Constants
Octal constants (other than ze- | Octal constants and escape se-
M7.1 Rule 7.1 Required
ro) and octal escape sequences | quences should not be used.
shall not be used.
Declarations and definitions
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M8.1.1 Rule 8.1 Functions shall have prototype | A prototype for the static func- | Required
declarations and the prototype [tion <name> should be declared
M8.1.2 shall be visible at both the func- | before defining the function.
tion definition and call.
M8.1.3
M8.2.1 Rule 8.2 | Whenever an object or function | The type of <name> should be Required
is declared or defined, its type explicitly stated.
M8.2.2 shall be explicitly stated. Required
Rule 8.3 | For each function parameter the | Parameters and return types
M8.3 . . . Required
type given in the declaration and | should use the same type
definition shall be identical, and | names in the declaration and in
the return types shall also be the definition, even if basic types
identical. are the same.
Rule 8.4 | If objects or functions are de- If objects or functions are de- Required
M8.4
clared multiple times their types | clared multiple times their types
should be compatible. should be compatible.
Rule 8.5 | There shall be no definitions of | The body of function <name>
M8.5.1 . . . . Required
objects or functions in a header | should not be located in a head- equire
file. er file.
The memory storage (definition)
M8.5.2 .
for the variable <name> should
not be in a header file.
Rule 8.6 | Functions should not be de- Functions should not be de-
M8.6 Required
clared at block scope. clared at block scope. equire
Rule 8.7 | Objects shall be defined at block | Global objects should not be de-
M8.7 . . Required
scope if they are only accessed | clared if they are only used from
from within a single function. within a single function.
Static function <name> should
M8.8.2 Rule 8.8 Required
uie only be declared in a single file. equire
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Table 13. MISRA 2004 rules (continued)

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Redundant declaration found at:
M8.8.3 %location%.
Identifiers <name> that declare
M8.8.4 . . .
objects or functions with exter-
nal linkage shall be declared
once in one and only one file.
Identifiers <name> that declare
M8.8.5 , . .
objects or functions with exter-
nal linkage shall be unique.
An identifier with external link- The global object or function
M8.9.1 Rule 8.9 Required
age shall have exactly one exter- | <name> should have exactly one
nal definition. external definition. Redundant
definition found in %location%.
The global object or function
M8.9.2
<name> should have exactly one
external definition. No definition
found.
Rule 8.10 |All declarations and definitions | Global object <name> that are
M8.10.1 . . . Required
of objects or functions at file only used within the same file
scope shall have internal link- should be declared using the
M8.10.2 age unless external linkage is re- | static storage-class specifier.
quired.
M8.11 Rule 8.11 | The static storage class speci- | Global objects or functions that | Required
fier shall be used in definitions | are only used within the same
and declarations of objects and | file should be declared with
functions that have internal link- | using the static storage-class
age. specifier.
M8.12 Rule 8.12 |When an array is declared with | When a global array variable can | Required
external linkage, its size shall be [be used from multiple files, its
stated explicitly or defined im- size should be defined at initial-
plicitly by initialisation. ization time.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Initialisation
Variables with automatic stor- )
M9.1 Rule 9.1 age duration should be initial- Required
ized before being used.
Nested braces should be used to | Required
M9.2 Rule9.2 initialize nested multi-dimension
arrays and nested structures.
M9.3 Rule 9.3 |In an enumerator list, the “=" Either all members or only the Required
construct shall not be used to first member of an enumerator
explicitly initialize members oth- | list should be initialized.
er than the first, unless all items
are explicitly initialized.
Arithmetic type conversions
Implicit conversion of a complex
M10.1.1 |Rule 10.1 | The value of an expression of in- integer expression o a smaller Required
teger type shall not be implicitly sized integer is not allowed.
M10.1.2 |Rule10.1 converted to a different underly-
ing type if:
- a) itis not a conversion
to a wider integer type of
the same signedness, or
* b) the expression is
complex, or
+ c) the expression is not
constant and is a func-
tion argument, or
- d) the expression is not
constant and is a return
expression.

443



444

HCL DevOps Test Embedded

Table 13. MISRA 2004 rules (continued)

are apply to an operand of un-
derlying type unsigned char or
unsigned int, the result shall be
immediately cast to the underly-
ing type of the operand.

on 'unsigned char' or 'unsigned
int', you should always cast re-

turned value.

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M10.2 Rule 10.2 | The value of an expression of Conversion of a complex float- [ Required
floating type shall not be implic- |ing expression is not allowed.
itly converted to a different type | Only constant expressions can
if: be implicitly converted and on-
ly to a wider floating type of the
« a) it is not a conversion same signedness.
to a wider floating type,
or
* b) the expression is com-
plex, or
« c) the expression is a
function argument, or
« d) the expression is a re-
turn expression.
M10.3 Rule 10.3 | The value of a complex expres- | Type cast of complex integer Required
sion of integer type may only expressions is only allowed in-
be cast to a type that is narrow- |[to a narrower type of the same
er and of the same signedness [ signedness. Type cast of com-
as the underlying type of the ex- [ plex floating expressions is only
pression. allowed into a narrower type of
the same signedness.
M10.4 Rule 10.4 | The value of a complex expres- Required
sion of floating type may only be
cast to a narrower floating type.
M10.5 Rule 10.5 |If the bitwise operators ~ and << | When using operator '~' or '<<' Required
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M10.6 Rule 10.6 | A “U" suffix shall be applied to all | Definitions of unsigned type con- | Required
constants of unsigned type. stants should use the 'U' suffix.
Pointer type conversions
M11.1 Rule 11.1 | Conversions shall not be per- A function pointer should not Required
formed between a pointer to a be converted to another type of
function and any type other than | pointer.
an integral type.
M11.2 Rule 11.2 | Conversions shall not be per- An object pointer should not be | Required
formed between a pointer to ob- | converted to another type of
ject and any type other than an | pointer.
integral type, another pointer to
object type or a pointer to void.
M11.3 Rule 11.3 | A cast should not be performed | Casting a pointer type to an inte- | Advisory
between a pointer type and an ger type should not occur.
integral type.
M11.4.1 Rule 11.4 | A cast should not be performed | Casting an object pointer type Advisory
between a pointer to object type |to a different object pointer type
and a different pointer to object [ should not occur.
type.
Casting an object pointer type
M11.4.2 to a different object pointer type
should not occur, especially
when object sizes are not the
same.
M11.5 Rule 11.5 | A cast shall not be performed Casting of pointers to a type that [ Required
that removes any const or removes any const or volatile
volatile qualification from the qualification on the pointed ob-
type addressed by a pointer. ject should not occur.
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Table 13. MISRA 2004 rules (continued)
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence

Expressions

M12.1 Rule 12.1 |Limited dependence should be | Implicit operator precedence Advisory
placed on C's operator prece- may cause ambiguity. Use
dence rules in expressions. parenthesis to clarify this ex-

pression.

M12.2 Rule 12.2 | The value of an expression shall Required | Unsup-
be the same under any order of ported
evaluation that the standard per-
mits.

Required

M12.3 Rule 12.3 | The sizeof operator should not | The size of operator should not
be used on expressions that be used on expressions that
contain side effects. contain side effects.

M12.4.1 Rule 12.4 | The right-hand operand of a log- | An expression that contains a Required
ical && or || operator shall not side effect should not be used in
contain side effects. the right-hand operand of a logi-

cal && or || operator.
M12.4.2 The function in the right-hand
operand of a logical && or || op-
erator might cause side effects.
Required

M12.5 Rule 12.5 | The operands of a logical && or | Parenthesis should be used

|| shall be primary-expressions around expressions that are
operands of a logical && or ||.

M12.6 Rule 12.6 | The operands of logical opera- | Only Boolean operands should | Advisory
tors (&&, || and !) should be ef- be used with logical operators
fectively Boolean. Expressions | ( &&, | and!).
that are effectively Boolean
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
should not be used as operands
to operators other than (&&, ||
and!)

M12.7 Rule 12.7 |Bitwise operators shall not be Bitwise operators should only Required
applied to operands whose un- | use unsigned operands.
derlying type is signed.

M12.8 Rule 12.8 | The right-hand operand of a shift | The right-hand operand of a shift | Required
operator shall lie between zero | operator should not be too big or
and one less than the width in negative.
bits of the underlying type of the
left-hand operand.

M12.9 Rule 12.9 | The unary minus operator shall | Only use unary minus operators | Required
not be applied to an expression | with signed expressions.
whose underlying type is un-
signed.

M12.10 Rule The comma operator shall not Do not use the comma operator. | Required

12.10 be used.
Evaluation of constant expres- | Advisory

M12.11 Rule Evaluation of constant unsigned | .

sions should not lead to un-
12.11 integer expressions should not . .
signed integer wrap around.
lead to wrap around.

M12.12 Rule12.12 | The underlying bit representa- Required | Unsup-
tions of floating-point values ported
shall not be used.

M12.13 Rule The increment (++) and decre- | The increment (++) or the decre- | Advisory

12.13 ment () operators should not ment (--) operators should not
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one loop counter for loop state-

ment.

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
be mixed with other operators in | be used with other operators in
an expression. an expression.
Control statement expressions
M13.1.1 |Rule 13.1 | Assignment operators shall not | Boolean expressions should not | Required
be used in expressions that yield | contain assignment operators.
a Boolean value .
M13.1.2 Boolean expressions should not
contain side effect operators.
M13.2 Rule 13.2 | Tests of a value against zero Non-Boolean values that are Advisory
should be made explicit, un- tested against zero should have
less the operand is effectively an explicit test.
Boolean.
M13.3 Rule 13.3 |Floating-point expressions shall | The equal or not equal opera- Required
not be tested for equality orin- | tor should not be used in float-
equality. ing-point expressions.
Floating-point variables should
M13.4 Rule 13.4 | The controlling expression of a Required
not be used to control a for
for statement shall not contain
statement.
any objects of floating type.
Only loop counter should be ini-
M13.5.1 Rule 13.5 | The three expressions of a for . . e Required
tialized in a loop initialization
statement shall be concerned
part.
with loop control only.
M13.5.2 In the 'update part' of a 'for
statement, only 'loop counter'
should be updated.
There should be one and only
M13.5.3




Table 13. MISRA 2004 rules (continued)

Chapter 6. Test Execution Specialist Guide

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M13.6 Rule 13.6 | Numeric variables being used Loop counter of a 'for statement' | Required
within a for loop for iteration should not be modified within
counting shall not be modified in | the body of the loop.
the body of the loop.
M13.7 Rule 13.7 | Boolean operations whose re- Invariant Boolean expressions Required
sults are invariant shall not be should not be used.
permitted.
Control flow
M14.1 Rule 14.1 | There shall be no unreachable Unreachable code Required
code.
A non-null statement should ei-
M14.2 Rule 14.2 | All non-null statements should . Required
ther have a side effect or change
either: a) have at least one side-
the control flow.
effect however executed, or b)
cause control flow to change.
M14.3 Rule 14.3 | Before preprocessing, a null A null statement in original Required
statement shall only occur ona | source code should be on a sep-
line by itself; it may be followed | arate line and the semicolon
by a comment provided that the |should be followed by at least
first character following the null | one white space and then a
statement is a white-space char- | comment.
acter.
M14.4 Rule 14.4 | The goto statement shall not be | Do not use the goto statement. | Required
used.
M14.5 Rule 14.5 | The continue statement shall not | Do not use the continue state- Required
be used. ment.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M14.6 Rule 14.6 |For any iteration statement there | Only one break statement Required
shall be at most one break state- | should be used within a loop.
ment used for loop termination.
M14.7.1 Rule 14.7 | A function shall have a single Only one exit point should be de- | Required
point of exit at the end of the fined in a function.
function.
M14.7.2 The return keyword should not
be used in a conditional block.
M14.8.1 Rule 14.8 | The statement forming the body | The switch statement should be | Required
of a switch, while, do ... while or [ followed by a compound state-
for statement shall be a com- ment {}.
pound statement.
M14.8.2 The while statement should be
followed by a compound state-
ment {}.
M14.8.3 The do..while statement should
contain a compound statement
{
M14.8.4 The for statement should be fol-
lowed by a compound statement
{.
M14.9.1 |Rule 14.9 |Anif (expression) construct The if (expression) construct Required
shall be followed by a com- should be followed by a com-
pound statement. The else key- [ pound statement {}.
word shall be followed by either
M14.9.2 a compound statement, or an- The else keyword should be fol-
other if statement. lowed by either a compound




Table 13. MISRA 2004 rules (continued)

Chapter 6. Test Execution Specialist Guide

represent a value that is effec-

tively Boolean.

a switch expression.

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
statement or another if state-
ment.
M14.9.3 The else keyword should be fol-
lowed by a compound state-
ment.
M14.10 Rule Allif ... else if constructs shall be | All if ... else if sequences should | Required
14.10 terminated with an else clause. | have an else block.
Switch statements
The MISRA C switch syntax shall | A switch block should start with
M15.0 Rule 15.0 Required
be used. a case.
M15.1 Rule 15.1 | A switch label shall only be used | A case or default statements Required
when the most closely-enclos- | should only be used directly
ing compound statement is the [ within the compound block of a
body of a switch statement. switch statement.
M15.2 Rule 15.2 | An unconditional break state- The break statement should only | Required
ment shall terminate every non- | be used to terminate every non-
empty switch clause. empty switch block.
M15.3.1 Rule 15.3 | The final clause of a switch The switch statement should Required
statement shall be the default have a default clause.
clause.
The default clause should be the
M15.3.2 .
last clause of the switch state-
ment.
M15.4.1 Rule 15.4 | A switch expression shall not A Boolean should not be used as | Required
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
Required
M15.4.2 A constant should not be used
as a switch expression.
M15.5 Rule 15.5 | Every switch statement shall At least one case should be de- | Required
have at least one case clause. fined in the switch.
Functions
M16.1 Rule 16.1 | Functions shall not be defined The function <name> should not | Required
with a variable number of argu- | have a variable number of argu-
ments. ments.
M16.1.2 The library functions 'va_list, va_-
arg, va_start, va_end, va_copy'
should not be used.
M16.2.1 |Rule 16.2
Functions shall not call them- Recursive functions are not al- Required
selves, either directly or indirect- | lowed. The function <name> is
ly Functions shall not call them- | directly recursive.
selves, either directly or indirect-
M16.2.2 ly. Recursive functions are not al-
lowed. The function <name> is
recursive when calling <name>.
M16.3 Rule 16.3 |Identifiers shall be given for all | The function prototype should Required
of the parameters in a function | name all its parameters.
prototype declaration.
M16.4 Rule 16.4 | The identifiers used in the dec- | The identifiers used in the proto- | Required
laration and definition of a func- |type and definition should be the
tion shall be identical. same.
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M16.5 Rule 16.5 |Functions with no parameters Functions with no parameters Required
shall be declared with parameter | should use the void type.
type void.
M16.6 Rule 16.6 | The number of arguments used | The number of arguments Required
in the call does not match the passed to a function shall match
number declared in the proto- the number of parameters.
type.
M16.7 Rule 16.7 | A pointer parameter in a func- Use the const qualification for Required
tion prototype should be de- parameter <name> which is
clared as pointer to const if the | pointer and which is not used to
pointer is not used to modify the | change the pointed object.
addressed object.
M16.8 Rule 16.8 | All exit paths from a function The return should always be de- | Required
with non-void return type shall fined with an expression for non-
have an explicit return statement | void functions.
with an expression.
M16.9 Rule 16.9 | A function identifier shall only be | Function identifiers should al- Required
used with either a preceding & | ways use a parenthesis or a pre-
or with a parenthesized parame- | ceding &.
ter list, which may be empty.
M16.10 Rule If a function returns error infor- | When a function returns a value, | Required
16.10 mation, then that error informa- | this value should be used.
tion shall be tested.
Pointers and arrays
Pointer arithmetic shall only be
M17.1 Rule17.1 . . Required | Unsup-
applied to pointers that address
ported
an array or array element.
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence

M17.2 Rule17.2 | Pointer subtraction shall only be Required | Unsup-
applied to pointers that address ported
elements of the same array.

M17.3 Rule17.3 | >, >=, <, <= shall not be applied to Required | Unsup-
pointer types except where they ported
point to the same array.

Pointer arithmetic except array

M17.4 Rule 17.4 | Al indexi hall be the on- . . Required

uie ray indexing shafi be the on indexing should not be used. equire
ly allowed form of pointer arith-
metic.

M17.5 Rule 17.5 | A declaration should not use The declaration of objects Advisory
more than two levels of pointer | should contain no more than 2
indirection. levels of pointer indirection.

M17.6 Rule 17.6 | The address of an object with Required | Unsup-
automatic storage shall not be ported
assigned to another object that
may persist after the first object
has ceased to exist.

Structures and unions

M18.1 Rule 18.1 | Structure or union types %name | Structure or union types should | Required
% should be finalized before the | be finalized before the end of
end of the compilation units. the compilation units.

M18.2 Rule 18.2 | An object shall not be assigned Required | Unsup-
to an overlapping object. ported
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M18.3 Rule 18.3 | An area of memory shall not be
reused for unrelated purposes.
M18.4 Rule 18.4 | Unions shall not be used Do not use unions. Required
Preprocessing directives
M19.1 Rule 19.1 | #include statements in a file Only preprocessor directives or | Advisory
should only be preceded by oth- | comments may occur before the
er preprocessor directives or #include statements.
comments.
M19.2 Rule 19.2 | Do not use non-standard charac- | Non-standard characters should | Advisory
ters in included file names. not occur in header file names in
#include directives.
M19.3 Rule 19.3 |Filenames with the #include di- | The #include directive shall be Required
rective should always use the followed by either a <filename>
<filename> or "filename" syntax. | or'filename" sequence.
Required
M19.4 Rule 19.4 | A C macro should only be ex- C macros shall only expand to a
panded to a constant, a braced | braced initialiser, a constant, a
initializer, a parenthesised ex- parenthesised expression, a type
pression, a storage class key- qualifier, a storage class specifi-
word, a type qualifier, or a do- er, or a do-while-zero construct.
while-zero block.
M19.5 Macro definitions or #undef
Rule 19.5 I Macros shall not be #define'd Required
should not be located within a
or#undef’d within a block.
block.
M19.6 Rule 19.6 | Do not use the #undef directive. | #undefshall not be used. Required
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Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M19.7 Rule 19.7 | Function should be used instead | A function should be used in Advisory
of macros when possible. preference to a function-like
macro.
M19.8 Rule 19.8 | A function-like macro shall not | Missing argument when calling | Required
be invoked without all of its ar- | the macro.
guments.
M19.9 Rule 19.9 | The preprocessing directive Arguments to a function-like Required
%name% should not be used as [ macro shall not contain tokens
argument to the macro. that look like preprocessing di-
rectives.
M19.10 Rule The parameter %name% in the | In the definition of a function-like | Required
19.10 macro should be enclosed in macro each instance of a pa-
parentheses except when it is rameter shall be enclosed in
used as the operand of # or ##. | parentheses unless it is used as
the operand of # or ##.
M19.11 Rule Undefined macro identifier in the | All macro identifiers in pre- Required
19.11 preprocessor directive. processor directives shall be de-
fined before use, except in #ifdef
and #ifndef preprocessor direc-
tives and the defined() operator.
M19.12 Rule The # or ## preprocessor oper- | There shall be at most one oc- Required
19.12 ator should not be used more currence of the # or # preproces-
than once. sor operators in a single macro
definition.
The # and ## preprocessor op-
M19.13 Rule erator should be avoided. The #and #preprocessor opera- | Advisory
19.13 tors should not be used.
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used on identifier beginning with

Codere- |MISRA-C: |Description Message Level
view ref- | 2004 ref- Note
erence erence
M19.14 Rule Only use the 'defined' preproces- | The defined preprocessor oper- | Required
19.14 sor operator with a single identi- | ator shall only be used in one of
fier. the two standard forms.
M19.15 Rule Header file contents should be | Precautions shall be taken in or- | Required
19.15 protected against multiple inclu- | der to prevent the contents of a
sions. header file being included twice.
Preprocessing directives shall
M19.16 Rule Possible bad syntax in prepro- . ) Required
be syntactically meaningful even
19.16 ing directive.
cessing clrective when excluded by the preproces-
sor.
M19.17 Rule A #if, #ifdef, #else, #elif or #en- | All #else, #elif and #endif pre- Required
19.17 dif preprocessor directive has processor directives shall re-
been found without its matching | side in the same file as the #if or
directive in the same file. #ifdef directive to which they are
related.
Standard libraries
M20.1 Rule 20.1 | %name% should not be defined, |Reserved identifiers, macros and | Required
redefined or undefined. functions in the standard library,
shall not be defined, redefined or
undefined.
M20.2.1 |Rule 20.2 | #define and #undef shall not be Required
used on a reserved identifier or
reserved macro name: Identi-
fier %name% already found in
%name%
M20.2.2 #define and #undef shall not be

457



458

HCL DevOps Test Embedded

Table 13. MISRA 2004 rules (continued)

tion shall not be used.

functions calloc, malloc, realloc

free and strdup. There is a whole

range of unspecified, undefined
and implementation-defined be-
haviour associated with dynam-
ic memory allocation, as well as
a number of other potential pit-
falls. Dynamic heap memory al-
location may lead to memory
leaks, data inconsistency, mem-
ory exhaustion, non-determinis-
tic.

Note that some implementa-

tions may use dynamic heap

Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
an underscore or on 'defined’
keyword: %name%

M20.2.3 Declared identifier should not be
a reserved identifier or reserved
macro name: Identifier %name%
already found in %name%

M20.2.4 Declared identifier should not
begin with an underscore or be
'defined’ keyword: %name%

M20.2 The names of standard library Unsup-
macros, objects and functions ported
shall not be reused.

| The validity of values passed

M20.3 Rule20.3 to library functions shall be Unsup-
checked. ported

M20.4 Rule 20.4 | Dynamic heap memory alloca- | This precludes the use of the Required
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Code re-
view ref-

erence

MISRA-C:
2004 ref-

erence

Description

Message

Level

Note

memory allocation to implement
other functions (for example
functions in the library string.h).
If this is the case then these
functions shall also be avoided.

M20.5

Rule 20.5

The variable %name% shoud not

be used

errno is a facility of C, which

in theory should be useful, but
which in practice is poorly de-
fined by the standard. A non ze-
ro value may or may not indicate
that a problem has occurred; as
aresult it shall not be used. Even
for those functions for which
the behaviour of errno is well de-
fined, it is preferable to check
the values of inputs before call-
ing the function rather than re-

ly on using errno to trap errors
(seeRule 16.10).

Required

M20.6

Rule 20.6

The macro '‘%»name%' should not

be used.

Use of this macro can lead to
undefined behaviour when the
types of the operands are in-
compatible or when bit fields are
used.

Required

M20.7

Rule 20.7

The library macro or function

‘%name%' should not be used.

The setjmp macro and the
longjmp function shall not be
used.

Required

M20.8

Rule 20.8

Signal handling contains imple-
mentation-defined and unde-
fined behavior.

Required
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Codere- |MISRA-C: |Description Message Level

view ref- | 2004 ref- Note

erence erence
The signal handling facilities of <
%name%> shall not be used.

M20.9 Rule 20.9 | The input/output library <%name | The input/output library Required
%> shall not be used in produc- | <stdio.h>shall not be used in
tion code. production code.

M20.10 Rule The library macro or function The library functions atof, atoi Required

20.10 '‘%»name%' should not be used. and atol from library <stdlib.h>
shall not be used.
M20.11 Rule The library macro or function The library functions abort, exit, | Required
20.11 ‘%»name%' should not be used. getenv and system from library
<stdlib.h> shall not be used.
M20.12 Rule The time handling functions of | The time handling functions of li- | Required
20.12 library <%name%> shall not be brary <time.h> shall not be used.
used.

M21.1 Rule 21.1 | Minimisation of run-time failures Required | Unsup-
shall be ensured by the use of at ported
least one of:

(a) static analysis tools/tech-
niques;

(b) dynamic analysis tools/tech-
niques;

(c) explicit coding of checks to
handle run-time faults.

In addition to the MISRA rules, Test Embedded includes extended rules that you can select or not select to complete

your static analysis.
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Table 14. Extended rules

Code re-
view ref- | Code review message Level
erence
Language extensionsRequired
E2.3.1 The character sequence // should not be used within a 'C-style' comment except for URL. Advi-
sory
E2.3.2 Line-splicing shall not be used in // comments. Advi-
sory
E2.3.3 The character sequence // should not be used within a 'C-style' comment even for URL. Advi-
sory
E2.6 A function should not contain unused label declarations. Advi-
sory
Advi-
E2.7 There should be no unused parameters in functions. sory
E2.8 Macro <name> is never used Advi-
sory
E2.9 Type <name> is never used Advi-
sory
E2.10 Tag <name> is never used. Advi-
sory
E2.50 Functions should have less than 100’ lines. Note The number of lines can be specified. Advi-
sory
E2.51 Functions should have less than '15' V(g) complexity. Note: The complexity limit of lines can be | Advi-
specified. sory
E2.52 Functions should have less than '‘%param%' lines, outside empty lines (current value: <name>).
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462

Code re-
view ref- | Code review message Level
erence
E2.53 Functions should have less than '%param%' lines, outside empty lines or comment lines (current
value : <name>).
E2.54 Functions should have less than '‘%»param%' lines not counting empty lines, comments or brackets
(current value: %name%).
E2.55 Compilation units should have less than '%param%' functions (current value: %name%).
Op-
E2.56 Compilation units should have less than '%param%' variables (current value: %name%). tional
E2.57 Compilation unit should have less than '%param%' lines (current value: %name%). Op-
tional
E2.58 Compilation unit should have less than '%param%' lines not counting empty lines (current value: | Op-
%name%). tional
E2.59 Compilation unit should have less than '%param%' lines not counting empty lines or comments | Op-
(current value: %name%). tional
E2.60 Compilation unit should have less than '%param%' lines not counting empty lines, comments or | Op-
brackets (current value: %name%). tional
E2.61 Functions should have less than '%param%' parameters (current value: %name%).
Identifiers
E5.1.1 Identifiers '%name%' and '%name%' are ambiguous because of possible character confusion. Advi-
sory
E5.1.2 Possible typing mistake between the variables '%name%' and '‘%»name%' because of repeating char- | Advi-
acter. sory
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Table 14. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
E5.1.3 Identifiers <name> and <name> are identical in the first %param% characters ignoring case. Advi-
sory
E5.1.4 Macros '%name%' and '%»name%" are identical in the first '%param%' characters. Advi-
sory
E5.1.5 Macro '%»name%' and identifier '%name%' are identical in the first '%param%' characters. Advi-
sory
E5.1.6 Macros '%name%' and '%name%" are identical in the first ‘%param%' characters ignoring case. Advi-
sory
E5.1.7 Macro '‘%name%' and identifier '%name%' are identical in the first ‘%param%' characters ignoring | Advi-
case. sory
E5.3 The tag name '%name%' should not be reused. Name already found in %location%. Advi-
sory
Types
Re-
E6.3 The implicit 'int' type should not be used. .
quired
E7.1 Octal and hexadecimal escape sequences shall be terminated. Re-
quired
E7.2 The lowercase character 'I' shall not be used in a literal suffix. Re-
quired
E7.3 A string literal shall not be assigned to an object unless the object's type is pointer to a const-qual- | Re-
ified char. quired
Declarations and definitions
Re-
E8.1.1 A prototype for the global object '%name%' should be declared before defining the object. quired
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Code re-
view ref- | Code review message Level
erence
Re-
E8.3 Parameters and return types should use compatible type in the declaration and in the definition. quired
E8.10 Inline function '‘%name%' should be static
Re-
E8.14 The restrict type qualifier shall not be used. .
quired
Re-
E.8.50 Use the const qualification for variable '%name%' which is pointer and which is not used to change quired
the pointed object.
Re-
E.8.51 The object '%name%' is never referenced. .
quired
Initialization
Re-
E9.1 An element of an object shall not be in itialized more than once. quired
Re-
E9.2 Arrays shall not be partially initialized
y partially initializ quired
Re-
E9.3 Enumeration member '%name%' have a not unique implicitly-specified value. quired
Re-
E9.4 The global variable '%name%' is not initialized. .
quired
Re-
E9.5 Where designated initializers are used to initialize an array object the size of the array shall be quired
specified explicitly
Arithmetic type conversions
Re-
E10.1 Constraint violation: can't use floating type as operand of '[], %, <<, >>, ~, & |, * quired
Re-
E10.2 Operand should be boolean. .
quired
Re-
E10.3 Can't use a boolean as a numeric value. .
quired
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Code re-
view ref- | Code review message Level
erence
Re-
E10.4 Can't use a char as a numeric value. .
quired
Re-
E10.5 Can't use a not anonymous enum as a numeric value. .
quired
Re-
E10.6 Shift and bitwise operations should be performed on unsigned value. quired
Re-
E10.7 Right hand operand of shift operation should be an unsigned value. quired
Re-
E10.8 Unary minus operation should not be performed on unsigned value. quired
Re-
E10.9 Expressions of essentially character type shall not be used inappropriately in addition and subtrac- quired
tion operations.
Re-
E10.10 |The value of an expression shall not be assigned to an object with a narrower essential type quired
Re-
E10.11 The value of an expression shall not be assigned to an object with a different essential type cat- quired
egory.
Re-
E10.12 |Both operands of an operator in which the usual arithmetic conversions are performed shall have quired
the same essential type category.
Re-
E10.13 | The value of an expression should not be cast to an inappropriate essential type. quired
The value of a composite expression shall not be assigned to an object with wider essential type | Re-
E10.14
quired
If a composite expression is used as one operand of an operation in which the usual arithmetic | Re-
E10.15 . . . .
conversions are performed then the other operand shall not have wider essential type quired
The value of a composite expression shall not be cast to a different essential type category or a | Re-
E10.16
wider essential type quired
Pointer type conversions
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Code re-
view ref- | Code review message Level
erence

Re-
E11.1 Conversions shall not be performed between a pointer to an incomplete type and any other type. quired

Re-
E11.2 A conversion should not be performed from pointer to void into pointer to object quired

Re-
E11.3 A cast shall not be performed between pointer to void and an arithmetic type quired

Re-
E11.4 A cast shall not be performed between pointer to object and a non-integer arithmetic type quired

Re-
E11.5 The macro NULL shall be the only permitted form of integer NULL pointer constant quired
Expressions

Advi-
E12.11 Implicit bitwise operator precedence may cause ambiguity. Use parenthesis to clarify this expres- sory

sion.

Advi-
E12.51 E12.51 Ternary expression '?:' should not be used. sory

Advi-
E12.54 | Expressions should not cause a side effect assignment. sory

Advi-
E12.61 The operator on a Boolean expression should be a logical operator. ( &&, || or !). sory
Control statement expressions

Re-
E13.1 The result of an assignment operator should not be used in an expression. quired
Control flow

Re-
E14.4.1 | The goto statement shall jump to a label declared later in the same function. quired

Re-
E14.4.2 | Any label referenced by a goto statement shall be declared in the same block, or in any block quired

enclosing the goto statement.
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Code re-
view ref- | Code review message Level
erence
Re-
E14.4.3 | There should be no more than one break or goto statement used to terminate any iteration state- quired
ment.
Switch statements
Re-
E15.10 | Flexible arrays members shall not be declared. .
quired
Functions
Re-
E16.50 | The function <name> is never referenced. .
quired
Structures and unions
Re-
E18.1 Flexible arrays members shall not be declared. .
quired
Re-
E18.3 The declaration of an array parameter shall not contain the static keyword between the []. quired
Preprocessing directives
Re-
E19.18 | The controlling expression of a #if or #elif preprocessing directive shall evaluate to 0 or 1. quired
Re-
E19.19 | A macro parameter immediately following a # operator shall not immediately be followed by a ## quired
operator.
Re-
E19.20 |Macro parameter <name> used as an operand to the # and ## operators shall not be used else- quired
where in this macro.
Standard libraries
A macro shall not be defined with the same name as a keyword: %name% Re-
E20.1
quired
The standard header file <setjmp.h> shall not be used Re-
E20.7 .
quired
The signal handling facilities of <signal.h> shall not be used. Re-
E20.8 .
quired
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Table 14. Extended rules (continued)

Code re-
view ref- | Code review message Level
erence
The library macro or function 'bsearch, gsort' should not be used Re-
E20.11 .
quired
The input/output library <wchar.h> shall not be used in production code Re-
E20.12 .
quired
The standard header file <tgmath.h> shall not be used Re-
E20.13 .
quired
The library macro or function 'feclearexcept, fegetexceptflag, feraiseexcept, fesetexceptflag, fetes- | Re-
E20.14
texcept, FE_INEXACT, FE_DIVBYZERO, FE_UNDERFLOW, FE_OVERFLOW, FE_INVALID, FE_ALL_EX- | quired
CEPT' should not be used

Note: Applies to Test Embedded Studio only:

The code review references in bold in this table are disabled when they are run from the code review link

checker in test mode. To verify these rules, you must run the code review from the application node in

Test Embedded Studio. For more information, see Running complete verification of MISRA rules from an

application node on page 535.

Code review MISRA 2012 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be

individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules

also have parameters that can be changed. Among other guidelines, the code review tool implements most rules

from the MISRA-C:2012 standard, "Guidelines for the use of the C language in critical systems". These rules are

referenced with an M prefix. In addition to the industry standard rules, Test Embedded provides some additional

coding guidelines, which are referenced with an E prefix.

Code Review - MISRA 2012 rules

Misra rules can be categorized as either Decidable or Undecidable:

» A Decidable rule can be checked by a static analyzer, and so, is totally covered within the capabilities of the

tool.

« An Undecidable rule cannot, in theory, be checked by a static analyzer. If an undecidable rule is covered within

the capabilities of the tool, then this rule is partially covered.
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unreachable

code.

Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
A standard C environment
M1.1 Rule 1.1 Decidable The program | ANSI C error: | Required
shall contain %name%
no violations
M1.1W ofthestan- | ANsi ¢ warn-
dard C syn- ing: %name%
tax and con-
straints, and
shall not ex-
ceed the im-
plementation’s
translation lim-
its.
Partially sup-
M1.2 Rule 1.2 Undecidable Language Use of #prag- |Advisory ported
extensions ma %name%
should not be | should always
used. be encapsulat-
ed and docu-
mented.
Partially sup-
M1.3 Rule 1.3 Undecidable There shall be | For more in- Required ported
no occurrence | formation,
of undefined |see Annex to
or critical un- [ MISRA 2012
specified be- |Rule 1.3 on
haviour. page 317.
Unused code
Partially sup-
M2.1 Rule 2.1 Undecidable A project shall | Unreachable Required ported
not contain code.
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Table 15. MISRA rules (continued)
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
Partially sup-
M2.2.1 Rule 2.2 Undecidable There shall be | A non-null Required ported
no dead code. |statement
should either
have a side ef-
fect or change
the control
flow.
M2.2.2 The function
%name% is
never refer-
enced.
M2.2.3 The object
%name% is
never refer-
enced
M2.3 Rule 2.3 Decidable A project Type %name% | Advisory
should not is never used.
contain un-
used type dec-
larations.
M2.4 Rule 2.4 Decidable A project Tag %name% | Advisory
should not is never used.
contain un-
used tag dec-
larations.
M2.5 Rule 2.5 Decidable A project Macro %name | Advisory
should not % is never
contain un- used.
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
used macro
declarations.

M2.6 Rule 2.6 Decidable A function A function Advisory
should not should not
contain un- contain un-
used label dec- | used label dec-
larations. larations.

M2.7 Rule 2.7 Decidable There should | There should | Advisory
be no unused |be no unused
parameters in | parameters in
functions. functions.

Comments

M3.1.1 Rule 3.1 Decidable The character | The character |Required
sequences /* | sequence /*
and // shall not | should not be
be used within |used within a
a comment. comment.

M3.1.2 The character

sequence //
should not be
used within a
'C-style' com-
ment.

M3.2 Rule 3.2 Decidable Line-splicing Line-splicing Required
shall not be shall not be
used in // com- [ used in // com-
ments. ments.

Character sets and lexical conventions
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
M4.1 Rule 4.1 Decidable Octal and Octal and Required
hexadecimal |hexadecimal
escape se- escape se-
quences shall | quences shall
be terminated. | be term inated.
M4.2 Rule 4.2 Decidable Trigraphs Trigraphs Advisory
should not be | should not be
used. used.
Identifiers
M5.1.1 Rule 5.1 Decidable External iden- [ External iden- |Required
tifiers shall be |tifiers %name
distinct in the | % and %name
first 31 charac- | % are iden-
ters. tical in the
first %param%
characters.
External iden-
M5.1.2 tifiers shall be
distinct in the
first 6 charac-
ters ignoring
case.
M5.2 Rule 5.2 Decidable Identifiers de- | Identifiers Required
clared in the %name% de-
same scope clared in the
and name same scope
space shall be |and name
distinct. space shall
be distinct.
Identifier iden-
tical in the
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Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

first %param%
characters al-
ready found in

%location%.

M5.3

Rule 5.3

Decidable

An identifier
declared in an
inner scope
shall not hide
an identifier
declared in an

outer scope.

Identifier
%name% de-
clared in an
inner scope
shall not hide
an identifier
declared in an
outer scope.
Identifier iden-
tical in the
first %param%
characters al-
ready found in

%location%

Required

M5.4.1

M5.4.2

Rule 5.4

Decidable

Macro identi-
fiers shall be

distinct.

Macros
%name% and
%name% are
identical in the
first %param%

characters

Macros
%name% and
%name% are
identical in the
first %param%
characters ig-

noring case.

Required
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Table 15. MISRA rules (continued)

Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M5.5.1

M5.5.2

Rule 5.5

Decidable

Identifiers
shall be dis-
tinct from

macro names.

Macro %name
% and iden-
tifier %name
% are iden-
tical in the
first %param%
characters.

Macro %name
% and iden-
tifier %name
% are iden-
tical in the
first %param%
characters ig-

noring case.

Required

M5.6

Rule 5.6

Decidable

A typedef
name shall be
a unique iden-

tifier.

The typedef
name %name
% should not
be reused ex-
cept for its tag.
Name already
found in %lo-

cation%

Required

M5.7.1

474

Rule 5.7

Decidable

The tag name
%name%
should not be

reused.

The tag name
%name%

should not be
reused. Name
already found

%location%

Required
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Code review MISRA-C: Decidable/Un- | Description Message Level Note
reference 2012 refer- decidable
ence
MS5.7.2 A struct and
union cannot
use the same
tag name.
M5.8 Rule 5.8 Decidable Identifiers that | Identifiers Required
define objects | '%name%' that
or functions defines ob-
with external |jects or func-
linkage shall tions with ex-
be unique. ternal link-
age shall be
unique. Iden-
tifier already
found in %lo-
cation%
M5.9 Rule 5.9 Decidable Identifiers that | Identifiers or | Advisory
define objects | macro '‘%name
or functions %' and '%name
with internal %'are ambigu-
linkage should | ous because
be unique. of possible
character con-
fusion.
Types
Bit- fields shall
M6.1.1 Rule 6.1 Decidable only be de- Bit fields Required
clared with an should only
appropriate be of type 'un-
ype. signed int' or
'signed int'.
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Table 15. MISRA rules (continued)

Code review

reference

MISRA-C:
2012 refer-

ence

Decidable/Un-
decidable

Description

Message

Level

Note

M6.1.2

M6.1.3

M6.1.4

M6.1.5

Bit fields
should not be
of type 'enum’.

Bit fields
should only

be of explicit-
ly signed or un-
signed type.

Bit fields
should not

be of type
'‘boolean